
QGIS Training Manual

QGIS Project

mrt. 24, 2022





Inhoudsopgave

1 Introductie voor de cursus 1
1.1 Voorwoord . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.1.1 Waarom QGIS? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.1.2 Achtergrond . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.1.3 Licentie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.1.4 Hoofdstukken over sponsoring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.1.5 Auteurs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.1.6 Individuele meewerkenden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.1.7 Sponsoren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.1.8 Bronbestanden en rapporteren van problemen . . . . . . . . . . . . . . . . . . . . . . . . 3
1.1.9 Laatste versie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

1.2 Over de oefeningen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.2.1 Hoe deze handleiding te gebruiken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.2.2 Gestaffelde doelen voor de cursus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
1.2.3 Gegevens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2 Module: Een basiskaart maken en verkennen 7
2.1 Lesson: Een overzicht van de interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.1.1 Try Yourself: De basisonderdelen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
2.1.2 Try Yourself 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.1.3 Try Yourself 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.1.4 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2.2 Lesson: Uw eerste lagen toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
2.2.1 Follow Along: Een kaart voorbereiden . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
2.2.2 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
2.2.3 Follow Along: Vectorgegevens uit een database van GeoPackage laden . . . . . . . . . . . 14
2.2.4 Follow Along: Vectorgegevens laden met de Browser uit een database van SpatiaLite . . . 15
2.2.5 Try Yourself Meer vectorgegevens laden . . . . . . . . . . . . . . . . . . . . . . . . . . 16
2.2.6 Follow Along: De lagen opnieuw schikken . . . . . . . . . . . . . . . . . . . . . . . . . 17
2.2.7 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
2.2.8 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

2.3 Lesson: Navigeren in het kaartvenster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
2.3.1 Follow Along: Basisgereedschappen voor navigeren . . . . . . . . . . . . . . . . . . . . . 18
2.3.2 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

2.4 Lesson: Symbologie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
2.4.1 Follow Along: Kleuren wijzigen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
2.4.2 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
2.4.3 Follow Along: Symboolstructuur wijzigen . . . . . . . . . . . . . . . . . . . . . . . . . . 24
2.4.4 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
2.4.5 Follow Along: Op schaal gebaseerde zichtbaarheid . . . . . . . . . . . . . . . . . . . . . 25
2.4.6 Follow Along: Symboollagen toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

i



2.4.7 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
2.4.8 Follow Along: Niveaus van symbolen schikken . . . . . . . . . . . . . . . . . . . . . . . 30
2.4.9 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
2.4.10 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
2.4.11 Follow Along: Typen symboollagen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
2.4.12 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
2.4.13 Follow Along: Symbologie voor Geometrie-generator . . . . . . . . . . . . . . . . . . . 43
2.4.14 Follow Along: Een aangepaste SVG-vulling maken . . . . . . . . . . . . . . . . . . . . . 47
2.4.15 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
2.4.16 Further Reading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
2.4.17 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

3 Module: Vectorgegevens classificeren 55
3.1 Lesson: Vector attributengegevens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

3.1.1 Follow Along: Laagattributen bekijken . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
3.1.2 Try Yourself Attributen van vectorgegevens verkennen . . . . . . . . . . . . . . . . . . . 59
3.1.3 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
3.1.4 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

3.2 Lesson: Labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
3.2.1 Follow Along: Labels gebruiken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
3.2.2 Follow Along: Opties voor labels wijzigen . . . . . . . . . . . . . . . . . . . . . . . . . . 62
3.2.3 Follow Along: Labels in plaats van symbologie voor lagen gebruiken . . . . . . . . . . . . 66
3.2.4 Try Yourself De labels aanpassen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
3.2.5 Follow Along: Lijnen labelen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
3.2.6 Follow Along: Gegevensgedefinieerde instellingen . . . . . . . . . . . . . . . . . . . . . 74
3.2.7 Try Yourself Gegevensgedefinieerde instellingen gebruiken . . . . . . . . . . . . . . . . . 76
3.2.8 Meer mogelijkheden met labelen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
3.2.9 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
3.2.10 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

3.3 Lesson: Classificatie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
3.3.1 Follow Along: Nominale gegevens classificeren . . . . . . . . . . . . . . . . . . . . . . . 78
3.3.2 Try Yourself Meer classificatie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
3.3.3 Follow Along: Ratio-classificatie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
3.3.4 Try Yourself De classificatie verfijnen . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
3.3.5 Follow Along: Op regels gebaseerde classificatie . . . . . . . . . . . . . . . . . . . . . . 91
3.3.6 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
3.3.7 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

4 Module: De kaarten opmaken 97
4.1 Lesson: Afdruklay-out gebruiken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

4.1.1 Follow Along: Lay-out beheren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
4.1.2 Follow Along: Compositie basiskaart . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
4.1.3 Follow Along: Een titel toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
4.1.4 Follow Along: Een legenda toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
4.1.5 Follow Along: Items voor legenda’s aanpassen . . . . . . . . . . . . . . . . . . . . . . . 105
4.1.6 Follow Along: Uw kaart exporteren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
4.1.7 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

4.2 Lesson: Een dynamische afdruklay-out maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
4.2.1 Follow Along: Het dynamische kaartvenster maken . . . . . . . . . . . . . . . . . . . . . 109
4.2.2 Follow Along: De dynamische kop maken . . . . . . . . . . . . . . . . . . . . . . . . . 110
4.2.3 Follow Along: Labels maken voor de dynamische kop . . . . . . . . . . . . . . . . . . . 111
4.2.4 Follow Along: Afbeeldingen toevoegen aan de dynamische kop . . . . . . . . . . . . . . 113
4.2.5 Follow Along: De schaalbalk maken voor de dynamische kop . . . . . . . . . . . . . . . 114
4.2.6 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

4.3 Opdracht 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
4.3.1 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

5 Module: Vectorgegevens maken 117
5.1 Lesson: Een nieuwe vector gegevensset maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

ii



5.1.1 Follow Along: Het dialoogvenster Laag maken . . . . . . . . . . . . . . . . . . . . . . . 117
5.1.2 Follow Along: Gegevensbronnen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
5.1.3 Try Yourself Polygonen digitaliseren . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
5.1.4 Follow Along: Tabel Punten bewerken gebruiken . . . . . . . . . . . . . . . . . . . . . . 134
5.1.5 Try Yourself Lijnen digitaliseren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
5.1.6 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
5.1.7 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

5.2 Lesson: Topologie voor objecten . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
5.2.1 Follow Along: Snappen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
5.2.2 Follow Along: Juiste topologische objecten . . . . . . . . . . . . . . . . . . . . . . . . . 142
5.2.3 Follow Along: Gereedschap: Object vereenvoudigen . . . . . . . . . . . . . . . . . . . . 145
5.2.4 Try Yourself Gereedschap: Ring toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . 147
5.2.5 Try Yourself Gereedschap: Deel toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . 147
5.2.6 Follow Along: Gereedschap: Objecten vervormen . . . . . . . . . . . . . . . . . . . . . . 148
5.2.7 Try Yourself Gereedschap: Objecten splitsen . . . . . . . . . . . . . . . . . . . . . . . . 150
5.2.8 Try Yourself Gereedschap: Objecten samenvoegen . . . . . . . . . . . . . . . . . . . . . 152
5.2.9 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
5.2.10 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152

5.3 Lesson: Formulieren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
5.3.1 Follow Along: QGIS’ functionaliteit formulierontwerp gebruiken . . . . . . . . . . . . . . 152
5.3.2 Try Yourself Het formulier gebruiken om waarden te bewerken . . . . . . . . . . . . . . 153
5.3.3 Follow Along: Typen velden voor formulieren instellen . . . . . . . . . . . . . . . . . . . 154
5.3.4 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
5.3.5 Try Yourself Testgegevens maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
5.3.6 Follow Along: Een nieuw formulier maken . . . . . . . . . . . . . . . . . . . . . . . . . 158
5.3.7 Follow Along: Het formulier associëren met uw laag . . . . . . . . . . . . . . . . . . . . 160
5.3.8 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
5.3.9 Further Reading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
5.3.10 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

5.4 Lesson: Acties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
5.4.1 Follow Along: Een veld voor afbeeldingen toevoegen . . . . . . . . . . . . . . . . . . . . 162
5.4.2 Follow Along: Een actie maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
5.4.3 Follow Along: Zoeken op het internet . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
5.4.4 Follow Along: Een webpagina direct in QGIS openen . . . . . . . . . . . . . . . . . . . 171
5.4.5 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
5.4.6 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173

6 Module: Vectoranalyse 175
6.1 Lesson: Gegevens opnieuw projecteren en transformeren . . . . . . . . . . . . . . . . . . . . . . . 175

6.1.1 Follow Along: Projecties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176
6.1.2 Follow Along: “Direct” opnieuw projecteren . . . . . . . . . . . . . . . . . . . . . . . . 176
6.1.3 Follow Along: Een gegevensset opslaan in een ander CRS . . . . . . . . . . . . . . . . . 177
6.1.4 Follow Along: Uw eigen projectie maken . . . . . . . . . . . . . . . . . . . . . . . . . . 180
6.1.5 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
6.1.6 Further Reading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
6.1.7 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

6.2 Lesson: Vectoranalyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
6.2.1 Het proces GIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
6.2.2 Het probleem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
6.2.3 De gegevens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183
6.2.4 Follow Along: Een project beginnen en de gegevens ophalen . . . . . . . . . . . . . . . . 184
6.2.5 Try Yourself CRS van een laag converteren . . . . . . . . . . . . . . . . . . . . . . . . . 185
6.2.6 Follow Along: Analyseren van het probleem: Afstanden van scholen en wegen . . . . . . . 187
6.2.7 Try Yourself Afstand van scholen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
6.2.8 Follow Along: Overlappende gebieden . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
6.2.9 Follow Along: De gebouwen uitnemen . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
6.2.10 Try Yourself Onze gebouwen verder filteren . . . . . . . . . . . . . . . . . . . . . . . . 198
6.2.11 Follow Along: Selecteren van gebouwen met de juiste grootte . . . . . . . . . . . . . . . 198

iii



6.2.12 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
6.2.13 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
6.2.14 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201

6.3 Lesson: Netwerkanalyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
6.3.1 Follow Along: De gereedschappen en de gegevens . . . . . . . . . . . . . . . . . . . . . 201
6.3.2 Kortste pad (punt naar punt) berekenen . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
6.3.3 Try Yourself Snelste pad . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206
6.3.4 Follow Along: Gevorderde opties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206
6.3.5 Kortste pad met snelheidsbeperking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 208
6.3.6 Servicegebied (vanuit laag) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
6.3.7 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
6.3.8 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212

6.4 Lesson: Ruimtelijke statistieken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
6.4.1 Follow Along: Een test-gegevensset maken . . . . . . . . . . . . . . . . . . . . . . . . . 212
6.4.2 Follow Along: Basisstatistieken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
6.4.3 Follow Along: Statistieken berekenen van afstanden tussen punten . . . . . . . . . . . . . 218
6.4.4 Follow Along: ‘Dichtstbijzijnde buur’-analyse (in laag) . . . . . . . . . . . . . . . . . . . 220
6.4.5 Follow Along: Gemiddelde coördinaten . . . . . . . . . . . . . . . . . . . . . . . . . . . 221
6.4.6 Follow Along: Histogrammen van afbeeldingen . . . . . . . . . . . . . . . . . . . . . . . 222
6.4.7 Follow Along: Ruimtelijke interpolatie . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
6.4.8 Try Yourself Verschillende methoden voor interpolatie . . . . . . . . . . . . . . . . . . . 225
6.4.9 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226
6.4.10 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

7 Module: Rasters 227
7.1 Werken met rastergegevens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227

7.1.1 Follow Along: Rastergegevens laden . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
7.1.2 Follow Along: Een virtueel raster maken . . . . . . . . . . . . . . . . . . . . . . . . . . 228
7.1.3 Rastergegevens transformeren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
7.1.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
7.1.5 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233

7.2 Lesson: Symbologie van rasters wijzigen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
7.2.1 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
7.2.2 Follow Along: Symbologie van rasterlagen wijzigen . . . . . . . . . . . . . . . . . . . . . 234
7.2.3 Follow Along: Enkelbands grijs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
7.2.4 Follow Along: Enkelbands pseudokleur . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
7.2.5 Follow Along: Transparantie wijzigen . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238
7.2.6 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241
7.2.7 Verwijzing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241
7.2.8 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241

7.3 Lesson: Terreinanalyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241
7.3.1 Follow Along: Een schaduw voor heuvels berekenen . . . . . . . . . . . . . . . . . . . . 241
7.3.2 Follow Along: Schaduw voor heuvels gebruiken door er overheen te leggen . . . . . . . . 243
7.3.3 Follow Along: De beste gebieden zoeken . . . . . . . . . . . . . . . . . . . . . . . . . . 244
7.3.4 Follow Along: Berekenen van de helling . . . . . . . . . . . . . . . . . . . . . . . . . . 244
7.3.5 Try Yourself Berekenen van het aspect . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
7.3.6 Follow Along: Het aspect zoeken dat op het noorden uitkijkt . . . . . . . . . . . . . . . . 245
7.3.7 Try Yourself Meer criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
7.3.8 Follow Along: Resultaten van rasteranalyses combineren . . . . . . . . . . . . . . . . . . 248
7.3.9 Follow Along: Het raster vereenvoudigen . . . . . . . . . . . . . . . . . . . . . . . . . . 249
7.3.10 Follow Along: Het raster opnieuw classificeren . . . . . . . . . . . . . . . . . . . . . . . 252
7.3.11 Follow Along: Het raster bevragen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256
7.3.12 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
7.3.13 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

8 Module: De analyse completeren 261
8.1 Lesson: Conversie van raster naar vector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261

8.1.1 Follow Along: Het gereedschap Raster naar vector . . . . . . . . . . . . . . . . . . . . . 261

iv



8.1.2 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 262
8.1.3 Follow Along: Het gereedschap Vector naar raster . . . . . . . . . . . . . . . . . . . . . 263
8.1.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264
8.1.5 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264

8.2 Lesson: Combineren van de analyses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264
8.2.1 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264
8.2.2 Try Yourself Inspecteren van de resultaten . . . . . . . . . . . . . . . . . . . . . . . . . 265
8.2.3 Try Yourself De analyse opnieuw definiëren . . . . . . . . . . . . . . . . . . . . . . . . 265
8.2.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265
8.2.5 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266

8.3 Opdracht . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
8.4 Lesson: Extra oefening . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266

8.4.1 Definitie van het probleem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
8.4.2 Overzicht van de oplossing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267
8.4.3 Follow Along: Instellen van de kaart . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267
8.4.4 Gegevens in de kaart laden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267
8.4.5 Wijzigen van de volgorde van lagen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268
8.4.6 Zoek naar de juiste districten . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268
8.4.7 Clippen van de rasters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 269
8.4.8 Wijzigen van de symbologie van vectorlagen . . . . . . . . . . . . . . . . . . . . . . . . 270
8.4.9 Wijzigen van de symbologie van rasterlagen . . . . . . . . . . . . . . . . . . . . . . . . 270
8.4.10 De kaart opruimen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271
8.4.11 De schaduw voor heuvels maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271
8.4.12 Helling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271
8.4.13 Try Yourself Ligging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272
8.4.14 Rasters opnieuw classificeren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272
8.4.15 Rasters combineren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273
8.4.16 Landelijke gebieden zoeken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273
8.4.17 Een negatieve buffer maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
8.4.18 Het raster vectoriseren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
8.4.19 Geometrieën repareren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275
8.4.20 Bepalen van de kruising van vectors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275
8.4.21 Het gebied voor elke polygoon berekenen . . . . . . . . . . . . . . . . . . . . . . . . . . 275
8.4.22 Gebieden met een bepaalde grootte selecteren . . . . . . . . . . . . . . . . . . . . . . . 276
8.4.23 Digitaliseren van de universiteit van Kaapstad . . . . . . . . . . . . . . . . . . . . . . . . 276
8.4.24 Zoek de locaties die het dichtst bij de universiteit van Kaapstad liggen . . . . . . . . . . . 277

9 Module: Plug-ins 279
9.1 Lesson: Plug-ins installeren en beheren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279

9.1.1 Follow Along: Plug-ins beheren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279
9.1.2 Follow Along: Nieuwe plug-ins Installeren . . . . . . . . . . . . . . . . . . . . . . . . . 280
9.1.3 Follow Along: Aanvullende opslagplaatsen voor plug-ins configureren . . . . . . . . . . . 282
9.1.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284
9.1.5 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284

9.2 Lesson: Handige plug-ins voor QGIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284
9.2.1 Follow Along: De plug-in QuickMapServices . . . . . . . . . . . . . . . . . . . . . . . . 284
9.2.2 Follow Along: De plug-in QuickOSM . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285
9.2.3 Follow Along: Het programma voor de query van QuickOSM . . . . . . . . . . . . . . . 286
9.2.4 Follow Along: De plug-in DataPlotly . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
9.2.5 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293
9.2.6 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293

10 Module: Online bronnen 295
10.1 Lesson: Web Mapping Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295

10.1.1 Follow Along: Een WMS-laag laden . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295
10.1.2 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 304
10.1.3 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
10.1.4 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305

v



10.1.5 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
10.1.6 Further Reading . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
10.1.7 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305

10.2 Lesson: Web Feature Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
10.2.1 Follow Along: Een WFS-laag laden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 306
10.2.2 Follow Along: Een WFS-laag bevragen . . . . . . . . . . . . . . . . . . . . . . . . . . . 309
10.2.3 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 312
10.2.4 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 312

11 Module: QGIS Server 313
11.1 Lesson: QGIS Server installeren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313

11.1.1 Follow Along: Installeren vanuit pakketten . . . . . . . . . . . . . . . . . . . . . . . . . 313
11.1.2 Follow Along: QGIS Server uitvoerbare bestand . . . . . . . . . . . . . . . . . . . . . . 314
11.1.3 HTTP serverconfiguratie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 314
11.1.4 Follow Along: Een andere virtuele host maken . . . . . . . . . . . . . . . . . . . . . . . 314
11.1.5 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315
11.1.6 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315

11.2 Lesson: Server voor WMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315
11.2.1 Loggen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 318
11.2.2 Verzoeken GetMap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 319
11.2.3 Try Yourself De parameters Image en Layers wijzigen . . . . . . . . . . . . . . . . . . . 320
11.2.4 Follow Along: Filteren, transparantie en parameters Stijlen gebruiken . . . . . . . . . . . 321
11.2.5 Follow Along: Redlining gebruiken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 322
11.2.6 Verzoeken GetPrint . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 323
11.2.7 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325
11.2.8 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326

12 Module: GRASS 327
12.1 Lesson: GRASS instellen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327

12.1.1 Follow Along: Een nieuwe sessie in GRASS beginnen . . . . . . . . . . . . . . . . . . . 327
12.1.2 Follow Along: Een nieuw project in GRASS beginnen . . . . . . . . . . . . . . . . . . . 330
12.1.3 Follow Along: Vectorgegevens in GRASS laden . . . . . . . . . . . . . . . . . . . . . . 337
12.1.4 Follow Along: Rastergegevens in GRASS laden . . . . . . . . . . . . . . . . . . . . . . . 341
12.1.5 Try Yourself Lagen toevoegen aan mapset . . . . . . . . . . . . . . . . . . . . . . . . . 343
12.1.6 Een bestaande maspet van GRASS openen . . . . . . . . . . . . . . . . . . . . . . . . . 343
12.1.7 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346
12.1.8 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346

12.2 Lesson: GRASS-gereedschap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346
12.2.1 Follow Along: Een kaart van de ligging maken . . . . . . . . . . . . . . . . . . . . . . . 346
12.2.2 Follow Along: Basisstatistieken van de rasterlaag verkrijgen . . . . . . . . . . . . . . . . 348
12.2.3 Follow Along: Het gereedschap Reclass . . . . . . . . . . . . . . . . . . . . . . . . . . . 350
12.2.4 Try Yourself Opnieuw classificeren met uw regels . . . . . . . . . . . . . . . . . . . . . 352
12.2.5 Follow Along: Het gereedschap Mapcalc . . . . . . . . . . . . . . . . . . . . . . . . . . 352
12.2.6 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355

13 Module: Beoordeling 357
13.1 Een basiskaart maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357

13.1.1 De puntlaag toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357
13.1.2 Voeg de lijnlaag toe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358
13.1.3 Voeg de polygoonlaag toe . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359
13.1.4 Maak de raster-achtergrond . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359
13.1.5 Voltooien van de basiskaart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359

13.2 De gegevens analyseren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360
13.2.1 / . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360

13.3 Uiteindelijke kaart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360

14 Module: Toepassing Bosbouw 361
14.1 Lesson: Presentatie module Bosbouw . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 361

14.1.1 Voorbeeldgegevens Bosbouw . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 362

vi



14.2 Lesson: Geoverwijzingen in een kaart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 362
14.2.1 De kaart scannen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 362
14.2.2 Follow Along: De gescande kaart voorzien van geoverwijzingen . . . . . . . . . . . . . . 363
14.2.3 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368
14.2.4 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368

14.3 Lesson: Bosopstanden digitaliseren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368
14.3.1 Follow Along: De grenzen van de bosopstanden uitnemen . . . . . . . . . . . . . . . . . 368
14.3.2 Try Yourself De afbeelding met groene pixels voorzien van geoverwijzingen . . . . . . . . 371
14.3.3 Follow Along: Ondersteunende punten voor digitaliseren maken . . . . . . . . . . . . . . 371
14.3.4 Follow Along: De bosopstanden digitaliseren . . . . . . . . . . . . . . . . . . . . . . . . 374
14.3.5 Try Yourself Digitaliseren van de bosopstanden voltooien . . . . . . . . . . . . . . . . . 378
14.3.6 Follow Along: De gegevens voor de bosopstanden samenvoegen . . . . . . . . . . . . . . 379
14.3.7 Try Yourself Namen voor attributen hernoemen en gebied en begrenzing toevoegen . . . . 380
14.3.8 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 382
14.3.9 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 382

14.4 Lesson: Bijwerken van de bosopstanden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 382
14.4.1 Oude bosopstanden met huidige luchtfoto’s vergelijken . . . . . . . . . . . . . . . . . . . 382
14.4.2 De CIR-afbeelding interpreteren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 383
14.4.3 Try Yourself Bosopstanden vanuit CIR-afbeeldingen digitaliseren . . . . . . . . . . . . . 385
14.4.4 Follow Along: Bosopstanden bijwerken met informatie over natuurbehoud . . . . . . . . . 387
14.4.5 Try Yourself Bosopstanden bijwerken met afstand tot de stroom . . . . . . . . . . . . . . 391
14.4.6 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
14.4.7 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392

14.5 Lesson: Systematisch ontwerpen van monsters . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
14.5.1 Inventariseren van het bos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
14.5.2 Follow Along: Een systematisch ontwerp van monsterplaatsen implementeren . . . . . . . 393
14.5.3 Follow Along: Monsterplaatsen in GPX-indeling exporteren . . . . . . . . . . . . . . . . 397
14.5.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399
14.5.5 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399

14.6 Lesson: Gedetailleerde kaarten maken met het gereedschap Atlas . . . . . . . . . . . . . . . . . . 399
14.6.1 Follow Along: De afdruklay-out voorbereiden . . . . . . . . . . . . . . . . . . . . . . . 399
14.6.2 Follow Along: Een achtergrondkaart toevoegen . . . . . . . . . . . . . . . . . . . . . . . 401
14.6.3 Try Yourself De symbologie van de lagen wijzigen . . . . . . . . . . . . . . . . . . . . . 402
14.6.4 Try Yourself Een sjabloon voor een basiskaart maken . . . . . . . . . . . . . . . . . . . 403
14.6.5 Follow Along: Meer elementen aan de lay-out toevoegen . . . . . . . . . . . . . . . . . . 404
14.6.6 Follow Along: Een Atlas-bedekking genereren . . . . . . . . . . . . . . . . . . . . . . . 406
14.6.7 Follow Along: Het gereedschap Atlas instellen . . . . . . . . . . . . . . . . . . . . . . . 408
14.6.8 Follow Along: De bedekkingslaag bewerken . . . . . . . . . . . . . . . . . . . . . . . . 410
14.6.9 Follow Along: De kaarten afdrukken . . . . . . . . . . . . . . . . . . . . . . . . . . . . 413
14.6.10 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 414
14.6.11 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 414

14.7 Lesson: De parameters voor het bos berekenen . . . . . . . . . . . . . . . . . . . . . . . . . . . . 414
14.7.1 Follow Along: De resultaten van de inventarisatie toevoegen . . . . . . . . . . . . . . . . 414
14.7.2 Follow Along: Schatting voor parameters voor gehele bos . . . . . . . . . . . . . . . . . 415
14.7.3 Follow Along: Parameters voor de bosopstanden schatten . . . . . . . . . . . . . . . . . 416
14.7.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 419
14.7.5 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 420

14.8 Lesson: DEM vanuit gegevens van LiDAR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 420
14.8.1 Follow Along: LAStools installeren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 420
14.8.2 Follow Along: Een DEM berekenen met LAStools . . . . . . . . . . . . . . . . . . . . . 422
14.8.3 Follow Along: Een terrein met schaduw voor heuvels maken . . . . . . . . . . . . . . . . 427
14.8.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 429
14.8.5 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 430

14.9 Lesson: Kaartweergave . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 430
14.9.1 Follow Along: De gegevens voor de kaart voorbereiden . . . . . . . . . . . . . . . . . . . 430
14.9.2 Try Yourself Verschillende mengmodi gebruiken . . . . . . . . . . . . . . . . . . . . . . 432
14.9.3 Try Yourself Een sjabloon van afdruklay-out gebruiken om het kaartresultaat te maken . . 433
14.9.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 436

vii



15 Module: Concepten van databases met PostgreSQL 437
15.1 Lesson: Introductie voor databases . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 437

15.1.1 Wat is een database? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 437
15.1.2 Tabellen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 437
15.1.3 Kolommen / Velden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 438
15.1.4 Records . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 438
15.1.5 Datatypen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 438
15.1.6 Een adresdatabase modelleren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439
15.1.7 Database theorie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439
15.1.8 Normalisatie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439
15.1.9 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 440
15.1.10 Indexen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 440
15.1.11 Reeksen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 440
15.1.12 Entiteit Relaties Diagrammen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 441
15.1.13 Beperkingen, Primaire sleutels en Vreemde sleutels . . . . . . . . . . . . . . . . . . . . . 442
15.1.14 Transacties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 442
15.1.15 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 442
15.1.16 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 443

15.2 Lesson: Het gegevensmodel implementeren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 443
15.2.1 PostgreSQL installeren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 443
15.2.2 Hulp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 443
15.2.3 Een gebruiker voor de database aanmaken . . . . . . . . . . . . . . . . . . . . . . . . . 444
15.2.4 Het nieuwe account verifiëren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 444
15.2.5 Een database maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 444
15.2.6 Een database shell-sessie beginnen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 445
15.2.7 Tabellen in SQL maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 445
15.2.8 Sleutels maken in SQL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 446
15.2.9 Indexen in SQL maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 447
15.2.10 Tabellen in SQL verwijderen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 448
15.2.11 Een woord over pgAdmin III . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 448
15.2.12 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 448
15.2.13 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 448

15.3 Lesson: Gegevens aan het model toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 449
15.3.1 Argument Insert . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 449
15.3.2 Toevoegen van gegevens in overeenstemming met beperkingen . . . . . . . . . . . . . . . 449
15.3.3 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 449
15.3.4 Gegevens selecteren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 450
15.3.5 Gegevens bijwerken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 450
15.3.6 Gegevens verwijderen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451
15.3.7 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451
15.3.8 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451
15.3.9 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451

15.4 Lesson: Query’s . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 451
15.4.1 Resultaten ordenen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 452
15.4.2 Filteren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 452
15.4.3 Samenvoegingen (joins) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 453
15.4.4 Sub-Select . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 454
15.4.5 Samenvattende query’s . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 455
15.4.6 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 455
15.4.7 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 455

15.5 Lesson: Weergaven . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 456
15.5.1 Een weergave maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 456
15.5.2 Een weergave aanpassen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 456
15.5.3 Een weergave verwijderen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 457
15.5.4 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 457
15.5.5 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 457

15.6 Lesson: Regels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 457
15.6.1 Een regel voor loggen maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 457

viii



15.6.2 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 458
15.6.3 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 458

16 Module: Concepten van een ruimtelijke database met PostGIS 459
16.1 Lesson: Instellen van PostGIS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 459

16.1.1 Installeren onder Ubuntu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 460
16.1.2 Installeren onder Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 460
16.1.3 Installeren op andere platformen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 460
16.1.4 Databases configureren om PostGIS te gebruiken . . . . . . . . . . . . . . . . . . . . . . 460
16.1.5 Kijken naar de geïnstalleerde functies van PostGIS . . . . . . . . . . . . . . . . . . . . . 461
16.1.6 Ruimtelijke referentiesystemen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 462
16.1.7 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 462
16.1.8 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 463

16.2 Lesson: Eenvoudig object model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 463
16.2.1 Wat is OGC? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 463
16.2.2 Wat is het SFS-model (Eenvoudig object model) . . . . . . . . . . . . . . . . . . . . . . 463
16.2.3 Een veld voor geometrie aan een tabel toevoegen . . . . . . . . . . . . . . . . . . . . . . 464
16.2.4 Een beperking, gebaseerd op een type geometrie, toevoegen . . . . . . . . . . . . . . . . 464
16.2.5 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 464
16.2.6 Tabel geometry_columns vullen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 464
16.2.7 Record met geometrie toevoegen aan tabel met behulp van SQL . . . . . . . . . . . . . . 465
16.2.8 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 468
16.2.9 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 468

16.3 Lesson: Importeren en exporteren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 468
16.3.1 shp2pgsql . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 468
16.3.2 pgsql2shp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 468
16.3.3 ogr2ogr . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 469
16.3.4 DB Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 469
16.3.5 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 469
16.3.6 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 469

16.4 Lesson: Ruimtelijke query’s . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 469
16.4.1 Ruimtelijke operatoren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 469
16.4.2 Ruimtelijke indexen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 470
16.4.3 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 470
16.4.4 Demonstratie ruimtelijke functies van PostGIS . . . . . . . . . . . . . . . . . . . . . . . 471
16.4.5 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 477
16.4.6 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 477

16.5 Lesson: Construeren van geometrie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 477
16.5.1 Lijnen maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 478
16.5.2 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 478
16.5.3 Polygonen maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 478
16.5.4 Oefening: Steden aan mensen koppelen . . . . . . . . . . . . . . . . . . . . . . . . . . . 479
16.5.5 Ons schema bekijken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 479
16.5.6 Try Yourself . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 480
16.5.7 Toegang tot sub-objecten . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 480
16.5.8 Gegevens verwerken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 480
16.5.9 Clippen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 480
16.5.10 Geometrieën uit andere geometrieën bouwen . . . . . . . . . . . . . . . . . . . . . . . . 482
16.5.11 Geometrie opruimen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 483
16.5.12 Verschillen tussen tabellen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 483
16.5.13 Tabelruimten . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 484
16.5.14 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 484

17 De QGIS-gids voor Processing 485
17.1 Introductie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 485
17.2 Een belangrijke waarschuwing vóór het beginnen . . . . . . . . . . . . . . . . . . . . . . . . . . 486
17.3 Het framework Processing instellen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 487
17.4 Uw eerste algoritme uitvoeren. De Toolbox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 490

ix



17.5 Meer algoritmen en gegevenstypen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 493
17.6 CRS-en opnieuw.projecteren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 501
17.7 Selectie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 504
17.8 Een extern algoritme uitvoeren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 506
17.9 Het log van de verwerking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 511

17.9.1 Gevorderd . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 513
17.10 De Raster calculator. Waarden Geen gegevens . . . . . . . . . . . . . . . . . . . . . . . . . . . . 513
17.11 Vectorcalculator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 518
17.12 Bereiken definiëren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 522
17.13 HTML-uitvoer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 526
17.14 Eerste voorbeeld analyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 529
17.15 Rasterlagen clippen en samenvoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 537
17.16 Hydrologische analyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 547
17.17 Beginnen met Grafische modellen bouwen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 559
17.18 Meer complexe modellen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 570
17.19 Numerieke berekeningen in Grafische modellen bouwen . . . . . . . . . . . . . . . . . . . . . . . 576
17.20 Een model binnen een model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 581
17.21 Specifiek modelleergereedschap gebruiken om een model te maken . . . . . . . . . . . . . . . . . 582
17.22 Interpolatie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 588
17.23 Meer interpolatie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 597
17.24 Herhalend uitvoeren van algoritmen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 604
17.25 Meer herhaalde uitvoering van algoritmen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 608
17.26 De interface Batch-processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 610
17.27 Modellen in de interface Batch-processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 613
17.28 Haken voor vóór en na uitvoering van scripts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 614
17.29 Andere programma’s . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 615

17.29.1 GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 615
17.29.2 R . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 615
17.29.3 Andere . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 616
17.29.4 Vergelijking tussen programma’s . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 616

17.30 Interpolatie en contouren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 617
17.30.1 Interpolatie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 617
17.30.2 Contour . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 617

17.31 Vereenvoudigen van vectoren en gladder maken . . . . . . . . . . . . . . . . . . . . . . . . . . . 618
17.32 Zonnepanelen plannen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 618
17.33 Scripts van R gebruiken in Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 619

17.33.1 Scripts toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 619
17.33.2 Plots maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 620
17.33.3 Een vector maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 624
17.33.4 Tekst en grafische uitvoer vanuit R - syntaxis . . . . . . . . . . . . . . . . . . . . . . . . 627

17.34 Landverschuivingen voorspellen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 627

18 Module: Ruimtelijke databases in QGIS gebruiken 629
18.1 Lesson: Werken met databases in de Browser van QGIS . . . . . . . . . . . . . . . . . . . . . . . 629

18.1.1 Follow Along: Databasetabellen aan QGIS toevoegen met behulp van de Browser . . . . . 629
18.1.2 Follow Along: Een gefilterde set records als een laag toevoegen . . . . . . . . . . . . . . 631
18.1.3 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 632
18.1.4 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 633

18.2 Lesson: DB Manager gebruiken om te werken met ruimtelijke databases in QGIS . . . . . . . . . . 633
18.2.1 Follow Along: Databases van PostGIS beheren met DB Manager . . . . . . . . . . . . . . 633
18.2.2 Follow Along: Een nieuwe tabel maken . . . . . . . . . . . . . . . . . . . . . . . . . . . 639
18.2.3 Follow Along: Basisbeheer van database . . . . . . . . . . . . . . . . . . . . . . . . . . 640
18.2.4 Follow Along: SQL-query’s met DB Manager uitvoeren . . . . . . . . . . . . . . . . . . 641
18.2.5 Gegevens in een database importeren met DB Manager . . . . . . . . . . . . . . . . . . 642
18.2.6 Gegevens uit een database exporteren met DB Manager . . . . . . . . . . . . . . . . . . 644
18.2.7 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 646
18.2.8 What’s Next? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 646

18.3 Lesson: Werken met databases van SpatiaLite in QGIS . . . . . . . . . . . . . . . . . . . . . . . 646

x



18.3.1 Follow Along: Een database van SpatiaLite maken met de Browser . . . . . . . . . . . . 646
18.3.2 In Conclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 648

19 Appendix: Bijdragen aan deze handleiding 649
19.1 Bronnen downloaden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 649
19.2 Indeling handleiding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 649
19.3 Een module toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 649
19.4 Een les toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 650
19.5 Een gedeelte toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 651

19.5.1 Een gedeelte “follow along” toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . 651
19.5.2 Een gedeelte “try yourself” toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . 652

19.6 Een conclusie toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 652
19.7 Een gedeelte Meer informatie toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 653
19.8 Een gedeelte Wat nu toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 653
19.9 Opmaak gebruiken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 653

19.9.1 Nieuwe concepten . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 653
19.9.2 Benadrukken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 653
19.9.3 Afbeeldingen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 653
19.9.4 Interne koppelingen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 654
19.9.5 Externe koppelingen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 654
19.9.6 Mono gespatieerde tekst gebruiken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 654
19.9.7 Items voor de GUI labelen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 654
19.9.8 Menuselecties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 654
19.9.9 Opmerkingen toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 655
19.9.10 Een opmerking voor sponsors/auteurs toevoegen . . . . . . . . . . . . . . . . . . . . . . 655

19.10 Dank u wel! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 655

20 Voorbereiden gegevens voor oefeningen 657
20.1 Try Yourself Op OSM gebaseerde vectorbestanden maken . . . . . . . . . . . . . . . . . . . . . 657
20.2 Try Yourself SRTM DEM tiff-bestanden maken . . . . . . . . . . . . . . . . . . . . . . . . . . . 664
20.3 Try Yourself TIFF afbeeldingsbestanden maken . . . . . . . . . . . . . . . . . . . . . . . . . . . 664
20.4 Try Yourself Tokens vervangen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 665

21 Antwoordenblad 667
21.1 Results For Een overzicht van de interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 667

21.1.1 Overzicht (Deel 1) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 667
21.1.2 Overzicht (Deel 2) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 667

21.2 Results For Uw eerste laag toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 667
21.2.1 Voorbereiding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 667
21.2.2 Gegevens laden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 668

21.3 Results For Symbologie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 668
21.3.1 Kleuren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 668
21.3.2 Symboolstructuur . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 669
21.3.3 Symboollagen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 670
21.3.4 Symboolniveau’s . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 671
21.3.5 Symboolniveaus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 672

21.4 Markeringen voor omtrek . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 673
21.4.1 Symbologie voor Geometrie-generator . . . . . . . . . . . . . . . . . . . . . . . . . . . 674

21.5 Results For Vector attributengegevens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 675
21.5.1 Attributen van vectorgegevens verkennen . . . . . . . . . . . . . . . . . . . . . . . . . . 675

21.6 Results For Labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 675
21.6.1 Aanpassen van Label (Deel 1) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 675
21.6.2 Aanpassen van Label (Deel 2) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 676
21.6.3 Gegevens-bepaalde instellingen gebruiken . . . . . . . . . . . . . . . . . . . . . . . . . . 679

21.7 Results For Classificatie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 680
21.7.1 De classificatie verfijnen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 680

21.8 Results For Een nieuwe vector gegevensset maken . . . . . . . . . . . . . . . . . . . . . . . . . . . 681
21.8.1 Digitialiseren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 681
21.8.2 Topologie: Gereedschap Ring toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . 682

xi



21.8.3 Topologie: Gereedschap Deel toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . 683
21.8.4 Objecten samenvoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 684
21.8.5 Formulieren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 684

21.9 Results For Vectoranalyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 686
21.9.1 Afstand van scholen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 686
21.9.2 Afstand vanaf restaurants . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 688

21.10 Results For Netwerkanalyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 691
21.11 Fastest path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 691
21.12 Results For Rasteranalyse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 692

21.12.1 Aspect berekenen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 692
21.12.2 Helling berekenen (minder dan 2 en 5 graden) . . . . . . . . . . . . . . . . . . . . . . . 693

21.13 Results For De analyse voltooien . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 696
21.13.1 Raster naar vector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 696
21.13.2 Inspecteren van de resultaten . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 697
21.13.3 De analyse verfijnen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 698

21.14 Results ForWMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 702
21.14.1 Een andere WMS-laag toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 702
21.14.2 Een nieuwe WMS-server toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 703
21.14.3 Een WMS-server zoeken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 705

21.15 Results For Integratie van GRASS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 705
21.15.1 Lagen toevoegen aan mapset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 705
21.15.2 Opnieuw classificeren rasterlaag . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 705

21.16 Results For Database-concepten . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 706
21.16.1 Address tabeleigenschappen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 706
21.16.2 De tabel People normaliseren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 707
21.16.3 Verdere normalisatie van de tabel People . . . . . . . . . . . . . . . . . . . . . . . . . . 707
21.16.4 Een tabel People maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 708
21.16.5 De opdracht DROP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 709
21.16.6 Een nieuwe straat invoeren . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 709
21.16.7 Een nieuwe persoon met een relatie Foreign Key toevoegen . . . . . . . . . . . . . . . . 709
21.16.8 Straatnamen teruggeven . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 710

21.17 Results For Ruimtelijke query’s . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 710
21.17.1 De eenheden gebruikt in ruimtelijke query’s . . . . . . . . . . . . . . . . . . . . . . . . 710
21.17.2 Een ruimtelijke index maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 710

21.18 Results For Construeren van geometrie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 711
21.18.1 Lijnen maken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 711
21.18.2 Tabellen koppelen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 711

21.19 Results For Eenvoudig object model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 712
21.19.1 Tabellen vullen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 712
21.19.2 De tabel geometry_columns vullen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 712
21.19.3 Geometrie toevoegen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 712

xii



HOOFDSTUK1

Introductie voor de cursus

1.1 Voorwoord

Welkom bij onze cursus! We zullen u laten zien hoe QGIS gemakkelijk en efficiënt te gebruiken. Als GIS nieuw voor
u is, zullen we u vertellen wat u nodig hebt om te kunnen beginnen. Als u al een ervaren gebruiker bent, zult u zien
hoe QGIS alle functies uitvoert die u verwacht van een programma voor GIS, en meer!

1.1.1 Waarom QGIS?

Waar informatie steeds meer ruimtelijk bewust wordt, is er geen tekort aan gereedschappen die in staat zijn enkele
of alle veel gebruikte functies voor GIS uit te voeren. Waarom zou iemand QGIS gebruiken boven een ander
softwarepakket voor GIS?
Hier zijn slechts enkele van de redenen:

• Het is gratis, zoals in lunch. Installeren en gebruiken van het programma QGIS kost u een totaalbedrag van nul
geld. Geen initiële kosten, geen terugkerende kosten, helemaal niets.

• Het is vrij, zoals in vrijheid. Wanneer u extra functionaliteit nodig hebt in QGIS, kunt u meer doen dan
alleen hopen dat het in de volgende uitgave wordt opgenomen. U kunt het ontwikkelen van een mogelijkheid
sponsoren, of het zelf toevoegen als u bekend bent met programmeren.

• Het wordt doorlopend ontwikkelt. Omdat iedereen nieuwe mogelijkheden kan toevoegen en bestaande kan
verbeteren, stagneert QGIS nooit. De ontwikkeling van een nieuw gereedschap kan zo snel gaan als u zelf
wilt.

• Uitgebreide hulp en documentatie is beschikbaar. Als u ergens mee zit kunt u de uitgebreide documentatie
bekijken, u richten tot uw mede-QGIS-gebruikers, of zelfs tot de ontwikkelaars.

• Cross-platform. QGIS kan worden geïnstalleerd op MacOS, Windows en Linux.
Nu weet waarom u QGIS zou willen gebruiken, zullen deze oefeningen u laten zien hoe.
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1.1.2 Achtergrond

In 2008 brachten we Een kleine introductie in GIS, een volledig gratis, open bron-inhoud voor mensen die wilden
leren over GIS zonder te worden bedolven onder jargon en nieuwe terminologie. Het werd gesponsord door de Zuid-
Afrikaanse overheid en was een fenomenaal succes, met mensen van over de gehele wereld die ons vertelden hoe zij
het materiaal gebruikten voor het uitvoeren van trainingscursussen op universiteiten, zichzelf GIS leerden enzovoort.
‘Een kleine introductie’ is geen handleiding voor de software maar richt zich op een meer algemene tekst (hoewel we
QGIS in alle voorbeelden gebruikten) voor iemand die iets over GIS wil leren. Er is ook de handleiding voor QGIS
die een gedetailleerd functioneel overzicht van de toepassing QGIS verschaft. Die is echter niet gestructureerd als een
leidraad, maar meer als een gids voor verwijzingen. Bij Linfiniti Consulting CC. geven we frequent trainingscursussen
en hebben we ons gerealiseerd dat een derde bron nodig is - een die de lezer stapsgewijze leidt door het leren van de
sleutelaspecten van QGIS in een formaat trainer-trainee - wat ons aanzette tot het maken van dit werk.
Deze trainingshandleiding is bedoeld om alle materiaal te verschaffen voor een 5-daagse cursus over QGIS,
PostgreSQL en PostGIS. De cursus is gestructureerd met een inhoud die gelijktijdig geschikt is voor nieuwe,
gemiddelde en gevorderde gebruikers en veel oefeningen heeft, compleet met geannoteerde antwoorden door de
gehele tekst.

1.1.3 Licentie

De gratis QuantumGIS Training Handleiding van Linfiniti Consulting CC is beschikbaar onder de Creative Commons
Attribution 4.0 International Licentie. Rechten buiten het bereik van deze licentie zouden beschikbaar kunnen zijn
op het hieronder vermelde.
We hebben deze QGIS trainingshandleiding gepubliceerd onder een liberale licentie die u toestaat dit werk gratis te
kopiëren, aan te passen en opnieuw te distribueren. Een volledige kopie van de licentie is beschikbaar aan het einde
van dit document. In eenvoudige woorden, de richtlijnen voor het gebuik zijn als volgt:

• U mag dit werk niet weergeven als uw eigen werk, of teksten met betrekking tot rechten van auteurs of credits
uit dit werk verwijderem.

• U mag dit werk niet opnieuw distribueren onder meer beperkende rechten dan die waaronder het aan u werd
verschaft.

• Als u een substantieel gedeelte toevoegt aan het werk en teruggeeft aan het project (tenminste één complete
module) mag u uw naam toevoegen aan de lijst van auteurs aan het einde van dit document (die zal verschijnen
op de voorpagina)

• Als u kleine wijzigingen en correcties toevoegt mag u zichzelf toevoegen aan de lijst van deelnemers hieronder.
• Als u dit document in zijn geheel vertaald mag u uw naam toevoegen aan de lijst van de auteurs in de vorm
“Translated by Joe Bloggs”.

• Als u een module of les sponsort, mag u de auteur verzoeken om een vermelding daarvan op te nemen aan het
begin van elke bijgedragen les, bijv.:

Notitie: Deze les werd gesponsord door MegaCorp.

• Als u er niet zeker van bent wat u onder deze licentie mag doen, neem dan contact met ons op via
office@linfiniti.com en zullen we u adviseren of wat u van plan bent te doen acceptabel is.

• Als u dit werk publiceert onder een zichzelf publicerende site zoals https://www.lulu.com verzoeken we u de
winsten te doneren aan het project QGIS.

• U mag dit werk niet vercommercialiseren, tenzij met de uitdrukkelijke toestemming van de auteurs. Voor de
duidelijkheid: met vercommercialiseren bedoelen we dat u niet voor winst mag verkopen, geen afgeleide werken
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mag maken (bijv. verkopen van inhoud om te gebruiken als artikelen in een tijdschrift). De uitzondering hierop
is als alle winst wordt gegeven aan het project QGIS. U mag (en we moedigen u aan dat te doen) dit werk
gebruiken als een tekstboek bij het geven van trainingscursussen, zelfs als de cursus zelf commercieel van
nature is. Met andere woorden: het staat u vrij om geld te verdienen door het geven van een trainingscursus dat
dit werk als tekstboek gebruikt, maar u mag niet profiteren van de verkoop van het boek zelf - alle dergelijke
winsten zouden ten goede moeten komen aan QGIS.

1.1.4 Hoofdstukken over sponsoring

Dit werk is geenszins bedoeld als een volledige verhandeling over alle dingen die u kunt doen met QGIS en we
moedigen anderen aan om nieuw materiaal toe te voegen om eventuele gaten te dichten. Linfiniti Consulting CC. kan
ook aanvullend materiaal voor u maken als een commerciële service, met dien verstande dat al dergelijk geproduceerd
werk onderdeel zou moeten worden van de broninhoud en moeten worden gepubliceerd onder dezelfde licentie.

1.1.5 Auteurs

• Rüdiger Thiede (rudi@linfiniti.com) - Rudi heeft het materiaal met instructies voor QGIS geschreven en delen
van het materiaal over PostGIS.

• Tim Sutton (tim@linfiniti.com) - Tim was de leider van het project en begeleidde dat en is co-auteur voor de
delen over PostgreSQL en PostGIS. Tim is ook de auteur van het aangepaste thema van Sphinx dat is gebruikt
voor deze handleiding.

• Horst Düster (horst.duester@kappasys.ch ) - Horst is co-auteur van de delen over PostgreSQL en PostGIS
• Marcelle Sutton (marcelle@linfiniti.com) - Marcelle deed het proeflezen en gaf editoriaal advies gedurende het
maken van dit werk.

1.1.6 Individuele meewerkenden

Vul hier uw naam in!

1.1.7 Sponsoren

• Cape Peninsula University of Technology

1.1.8 Bronbestanden en rapporteren van problemen

De bron van dit document is beschikbaar op GitHub QGIS Documentation repository. Consulteer GitHub.com voor
instructies over hoe het versiebeheerssysteem GIT te gebruiken.
Ondanks onze inspanningen zou het kunnen zijn dat u enkele fouten vindt of enige informatie mist bij het volgen van
deze training. Rapporteer dat dan op https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Laatste versie

U kunt altijd de laatste versie van dit document verkrijgen door de online versie te bezoeken die deel uitmaakt van
de website voor de documentatie voor QGIS (https://docs.qgis.org).

Notitie: Dewebsite voor de documentatie bevat links naar zowel online- als PDF-versies van de Trainingshandleiding
en andere delen van de documentatie van QGIS.
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1.2 Over de oefeningen

Nu u weet waarom u QGIS zou willen gebruiken, kunnen we u laten zien hoe.

Waarschuwing: Deze cursus bevat instructies over het toevoegen, verwijderen en wijzigen van gegevenssets voor
GIS. We hebben voor dit doel gegevenssets om mee te trainen verschaft. Vóórdat u de hier beschreven technieken
toepast op uw eigen gegevens, zorg er dan altijd voor dat u goede back-ups heeft!

1.2.1 Hoe deze handleiding te gebruiken

Elke tekst die er zo uitziet verwijst naar iets wat u kunt zien in de gebruikersinterface van QGIS.
Tekst die er ► zo ► uitziet leidt u door menu’s.
Dit soort tekst verwijst naar iets wat u kunt typen, zoals een opdracht, pad, of bestandsnaam.
Dit/soort/van.tekst verwijst naar iets wat u kunt typen, zoals een opdracht, pad, of bestandsnaam.
Dit+dat verwijst naar een sneltoets die is samengestelde uit twee toetsen.

1.2.2 Gestaffelde doelen voor de cursus

Deze cursus is gericht op verschillende niveaus van gebruikservaring. Afhankelijk van in welke categorie u zich plaatst,
kunt u een verschillende set van uitkomsten voor de cursus verwachten. Elke categorie bevat informatie die essentieel
is voor de volgende, het is dus belangrijk om eerst alle oefeningen te doen die behoren tot uw niveau van ervaring.

Basis

In deze categorie gaat de cursus er van uit dat u geen of weinig eerdere ervaring hebt met theoretische kennis van GIS
of de werking van GIS-software.
Beperkte theoretische achtergrond zal worden verschaft om het doel van een actie uit te leggen die u in het programma
zult uitvoeren, maar de nadruk ligt op het leren door te doen.
Wanneer u de cursus voltooid hebt, zult u een beter begrip hebben van demogelijkheden van GIS, en hoe hun krachten
te gebruiken via QGIS.

Gemiddeld

In deze categorie wordt er van uitgegaan dat u kennis hebt van de werking en ervaring met het gebruik voor elke dag
hebt van GIS-software.
Voortbouwend op de instructies voor het niveau van de beginner zult u bekende dingen zien, als ook u bewust te
maken van gevallen waarin QGIS dingen op een iets andere manier doet dan andere software, die u ook gebruikt zou
kunnen hebben. U zult ook leren hoe functies voor analyses te gebruiken in QGIS.
Wanneer u de cursus voltooid, zou u er vertrouwen in moeten hebben QGIS te gebruiken voor alle functies die u
gewoonlijk nodig hebt bij gebruik voor elke dag.
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Gevorderd

Voor deze categorie wordt er van uitgegaan dat u ervaring hebt in het gebruiken van GIS-software, kennis hebt van
en ervaring met ruimtelijke databases, gegevens te gebruiken op een server op afstand, misschien het schrijven van
scripts voor analyses, etc.
Voortbouwend op de instructies voor de andere twee niveaus zullen u bekend laten worden met de benadering die de
interface van QGIS volgt, en zal er voor zorgen dat u weet hoe u toegang krijgt tot de basisfuncties die u nodig hebt.
U zult ook zien hoe gebruik te maken van het systeem voor plug-ins in QGIS, toegang tot databases, enzovoort.
Wanneer u de cursus voltooid, zou u goed bekend moeten zijn met de werking van QGIS voor gebruik voor elke dag,
als ook met zijn meer gevorderde functies.

1.2.3 Gegevens

De voorbeeldgegevens die bij deze bron horen zijn vrij beschikbaar en komen vanaf de volgende bronnen:
• gegevenssets Streets and Places van OpenStreetMap (https://www.openstreetmap.org/)
• Property boundaries (urban and rural), water bodies van NGI (http://www.ngi.gov.za/)
• SRTM DEM van de CGIAR-CGI (http://srtm.csi.cgiar.org/)

Download de voorbereide gegevensset vanaf de opslagplaats voor Trainingsgegevens en pak het bestand uit. Alle
benodigde gegevens worden verschaft in de map exercise_data.
Als u een instructeur bent, en meer relevante gegevens zou willen gebruiken, vindt u instructies voor het maken van
lokale gegevens in de appendix Voorbereiden gegevens voor oefeningen.

1.2. Over de oefeningen 5
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Module: Een basiskaart maken en verkennen

In deze module zult u een basiskaart maken die later zal worden gebruikt als basis voor meer demonstraties van de
functionaliteit van QGIS.

2.1 Lesson: Een overzicht van de interface

We zullen de gebruikersinterface van QGIS verkennen zodat u bekend raakt met de menu’s, werkbalken, kaartvenster
en lagenlijst die de basisstructuur van de interface vormen.
Het doel voor deze les: Begrijpen van de basisonderdelen van de gebruikersinterface van QGIS.

7
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2.1.1 Try Yourself: De basisonderdelen

De elementen die kunnen worden geïdentificeerd in de bovenstaande afbeelding zijn:
1. Lagenlijst / paneel Browser
2. Werkbalken
3. Kaartvenster
4. Statusbalk
5. Werkbalk zijkant
6. balk Lokaliseren

De lagenlijst

In de lagenlijst kunt u op elk moment een lijst zien van alle lagen die voor u beschikbaar zijn.
Uitbreiden van samengevouwen items (door te klikken op de pijl of het symbool plus ernaast) zal u meer informatie
verschaffen over het huidige uiterlijk van de laag.
De laag zal, als u daar overheen gaat met de muisaanwijzer, enige basisinformatie geven: laagnaam, type geometrie,
coördinaten referentiesysteem en het volledige pad van de locatie op uw apparaat.
Rechts-klikken op een laag zal u een menu geven met heel veel extra opties. U zult sommige ervan op korte termijn
gaan gebruiken, kijk dus even rond!

Notitie: Een vectorlaag is een gegevensset, gewoonlijk van een specifiek soort object, zoals wegen, bomen, etc. Een
vectorlaag kan bestaan uit punten, lijnen of polygonen.
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Het paneel Browser

De Browser van QGIS is een paneel in QGIS waarmee u eenvoudig door uw database kunt bladeren. U heeft daarbij
toegang tot algemene vectorbestanden (bijv. ESRI Shapefiles of bestanden van MapInfo ), databases (bijv. PostGIS,
Oracle, SpatiaLite of MSSQL Spatial) en webservices WMS/WFS. U kunt ook gegevens van GRASS bekijken.
Als u een project hebt opgeslagen zal het paneel Browser u ook snelle toegang verschaffen tot alle lagen die zijn
opgeslagen in hetzelfde pad van het projectbestand in het item Thuis voor project.
U kunt daarnaast één of meer mappen instellen als Favorieten: zoek naar uw pad en als u de map eenmaal hebt
gevonden, klik er met rechts op en klik op Als Favoriet toevoegen. U zou dan uw map moeten kunnen zien
in het item Favorieten.

Tip: Het kan gebeuren dat de mappen die zijn toegevoegd aan het item Favorieten een behoorlijk lange naam hebben:
geen zorgen, klik met rechts op het pad en kies Favoriet hernoemen… om een andere naam in te stellen.

Werkbalken

Van de door u het meest gebruikte aantal gereedschappen kunnen werkbalken worden gemaakt voor basistoegang. De
werkbalk Bestand stelt u bijvoorbeeld in staat een nieuw project op te slaan, te laden, af te drukken en te beginnen.
U kunt de interface gemakkelijk aanpassen om alleen de gereedschappen te zien die u het meest gebruikt, door
werkbalken, zoals nodig, toe te voegen of te verwijderen via het menu Beeld ►Werkbalken.
Zelfs als zij niet zichtbaar zijn in een werkbalk blijven al uw gereedschappen toegankelijk via de menu’s. Als u
bijvoorbeeld de werkbalk Project verwijdert (die de knop Opslaan bevat), kunt u nog steeds uw kaart opslaan door te
klikken op het menu Project en dan te klikken op Opslaan.

Het kaartvenster

Dit is waar de kaart zelf wordt weergegeven en waar de lagen worden geladen. In het kaartvenster kunt u interactief
werkenmet de zichtbare lagen: in-/uitzoomen, de kaart verplaatsen, objecten selecteren en nog veel meer bewerkingen
die we nader zullen bekijken in de volgende gedeelten.

De Statusbalk

Toont u informatie over de huidige kaart. Stelt u ook in staat de schaal van de kaart, de oriëntatie van de kaart aan te
passen en de coördinaten van de muiscursor op de kaart te zien.

De werkbalk Zijkant

Standaard bevat de werkbalk Zijkant de knoppen om lagen te laden en alle knoppen om een nieuwe laag te maken.
maar onthoud dat u alle werkbalken kunt verplaatsen naar waar ze voor u meer comfortabel zijn om mee te werken.

2.1. Lesson: Een overzicht van de interface 9
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De balk Lokaliseren

Op deze balk kunt u toegang krijgen tot bijna alle objecten van QGIS: lagen, laagobjecten, algoritmen, Favoriete
plaatsen, etc. Controleer alle verschillende opties in het gedeelte locator_options van de QGIS Gebruikershandleiding.

Tip: Met de sneltoets Ctrl+K krijgt u snel toegang tot de balk.

2.1.2 Try Yourself 1

Probeer de vier hierboven vermelde elementen te identificeren op uw eigen scherm, zonder naar het diagram hierboven
te kijken. Kijk of u hun namen en functies kunt identificeren. U zult meer bekend raken met deze elementen als u ze
in de komende dagen gaat gebruiken.
Controleer uw resultaten

2.1.3 Try Yourself 2

Probeer elk van deze gereedschappen op uw scherm te vinden. Wat zijn hun doelen?

1.

2.

3.

4. (Her)teken

5.

Notitie: Als een van deze gereedschappen niet zichtbaar is op het scherm, probeer dan enkele werkbalken in te
schakelen die momenteel verborgen zijn. Onthoud ook dat als er te weinig ruimte is op het scherm, een werkbalk
verkleind kan zijn door enkele van zijn gereedschappen te verbergen. U kunt de verborgen gereedschappen zichtbaar
maken door te dubbelklikken op de pijlknop rechts in een dergelijke verkleinde werkbalk. U kunt een Helptip zien
met de naam van elk gereedschap door de muiscursor enige tijd boven het gereedschap te houden.

Controleer uw resultaten

2.1.4 What’s Next?

Nu u bekend bent met de basisbeginselen van de interface van QGIS zullen we in de volgende les zien hoe enkele veel
voorkomende typen gegevens te laden.
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2.2 Lesson: Uw eerste lagen toevoegen

We zullen de toepassing starten en een basiskaart maken om voor voorbeelden en oefeningen te gebruiken.
Het doel voor deze les: Beginnen met een voorbeeldkaart.

Notitie: Vóór het beginnen van deze oefening moet QGIS zijn geïnstalleerd op uw computer. U zou ook de te
gebruiken voorbeeldgegevens al moeten hebben gedownload.

Start QGIS met de sneltoets op het bureaublad, menuitem, etc., afhankelijk van hoe u de installatie ervan heeft
geconfigureerd.

Notitie: De schermafdrukken voor deze cursus werden genomen in QGIS 3.4 dat werd uitgevoerd op Linux.
Afhankelijk van uw instellingen zouden de schermen die u tegenkomt er misschien ietwat anders uit kunnen zien.
Echter, al dezelfde knoppen zullen nog steeds beschikbaar zijn en de instructies zullen op elk OS werken. U heeft
QGIS 3.4 (de laatste versie op het moment van schrijven) nodig om deze cursus te gebruiken.

Laten we direct gaan beginnen!

2.2.1 Follow Along: Een kaart voorbereiden

1. Open QGIS. U zult een nieuwe, blanco kaart hebben.

2. Het dialoogvenster Databronnen beheren stelt u in staat te laden gegevens te kiezen, afhankelijk van het
gegevenstype.We zullen het gebruiken om onze gegevensset te laden: klik op de knop Databronnen beheren openen

.
Als u het pictogram niet kunt vinden, controleer dan of de werkbalk Databronnen beheren is ingeschakeld in
het menu Beeld ►Werkbalken.

2.2. Lesson: Uw eerste lagen toevoegen 11
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3. Laad de vector gegevensset protected_areas.shp
1. Klik op de tab Vector.

2. Schakel het Type bron Bestand in.
3. Druk op de knop… naast Vectordatabron(nen).
4. Selecteer het bestand exercise_data/shapefile/protected_areas.shp in uw map voor

de training.
5. Klik op Openen. U zult het originele dialoogvenster zien waarin het bestandspad is ingevuld.
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6. Klik hier ook op Toevoegen. De gegevens die u hebt gespecificeerd zullen nu worden geladen: u kunt
een item protected_areas zien in het paneel Lagen (linksonder) waarvan de objecten worden
weergegeven in het kaartvenster.

2.2. Lesson: Uw eerste lagen toevoegen 13
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Gefeliciteerd! U heeft nu een basiskaart. Het is nu een goed moment om uw werk op te slaan.

1. Klik op de knop Opslaan als:
2. Sla de kaart op in een map solution, naast exercise_data, en noem hem basic_map.qgz.

2.2.2 Try Yourself

Herhaal de bovenstaande stappen en voeg de lagen places.shp en rivers.shp uit dezelfde map
(exercise_data/shapefile) toe aan de kaart.
Controleer uw resultaten

2.2.3 Follow Along: Vectorgegevens uit een database van GeoPackage
laden

Databases stellen u in staat een grote hoeveelheid geassocieerde gegevens in één bestand op te slaan. U zou al bekend
kunnen zijn met een beheerssysteem voor databases (DBMS) zoals LibreOffice Base of MS Access. Toepassingen
voor GIS kunnen ook gebruik maken van databases. GIS-specifieke DBMS-en (zoals PostGIS) hebben extra functies,
omdat zij ruimtelijke gegevens moeten behandelen.
De open indeling GeoPackage is een container die u in staat stelt uw gegevens voor GIS (lagen) op te slaan in één
enkel bestand. Anders dan de indeling ESRI Shapefile (bijv. de gegevensset protected_areas.shp die u eerder
laadde), kan één enkel bestand van GeoPackage verscheidene gegevens bevatten (zowel vector- en rastergegevens) in
verschillende coördinaten referentiesystemen, als ook tabellen zonder ruimtelijke informatie; al deze mogelijkheden
stellen u in staat gegevens eenvoudig te delen en duplicaten te voorkomen.
U dient eerst een verbinding te maken om een laag uit een pakket van GeoPackage te kunnen laden:

1. Klik op de knop Databronnen beheren openen.

2. Klik, aan de linkerkant, op de tab GeoPackage.
3. Klik op de knop Nieuw en blader naar het bestand training_data.gpkg in de map exercise_data

dat u eerder downloadde.
4. Selecteer het bestand en druk op Openen. Het bestandspad wordt nu toegevoegd aan de lijst met verbindingen

voor Geopackage, en verschijnt in het keuzemenu.
U bent nu klaar om elke laag uit dit GeoPackage in te laden in QGIS.

1. Klik op de knop Verbinden. In het centrale deel van het venster zou u nu een lijst moeten zien met alle lagen
die zijn opgenomen in het bestand van GeoPackage.

2. Selecteer de laag roads en klik op de knop Toevoegen.

14 Hoofdstuk 2. Module: Een basiskaart maken en verkennen
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Een laag roads is toegevoegd aan het paneel Lagen met de objecten weergegeven in het kaartvenster.
3. Klik op Sluiten.

Gefeliciteerd! U heeft nu de eerste laag uit een GeoPackage geladen.

2.2.4 Follow Along: Vectorgegevens laden met de Browser uit een
database van SpatiaLite

QGIS verschaft toegang tot veel andere indelingen van databases. Net als GeoPackage, is de database-indeling
SpatiaLite een uitbreiding van de bibliotheek SQLite. En het laden van een laag uit een provider van SpatiaLite
volgt dezelfde regels als hierboven beschreven: Maak de verbinding –> Schakel die in –> Voeg de la(a)g(en) toe.
Waar dit één manier is om gegevens van SpatiaLite aan uw kaart toe te voegen, laten we eens een andere krachtige
manier verkennen om gegevens toe te voegen: de Browser.

1. Klik op het pictogram om het venster Databronnen beheren te openen.

2. Klik op de tab Browser.
3. Op deze tab kunt u alle opslagschijven zien die zijn verbonden met uw computer, als ook items voor de meeste

tabs aan de linkerkant. Deze maken snelle toegang mogelijk tot de verbonden databases of mappen.

Klik, bijvoorbeeld, op het pictogram in het keuzemenu naast het item GeoPackage. U zult het bestand
training-data.gpkg zien waarmee we eerder verbonden (en de lagen ervan, indien uitgebreid).

4. Klik met rechts op het item SpatiaLite en selecteer Nieuwe verbinding….
5. Navigeer naar de map exercise_data, selecteer het bestand landuse.sqlite en klik op Openen.

Merk op dat een item landuse.sqlite is toegevoegd onder die van SpatiaLite.

6. Breid het item landuse.sqlite uit.

2.2. Lesson: Uw eerste lagen toevoegen 15
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7. Dubbelklik op de laag landuse of selecteer en sleep het naar het kaartvenster en zet het daar neer.
Een nieuwe laag wordt toegevoegd aan het paneel Lagen en de objecten daarvan worden weergegeven in het
kaartvenster.

Tip: Schakel het paneel Browser in onder Beeld ► Panelen ► en gebruik het om uw gegevens toe te voegen. Het is
een handige sneltoets voor de tab Databronnen beheren ► Browser, met dezelfde functionaliteit.

Notitie: Vergeet niet om uw project regelmatig op te slaan! Het projectbestand bevat niet direct de gegevens, maar
het onthoud welke lagen u in uw kaart geladen heeft.

2.2.5 Try Yourself Meer vectorgegevens laden

Laad de volgende gegevenssets uit de map exercise_data in uw kaart met een van de hierboven uitgelegde
methoden:

• buildings

• water

Controleer uw resultaten
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2.2.6 Follow Along: De lagen opnieuw schikken

De lagen in uw lijst Lagen worden in een bepaalde volgorde op de kaart getekend. De laag onder in de lijst wordt als
eerste getekend en de laag aan de bovenkant wordt als laatste getekend. Door de volgorde, waarin zij in de lijst zijn
weergegeven, te wijzigen, kunt u de volgorde wijzigen waarin zij getekend worden.

Notitie: U kunt dit gedrag veranderen met het keuzevak Rendervolgorde controleren onder in het paneel
Laagvolgorde. We zullen deze mogelijkheid echter nog niet verder bespreken.

De volgorde waarin de lagen zijn geladen in de kaart is in dit stadium waarschijnlijk niet logisch. Het is mogelijk dat
de laag met wegen volledig is verborgen omdat andere lagen er bovenop liggen.
Deze volgorde van lagen bijvoorbeeld…

… zou resulteren in verborgen wegen en plaatsen, omdat zij onder de polygonen van de laag landuse liggen.
Dit probleem oplossen:

1. Klik en sleep een laag uit de lijst met Lagen.
2. Schik ze opnieuw naar deze volgorde:

U zult zien dat de kaart visueel nu meer betekenis heeft, met wegen en gebouwen die bovenop de regio’s van landuse
verschijnen.

2.2. Lesson: Uw eerste lagen toevoegen 17
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2.2.7 In Conclusion

Nu heeft u uit verschillende bronnen alle lagen toegevoegd die u nodig heeft en een basiskaart gemaakt!

2.2.8 What’s Next?

Nu bent u bekend met de basisfunctie van de knop Databronnen beheren openen, maar wat met al die andere? Hoe
werkt deze interface? Laten we, voordat we verder gaan, eens kijken enige basale interactie met de interface van
QGIS. Dat is het onderwerp van de volgende les.

2.3 Lesson: Navigeren in het kaartvenster

Dit gedeelte zal zich focussen op basisgereedschappen voor navigatie in QGIS, om in het kaartvenster te navigeren.
Deze gereedschappen zullen u in staat stellen de lagen visueel te verkennen op verschillende schalen.
Het doel voor deze les: Leren hoe gereedschappen voor Verschuiven en Zoomen te gebruiken in QGIS en leren over
schaal van kaarten.

2.3.1 Follow Along: Basisgereedschappen voor navigeren

Laten we, voordat we leren hoe te navigeren binnen het kaartvenster, enkele lagen toevoegen, die we tijdens deze
handleiding kunnen verkennen.

1. Open een nieuw leeg project en gebruik de in Een kaart maken, geleerde stappen om de eerder bekeken lagen
protected_areas, roads en buildings in het project te laden. Het resultaat van de weergave zou
eruit moeten zien als in de snipper in Fig. 2.1 hieronder (de kleuren zijn niet van belang):
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Fig. 2.1: Beschermde gebieden, wegen en gebouwen toegevoegd

Laten we eerst leren hoe het gereedschap Kaart verschuiven te gebruiken.

1. Zorg er voor dat, op de werkbalk Kaartnavigatie, de knop Kaart verschuiven is geactiveerd.
2. Verplaats de muis naar het midden van het gebied van het kaartvenster.
3. Klik met links en houdt die ingedrukt, en sleep de muis in een willekeurige richting om de kaart te verschuiven.

Laten we vervolgens inzoomen en de lagen, die we hebben geladen, eens nader bekijken.

1. Klik, op de werkbalk Kaartnavigatie, op de knop Inzoomen.
2. Verplaats uw muis naar ongeveer het linksboven gelegen gebied van waar de grootste dichtheid aan gebouwen

en wegen is.
3. Klik met links en houdt ingedrukt.
4. Sleep dan de muis, die een rechthoek zal maken, en bedek het dichte gebied met gebouwen en wegen (Fig.

2.2).
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Fig. 2.2: Inzoomen

5. Laat de linkermuisknop los. Dit zal inzoomen op het gebied dat u hebt geselecteerd met uw rechthoek.
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6. Selecteer, om uit te zoomen, de knop Uitzoomen en voer dezelfde actie uit als welke u deed voor inzoomen.
Als u verschuift, inzoomt, of uitzoomt slaat QGIS deze weergaven op in een geschiedenis. Dit stelt u in staat terug te
vallen op een eerdere weergave.

1. Klik, op de werkbalk Kaartnavigatie, op de knop Vorig beeld om naar uw eerdere weergave te gaan.

2. Klik op de knop Volgend beeld om voorwaarts te gaan in uw geschiedenis.
Soms, na het verkennen van de gegevens, moeten we onze weergave herstellen naar het bereik van alle lagen. In plaats
van het gereedschap Uitzoomen meerdere keren te gebruiken, verschaft QGIS ons een knop om die actie voor ons
uit te voeren.

1. Klik op de knop Volledig uitzoomen.
Wanneer u in en uit zoomt, merk dan op dat de waarde van Schaal op de Statusbalk wijzigt. De waarde Schaal geeft
de schaal van de kaart weer. In het algemeen geeft het getal rechts van : weer hoeveel keer kleiner het object is dat u
ziet in het kaartvenster, vergeleken met het feitelijke object in de echte wereld.
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U kunt dit veld ook gebruiken om de schaal van de kaart handmatig in te stellen.
1. Klik, op de Statusbalk, op het tekstveld Schaal.
2. Typ in 50000 en druk op Enter. Dit zal de objecten in het kaartvenster opnieuw tekenen om de schaal weer

te geven die u hebt ingetypt.
3. Als alternatief, klik op de pijl voor de opties van het veld Schaal om de vooraf ingestelde schalen voor de kaart

te bekijken.

4. Selecteer 1:5000. Dit zal ook de schaal voor de kaart bijwerken in het kaartvenster.
Nu kent u de basis voor het navigeren in het kaartvenster. Bekijk de Gebruikershandleiding over Zoomen en
verschuiven om alternatieve manieren te leren voor het navigeren in het kaartvenster.

2.3.2 In Conclusion

Weten hoe te navigeren in het kaartvenster is belangrijk, omdat dat het mogelijk maakt de lagen te verkennen en
visueel te inspecteren. Dit zou kunnen worden gedaan voor de eerste verkenning van de gegevens, of om uit voer van
een ruimtelijke analyse te valideren.

2.4 Lesson: Symbologie

De symbologie van een laag is zijn visuele uiterlijk op een kaart. De basissterkte van GIS, boven andere manieren
van het weergeven van gegevens met ruimtelijke aspecten, is dat met GIS u een dynamische visuele weergave heeft
van de gegevens waarmee u werkt.
Daarom is het visuele uiterlijk van de kaart (die afhankelijk is van de symbologie van de individuele lagen) zeer
belangrijk. De eindgebruiker van de kaarten die u maakt moet in staat zijn om eenvoudig te zien wat de kaart
weergeeft. Net zo belangrijk is dat u in staat moet zijn de gegevens te verkennen, terwijl u ermee werkt, en goede
symbologie helpt daar veel bij.
Met andere woorden: juiste symbologie hebben is geen luxe of leuk om te hebben. In feite is het essentieel voor u om
een GIS juist te gebruiken en kaarten en informatie te produceren die mensen kunnen gebruiken.
Het doel voor deze les: Symbologie te kunnen maken die u wilt gebruiken voor een willekeurige vectorlaag.

22 Hoofdstuk 2. Module: Een basiskaart maken en verkennen



QGIS Training Manual

2.4.1 Follow Along: Kleuren wijzigen

De kleur van de symbologie van een laag wijzigen: open zijn Laageigenschappen. Laten we beginnen met het wijzigen
van de kleur van de laag landuse.

1. Klik met rechts op de laag landuse in de Lagenlijst.
2. Selecteer het menuitem Eigenschappen… in het menu dat verschijnt.

Notitie: Standaard kunt u ook toegang krijgen tot de eigenschappen van een laag door erop te dubbelklikken
in de Lagenlijst.

Tip: De knop , direct boven het paneel Lagen, zal het paneel Laag opmaken openen. U kunt dit
paneel gebruiken om enkele eigenschappen van de laag te wijzigen: standaard zullen wijzigingen direct worden
toegepast.

3. Selecteer, in het venster Laageigenschappen, de tab Symbologie:

4. Klik op de knop Kleur selecteren naast het label Kleur. Een standaard dialoogvenster voor kleuren zal
verschijnen.

5. Kies een grijze kleur en klik op OK.
6. Klik opnieuw op OK in het venster Laageigenschappen en u zult zien dat de wijziging van de kleur is toegepast

op de laag.

2.4. Lesson: Symbologie 23



QGIS Training Manual

2.4.2 Try Yourself

Wijzig de kleur van de laag water naar lichtblauw. Probeer het paneel Laag opmaken te gebruiken in plaats van het
menu Laageigenschappen.
Controleer uw resultaten

2.4.3 Follow Along: Symboolstructuur wijzigen

Dit gaat tot dusverre prima, maar er is meer symbologie op een laag dan alleen de kleur ervan. Vervolgens willen we
de lijnen elimineren, die tussen de verschillende gebieden van landuse bestaan, om de kaart visueel minder rommelig
te laten lijken.

1. Open het venster Laageigenschappen voor de laag landuse.

Op de tab Symbologie zult u hetzelfde dialoogvenster zien als eerder. Deze keer echter gaat u meer doen
dan alleen snel de kleur wijzigen.

2. Vergroot, in de boom van symboollagen, de keuzelijst Vulling en selecteer de optie Standaard vulling:
3. Klik op de keuzelijst Lijnstijl. Op dit moment zou die een korte lijn moeten laten zien en de woorden

Doorlopende lijn.
4. Wijzig dit naar Geen Pen.
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5. Klik op OK.
Nu zal de laag landuse geen lijnen tussen gebieden meer hebben.

2.4.4 Try Yourself

• Wijzig de symbologie van de laag water opnieuw zodat het een meer donkerblauwe rand heeft.
• Wijzig de symbologie van de laag rivers naar een zinvolle weergave van waterwegen.

Onthoud: u kunt de knop Paneel Laag opmaken openen gebruiken en direct alle wijzigingen zien. Dat paneel stelt u ook
in staat individuele wijzigingen bij het symboliseren van een laag ongedaan te maken.
Controleer uw resultaten

2.4.5 Follow Along: Op schaal gebaseerde zichtbaarheid

Soms zult u vinden dat een laag niet geschikt is voor een opgegeven schaal. Een gegevensset van, bijvoorbeeld, alle
werelddelen kan een laag detail hebben en niet heel nauwkeurig zijn op straatniveau. Wanneer dat gebeurt wilt u in
staat zijn de gegevensset te verbergen voor niet toepasselijke schaalgrootten.
In ons geval zouden we kunnen besluiten om de gebouwen te verbergen van weergave op kleine schaalgrootten. Deze
kaart bijvoorbeeld…

… is niet erg nuttig. De gebouwen zijn moeilijk te onderscheiden op die schaal.
Inschakelen van renderen gebaseerd op schaal:

1. Open het dialoogvenster Laageigenschappen voor de laag buildings.
2. Activeer de tab Rendering.
3. Schakel op schaal gebaseerd renderen in door te klikken op het keuzevak gelabeld Schaalafhankelijke

zichtbaarheid:
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4. Wijzig de waarde Minimum naar 1:10.000.

5. Klik op OK.
Test de effecten hiervan door in- en uit te zoomen op uw kaart, merk op wanneer de laag buildings verdwijnt en weer
verschijnt.

Notitie: U kunt uw muiswiel gebruiken om in stappen te zoomen. Als alternatief kunt de gereedschappen Zoomen
gebruiken om in een venster te zoomen:

2.4.6 Follow Along: Symboollagen toevoegen

Nu u weet hoe u eenvoudige symbologie voor lagen kunt wijzigen, is de volgende stap om meer complexe symbologie
te maken. QGIS stelt u in staat dit te doen met behulp van symboollagen.

1. Ga terug naar de symbooleigenschappen van de laag landuse (door te klikken op Standaard vulling in de boom
met symboollagen).
In dit voorbeeld heeft het huidige symbool geen rand (d.i. het gebruikt de randstijl Geen Pen).
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2. Selecteer het niveau Vulling in de boom en klik op de knop Symboollaag toevoegen. Het dialoogvenster zal
wijzigen en er ongeveer uitzien zoals hier, met een nieuw toegevoegde symboollaag:
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Het zou er, bijvoorbeeld, qua kleur iets anders uit kunnen zien, maar u gaat dat toch wijzigen.
Nu is er een tweede symboollaag. Omdat het een effen kleur is zal het natuurlijk het eerdere soort symbool volledig
bedekken. En het heeft de randstijl Doorlopende lijn, die we niet willen. Duidelijk is dat dit symbool moet worden
gewijzigd.

Notitie: Het is belangrijk de kaartlaag en een symboollaag niet met elkaar te verwarren. Een kaartlaag is een vector
(of raster) die in de kaart is geladen. Een symboollaag maakt deel uit van het symbool dat wordt gebruikt om een
kaartlaag weer te geven. Deze cursus zal gewoonlijk naar een kaartlaag verwijzen als laag, maar een symboollaag zal,
om verwarring te voorkomen, altijd een symboollaag worden genoemd.

Met de nieuwe laag Standaard vulling geselecteerd:
1. Stel, net als tevoren, de randstijl in op Geen Pen.
2. Wijzig de stijl voor de vulling naar iets anders dan Doorgetrokken of Geen vulling. Bijvoorbeeld:
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3. Klik op OK.
Nu kunt u uw resultaten bekijken en ze eventueel nog iets verfijnen. U kunt zelfs meerdere extra symboollagen
toevoegen en op die manier een soort textuur voor uw laag maken.

Het is leuk! Maar het heeft vermoedelijk teveel kleuren om op een echte kaart te gebruiken…

2.4.7 Try Yourself

Onthoud om in te zoomen als dat nodig is, maak een eenvoudige, maar niet te afleidende textuur voor de laag buildings
met behulp van bovengenoemde methoden.
Controleer uw resultaten
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2.4.8 Follow Along: Niveaus van symbolen schikken

Wanneer symboollagen worden gerenderd, worden zij ook in een serie gerenderd, soortgelijk aan de manier waarop
verschillende kaartlagen worden gerenderd. Dit betekent dat, in sommige gevallen, als u veel symboollagen in één
symbool heeft, dat onverwachte resultaten kan opleveren.

1. Geef de laag roads een extra symboollaag (met de methoden voor het toevoegen van symboollagen zoals
hierboven gedemonstreerd).

2. Geef de basislijn een Lijndikte van 1.5 en een zwarte kleur.
3. Geef de nieuwe, bovenste laag een dikte van 0,8 en een witte kleur.

U zult zien dat dit gebeurd:

Wel, wegen hebben nu een straat-achtige symbologie, maar u ziet dat lijnen elkaar overlappen op elke kuising. Dat is
helemaal niet wat we willen!
U kunt de niveaus van symbolen sorteren en daarmee beheren in welke volgorde de verschillende symboollagen
worden gerenderd om te voorkomen dat dit gebeurt,
De volgorde van de symboollagen wijzigen:

1. Selecteer de bovenste laag Lijn in de boom van de symboollagen.
2. Klik op Geavanceerd ► Symboollagen… aan de rechter onderzijde van het venster.
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Dit zal een dialoogvenster openen zoals dit:

3. Selecteer Symboollagen tonen. U kunt dan de volgorde van de lagen van elk symbool instellen door het
overeenkomende nummer voor het niveau in te voeren. 0 is de onderste laag.
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In ons geval willen we alleen de optie activeren, zoals dit:

Dit zal de witte lijn bovenop de dikke zwarte lijnranden renderen.
4. Klik tweemaal op OK om terug te keren naar de kaart.

De kaart zal er nu zo uitzien:

Als u klaar bent, onthoud dan om het symbool zelf op te slaan om niet uw werk te verliezen als in de toekomst het
symbool opnieuw wijzigt. U kunt de huidige stijl van uw symbool opslaan door te klikken op de knop Stijl opslaan…
aan de onderzijde van het dialoogvenster Laageigenschappen. We zullen de indelingQGIS QML stijlbestand gebruiken.
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Sla uw stijl op onder solution/styles/better_roads.qml. U kunt een eerder opgeslagen stijl op elk
moment laden door te klikken op de knop Stijl laden…. Onthoud, voordat u een stijl wijzigt, dat elke niet opgeslagen
stijl die u vervangt verloren gaat.

2.4.9 Try Yourself

Wijzig het uiterlijk van de laag roads opnieuw.
Maak de wegen smal en geel, met een dunne bleke grijze rand en een dunne zwarte lijn in het midden. Onthoud
dat u misschien de volgorde voor het renderen van de laag moet wijzigen via het dialoogvenster Geavanceerd ►
Symboollagen….

Controleer uw resultaten

2.4.10 Try Yourself

Symboollagen werken ook voor geclassificeerde lagen (d.i. lagen die meerdere symbolen hebben). Omdat we
classificatie nog niet behandeld hebben, zult u werken met enige rudimentaire vooraf geclassificeerde gegevens.

1. Maak een nieuw project en voeg alleen de gegevensset roads toe.
2. Pas het stijlbestand advanced_levels_demo.qml, verschaft in exercise_data/styles, toe op

de laag. Dit kan worden gedaan met het combinatievak Stijl ► Stijl laden… aan de onderzijde van het
dialoogvenster Laageigenschappen.

3. Zoom in op het gebied Swellendam.
4. Zorg er met behulp van symboollagen voor dat de randen van lagen in elkaar vloeien zoals in de afbeelding

hieronder:
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Controleer uw resultaten

2.4.11 Follow Along: Typen symboollagen

In aanvulling op het instellen van vulkleuren en het gebruiken van vooraf gedefinieerde patronen, kunt u geheel andere
typen symboollagen gebruiken. Het enige type dat we tot op heden hebben gebruikt, was het type Standaard vulling.
De meer geavanceerde typen symboollagen stellen u in staat uw symbolen nog verder aan te passen.
Elk type vector (punt, lijn en polygoon) heeft zijn eigen set van typen symboollagen. Eerst zullen we kijken naar de
typen die beschikbaar zijn voor punten.

Typen symboollagen voor punt

1. Deselecteer alle lagen, met uitzondering van places.
2. Wijzig de eigenschappen voor de laag places:
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3. Een type symboollaag kan worden gekozen door in de boom van de symboollagen Standaard symbool te
selecteren uit de keuzelijst Symboollaagtype:
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4. Onderzoek de verschillende opties die voor u beschikbaar zijn en kies een symbool met de stijl waarvan u denkt
dat die toepasselijk is.

5. Indien u twijfelt, gebruik dan een rond Standaard symbool met een witte rand en een bleke groene vulling, met
een Grootte van 3.00 en een Lijndikte van 0.5.

Typen symboollagen voor lijn

De verschillende beschikbare opties voor lijngegevens bekijken:
1. Wijzig het Type symboollaag voor de bovenste symboollaag van roads naar Symbolen-lijn:
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2. Selecteer de laag Standaard symbool in de boom van de symboollagen. Wijzig de eigenschappen voor het
symbool zodat ze overeenkomen met dit dialoogvenster:
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3. Selecteer de laag Symbolen-lijn en wijzig de interval naar 1.00:
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4. Controleer of de symboolniveaus correct zijn (in het dialoogvensterGeavanceerd► Symboollagen dat we eerder
gebruikten) alvorens de stijl toe te passen.

Als u de stijl eenmaal heeft toegepast kijk dan even naar de resultaten op de kaart. Zoals u kunt zien wijzigen deze
symbolen van richting met de weg, maar buigen er niet altijd mee. Dit is voor sommige doeleinden nuttig, maar niet
voor andere. Als u wilt, kunt u de symboollaag terug veranderen naar de manier waarop het eerder was.

Typen symboollagen voor polygoon

De verschillende beschikbare opties voor polygoongegevens bekijken:
1. Wijzig het Symboollaagtype voor de laag water, zoals eerder voor de andere lagen.
2. Onderzoek wat de verschillende opties in de lijst kunnen.
3. Kies er een die u geschikt vindt.
4. Indien u twijfelt, gebruik dan de Puntpatroonvulling met de volgende opties:
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5. Voeg een nieuwe symboollaag toe met een normale Standaard vulling.
6. Maak hem hetzelfde lichte blauw met een donkerblauwe rand.
7. Verplaats het tot onder de puntpatroonvulling-symboollaag met de knop Naar beneden:
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Als resultaat heeft u een symbool met textuur voor de laag met water, met het toegevoegde voordeel dat u de grootte
vorm en afstand van de individuele stippen die de textuur vormen kunt wijzigen.

2.4.12 Try Yourself

Pas een groene transparante vulkleur toe op de laag protected_areas en wijzig de omtrek zodat het er uitziet zoals dit:
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Controleer uw resultaten

2.4.13 Follow Along: Symbologie voor Geometrie-generator

U kunt de Symbologie voor geometrie-generator gebruiken met alle typen lagen (punten, lijnen en polygonen). Het
resulterende symbool is direct afhankelijk van het type laag.
Heel kort, de Symbologie voor geometrie-generator stelt u in staat enkele ruimtelijke bewerkingen uit te voeren
binnen de symbologie zelf. U kunt bijvoorbeeld een echte ruimtelijke bewerking voor het zwaartepunt uitvoeren op
een polygonen-laag, zonder een puntenlaag te maken.
Meer nog, u heeft alle opties voor de opmaak om het uiterlijk van het resulterende symbool te wijzigen.
Laten we het eens proberen!

1. Selecteer de laag water.
2. Klik op Standaard vulling en wijzig het Symboollaagtype naar Geometrie-generator.
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3. Vóór we beginnen met het schrijven van de ruimtelijke query moeten we het type geometrie kiezen voor de
uitvoer. In dit voorbeeld gaan we zwaartepunten maken voor elk object, wijzig dus het type geometrie naar
Punt / Multipunt.

4. Laten we dan nu de query schrijven in het paneel voor de query:

centroid($geometry)
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5. Wanneer u klikt op OK zult u zien dat de laag water is gerenderd als een puntenlaag! We hebben zojuist een
ruimtelijke bewerking uitgevoerd binnen de laag op de symbologie zelf, is dat niet verbazingwekkend?
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Met de symbologie van de Geometrie-generator kunt u echt over de grenzen van normale symbologie gaan.

Try Yourself

Geometrie-generator is slechts een ander niveau symbool. Probeer een andere Standaard vulling toe te voegen onder
de Geometrie-generator.
Wijzig ook het uiterlijk van de Standaard markering van de symbologie van de Geometrie-generator.
Het uiteindelijke resultaat zou er als volgt uit moeten zien:
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Controleer uw resultaten

2.4.14 Follow Along: Een aangepaste SVG-vulling maken

Notitie: Umoet de gratis software voor het bewerken van vectoren Inkscape hebben geïnstalleerd om deze oefening
te kunnen doen,

1. Start het programma Inkscape. U zult de volgende interface zien:
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Dit zou u bekend kunnen voorkomen als u eerder andere programma’s voor het bewerken van
vectorafbeeldingen, zoals Corel, hebt gebruikt.
Eerst zullen we het werkvenster wijzigen naar een grootte die toepasselijk is voor een kleine textuur.

2. Klik op het menuitem Bestand►Documenteigenschappen. Dit zal u het dialoogvensterDocumenteigenschappen
tonen.

3. Wijzig Eenheden naar px.
4. Wijzig de Breedte en Hoogte naar 100.
5. Sluit het dialoogvenster als u klaar bent.
6. Klik op het menuitem Beeld ► Zoomen ► Pagina om de pagina te zien waar u mee werkt.
7. Selecteer het gereedschap Cirkel:
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8. Klik en sleep op de pagina om een ellips te tekenen. Houd de toets Ctrl ingedrukt terwijl u tekent, om van
de ellips een cirkel te maken.

9. Klik met rechts op de cirkel die u zojuist gemaakt hebt en open zijn opties Vulling en lijn. U kunt het renderen
aanpassen, zoals:
1. Wijzig de laag Vulling naar een lichtere kleur blauw.
2. Wijs, op de tab Lijnkleur, een donkerder kleur toe aan de rand.
3. En verklein de dikte van de rand op de tab Lijnstijl.
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10. Teken een lijn met behulp van het gereedschap Potlood:
1. Klik eenmaal om de lijn te beginnen. Houd Ctrl ingedrukt om het te laten ‘snappen’ in stappen van 15

graden.
2. Verplaats de aanwijzer horizontaal en plaats een punt met één enkele klik.
3. Klik en snap aan het hoekpunt van de lijn en maak een verticale lijn, beëindig die met één enkele klik.
4. Verbindt de twee eindpunten met elkaar.
5. Wijzig de kleur en breedte van het symbool Driehoek om het overeen te laten komen met de rand van de

cirkel en verplaats het indien nodig, zodat u eindigt met een symbool zoals dit:
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11. Als het symbool naar uw wensen is, sla het op als landuse_symbol in de map waar de cursus in staat, onder
exercise_data/symbols, als SVG-bestand.

In QGIS:
1. Open Laageigenschappen voor de laag landuse.
2. Wijzig, op de tab Symbologiel, de structuur van het symbool door het Symboollaagtype te wijzigen naar SVG-

vulling, zoals hieronder weergegeven.
3. Klik op de knop… en dan op Openen… om uw SVG-afbeelding te selecteren.

Het wordt toegevoegd aan de boom met symbolen en u kunt nu de verschillende karakteristieken ervan
aanpassen (kleuren, hoek, effecten, eenheden…).
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Als u eenmaal het dialoogvenster hebt gevalideerd, zouden objecten op de laag landuse nu moeten zijn bedekt door
een verzameling symbolen, die een textuur weergeven zoals die op de volgende kaart. Als texturen niet zichtbaar
zijn, dient u misschien in te zoomen op het kaartvenster of een grotere Breedte voor de textuur in te stellen in de
eigenschappen van de laag.
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2.4.15 In Conclusion

Wijzigen van de symbologie voor de verschillende lagen heeft een collectie vectorbestanden getransformeerd naar
een leesbare kaart. Niet alleen kunt u zien wat er gebeurt, het ziet er ook leuk uit!

2.4.16 Further Reading

Voorbeelden van mooie kaarten

2.4.17 What’s Next?

Wijzigen van symbolen voor gehele lagen is nuttig, maar de informatie die is opgenomen in elke laag is nog niet
beschikbaar voor iemand die deze kaart leest. Hoe heten de straten? Tot welke administratieve regio’s behoren
bepaalde gebieden? Wat zijn de relatieve oppervlaktegebieden van de boerderijen? Al deze informatie is nog steeds
verborgen. De volgende les zal uitleggen hoe u deze gegevens op uw kaart weergeeft.

Notitie: Heeft u onthouden om uw kaart regelmatig op te slaan?
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Module: Vectorgegevens classificeren

Classificeren van vectorgegevens stelt u in staat verschillende symbolen aan objecten toe te wijzen (verschillende
objecten op dezelfde laag), afhankelijk van hun attributen. Dit stelt iemand die de kaart gebruikt in staat om de
attributen van de verschillende objecten te zien.

3.1 Lesson: Vector attributengegevens

Vectorgegevens zijn mogelijkerwijs de meest voorkomende soort gegevens die u zult tegenkomen bij het dagelijks
gebruik van een GIS. Het vectormodel geeft de locatie en vorm van geografische objecten weer in punten, lijnen en
polygonen (en voor 3D-gegevens ook oppervlakten en volumes), terwijl hun andere eigenschappen zijn opgenomen
als attributen (vaak weergegeven als een tabel in QGIS).
Tot nu toe zijn geen van de wijzigingen, die wij aan de kaart hebben verricht, beïnvloed door de objecten die worden
weergegeven. Met andere woorden, alle gebieden van het gebruik van het land zien er hetzelfde uit, en alle wegen
zien er hetzelfde uit. Bij het kijken naar de kaart weten de kijkers niets over de wegen die zij zien; alleen dat er een
weg met een bepaalde vorm in een bepaald gebied ligt.
Maar de gehele kracht van GIS is dat alle objecten die zichtbaar op de kaart staan ook attributen hebben. Kaarten in
een GIS zijn niet slechts afbeeldingen. Zij vertegenwoordigen niet alleen objecten op locaties, maar ook informatie
over deze objecten.
Het doel voor deze les: De structuur van vectorgegevens te leren en de gegevensattributen van een object te
verkennen.

3.1.1 Follow Along: Laagattributen bekijken

Het is belangrijk te weten dat de gegevens waarmee u gaat werken niet alleen weergeven waar objecten in de ruimte
staan, maar ook dat ze u vertellen wat die objecten zijn.
Vanuit de vorige oefening zou u de laag protected_areas moeten zijn geladen in uw kaart. Als die nog
niet is geladen, dan vindt u de gegevensset protected_areas.shp in de indeling ESRI Shapefile in de map
exercise_data/shapefile.
De polygonen geven de beschermde gebieden weer die bestaan uit de ruimtelijke gegevens, maar we kunnen meer
te weten komen over de beschermde gebieden door de attributentabel te verkennen.

1. Klik, in het paneel Lagen, op de laag protected_areas om die te selecteren.
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2. Klik, op de werkbalk Attributen, op de knop Attributentabel openen. Dit zal een nieuw venster openen dat de
attributentabel van de laag protected_areas zal weergeven.

Een rij wordt een record genoemd en is geassocieerd met een object in het kaartvenster, zoals een polygoon.
Een kolom wordt een veld (of een attribuut) genoemd, en heeft een naam die helpt om het te beschrijven,
zoals name of id. Waarden in de cellen worden attribuutwaarden genoemd. Deze definities worden veel
gebruikt in GIS, dus is het goed om ze te onthouden.
Op de laag protected_areas staan twee objecten, die de twee polygonen weergeven die we zien in het
kaartvenster.

Notitie: Om te kunnen begrijpen wat de velden en attribuutwaarden weergeven, moet men misschien de
documentatie (of metadata) zoeken die de betekenis van de attribuutwaarden beschrijft. Deze zijn gewoonlijk
beschikbaar bij de maker van de gegevensset.

Laten we vervolgens eens kijken hoe een record in de attributentabel is gekoppeld aan een object polygoon die we
zien in het kaartvenster.

1. Ga terug naar het hoofdvenster van QGIS.

2. Klik, op de werkbalk Attributen, op de knop Object selecteren.
3. Zorg er voor dat de laag protected_areas nog steeds is geselecteerd in het paneel Lagen.
4. Verplaats uw muis naar het kaartvenster en klik met links op de kleinste van de twee polygonen. De polygoon

zal geel worden, wat aangeeft dat die is geselecteerd.
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5. Ga terug naar het venster Attributentabel, en u zou een record (rij) geaccentueerd moeten zien. Dat zijn de
attribuutwaarden van de geselecteerde polygoon.
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U kunt ook een object selecteren in de Attributentabel.
1. Klik, in het venster Attributentabel, aan de uiterste linkerkant, op het rijnummer van het record dat momenteel

niet geselecteerd is.

2. Ga terug naar het hoofdvenster van QGIS en kijk naar het kaartvenster. U zou nu het grootste van de twee
polygonen geel gekleurd moeten zien.

3. Ga naar het venster Attributentabel en klik op de knop Alle objecten van de laag deselecteren om het object te
deselecteren.

Soms worden er heel veel objecten weergegeven in het kaartvenster en zou het moeilijk kunnen zijn om te zien welk
object in de Attributentabel is geselecteerd. Een andere manier om de locatie van een object te identificeren is om het
gereedschap Flitsmogelijkheid te gebruiken.

1. Klik met rechts, in de Attributentabel, op de cel in de rij die de attribuutwaarde r2855697 voor het veld
full_id heeft.

2. Klik, in het contextmenu, op Flitsmogelijkheid en kijk dan in het kaartvenster.

U zou nu moeten zien dat de polygoon een aantal keren rood flikkert. Als u het niet zag, probeer het dan nog
eens.

Een ander handig gereedschap is het gereedschap Naar object zoomen, dat QGIS zegt naar het betrokken object te
zoomen.
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1. Klik met rechts, in de Attributentabel, op de cel in de rij die de attribuutwaarde r2855697 voor het veld
full_id heeft.

2. Klik, in het contextmenu, op Naar object zoomen

Kijk naar het kaartvenster. De polygoon zou nu het bereik van het gebied van het kaartvenster moeten innemen.
U mag nu de attributentabel sluiten.

3.1.2 Try Yourself Attributen van vectorgegevens verkennen

1. Hoeveel velden zijn er beschikbaar in de laag rivers?
2. Vertel ons eens iets meer over de plaatsen town in uw gegevensset.
3. Open de attributentabel voor de laag places. Welk veld zou het meest nuttig zijn om weer te geven in de vorm

van een label, en waarom?
Controleer uw resultaten

3.1.3 In Conclusion

U weet nu hoe u de attributentabel kunt gebruiken om te zien wat er echt in de gegevens staat die u gebruikt. Een
gegevensset zal alleen nuttig voor u zijn als het de attributen heeft waar het u om gaat. Als u weet welke attributen
u nodig heeft, kunt u snel beslissen of u een bepaalde gegevensset kunt gebruiken, of dat u naar een andere moet
zoeken die wel de vereiste gegevens voor de attributen heeft.
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3.1.4 What’s Next?

Verschillende attributen zijn nuttig voor verschillende doeleinden. Sommige ervan kunnen direct als tekst worden
weergegeven om door de gebruiker van de kaart te worden gezien. Hoe dit te doen leert u in de volgende les.

3.2 Lesson: Labels

Labels kunnen aan een kaart worden toegevoegd om elke soort informatie over een object weer te geven. Elke
vectorlaag kan labels met zich geassocieerd hebben. Deze labels zijn afhankelijk van de gegevens voor attributen
van een laag voor hun inhoud.
Het doel voor deze les: Nuttige en goed uitziende labels toe kunnen passen op een laag.

3.2.1 Follow Along: Labels gebruiken

Zorg er eerst voor dat de knop zichtbaar is in de gebruikersinterface:
1. Ga naar het menuitem Beeld ►Werkbalken

2. Zorg er voor dat het item Werkbalk Label een vinkje voor zich heeft staan. Als dat niet zo is, klik dan op het
itemWerkbalk Label om het te activeren.

3. Klik op de laag places in het paneel Lagen, zodat die wordt geaccentueerd
4. Klik op de knop op de werkbalk om de tab Labels van het paneel Laag opmaken te openen
5. Schakel van Geen labels naar Enkele labels

U zult moeten kiezen welk veld in de attributen zal worden gebruikt voor de labels. In de vorige les heeft u
besloten dat het veld name het meest geschikte voor dit doel was.

6. Selecteer name uit de lijst Waarde:

60 Hoofdstuk 3. Module: Vectorgegevens classificeren



QGIS Training Manual

7. Klik op Apply

De kaart zou nu labels moeten hebben zoals deze:
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3.2.2 Follow Along: Opties voor labels wijzigen

Afhankelijk van de stijlen die u in eerdere lessen voor uw kaart koos, zou u kunnen vinden dat de labels niet
toepasselijk zijn opgemaakt en ofwel elkaar overlappen of te ver af staan van hun markeringen voor het punt.

Notitie: Boven gebruikte u de knop op deWerkbalk Label om het paneel Laag opmaken te openen. Net als met
Symbologie zijn dezelfde opties voor labelen beschikbaar via zowel het paneel Laag opmaken, als het dialoogvenster
Laageigenschappen. Hier zult u het dialoogvenster Laageigenschappen gebruiken.

1. Open het dialoogvenster Laageigenschappen door dubbel te klikken op de laag places
2. Selecteer de tab Labels

3. Zorg er voor dat Tekst is geselecteerd in de lijst met opties aan de linkerkant, werk dan de opties voor
tekstopmaak bij zodat die overeenkomen met die welke hier worden weergegeven:
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4. Klik op Apply

Dat lettertype zou groter en bekender kunnen zijn voor gebruikers, maar de leesbaarheid ervan is nog steeds
afhankelijk van welke lagen daaronder zijn gerenderd. Laten we, om dit op te lossen, eens kijken naar de optie
Buffer.

5. Selecteer Buffer uit de lijst met opties aan de linkerkant
6. Selecteer het keuzevak naast Teken tekstbuffer, en kies dan de opties, zodat die overeenkomen met die welke

hier worden weergegeven:
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7. Klik op Apply

U zult zien dat dit een gekleurde buffer of rand toevoegt aan de labels met plaatsen, wat het eenvoudiger maakt
ze te zien op de kaart:
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Nu kunnen we de plaatsing van de labels in relatie tot hun puntmarkeringen aanpakken.
8. Selecteer Plaatsing uit de lijst met opties aan de linkerkant
9. Selecteer Rondom punt en wijzig de waarde voor Afstand naar 2.0Millimeters:
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10. Klik op Apply

U zult nu zien dat de labels niet langer hun puntmarkeringen overlappen.

3.2.3 Follow Along: Labels in plaats van symbologie voor lagen
gebruiken

In veel gevallen hoeft de locatie van een punt niet heel specifiek te zijn. Bijvoorbeeld: de meeste punten in de laag
places verwijzen naar gehele steden of voorsteden, en het specifieke punt dat is geassocieerdmet dergelijke objecten
is niet zo specifiek op een grote schaal. In feite is het opgeven van een punt dat te specifiek is vaak verwarrend voor
iemand die een kaart leest.
Een voorbeeld: op een kaart van de wereld zou het punt dat wordt opgegeven voor de Europese Unie bijvoorbeeld
ergens in Polen kunnen liggen. Voor iemand die de kaart leest, zou het zien van een punt dat is gelabeld Europese
Unie in Polen, zou het kunnen lijken dat de hoofdstad van de Europese Unie daarom in Polen ligt.
Het is vaak nuttig om de symbolen voor punten uit te schakelen en ze compleet te vervangen door labels om dus dit
soort misverstanden te voorkomen.
In QGIS kunt u dit doen door de positie van de labels te wijzigen zodat ze direct worden gerenderd over de punten
waar zij naar verwijzen.
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1. Open de tab Labels van het dialoogvenster Laageigenschappen voor de laag places
2. Selecteer de optie Plaatsing uit de lijst met opties
3. Klik op de knop Op afstand van punt

Dit zal de opties Kwadrant onthullen die u kunt gebruiken om de positie van het label in relatie tot de
puntmarkering in te stellen. In dit geval willen we het label centreren op het punt, dus kies het kwadrant in
het centrum:

4. Verberg de symbolen voor de punten door, zoals gewoonlijk, de Symbologie van de laag te bewerken, en stel
de grootte van de breedte en hoogte van Standaard symbool in op 0.0:
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5. Klik op Apply en u zult dit resultaat zien:
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Als u zou uitzoomen uit de kaart, zou u zien dat sommige van de labels verdwijnen op grotere schalen om overlappen
te vermijden. Soms is dat wat u wilt wanneer u met gegevenssets werkt die veel punten hebben, maar andere keren
zult u op deze manier nuttige informatie verliezen. Er is een andere mogelijkheid voor het behandelen van dit soort
gevallen, die we in een latere oefening in deze les zullen behandelen. Voor nu, zoom uit en klik op de knop op
de werkbalk en kijk wat er gebeurt.

3.2.4 Try Yourself De labels aanpassen

• Herstel de instellingen voor label en symbool terug naar de puntmarkering en een afstand tot punt van 2.0
Millimeters.

Controleer uw resultaten

• Stel de kaart in op de schaal 1:100000. U kunt dit doen door dit in te typen in het vak Schaal op de Statusbalk.
Pas uw labels aan, zodat zij geschikt zijn om op deze schaal te worden bekeken.

Controleer uw resultaten
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3.2.5 Follow Along: Lijnen labelen

Nu u weet hoe het labelen werkt is er een aanvullend probleem. Punten en polygonen zijn eenvoudig te labelen, maar
hoe gaat dat met lijnen? Als u ze op dezelfde manier labelt als de punten, zouden uw resultaten er als volgt uitzien:

We zullen nu de labels voor de laag roads opnieuw opmaken, zodat zij eenvoudiger te begrijpen zijn.
1. Verberg de laag places zodat die u niet afleidt
2. Activeer Enkele labels voor de laag roads, zoals u hierboven deed voor places
3. Stel de Grootte van het lettertype in op 10, zodat u meer labels kunt zien
4. Zoom in op het stadsgebied Swellendam
5. Kies, op de tab Plaatsing van de tab Labels, de volgende instellingen:
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U zult waarschijnlijk merken dat de opmaak voor de tekst standaardwaarden heeft gebruikt en dat de labels
als consequentie daarvan moeilijk te lezen zijn. Werk de Tekst bij om een donkergrijze of zwarte Kleur te
gebruiken en de Buffer om een lichtgele Kleur te gebruiken.
De kaart zal er ongeveer zoals deze uitzien, afhankelijk van de schaal:
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U zult zien dat sommige namen van wegen meerdere malen verschijnen en dat is niet altijd nodig. Dit
voorkomen:

6. Kies, op de tab Labels in het dialoogvenster Laageigenschappen, de optie Rendering en selecteer Aan elkaar
verbonden lijnen samenvoegen om labelduplicaten te voorkomen zoals weergegeven:
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7. Klik op OK

Een andere nuttige functie is om te voorkomen dat labels die worden getekend voor objecten te kort worden
om te worden opgemerkt.

8. Stel, in hetzelfde paneel Rendering, de waarde van Onderdruk labelen van objecten kleiner dan … in op 5.00
mm en bekijk de resultaten als u op Apply klikt.
Probeer ook de verschillende instellingen voor Plaatsing uit. Zoals we eerder hebben gezien, is de optie
Horizontaal in dit geval geen goed idee, dus laten we in plaats daarvan de optie Gebogen gebruiken.

9. Selecteer de optie Gebogen in het paneel Plaatsing op de tab Labels

Hier is het resultaat:
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Zoals u kunt zien verbergt dit enkele labels die eerder zichtbaar waren, wegens de moeilijkheid voor sommige ervan
om gebogen lijnen voor wegen te volgen en nog steeds leesbaar te zijn. Het maakt andere labels veel nuttiger, omdat
zij de wegen volgen in plaats van te zweven in de ruimte ertussen. U kunt beslissen om deze opties te gebruiken,
afhankelijk van wat u denkt dat nuttiger is of er beter uitziet.

3.2.6 Follow Along: Gegevensgedefinieerde instellingen

1. Deactiveer het labelen voor de laag roads
2. Activeer opnieuw het labelen voor de laag places

3. Open de attributentabel voor places met de knop
Het heeft één veld wat nu voor ons van belang is: place, wat het type stadsgebied definieert voor elk record.
We kunnen deze gegevens gebruiken om de stijlen voor labels te beïnvloeden.

4. Navigeer naar het paneel Tekst in het paneel Labels van places

5. Klik op de knop naast de knop voor cursieve tekst onder Stijl en selecteer Bewerken… om de Expressie-
string bouwer te openen:
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6. Dubbelklik, onder Velden en waarden, op place en klik dan op Alle unieke. Dit zal alle unieke waarden
vermelden van het veld place van deze laag. Voeg een = in de tekstbewerker in en dubbelklik dan op town.
Als alternatief, kunt u: "place" = 'town' direct in de tekstbewerker typen.

7. Klik twee keer op OK:
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Merk op dat de labels voor alle plaatsen waarvan het veld place overeenkomt met town cursief worden
weergegeven.

3.2.7 Try Yourself Gegevensgedefinieerde instellingen gebruiken

Notitie: We springen hier een stukje vooruit om enkele geavanceerde instellingen voor labelen te demonstreren. Op
het niveau voor gevorderden wordt aangenomen dat u weet wat het volgende betekent. Als u dat niet weet, laat dit
gedeelte dan rusten en kom later terug als u de vereiste materialen heeft behandeld.

1. Open de attributentabel voor places

2. Ga naar de modus Bewerken door te klikken op de knop

3. Voeg een nieuwe kolom toe met de knop
4. Configureer die als volgt:
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5. Gebruik dit om aangepaste lettergrootten in te stellen voor elk verschillend type plaats (elke sleutel in het veld
place`).

Controleer uw resultaten

3.2.8 Meer mogelijkheden met labelen

We kunnen in deze cursus niet elk optie behandelen, maar onthoud dat de tab Label nog veel meer andere nuttige
functies heeft. U kunt schaalafhankelijk renderen instellen, de prioriteit voor het afdrukken van labels in een laag
wijzigen, en elke optie voor labelen instellen met behulp van attributen van lagen. U kunt zelfs de rotatie, XY-positie
en andere eigenschappen van een label instellen (als u velden voor attributen voor dat doel heeft toegewezen), en deze
eigenschappen bewerken met behulp van de gereedschappen die naast de belangrijkste knop Laag-label opties staan:

(Deze gereedschappen zullen actief zijn als de vereiste velden voor attributen bestaan en u in de modus Bewerken
bent.)
Het staat u uiteraard vrij om meer mogelijkheden van het systeem voor labelen te verkennen.

3.2.9 In Conclusion

U heeft nu geleerd hoe u attributen van lagen gebruikt voor het maken van dynamische labels. Dit kan uw kaart veel
informatiever maken en meer stijl geven!

3.2.10 What’s Next?

Nu u weet hoe attributen een visueel verschil voor uw kaart kunnen maken, hoe zijn ze te gebruiken om de symbologie
van objecten zelf te wijzigen? Dat is het onderwerp voor de volgende les!
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3.3 Lesson: Classificatie

Labels zijn een goede manier om informatie te communiceren, zoals de namen van individuele plaatsen, maar zij
kunnen niet overal voor worden gebruikt. Laten we bijvoorbeeld zeggen dat iemand wil weten waar elk gebied van
landuse voor wordt gebruikt. Met behulp van labels zou u dit krijgen:

Dit maakt het labelen van de kaart moeilijk te lezen en zelfs overweldigend als er onnoemelijk veel verschillende
gebieden voor het gebruik van land op de kaart staan.
Het doel voor deze les: Leren om vectorgegevens effectief te classificeren.

3.3.1 Follow Along: Nominale gegevens classificeren

1. Open het dialoogvenster Laageigenschappen voor de laag landuse.
2. Ga naar de tab Symbologie

3. Klik op de keuzelijst genaamd Enkel symbool en wijzig het naar Categorieën:

78 Hoofdstuk 3. Module: Vectorgegevens classificeren



QGIS Training Manual

4. Wijzig, in het nieuwe paneel,Waarde naar landuse en Kleurverloop naarWillekeurig kleurverloop.
5. Klik op de knop genaamd Classificeren

6. Klik op OK

U zult iets zien zoals dit:
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7. Klik op de pijl (of plusteken) naast landuse in het panee; Lagen, u zult de categorieën zien uitgelegd:

80 Hoofdstuk 3. Module: Vectorgegevens classificeren



QGIS Training Manual

Nu zijn onze polygonen voor het gebruik van land gekleurd en geclassificeerd, zodat gebieden met hetzelfde
gebruik van het land dezelfde kleur hebben.

8. Als u wilt, kunt u het symbool voor elk gebied voor gebruik van het land wijzigen door te dubbelklikken op
het relevante kleurblok in het paneel Lagen of in het dialoogvenster Laageigenschappen:
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Merk op dat er één categorie is die leeg is:
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Deze lege categorie wordt gebruikt om objecten te kleuren die geen waarde voor het gebruik van het land gedefinieerd
hebben of die een waarde NULL hebben. Het kan nuttig zijn om deze lege categorie te behouden, zodat gebieden met
een waarde NULL nog steeds worden weergegeven op de kaart. U wilt misschien de kleur wijzigen naar een meer
opvallende om een blanco of NULL-waarde weer te geven.
Onthoud om uw kaart nu op te slaan zodat u uw welverdiende wijzigingen niet verliest!

3.3.2 Try Yourself Meer classificatie

Gebruik de kennis die u hierboven hebt opgedaan om de laag buildings te classificeren. Stel de categorie in op
het veld building en gebruik de kleurenbalk Spectraal.

Notitie: Onthoud om in te zoomen op een stadsgebied om de resultaten te zien.

3.3.3 Follow Along: Ratio-classificatie

Er zijn vier typen classificatie: nominaal, ordinaal, interval en ratio.
Bij nominale classificatie zijn de categorieën waarin de objecten worden geclassificeerd gebaseerd op namen; zij
hebben geen volgorde. Bijvoorbeeld: namen van steden, codes voor buurten, etc. Symbolen die worden gebruikt voor
nominale gegevens zouden geen volgorde of grootte moeten impliceren.

• Voor punten kunnen we symbolen met een verschillende vorm gebruiken.
• Voor polygonen kunnen we verschillende typen arcering of verschillende kleuren gebruiken (vermijd het mixen
van lichte en donkere kleuren).

• Voor lijnen kunnen we verschillende typen streeppatronen, verschillende kleuren gebruiken (vermijd het mixen
van lichte en donkere kleuren) en verschillende symbolen langs lijnen gebruiken.
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Bij ordinale classificatie worden de categorieën geschikt in een bepaalde volgorde. Wereldsteden wordt bijvoorbeeld
een rang gegeven afhankelijk van hun belang voor de wereldhandel, reizen, cultuur, etc. Symbolen die worden gebruikt
voor ordinale gegevens zouden een volgorde, maar geen grootte, moeten impliceren.

• Voor punten kunnen we symbolen met lichte naar donkere kleuren gebruiken.
• Voor polygonen kunnen we graduele kleuren gebruiken (van licht naar donker).
• Voor lijnen kunnen we graduele kleuren gebruiken (van licht naar donker).

Bij classificatie op interval staan de getallen op een schaal met positieve, negatieve en nulwaarden. Bijvoorbeeld:
hoogte boven/onder zeeniveau, temperatuur in graden Celsius. Symbolen die worden gebruikt voor gegevens met
interval zouden een volgorde en grootte moeten impliceren.

• Voor punten kunnen we symbolen variërende grootte gebruiken (van klein naar groot).
• Voor polygonen kunnen we graduele kleuren gebruiken (van licht naar donker) of diagrammen van variërende
grootte toevoegen.

• Voor lijnen kunnen we dikte gebruiken (van dun naar dik).
Bij ratio-classificatie staan de getallen op een schaal met alleen positieve en nulwaarden. Bijvoorbeeld: temperatuur
boven absoluut nul (0 graden Kelvin), afstand vanaf een punt, de gemiddelde hoeveelheid verkeer in een bepaalde
straat per maand, etc. Symbolen die worden gebruikt voor gegevens met ratio zouden een volgorde en grootte moeten
impliceren.

• Voor punten kunnen we symbolen variërende grootte gebruiken (van klein naar groot).
• Voor polygonen kunnen we graduele kleuren gebruiken (van licht naar donker) of diagrammen van variërende
grootte toevoegen.

• Voor lijnen kunnen we dikte gebruiken (van dun naar dik).
In het voorbeeld hierboven gebruikten we nominale classificatie om elk record op de laaglanduse, gebaseerd op zijn
attribuut landuse, te kleuren. Nu zullen we ratio-classificatie gebruiken om de records per gebied te classificeren.
We gaan de laag opnieuw classificeren dus zullen bestaande klassen verloren gaan, indien zij niet zijn opgeslagen. De
huidige classificatie opslaan:

1. Open het dialoogvenster Laageigenschappen
2. Klik op de knop Stijl opslaan… in het keuzemenu Stijl.
3. Selecteer Huidige hernoemen…, voer in land usage en druk op OK.

De categorieën en hun symbolen zijn nu opgeslagen in de eigenschappen van de laag.
4. Klik nu op het item Toevoegen… van het keuzemenu Stijl en maak een nieuwe stijl, genaamd ratio. Dat zal

de nieuwe classificatie opslaan.
5. Sluit het dialoogvenster Laageigenschappen

We willen de gebieden voor het gebruik van het land classificeren op grootte, maar er is een probleem: zij hebben
geen veld voor de grootte, dus zullen we er een moeten maken.

1. Open de attributentabel voor de laag landuse.

2. Ga naar de modus Bewerken door te klikken op de knop Bewerken aan/uitzetten

3. Voeg, met de knop Nieuw veld, een nieuwe kolom toe van het type decimaal getal, genaamd AREA:
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4. Klik op OK

Het nieuwe veld zal worden toegevoegd (aan de uiterste rechterkant van de tabel; u zult misschien horizontaal
moeten scrollen om het te zien). Op dit moment bevat het echter geen gegevens, het heeft slechts veel waarden
NULL.
We moeten de gebieden berekenen om dit probleem op te lossen.

1. Open Veldberekening met de knop .
U krijgt dit dialoogvenster:
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2. Selecteer Bestaande velden vernieuwen

3. Selecteer AREA in de keuzelijst van de velden

4. Op de tab Expressie, vergroot de functiegroep Geometrie in de lijst en zoek naar $area
5. Dubbelklik er op zodat het in het veld Expressie verschijnt

6. Klik op OK

7. Scroll naar het veld AREA in de attributentabel en u zult zien dat het is gevuld met waarden (u moet
misschien op de kolomkop klikken om de gegevens te vernieuwen).

Notitie: Deze gebieden houden rekening met de instellingen voor eenheden van het project voor gebied, dus
zij zouden kunnen zijn in vierkante meters of vierkante graden.

5. Druk op om uw bewerkingen op te slaan en schakel de modus Bewerken uit met Bewerken aan/uitzetten

6. Sluit de attributentabel
Nu we de gegevens hebben, kunnen we die gebruiken om de laag landuse te renderen.
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1. Open de tab Symbologie van het dialoogvenster Laageigenschappen voor de laag``landuse``
2. Wijzig de stijl voor de classificatie van Categorieën naar Gradueel

3. Wijzig deWaarde naar AREA
4. Kies, onder Kleurverloop, de optie Nieuw kleurverloop maken…:

5. Kies Gradient (als het al niet geselecteerd is) en klik op OK. U zult dit zien:
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U zult dit gebruiken om gebieden aan te duiden, met kleine gebieden als Kleur 1 en grote gebieden als Kleur 2.
6. Kies toepasselijke kleuren

In het voorbeeld ziet het resultaat er als volgt uit:
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7. Klik op OK

8. U kunt het kleurverloop opslaan door te selecteren Kleurverloop opslaan… op de tab Kleurverloop. Kies een
toepasselijke naam voor het kleurverloop en klik op Opslaan. U zult nu gemakkelijk in staat zijn hetzelfde
kleurverloop te selecteren onder Alle kleurverlopen.

9. Klik op Classificeren

Nu zult u iets hebben zoals dit:
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Laat alles zoals het is.
10. Klik op OK:
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3.3.4 Try Yourself De classificatie verfijnen

• Wijzig de waarden van Modus en Klassen totdat u een classificatie heeft die zinvol is.
Controleer uw resultaten

3.3.5 Follow Along: Op regels gebaseerde classificatie

Het is vaak nuttig om meerdere criteria voor een classificatie te combineren, maar helaas houdt normale classificatie
slechts rekening met één attribuut. Dat is waar op regels gebaseerde classificatie handig is.
In deze les zullen we de laag landuse weergeven op een manier om de stad Swellendam gemakkelijk te kunnen
identificeren tussen de andere bewoonde gebieden, en tussen andere typen van gebruik van het land (gebaseerd op
hun gebied).

1. Open het dialoogvenster Laageigenschappen voor de laag landuse.
2. Schakel naar de tab Symbologie

3. Schakel de stijl voor de classificatie naar Regel-gebaseerd
QGIS zal automatisch de regels weergeven die de huidige geïmplementeerde classificatie voor deze laag
weergeeft. Bijvoorbeeld: na het voltooien van bovenstaande oefening zou u iets zoals dit kunnen zien:

4. Klik en sleep om alle regels te selecteren

5. Gebruik de knop Geselecteerde regels verwijderen om alle bestaande regels te verwijderen
Laten we nu onze aangepaste regels toevoegen

1. Klik op de knop Regel toevoegen

2. Het dialoogvenster Regel bewerken verschijnt dan
3. Voer Stad Swellendam in als Label

4. Klik op de knop naast het tekstvak Filter om de Expressie-string bouwer te openen
5. Voer het criterium "name" = 'Swellendam' in en valideer dat
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6. Terug in het dialoogvenster Regel bewerken, wijs een donkere grijsblauwe kleur toe om de belangrijkheid van
de stad in de regio aan te geven en verwijder de rand

7. Klik op OK

8. Herhaal de stappen hierboven om de volgende regels toe te voegen:
1. Label Anders bewoond met het criterium "landuse" = 'residential' AND "name" <>

'Swellendam' (of "landuse" = 'residential' AND "name" != 'Swellendam').
Kies een vale blauwgrijze Vulkleur

2. Label Grote, niet bewoonde gebieden met het criterium "landuse" <> 'residential' AND
"AREA" >= 605000. Kies een middengroene kleur.
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Deze filters zijn exclusief, met dien verstande dat zij gebieden op de kaart uitsluiten (niet-bewoonde
gebieden die kleiner zijn dan 605000 (vierkante meter) zijn in geen enkele regel opgenomen).

3. We zullen de overblijvende objecten vangen met een nieuwe regel, gelabeld Kleine, niet bewoonde
gebieden. Selecteer, in plaats van een filterexpressie, de radioknop Else. Geef deze categorie een
geschikte vaalgroene kleur.

Uw regels zouden er nu zo uit moeten zien:
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9. Pas deze symbologie toe
Uw kaart zal er ongeveer zo uitzien:

Nu heeft u een kaart met Swellendam als het meest prominente woongebied en andere gebieden die geen woongebied
zijn gekleurd overeenkomstig hun grootte.

3.3.6 In Conclusion

Symbologie stelt ons in staat de attributen van een kaart weer te geven op een eenvoudig te lezenmanier. Het stelt zowel
ons, als de lezer van de kaart in staat, om de significantie van objecten te begrijpen, met behulp van relevante attributen
die we kiezen. Afhankelijk van de problemen die u tegenkomt, past u verschillende technieken voor classificeren toe
om ze op te lossen.
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3.3.7 What’s Next?

Nu hebben we een kaart die er goed uitziet, maar hoe krijgen we die uit QGIS en in een indeling die we kunnen
afdrukken, of waarvan we een afbeelding of PDF kunnen maken? Dat is het onderwerp van de volgende les!
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Module: De kaarten opmaken

In deze module zult u leren hoe u de afdruklay-out van QGIS gebruikt om kwaliteitskaarten te maken met alle vereiste
kaartitems.

4.1 Lesson: Afdruklay-out gebruiken

Nu u een kaart heeft, dient u in staat te zijn die af te drukken of het naar een document te exporteren. De reden
daarvoor is dat een kaartbestand in GIS geen afbeelding is. Het slaat meer de status van het programma van GIS op,
met verwijzingen naar alle lagen, hun labels, kleuren, etc. Dus voor iemand die niet de gegevens heeft of hetzelfde
programma voor GIS (zoals QGIS), zal het kaartbestand nutteloos zijn. Gelukkig kan QGIS zijn kaartbestand
exporteren naar een indeling die ieders computer kan lezen, als ook de kaart afdrukken als umet een printer verbonden
bent. Zowel exporteren als afdrukken wordt afgehandeld via Afdruklay-out.
Het doel voor deze les: De Afdruklay-out van QGIS te gebruiken om een basiskaart te maken met alle vereiste
instellingen.

97



QGIS Training Manual

4.1.1 Follow Along: Lay-out beheren

QGIS stelt u in staat meerdere kaarten te maken met behulp van hetzelfde kaartbestand. Om die reden heeft het een
gereedschap genaamd Lay-out beheren.

1. Klik op het menuitem Project ► Lay-out beheren… om dit gereedschap te openen. U zult een blanco
dialoogvenster voor Lay-out beheren zien verschijnen.

2. Onder Nieuw uit sjabloon, selecteer Lege lay-out en klik op de knop Maken….
3. Geef de nieuwe lay-out de naam Swellendam en klik op OK.
4. U zult nu het venster Afdruklay-out zien:

U zou deze nieuwe lay-out ook kunnen maken via het menu Project ► Nieuwe afrduklay-out….
Welke route u ook nam, de nieuwe afrduklay-out is nu toegankelijk in het menu Project ► Lay-outs ►, zoals in de
afbeelding hieronder.
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4.1.2 Follow Along: Compositie basiskaart

In dit voorbeeld was de lay-out al zoals we die wilden hebben. Zorg er voor dat die van u dat ook is.
1. Klik met rechts op het blad in het centrale deel van het venster voor de lay-out en kies Pagina-eigenschappen…

in het contextmenu.
2. Controleer of de waarden op de tab Item-eigenschappen zijn ingesteld op het volgende:

• Grootte: A4
• Oriëntatie: Liggend

Nu heeft u de lay-out van de pagina zoals u die wilt hebben, maar deze pagina is nog steeds blanco. Er ontbreekt
duidelijk een kaart. Laten we dat repareren!

3. Klik op de knop Kaart toevoegen.
U zult, met dit gereedschap geactiveerd, in staat zijn een kaart op de pagina te plaatsen.

4. Klik en sleep een vak op de blanco pagina:
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De kaart zal verschijnen op de pagina.
5. Verplaats de kaart door er op te klikken en rond te slepen:

6. Pas de grootte aan door op de vakken in de hoeken te klikken en te slepen:
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Notitie: Uw kaart zou er natuurlijk heel anders uit kunnen zien! Dat is afhankelijk van hoe uw eigen project
is opgezet. Maar geen zorgen! Deze instructies zijn algemeen, dus zij werken hetzelfde ongeacht hoe de kaart
zelf eruit ziet.

7. Zorg er voor marges langs de randen te laten en een ruimte aan de bovenzijde voor een titel.
8. Zoom in en uit op de pagina (maar niet de kaart!) met behulp van deze knoppen:

9. Zoom en verschuif de kaart in het hoofdvenster van QGIS. U kunt ook de kaart verschuiven met behulp van
het gereedschap Inhoud item verschuiven.
De kaartweergave wordt bijgewerkt als in- of uitzoomt.

10. Als, om enige reden, de kaartweergave niet juist wordt bijgewerkt, kunt u de kaart geforceerd vernieuwen door
op de knop Scherm vernieuwen te klikken.
Onthoud dat de grootte en positie die u voor de kaart heeft opgegeven niet bindend hoeven te zijn. U kunt altijd
terugkomen en het later wijzigen als u niet tevreden bent. Voor nu dient u zich er van te vergewissen dat u uw
werk aan deze kaart heeft opgeslagen. U zult uw project moeten opslaan, omdat een Afdruklay-out in QGIS
deel uitmaakt van het hoofd-kaartbestand.

11. Ga naar Lay-out ► Project opslaan. Dit is een handige sneltoets voor die in het hoofd-dialoogvenster.
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4.1.3 Follow Along: Een titel toevoegen

Nu ziet uw kaart er op de pagina goed uit, maar uw lezers/gebruikers wordt nog niet verteld wat er gaande is. Zij
hebben een soort context nodig, wat is wat u hen verschaft door middel van het toevoegen van kaartitems. Laten we
eerst een titel toevoegen.

1. Klik op de knop Label toevoegen

2. Klik op de pagina, boven de kaart, accepteer de voorgestelde waarden in het dialoogvenster Nieuw item
Eigenschappen en een label zal boven de kaart verschijnen.

3. Pas de grootte aan en plaats het in het midden boven aan de pagina. Het kan op dezelfde manier worden
aangepast en verplaatst als waarop u de grootte van de kaart aanpaste en die verplaatste.
Als u de titel verplaatst, zult u merken dat er hulplijnen verschijnen om u te helpen de titel in het midden van
de pagina te plaatsen.
Er is echter ook een gereedschap op de werkbalk Acties om u te helpen de titel relatief aan de kaart (niet de
pagina) te plaatsen:

4. Klik op de kaart om het te selecteren
5. Houdt Shift ingedrukt op uw toetsenbord en klik op het label, zodat zowel de kaart als het label zijn

geselecteerd.

6. Zoek naar de knop Geselecteerde items links uitlijnen en klik op de pijl voor het keuzemenu ernaast om de opties
voor plaatsing weer te geven en klik op Midden uitlijnen:

Nu is het frame van het label gecentreerd aan de kaart, maar niet de inhoud ervan. De inhoud van het label
centreren:
1. Selecteer het label door er op te klikken.
2. Klik op de tab Item-eigenschappen in het zijpaneel van het venster Afdruklay-out.
3. Wijzig de tekst van het label naar “Swellendam”:
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4. Gebruik deze interface om het lettertype en de optie voor uitlijning in te stellen in het gedeelte Uiterlijk:
1. Kies een groot, maar zinnig, lettertype (het voorbeeld zal het standaard lettertype met een grootte

van 36 gebruiken)
2. Stel Horizontale uitlijning in op Centreren.

U kunt ook de kleur van het lettertype wijzigen, maar het is waarschijnlijk het beste om die zwart te laten
staan, zoals de standaard is.

5. De standaardinstelling is om geen kader toe te voegen rondom het tekstvak van de titel. Als u echter een
kader wilt toevoegen, kunt u dat zo doen:
1. Scroll, op de tab Item-eigenschappen, naar beneden tot u de optie Frame ziet.
2. Klik op het keuzevak Frame om het kader in te schakelen. U kunt ook de kleur en breedte van het

kader wijzigen.
In dit voorbeeld zullen we het kader niet inschakelen, dus is dit tot dusverre onze pagina:
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Om er voor te zorgen dat u niet per ongeluk deze elementen verplaatst nu ze uitgelijnd zijn, kunt u de items op
hun plaats vastzetten:
1. Selecteer zowel het label als de kaartitems

2. Klik op de knop Geselecteerde items vastzetten op de werkbalk Acties.

Notitie: Klik op de knop Alle items losmaken op de werkbalk Acties om de items opnieuw te kunnen
bewerken.

4.1.4 Follow Along: Een legenda toevoegen

De lezer van de kaart moet ook in staat zijn te zien welke verschillende dingen op de kaart eigenlijk betekenen. In
sommige gevallen, zoals de plaatsnamen, is dit nogal duidelijk. In andere gevallen is het moeilijker te raden, zoals
voor de kleuren van de bossen. Laten we een nieuwe legenda toevoegen.

1. Klik op de knop Legenda toevoegen

2. Klik op de pagina om de legenda neer te zetten, accepteer de voorgestelde waarden in het dialoogvensterNieuw
item Eigenschappen.

3. Een legenda wordt toegevoegd aan de pagina van de lay-out, de symbologie van de lagen weergevend zoals
ingesteld in het hoofddialoogvenster.

4. Zoals gewoonlijk kunt u klikken op het item en dat verplaatsen naar waar u dat wilt:
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4.1.5 Follow Along: Items voor legenda’s aanpassen

Niet alles op een legenda is noodzakelijk, dus laten we enkele niet gewenste items verwijderen.
1. Op de tab Item-eigenschappen vindt u het paneel Items voor Legenda.

2. Deselecteer het vak Automatisch bijwerken, wat u in staat stelt de items voor de legenda direct te bewerken
3. Selecteer het item met buildings.

4. Verwijder het uit de legenda door te klikken op de knop
U kunt ook items hernoemen.

1. Selecteer een laag uit dezelfde lijst.

2. Klik op de knop Geselecteerde item-eigenschappen bewerken.
3. Hernoem de lagen naar``Plaatsen``, Wegen en straten, Oppervlaktewater, en Rivieren.

U kunt ook de volgorde van de items wijzigen.
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De legenda zal waarschijnlijk breder worden door de nieuwe namen voor de lagen, dus u wilt misschien de legenda
en of de kaart verplaatsen. Dit is het resultaat:
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4.1.6 Follow Along: Uw kaart exporteren

Notitie: Heeft u onthouden om uw werk regelmatig op te slaan?

Tenslotte is de kaart gereed om te worden geëxporteerd! U zult de knoppen voor exporteren zien in de
linkerbovenhoek van het venster Afdruklay-out:

• Lay-out afdrukken: is verbonden met een printer. Omdat de opties voor de printer zullen verschillen, afhankelijk
van het model printer waarmee u werkt, is het waarschijnlijk beter om de handleiding van de printer of een
algemene gids over afdrukken te raadplegen voor meer informatie over dit onderwerp.
De andere knoppen stellen u in staat de kaart te exporteren naar een bestand.

• Als afbeelding exporteren: geeft u een selectie van verschillende algemene indelingen voor afbeeldingen om uit te
kiezen. Dit is waarschijnlijk de eenvoudigste optie, maar de afbeelding die het maakt is “dood” en moeilijk te
bewerken.

• Als SVG exporteren: Als u uw kaart stuurt naar een cartograaf (die de kaart misschien vóór publicatie wil
bewerken), is het het beste om als een SVG te exporteren. SVG staat voor “Scalable Vector Graphic” en
kan worden geïmporteerd in programma’s als Inkscape of andere software voor het bewerken van vector-
afbeeldingen.

• Als PDF exporteren: Als u de kaart naar een cliënt moet sturen, is het het meest voorkomend om een PDF te
gebruiken, omdat het eenvoudiger is om afdrukopties voor een PDF in te stellen. Sommige cartografen zouden
ook PDF kunnen prefereren, als zij een programma hebben dat hen in staat stelt deze indeling te importeren
en te bewerken.

Voor onze doeleinden gaan we een PDF gebruiken.

1. Klik op de knop Als PDf exporteren

2. Kies een locatie om op te slaan en een bestandsnaam, zoals gewoonlijk. Het volgende dialoogvenster zal worden
weergegeven.
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3. U kunt nu veilig de standaardwaarden gebruiken en klikken op Opslaan.
QGIS zal doorgaan met het exporteren van de kaart en een bericht sturen naar de bovenzijde van het
dialoogvenster Afdruklay-out zodra het is voltooid.

4. Klik op de hyperlink in het bericht om de map waar de PDF is opgeslagen, in het bestandsbeheer van uw
systeem, te openen

5. Open het en bekijk hoe uw lay-out er uitziet.
Is alles OK? Gefeliciteerd met uw eerste voltooide kaartproject van QGIS!

6. Is er iets niet naar uw zin? Ga terug naar het venster van QGIS, maak de noodzakelijke aanpassingen en
exporteer opnieuw.

7. Onthoud om uw kaart regelmatig op te slaan.
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4.1.7 In Conclusion

Nu hebt u geleerd een lay-out voor een statische basiskaart te maken. We gaan een stap verder en maken een kaartlay-
out die zich dynamisch aanpast, met meer items voor de lay-out.

4.2 Lesson: Een dynamische afdruklay-out maken

Nu u hebt geleerd een lay-out voor een basiskaart te maken, gaan we een stap verder en maken een kaartlay-out die
zich dynamisch aanpast aan ons kaartbereik en aan de eigenschappen van de pagina, bijv. als u de grootte van de
pagina wijzigt. Ook de datum van maken zal zich dynamisch aanpassen.

4.2.1 Follow Along: Het dynamische kaartvenster maken

1. Laad de ESRI Shapefile-indeling gegevenssets protected_areas.shp, places.shp, rivers.shp
en water.shp in het kaartvenster en pas de eigenschappen ervan aan naar uw eigen wensen.

2. Nadat alles volgens uw wensen is gerenderd en gesymboliseerd, klik op het pictogram Nieuwe afdruklay-out in
de werkbalk of kies Project ► Nieuwe afdruklay-out. U zult naar een nieuwe titel worden gevraagd voor de
nieuwe afdruklay-out.

3. We willen een kaartlay-out maken die bestaat uit een kop en een kaart van de regio nabij Swellendam, Zuid-
Afrika. De lay-out zou een marge van 7,5 mm moeten hebben en de kop zou 36 mm hoog moeten zijn.

4. Maak een kaartitem, genaamd hoofdkaart in het kaartvenster en ga naar het paneel Lay-out. Scroll naar
beneden naar het gedeelte Variabelen en zoek het gedeelte Lay-out. Hier stellen we enkele variabelen in die
u overal in de dynamische afdruklay-out kunt gebruiken. Ga naar het paneel Lay-out en scroll naar beneden
naar het gedeelte Variabelen. De eerste variabele zal de marge definiëren. Druk op de knop en typ de
naam sw_layout_margin in. Stel de waarde in op 7.5. Druk opnieuw op de knop en typ de naam
sw_layout_height_header in. Stel de waarde in op 36.

5. Nu bent u klaar om de positie en de grootte van het kaartvenster automatisch te maken door middel van de
variabelen. Zorg er voor dat het kaartitem is geselecteerd, ga naar het paneel Item-eigenschappen en scroll naar
beneden en open het gedeelte Positie en grootte. Klik op Data-bepaalde override voor X en kies, uit het item
Variabelen, @sw_layout_margin.

6. Klik op Data-bepaalde override voor Y, kies Bewerken… en typ de volgende formule in:

to_real(@sw_layout_margin) + to_real(@sw_layout_height_header)

7. U kunt de grootte van het kaartitem maken met de variabelen voor Breedte en Hoogte. Klik op
Data-bepaalde override voor Breedte en kies opnieuw Bewerken…. Vul de volgende formule in:

@layout_pagewidth - @sw_layout_margin * 2

Klik op Data-bepaalde override voor Hoogte en kies Bewerken…. Typ hier in de formule:

@layout_pageheight - @sw_layout_height_header - @sw_layout_margin * 2

8. We zullen ook een rastermaken dat de coördinaten van het bereik van het hoofd-kaartvenster bevat. Ga opnieuw
naar Item-eigenschappen en kies het gedeelte Rasters. Voeg een raster in door te klikken op de knop . Klik
op Raster aanpassen… en stel de Interval voor X, Y en Verspringing in overeenkomstig de schaal voor de kaart
die u koos in het hoofd-kaartvenster van QGIS. Het Type raster Kruis is zeer geschikt voor ons doel.

4.2. Lesson: Een dynamische afdruklay-out maken 109



QGIS Training Manual

4.2.2 Follow Along: De dynamische kop maken

1. Voeg een rechthoek in die de kop zal bevatten met de knop Vorm toevoegen. Voer in het paneel Items de naam
header in.

2. Ga opnieuw naar de Item-eigenschappen en open het gedeelte Positie en grootte. Gebruik Data-bepaalde override,
kies de variabele sw_layout_margin voor X als ook voor Y. Breedte zal worden gedefinieerd door de
expressie:

@layout_pagewidth - @sw_layout_margin * 2

en Hoogte door de variabele sw_layout_height_header.
3. We zullen één horizontale lijn en twee verticale lijnen invoegen om de kop op te delen in verschillende gedeelten

met behulp van het Item Knoop toevoegen. Maak een horizontale lijn en twee verticale lijnen en noem ze
Horizontale lijn, Verticale lijn 1 Verticale lijn 2.
1. Voor de horizontale lijn:

1. Stel X in op de variabele sw_layout_margin
2. Stel de expressie voor Y in op:

@sw_layout_margin + 8

3. Stel de expressie voor Breedte in op:

@layout_pagewidth - @sw_layout_margin * 3 - 53.5

2. Voor de eerste verticale lijn:
1. Stel de expressie voor X in op:

@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Stel Y in op de variabele sw_layout_margin
3. De hoogte moet hetzelfde zijn als de kop die we gemaakt hebben, dus stel Hoogte in op de variabele

sw_layout_height_header.
3. De tweede verticale lijn wordt links van de eerste geplaatst.

1. Stel de expressie voor X in op:

@layout_pagewidth - @sw_layout_margin * 2 - 83.5

2. Stel Y in op de variabele sw_layout_margin
3. De hoogte moet hetzelfde zijn als de andere verticale lijn, dus stel Hoogte in op de variabele

sw_layout_height_header.
De afbeelding hieronder geeft de structuur weer van onze dynamische lay-out. We zullen de gebieden, die door
de lijnen worden gevormd, vullen met enkele elementen.
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4.2.3 Follow Along: Labels maken voor de dynamische kop

1. De titel van uw project van QGIS kan automatisch worden ingevoegd. De titel is ingesteld in de
Projecteigenschappen. Voeg een label in met de knop Label toevoegen en voer de naam project title
(variable) in. In de Algemene eigenschappen van het paneel Item-eigenschappen voer in de expressie:

[%@project_title%]

Stel de positie van het label in.
1. Gebruik voor X de expressie:

@sw_layout_margin + 3

2. Gebruik voor Y de expressie:

@sw_layout_margin + 0.25

3. Gebruik voor Breedte de expressie:

@layout_pagewidth - @sw_layout_margin *2 - 90

4. Voer 11.25 in voor de Hoogte

Stel, onder Uiterlijk, de grootte van het lettertype in op 16 pt.
2. Het tweede label zal een beschrijving bevatten van de kaart die u gemaakt hebt. Voeg opnieuw een label in en

noem die map description. Voer, in de Algemene eigenschappen, de tekst beschrijving kaart
in. In de Algemene eigenschappen zullen we ook opnemen:

printed on: [%format_date(now(),'dd.MM.yyyy')%]

Hier gebruikten we twee functies Datum en Tijd (now en format_date).
Stel de positie van het label in.
1. Gebruik voor X de expressie:
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@sw_layout_margin + 3

2. Gebruik voor Y de expressie:

@sw_layout_margin + 11.5

3. Het derde label zal informatie bevatten over uw organisatie. Eerst zullen we enkele variabelen maken in het
menu Variabelen van de Item-eigenschappen. Ga naar het menu Lay-out, klik elke keer op de knop en voer
de namen o_department, o_name , o_adress en o_postcode in. Voer op de tweede regel informatie
in over uw organisatie. We zullen deze variabelen gebruiken in het gedeelte Algemene eigenschappen.
Voer in Algemene eigenschappen in:

[% @o_name %]
[% @o_department %]
[% @o_adress %]
[% @o_postcode %]

Stel de positie van het label in.
1. Gebruik voor X de expressie:

@layout_pagewidth - @sw_layout_margin - 49.5

2. Gebruik voor Y de expressie:

@sw_layout_margin + 15.5

3. Gebruik voor Breedte 49.00
4. Gebruik voor Hoogte de expressie:

@sw_layout_height_header - 15.5

112 Hoofdstuk 4. Module: De kaarten opmaken



QGIS Training Manual

4.2.4 Follow Along: Afbeeldingen toevoegen aan de dynamische kop

1. Gebruik de knop Afbeelding toevoegen om een afbeelding boven uw label organisatie informatie te
plaatsen. Definieer, na het invoeren van de naam organisatie logo, de positie en grootte van het logo:
1. Gebruik voor X de expressie:

@layout_pagewidth - @sw_layout_margin - 49.5

2. Gebruik voor Y de expressie:

@sw_layout_margin + 3.5

3. Gebruik voor Breedte 39.292
4. Gebruik voor Hoogte 9.583

U moet, om een logo van uw organisatie te hebben, uw logo opslaan in uw thuismap en het pad invoeren onder
Algemene eigenschappen ► Bron afbeelding.

2. Onze lay-out heeft nog steeds een noordpijl nodig. Deze zal ook worden ingevoegd met Noordpijl toevoegen.
We zullen de standaard noordpijl gebruiken. Definieer de positie:
1. Gebruik voor X de expressie:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Gebruik voor Y de expressie:
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@sw_layout_margin + 9

3. Gebruik voor Breedte 21.027
4. Gebruik voor Hoogte 21.157

4.2.5 Follow Along: De schaalbalk maken voor de dynamische kop

1. Klik, om een schaalbalk in de kop in te voegen, op Schaalbalk toevoegen en plaats die in de rechthoek boven
de noordpijl. In Kaart onder de Algemene eigenschappen kies uw hoofdkaart (Kaart 1). Dit betekent
dat de schaal automatisch wijzigt overeenkomstig het bereik dat u kiest in het hoofdvenster van QGIS. Kies
de Stijl Numeriek. Dit betekent dat we een eenvoudige schaal invoegen, zonder een schaalbalk. De schaal heeft
nog steeds een positie en grootte nodig.
1. Gebruik voor X de expressie:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Gebruik voor Y de expressie:

@sw_layout_margin + 1

3. Gebruik voor Breedte 25
4. Gebruik voor Hoogte 8

5. Plaats het Referentiepunt in het midden.
Gefeliciteerd! U hebt uw eerste dynamische kaartlay-out gemaakt. Kijk naar de lay-out en controleer of alles er
uitziet zoals u wilt! De dynamische kaartlay-out reageert automatisch als u de pagina eigenschappen wijzigt. Als u
bijvoorbeeld de grootte van de pagina wijzigt van DIN A4 naar DIN A3, klik dan op de knop Scherm vernieuwen en
het ontwerp van de pagina wordt aangepast.
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4.2.6 What’s Next?

Op de volgende pagina zal u een opdracht worden gegeven om uit te voeren. Die zal u in staat stellen de technieken
die u tot nu heeft geleerd in praktijk te brengen.

4.3 Opdracht 1

Open uw bestaande kaartproject en bekijk dat aandachtig. Als u kleine fouten ziet of dingen die u eerder had willen
repareren, doe dat dan nu.
Stel uzelf, tijdens het aanpassen van uw kaart, steeds vragen. Is deze kaart eenvoudig te lezen en te begrijpen voor
iemand die niet bekend is met de gegevens? Als ik deze kaart op het internet zou zien, of op een poster, of in een
tijdschrift, zou hij dan mijn aandacht trekken? Zou ik deze kaart willen lezen als het niet de mijne was?

Als u deze cursus doet op het Basis of Gemiddelde niveau, lees de technieken van de meer
gevorderde gedeelten door. Als u iets ziet wat u in uw kaart zou willen hebben, waarom dan niet proberen om het te
implementeren?
Als deze cursus aan u wordt gepresenteerd, zou de cursusleider u kunnen vragen een uiteindelijke versie van uw kaart
in te leveren, geëxporteerd naar PDF, voor evaluatie. Als u deze cursus voor uzelf doet, wordt aanbevolen dat u uw
eigen kaart evalueert met behulp van dezelfde criteria. Uw kaart zal worden geëvalueerd op het algehele uiterlijk en
symbologie van de kaart zelf, als ook het uiterlijk en de opmaak van de kaartpagina en items. Onthoud dat de nadruk
voor evaluatie van het uiterlijk van kaarten altijd gemak in gebruik is. Hoe netter de kaart eruit ziet en hoe eenvoudiger
hij in een glimp is te begrijpen, des te beter.
Veel plezier bij het aanpassen!

4.3.1 In Conclusion

De eerste vier modules hebben u geleerd een vectorkaart te maken en op te maken. In de volgende vier modules
zult u leren hoe u QGIS gebruikt voor een volledige analyse in GIS. Dit zal zijn inclusief het maken en bewerken
van vectorgegevens; analyseren van vectorgegevens; gebruiken en analyseren van rastergegevens en het gebruiken van
GIS om een probleem van begin tot eind op te lossen, met behulp van bronnen voor zowel raster- als vectorgegevens.
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Module: Vectorgegevens maken

Het maken van kaarten met behulp van bestaande gegevens is slechts het begin. In deze module zult u leren hoe u
bestaande vectorgegevens kunt aanpassen en geheel nieuwe gegevenssets te maken.

5.1 Lesson: Een nieuwe vector gegevensset maken

De gegevens die u gebruikt moeten ergens vandaan komen. Voor de meeste algemene toepassingen bestaan de
gegevens al; maar hoe meer bijzonder en speciaal het project, hoe minder aannemelijk het is dat de gegevens al
beschikbaar zullen zijn. In dergelijke gevallen zult u uw eigen gegevens moeten maken.
Het doel voor deze les: Een nieuwe vector gegevensset maken.

5.1.1 Follow Along: Het dialoogvenster Laag maken

Vóór u nieuwe vectorgegevens kunt toevoegen dient u een vector gegevensset te hebben om ze aan toe te kunnen
voegen. In ons geval zult u beginnen door geheel nieuwe gegevens te maken, in plaats van het bewerken van een
bestaande gegevensset. Daarom dient u eerst uw eigen nieuwe gegevensset te definiëren.

1. Open QGIS en maak een nieuw, blanco project.
2. Navigeer naar en klik op het menu-item Kaartlagen ► Laag maken ► Nieuwe Shapefile-laag. U krijgt het

dialoogvenster Nieuwe Shapefile-laag gepresenteerd dat u in staat stelt een nieuwe laag te definiëren.
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3. Klik op… voor het veld Bestandsnaam. Een dialoogvenster voor opslaan zal verschijnen.
4. Navigeer naar de map exercise_data.
5. Sla uw nieuwe laag op als school_property.shp.

Het is belangrijk om in dit stadium te beslissen welk soort gegevensset u wilt. Elk verschillend type vectorlaag
wordt “anders gebouwd” op de achtergrond, dus als u de laag eenmaal hebt gemaakt, kunt u het type niet meer
wijzigen.
Voor de volgende oefening zullen we nieuwe objectenmaken die gebieden beschrijven. Voor dergelijke objecten
moet u een polygoon gegevensset maken.

6. Selecteer, voor Type geometrie, Polygoon uit het keuzemenu.
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Dit heeft geen invloed op de rest van het dialoogvenster, maar het zorgt er voor dat het juiste type geometrie
zal worden gebruikt als de vector gegevensset wordt gemaakt.
Het volgende veld stelt u in staat het Coördinaten ReferentieSysteem, of CRS, te specificeren. CRS is een
methode van het associëren van numerieke coördinaten aan een positie op het oppervlak van de Aarde. Bekijk
de gebruikershandleiding over Werken met projecties om eer te weten te komen.
Voor dit voorbeeld zullen we het standaard CRS gebruiken dat is geassocieerd aan dit project, wat WGS84 is.

Vervolgens is er een collectie van velden gegroepeerd onderNieuw veld. Standaard heeft een nieuwe laag slechts
één attribuut, het veld id (wat u zou moeten zien in de Lijst met velden) onderin. Echter, om de gegevens die u
gaat maken bruikbaar te maken, dient u in feite iets te zeggen over de objecten die u gaat maken in deze nieuwe
laag. Voor onze huidige doelen is het voldoende om één veld, genaamd name, toe te voegen dat Text data
zal bevatten en zal worden beperkt tot een tekstlengte van 80 tekens.

7. Repliceer onderstaande instellingen en klik op de knop Aan lijst met velden toevoegen:

8. Controleer of uw dialoogvenster zou er nu ongeveer zo uit ziet:
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9. Klik op OK

De nieuwe laag zou moeten verschijnen in uw paneel Lagen.

5.1.2 Follow Along: Gegevensbronnen

Wanneer u nieuwe gegevens maakt, is het duidelijk dat het moet gaan over objecten die echt op de grond bestaan.
Daarom dient u uw informatie ergens vandaan te halen.
Er bestaan vele verschillende manieren om gegevens over objecten te verkrijgen. U zou bijvoorbeeld een GPS kunnen
gebruiken om punten vast te leggen in de echte wereld en dan later de gegevens in QGIS importeren. Of u zou punten
kunnen meten met behulp van een theodoliet, en de coördinaten handmatig kunnen invoeren om nieuwe objecten te
maken. Of u zou het proces voor digitaliseren kunnen gebruiken om objecten te traceren vanaf gegevens die vanaf
afstand zijn opgenomen, zoals satellietbeelden of luchtfotografie.

120 Hoofdstuk 5. Module: Vectorgegevens maken



QGIS Training Manual

Voor ons voorbeeld zult u de benadering voor digitaliseren gebruiken. Voorbeelden van raster gegevenssets worden
meegeleverd, dus u dient ze te importeren als dat nodig is.

1. Klik op de knop Databronnen beheren openen.

2. Selecteer Raster aan de linkerkant.
3. Klik, in het paneel Bron, op de knop…:
4. Navigeer naar exercise_data/raster/.
5. Selecteer het bestand 3420C_2010_327_RGB_LATLNG.tif.
6. Klik op Openen om het dialoogvenster te sluiten.

7. Klik op Toevegen en Close. Een afbeelding zal in uw kaart worden geladen.
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8. Als u geen luchtfoto ziet verschijnen, selecteer de nieuwe laag, klik met rechts en kies Op kaartlaag inzoomen
in het contextmenu.
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9. Klik op de knop Inzoomen en zoom naar het hieronder in blauw geaccentueerde gebied:
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Nu bent u klaar om deze drie velden te gaan digitaliseren:
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Laten we, voordat we beginnen, de laag school_property verplaatsen tot boven de luchtfoto.
1. Selecteer de laag school_property in het paneel Lagen en sleep hem naar boven.

U moet naar de modus Bewerken gaan om te kunnen beginnen met digitaliseren. GIS-software vereist dit in het
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algemeen om te voorkomen dat u per ongeluk belangrijke gegevens bewerkt of verwijdert. De modus Bewerken
wordt individueel in- of uitgeschakeld voor elke laag.
Modus Bewerken inschakelen voor de laag school_property:

1. Klik op de laag school_property in het paneel Lagen om hem te selecteren.

2. Klik op de knop Bewerken aan/uitzetten.
Als u deze knop niet kunt vinden, controleer dan of de werkbalk Digitaliseren is ingeschakeld. Er zou een
vinkje moeten staan naast het menu-item Beeld ►Werkbalken ► Digitaliseren.
Zodra u in de modus Bewerken bent, zult u zien dat enkele gereedschappen voor digitaliseren actief zijn
geworden:

• Object polygoon toevoegen

• Gereedschap Punten

Andere relevante knoppen zijn nog steeds inactief, maar zullen actief worden wanneer we beginnen met
interacties op onze nieuwe gegevens.
Merk op dat de laag school_property in het paneel Lagen nu het pictogram Potlood heeft, wat aangeeft
dat hij in modus Bewerken staat.

3. Klik nu op de knop Object polygoon toevoegen om te beginnenmet het digitaliseren van de velden van onze school.
Het zal u opgevallen zijn dat uw muiscursor een kruisdraad is geworden. Dit stelt u in staat om de punten die
u zult digitaliseren nauwkeuriger te plaatsen. Onthoud dat u, zelfs wanneer u het gereedschap Digitaliseren op
uw kaart gebruikt, kunt in- en uitzoomen door te draaien met het muiswiel, en u kunt verschuiven door het
muiswiel ingedrukt te houden en over de kaart te slepen.
Het eerste object dat u zult digitaliseren is het athletics field:

4. Start het digitaliseren door te klikken op een punt ergens langs de rand van het veld.
5. Plaats meer punten door te klikken verder langs de rand, totdat de vorm die u tekent het veld volledig bedekt.
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6. Klik met rechts na het plaatsen van uw laatste punt om het tekenen van de polygoon te voltooien. Dit zal het
object voltooien en u het dialoogvenster Attributen laten zien.

7. Vul de waarden in zoals hieronder:
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8. Klik op OK en u heeft een nieuw object gemaakt!

9. Selecteer, in het paneel Lagen, de laag school_property.
10. Klik met rechts en kies Attributentabel openen in het contextmenu
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In de tabel zult u het object zien dat u zojuist hebt toegevoegd. Terwijl u in modus Bewerken bent, kunt de
gegevens van de attributen bijwerken door te dubbelklikken op de cel die u wilt bijwerken.
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11. Sluit de attributentabel.

12. Klik op de knop Wijzigingen laag opslaan om het nieuwe object, dat we net gemaakt hebben, op te slaan.
Onthoud dat als u een vergissing maakte tijdens het digitaliseren van een object, kunt u dat altijd nog bewerken als
u het maken ervan voltooid heeft. Als u een fout maakte, ga dan door met digitaliseren totdat u klaar bent met het
maken van het object hierboven. Dan:

1. Klik op de knop Gereedschap Punten.
2. Ga met de muis over een punt dat u wilt verplaatsen en klik met links op het punt.
3. Verplaats de muis naar de juiste locatie voor het punt, en klik met links. Dit zal het punt naar de nieuwe locatie

verplaatsen.
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Dezelfde procedure kan worden gebruikt om een lijnsegment te verplaatsen, maar dan dient u over het
middelpunt van het llijnsegment te gaan.

Als u een wijziging ongedaan wilt maken, kunt u drukken op de knop Ongedaan maken of op Ctrl+Z.

4. Onthoud om uw wijzigingen op te slaan door te klikken op de knop Wijzigingen laag opslaan.

5. Klik, als u klaar bent met bewerken, op de knop Bewerken aan/uitzetten, om uit de modus Bewerken te gaan.
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5.1.3 Try Yourself Polygonen digitaliseren

Digitaliseer de school zelf en het bovenste veld. Gebruik deze afbeelding om u te helpen:

Onthoud dat elk nieuw object een unieke waarde id moet hebben!

Notitie: Wanneer u klaar bent met het toevoegen van objecten aan een laag, onthoud dan om de bewerkingen op te
slaan en de modus Bewerken te verlaten.

Notitie: U kunt de vulling, de omtrek en plaatsen van labels van school_property opmaken met behulp van
de technieken die werden geleerd in eerdere lessen.
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5.1.4 Follow Along: Tabel Punten bewerken gebruiken

Een ander manier om de objecten te bewerken is door het handmatig invoeren van de feitelijke coördinaatwaarden
voor elk punt, met de tabel Punten bewerker.

1. Zorg er voor dat u in modus Bewerken bent voor de laag school_property.

2. Klik, indien die nog niet geactiveerd is, op de knop Gereedschap Punten.
3. Ga met de muis over een van de objecten polygoon die u op de laag school_property hebt gemaakt en

klik er met rechts op. Dit zal het object selecteren en een venster Punten bewerker zal openen.

Notitie: Deze tabel bevat de coördinaten voor de punten van het object. Merk op dat er zeven punten voor dit
object zijn, maar er zijn er slechts zes visueel geïdentificeerd in het kaartgebied. Bij nadere beschouwing zult
u merken dat rij 0 en 6 identieke coördinaten hebben. Dat zijn de begin- en eindpunten van de geometrie van
het object, en zijn vereist om een gesloten object polygoon te maken.

4. Klik en sleep een vak over een punt, of meerdere punten, van het geselecteerde object.
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De geselecteerde punten zullen wijzigen naar de kleur blauw en de tabel Punten bewerker zal de
corresponderende rijen geaccentueerd hebben, die de coördinaten van de punten bevatten.

5.1. Lesson: Een nieuwe vector gegevensset maken 135



QGIS Training Manual

5. Dubbelklik met links, om een coördinaat bij te werken, op de cel in de tabel die u wilt bewerken en voer de
bijgewerkte waarde in. In dit voorbeeld is de X-coördinaat van rij 4 bijgewerkt van 20.4450 naar 20.4444.
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6. Druk, na het invoeren van de bijgewerkte waarde, op de toets Enter om de wijziging door te voeren. U zult het
punt in het kaartvenster zien verplaatsen naar de nieuwe locatie.

7. Klik, als u klaar bent met bewerken, op de knop Bewerken aan/uitzetten, om uit de modus Bewerken te gaan, en
sla uw gegevens op.

5.1.5 Try Yourself Lijnen digitaliseren

We gaan twee routes digitaliseren die nog niet zijn gemarkeerd op de laag roads; één is een pad de ander is een spoor.
Ons pad loopt langs de zuidelijke rand van de wijk Railton, beginnend en eindigend op gemarkeerde wegen:
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Ons spoor is iets meer naar het zuiden:
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1. Als de laag roads nog niet op uw kaart staat, voeg dan de laag roads toe vanuit het bestand voor GeoPackage
training-data.gpkg, opgenomen in de map exercise_data van de trainingsgegevens die u hebt
gedownload. U kunt Follow Along: Vectorgegevens uit een database van GeoPackage laden bekijken om te zien
hoe.

2. Maak een nieuwe ESRI Shapefile lijn gegevensset, genaamd routes.shp in de map exercise_data,
met de attributen id en type. (gebruik de benadering hierboven om u te leiden.)

3. Activeer modus Bewerken voor de laag routes.

4. Klik, omdat u werkt met een object lijn, op de knop Object lijn toevoegen om de modus voor het digitaliseren
van lijnen te initiëren.

5. Digitaliseer, één per keer, het pad en het spoor op de laag routes. Probeer de routes zo nauwkeurig mogelijk
te volgen door het toevoegen van punten langs bochten of koerswijzigingen.

6. Stel de attribuutwaarde type in op path of track.
7. Gebruik het dialoogvenster Laageigenschappen om opmaak aan uw routes toe te voegen. Het staat u vrij

verschillende stijlen voor paden en sporen te gebruiken.
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8. Sla uw bewerkingen op en schakel de modus Bewerken uit door te drukken op de knop Bewerken aan/uitzetten.
Controleer uw resultaten

5.1.6 In Conclusion

Nu weet u hoe u objecten kunt maken! Deze cursus behandelt niet het toevoegen van punt-objecten, omdat dat niet
echt nodig is als u eenmaal met meer gecompliceerde objecten heeft gewerkt (lijnen en polygonen). Het werkt exact
hetzelfde, behalve dat u slechts één keer klikt waar u het punt wilt plaatsen, geef het zoals gewoonlijk zijn attributen
en dan is het object gemaakt.
Weten hoe digitaliseren werkt is belangrijk omdat het een veel voorkomende activiteit in programma’s van GIS is.

5.1.7 What’s Next?

Objecten in een laag van GIS zijn niet slechts afbeeldingen, maar objecten in de ruimte. Bijvoorbeeld: aaneensluitende
polygonen weten waar zij in relatie tot elkaar staan. Dit wordt topologie genoemd. In de volgende les zult u een
voorbeeld zien van waarom dit handig kan zijn.

5.2 Lesson: Topologie voor objecten

Topologie is een handig aspect van vector gegevenslagen, omdat het fouten zoals overlappen of gaten minimaliseert.
Bijvoorbeeld: als twee objecten een rand delen en u bewerkt de rand met behulp van topologie, dan hoeft u niet
eerst het ene object te bewerken, dan een ander en dan zorgvuldig de randen op elkaar af te stemmen zodat zij
overeenkomen. In plaats daarvan kunt u hun gedeelde rand bewerken en beide objecten zullen tegelijkertijd wijzigen.
Het doel voor deze les: Topologie begrijpen door middel van voorbeelden.

5.2.1 Follow Along: Snappen

Snappenmaakt het bewerken van topologie gemakkelijker. Dit maakt het mogelijk uwmuiscursor aan andere objecten
te snappen, terwijl u digitaliseert. Opties voor snappen instellen:

1. Navigeer naar het menu-item Project ► Opties voor snappen….
2. Stel uw dialoogvenster Instellingen voor snappen in project in op het activeren van de laag landusemet Type

vertex en tolerantie 12 pixels:

3. Zorg er voor dat het vak in de kolom Voorkom overlappen is geselecteerd.
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4. Verlaat het dialoogvenster.

5. Selecteer de laag landuse en ga naar de modus Bewerken ( )
6. Controleer (onder Beeld ►Werkbalken) dat uw werkbalk Geavanceerd digitaliseren is ingeschakeld.
7. Zoom naar dit gebied (schakel indien nodig lagen en labels in):

8. Digitaliseer dit nieuwe (fictionele) gebied:
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9. Indien gevraagd, geef het een OGC_FID van 999, maar het staat u vrij de andere waarden ongewijzigd te laten.
Als u voorzichtig bent tijdens het digitaliseren en de cursor toestaat te snappen aan de punten van aanliggende
gebieden, zult u merken dat er geen gaten zijn tussen uw nieuwe gebieden de bestaande gebieden ernaast.

10. Denk aan de gereedschappen Ongedaan maken en Opnieuw op de werkbalk Geavanceerd digitaliseren.

5.2.2 Follow Along: Juiste topologische objecten

Objecten van topologie moeten soms bijgewerkt worden. In ons voorbeeldgebied is een gebied bos geworden, dus
moet de laag landuse worden bijgewerkt. We zullen daarom enkele objecten bos uitbreiden en samenvoegen in dit
gebied:
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In plaats van het maken van nieuwe polygonen om de bosgebieden samen te voegen, gaan we het gereedschap Punten
gebruiken om bestaande polygonen te bewerken en samen te voegen.

1. Ga naar de modus Bewerken (als die niet al actief is)

2. Selecteer het gereedschap Gereedschap Punten

3. Kies een bosgebied, selecteer een punt en verplaats die naar een naastgelegen punt, zodat de twee objecten bos
elkaar raken:
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4. Klik en sleep de knopen totdat zij op hun plaats snappen.
De juiste topologische rand ziet er uit zoals dit:
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Ga door en voeg nog enkele gebieden samen met het gereedschap Punten.

U kunt ook het gereedschap Object polygoon toevoegen gebruiken om het gat te vullen tussen de twee polygonen
bos. Als u Overlappen vermijden hebt ingeschakeld, hoeft u niet elk enkele punt toe te voegen - zij zullen
automatisch worden toegevoegd als uw nieuwe polygoon de bestaande overlapt.
Als u onze voorbeeldgegevens gebruikt, zou u een bosgebied moeten hebben dat er ongeveer zo uitziet:

Maak u geen zorgen als u meer, minder of andere bosgebieden heeft samengevoegd.

5.2.3 Follow Along: Gereedschap: Object vereenvoudigen

Doorgaand op dezelfde laag zullen we het gereedschap Object vereenvoudigen testen:
1. Klik er op om het te activeren.
2. Klik op één van de gebieden die u heeft samengevoegd met ofwel het gereedschap Punten of het gereedschap

Object toevoegen. U zult dit dialoogvenster zien:
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3. Pas de Tolerantie aan en zie wat er gebeurt:

Dit stelt u in staat het aantal punten te reduceren.
4. Klik op OK
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Het voordeel van dit gereedschap is dat het u een eenvoudige en intuïtieve interface verschaft voor veralgemeniseren.
Maar weet dat het gereedschap topologie beschadigt. De vereenvoudigde polygoon deelt niet langer grenzen met zijn
aanliggende polygonen, zoals zou moeten. Dus is dit gereedschap beter geschikt voor zelfstandige objecten.
Vóórdat u doorgaat, zet de polygoon terug naar zijn originele status door de laatste wijziging ongedaan te maken.

5.2.4 Try Yourself Gereedschap: Ring toevoegen

Het gereedschap Ring toevoegen stelt u in staat een interne ring aan een object polygoon toe te voegen (een gat in de
polygoon te zagen), zolang als het gat volledig is opgenomen binnen de polygoon (raken van de grens is OK). Als u
bijvoorbeeld de buitengrenzen van Zuid-Afrika heeft gedigitaliseerd en u moet een gat toevoegen voor Lesotho, zou
u dit gereedschap gebruiken.
Als u experimenteert met het gereedschap, zou u kunnen merken dat de huidige opties voor snappen zouden kunnen
voorkomen dat u een ring in de polygoon kunt maken. U wordt dus geadviseerd om snappen uit te schakelen voordat
u een gat maakt.

1. Schakel snappen voor de laag landuse uit met de knop Snappen inschakelen (of gebruik de sneltoets s).

2. Gebruik het gereedschap Ring toevoegen om een gat in het midden van een geometrie polygoon te maken.

3. Teken een polygoon over het doelobject, alsof u het gereedschap Polygoon toevoegen gebruikt.
4. Wanneer u met rechts klikt, zal het gat zichtbaar worden.

5. Verwijder het gat dat u net hebt gemaakt met het gereedschap Ring verwijderen.

Notitie: Klik in het gat om het te verwijderen.

Controleer uw resultaten

5.2.5 Try Yourself Gereedschap: Deel toevoegen

Het gereedschap Deel toevoegen stelt u in staat een nieuw gedeelte voor een object te maken, dat niet direct is
verbonden met het hoofdobject. Als bijvoorbeeld de grenzen van het vasteland van Zuid-Afrika heeft gedigitaliseerd,
maar u heeft de Prince Edward Islands nog niet toegevoegd, zou u dit gereedschap gebruiken om ze te maken.

1. Selecteer de polygoon waaraan u het deel wilt toevoegen door het gereedschap
Objecten selecteren per gebied of met een enkele klik te gebruiken.

2. Gebruik het gereedschap Deel toevoegen om een gebied dat er buiten ligt toe te voegen.

3. Verwijder het deel dat u net hebt gemaakt met het gereedschap Deel verwijderen.

Notitie: Klik in het deel om het te verwijderen.

Controleer uw resultaten
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5.2.6 Follow Along: Gereedschap: Objecten vervormen

Het gereedschap Objecten vervormen wordt gebruikt om een object polygoon groter te maken of een deel ervan weg
te snijden (langs de grens).
Vergropten:

1. Selecteer de polygoon door het gereedschap Objecten selecteren per gebied of met een enkele klik te gebruiken.
2. Klik met links binnen de polygoon om te beginnen met het tekenen.
3. Teken een vorm tot buiten de polygoon. Het laatste punt zou weer binnen de polygoon moeten liggen.
4. Klik met rechts om de vorm te voltooien:

Dit zal een soortgelijk resultaat geven als:
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Een deel wegsnijden:

1. Selecteer de polygoon door het gereedschap Objecten selecteren per gebied of met een enkele klik te gebruiken.
2. Klik buiten de polygoon.
3. Teken een vorm binnen de polygoon. Het laatste punt zou weer buiten de polygoon moeten liggen.
4. Klik met rechts buiten de polygoon:
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Het resultaat van bovenstaande:

5.2.7 Try Yourself Gereedschap: Objecten splitsen

Het gereedschap Objecten splitsen is soortgelijk aan het gereedschap Objecten vervormen, behalve dat het geen van de
twee gedeelten verwijdert. In plaats daarvan behoudt het ze allebei.
We zullen het gereedschap gebruiken om een hoek van een polygoon af te splitsen.

1. Selecteer de laag landuse en schakel snappen er opnieuw voor in.

2. Selecteer het gereedschap Objecten splitsen en klik op een punt om te beginnen met het tekenen van een lijn.
3. Teken de grenslijn.
4. Klik op een punt aan de “tegenoverliggende” zijde van de polygoon die u wilt afsplitsen en klik met rechts om

de lijn te voltooien:
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5. Op dit punt zou het lijken alsof er niet is gebeurd. Maar onthoud dat de laag landuse is gerenderd zonder
grenslijnen, dus de nieuwe lijn voor het delen zal niet worden weergegeven.

6. Gebruik het gereedschap Objecten selecteren per gebied of met een enkele klik om het deel te selecteren dat u zojuist
afgesplitst hebt, het nieuwe object zal nu worden geaccentueerd.
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5.2.8 Try Yourself Gereedschap: Objecten samenvoegen

Nu zullen we het object, dat u zojuist heeft afgesplitst, opnieuw samenvoegen met het resterende deel van de polygoon:

1. Experimenteer met de gereedschappen Geselecteerde objecten samenvoegen en
Attributen van geselecteerde objecten samenvoegen.

2. Let op de verschillen.
Controleer uw resultaten

5.2.9 In Conclusion

Het bewerken van topologie is een krachtig gereedschap dat u in staat stelt objecten snel en gemakkelijk te maken en
aan te passen, er intussen voor zorgend dat zij topologisch juist blijven.

5.2.10 What’s Next?

Nu weet u hoe u gemakkelijk de vorm van objecten kunt digitaliseren, maar het toevoegen van attributen is nog
steeds een ander verhaal! Hierna zullen we u tonen hoe u formulieren kunt gebruiken, wat het bewerken van attributen
eenvoudiger en meer effectief maakt.

5.3 Lesson: Formulieren

Wanneer u nieuwe gegevens toevoegt via digitaliseren, zult u geconfronteerd worden met een dialoogvenster dat u de
attributen voor dat object laat invullen. Dit dialoogvenster is echter, als standaard, niet erg netjes om naar te kijken.
Dat kan gebruiksproblemen veroorzaken, in het bijzonder als u zeer grote gegevenssets heeft om te maken, of als u
wilt dat andere mensen u helpen digitaliseren en zij de standaard formulieren verwarrend vinden.
Gelukkig laat QGIS u uw eigen aangepaste dialoogvensters voor een laag maken. Deze les laat u zien hoe.
Het doel voor deze les: Een formulier voor een laag maken.

5.3.1 Follow Along: QGIS’ functionaliteit formulierontwerp gebruiken

1. Selecteer de laag roads in het paneel Lagen
2. Ga, zoals eerder, naar modus Bewerken

3. Open de attributentabel van de laag roads
4. Klik met rechts op een willekeurige cel in de tabel. Een kort menu zal verschijnen dat het item Formulier openen

bevat.
5. Klik er op om het formulier te zien dat QGIS maakt voor deze laag

Uiteraard zou het leuker zijn om dit te kunnen doen als we naar de kaart kijken, in plaats van altijd naar een specifieke
straat te moeten zoeken in de Attributentabel.

1. Selecteer de laag roads in het paneel Lagen

2. Klik, met het gereedschap Objecten identificeren, op een straat in de kaart.
3. Het paneel Identificatieresultaten opent en geeft een boomweergave van de waarden van de velden en andere

algemene informatie over het aangeklikte object weer.
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4. Selecteer, aan de bovenzijde van het paneel, het keuzevak Automatisch formulier openen voor resultaten van
enkele objecten in het menu sup:Instellingen objecten identificeren.

5. Klik nu opnieuw op een straat in de kaart. Naast het eerdere dialoogvenster Identificatieresultaten, zult u het nu
bekende formulier zien:

6. Elke keer als u op een enkel object klikt met het gereedschap Objecten identificeren, komt het formulier naar
voren zolang het keuzevak Auto openen formulier is geselecteerd.

5.3.2 Try Yourself Het formulier gebruiken om waarden te bewerken

Als u in de modus Bewerken bent kunt u dit formulier gebruiken om de waarden van de attributen van het object te
bewerken.

1. Activeer de modus Bewerken (als die al niet actief is).

2. Klik, met het gereedschap Objecten identificeren, op de hoofdweg die door Swellendam loopt:
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3. Bewerk zijn waarde highway naar secondary.
4. Schakel de modus Bewerken uit en sla uw wijzigingen op
5. Open de Attributentabel en merk op dat de waarde is bijgewerkt in de attributentabel en daarom ook in de

brongegevens

5.3.3 Follow Along: Typen velden voor formulieren instellen

Het is aardig om dingen met behulp van een formulier te bewerken, maar u moet nog steeds alles met de hand
invoeren. Gelukkig hebben formulieren verschillende soorten zogenoemde widgets die u in staat stellen gegevens op
diverse verschillende manieren te bewerken.

1. Open de Eigenschappen… van de laag roads

2. Schakel naar de tab Velden. U zult dit zien:
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3. Schakel naar de tab Formulier attributen. U zult dit zien:

4. Klik op de rij oneway en kies Keuzevak als Type Widget in de lijst met opties:
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5. Klik op OK

6. Ga naar de modus Bewerken (als de laag roads al niet in de modus Bewerken staat)

7. Klik op het gereedschap Objecten identificeren

8. Klik op dezelfde hoofdweg die u eerder al koos
U zult nu zien dat het attribuut oneway een keuzevak ernaast heeft staan met de opties True (geselecteerd) of False
(niet geselecteerd).

5.3.4 Try Yourself

Stel een meer toepasselijk formulierwidget in voor het veld highway.
Controleer uw resultaten
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5.3.5 Try Yourself Testgegevens maken

U kunt ook uw eigen aangepaste formulier volledig vanaf de grond opbouwen.
1. Maak een enkele puntlaag genaamd test-data met twee attributen:

• naam (tekst)
• leeftijd (integer)

2. Leg enkele punten vast op uw nieuwe laag met behulp van de gereedschappen voor digitaliseren, zodat u
enige gegevens heeft om mee te werken. U zou, elke keer dat u een nieuw punt vastlegt, moeten worden
geconfronteerd met het standaardformulier voor QGIS voor gegenereerde attributen.

Notitie: U moet misschien Snappen uitschakelen als dat nog steeds is ingeschakeld vanuit eerdere taken.
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5.3.6 Follow Along: Een nieuw formulier maken

Nu willen we ons eigen aangepaste formulier maken voor de fase van het vastleggen van de attribuut-gegevens. U
moet QT Designer hebben geïnstalleerd om dit te kunnen doen (alleen nodig voor degene die de formulieren maakt).

1. Start QT Designer.
2. Maak, in het dialoogvenster dat verschijnt, een nieuw dialoogvenster:

3. Zoek naar de Widget Box langs de linkerzijde van uw scherm (standaard). Het bevat een item genaamd Line
Edit.

4. Klik en sleep dit item op uw formulier. Dit maakt een nieuw Line Edit in het formulier.
5. Met het nieuwe element Line Edit geselecteerd, zult u zijn properties zien langs de rand van uw scherm

(standaard aan de rechterzijde):
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6. Stel zijn naam in op naam.
7. Maak, met behulp van dezelfde benadering, een nieuw Spin Box en stel zijn naam in op leeftijd.
8. Voeg een Label toe met de tekst Nieuwe persoon toevoegen in een vet lettertype (kijk in de properties

van het object om te zien hoe deze in te stellen). Als alternatief wilt u misschien de titel van het dialoogvenster
zelf instellen (in plaats van het toevoegen van een label).

9. Voeg een Label toe voor uw tekstveld en uw draaiveld.
10. Schik de elementen naar uw eigen wensen.
11. Klik op een willekeurige plek in uw dialoogvenster.
12. Zoek naar de knop Lay Out in a Form Layout (standaard in een werkbalk langs de bovenzijde van het scherm).

Dit maakt automatisch uw dialoogvenster op.
13. Stel de maximumgrootte van het dialoogvenster (in zijn eigenschappen) in op 200 (breedte) bij 150 (hoogte).
14. Uw formulier zou er nu ongeveer zo uit moeten zien:
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15. Sla uw nieuwe formulier op als exercise_data/forms/add_people.ui
16. Als het opslaan is voltooid kunt u Qt Designer sluiten

5.3.7 Follow Along: Het formulier associëren met uw laag

1. Ga terug naar QGIS
2. Dubbelklik op de laag test-data in de legenda om toegang te krijgen tot de eigenschappen ervan.
3. Klik op de tab Formulier attributen in het dialoogvenster Laageigenschappen
4. In de keuzelijst Attribuut editor layout, selecteer Geef een UI-bestand op.
5. Klik op de knop ellipsis en kies het bestand add_people.ui dat u zojuist heeft gemaakt:

6. Klik op OK in het dialoogvenster Laageigenschappen
7. Ga naar de modus Bewerken en leg een nieuw punt vast
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8. Wanneer u dat doet zult u worden geconfronteerd met uw aangepaste dialoogvenster (in plaats van het algemene
dat QGIS gewoonlijk maakt).

9. Als u klikt op een van uw punten met het gereedschap Objecten identificeren, kunt u nu het formulier oproepen
door met rechts te klikken in het venster Identificatieresultaten en te kiezen Object-formulier bekijken uit het
contextmenu.

10. Als u in de modus Bewerken staat voor deze laag, zal dat contextmenu Formulier Object bewerken in plaats
daarvan weergeven, en u kunt dan de attributen aanpassen in het nieuwe formulier zelfs na het initiële
vastleggen.

5.3.8 In Conclusion

Met behulp van formulieren kunt u het leven voor uzelf eenvoudiger maken bij het bewerken of maken van gegevens.
Door typen widgets te bewerken of een geheel nieuw formulier uit het niets te maken, kunt u de ervaring beheren
van iemand die nieuwe gegevens voor die laag digitaliseert, daarbij het minimaliseren van misverstanden en onnodige
fouten.

5.3.9 Further Reading

Als u het gevorderde gedeelte hierboven heeft voltooid en kennis hebt van Python, wilt u misschien dit blog-item
bekijken over het maken van eigen aangepaste objectformulieren met Python-logica, wat geavanceerde functies
mogelijk maakt inclusief validatie van gegevens, automatisch aanvullen, etc.

5.3.10 What’s Next?

Openen van een formulier bij het identificeren van een object is één van de standaard acties die QGIS kan uitvoeren.
U kunt het echter ook opdragen aangepaste acties, die u definieert, direct uit te voeren. Dat is het onderwerp van de
volgende les.

5.4 Lesson: Acties

Nu u de standaard actie hebt gezien in de vorige les, is het tijd om uw eigen acties te definiëren.
Een actie is iets dat gebeurt wanneer u op een object klikt. Het kan zeer veel extra functionaliteit aan uw kaart
toevoegen, wat u, bijvoorbeeld, in staat stelt aanvullende informatie op te halen over een object. Toewijzen van acties
kan een geheel nieuwe dimensie aan uw kaart toevoegen!
Het doel voor deze les: Leren hoe aangepaste acties toegevoegd worden.
In deze les zult u de laag school_property gebruiken, die u eerder maakte. De voorbeeldgegevens bevatten foto’s van
elk van de drie eigendommen die u digitaliseerde. Wat we zullen gaan doen is elk eigendom associëren met zijn
afbeelding. Dan zullen we een actie maken die de afbeelding van het eigendom zal openen bij het klikken op het
eigendom.
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5.4.1 Follow Along: Een veld voor afbeeldingen toevoegen

De laag school_property heeft nog geen manier om een afbeelding met een eigendom te associëren. Voor dit
doel zullen we eerst een veld maken.

1. Open het dialoogvenster Laageigenschappen.
2. Klik op de tab Velden.
3. Schakel naar modus Bewerken:

4. Voeg een nieuwe kolom toe:

5. Voer de waarden in zoals hieronder:
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6. Ga, als het veld is gemaakt, naar de tab Formulier attributen en selecteer het veld afbeelding.
7. Stel Type widget in op Bijlage:

8. Klik op OK in het dialoogvenster Laageigenschappen.
9. Gebruik het gereedschap Objecten identificeren om op één van de drie objecten te klikken in de laag

school_property.
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Omdat u nog steeds in de modus Bewerken staat, zou het dialoogvenster actief moeten zijn en er uitzien zoals
dit:

10. Klik op de knop Bladeren (de… naast het veld afbeelding).
11. Selecteer het pad naar uw afbeelding. De afbeeldingen staan in exercise_data/

school_property_photos/ en zij hebben dezelfde naam als de objecten waarmee zij geassocieerd
zouden moeten worden.

12. Klik op OK.
13. Associeer alle afbeeldingen met de juiste objecten met behulp van deze methode.
14. Sla uw bewerkingen op en verlaat de modus Bewerken.

5.4.2 Follow Along: Een actie maken

1. Open de tab Acties voor de laag school_property, en klik op de knop Een nieuwe actie toevoegen.
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2. Voer, in het dialoogvenster Nieuwe actie toevoegen, de woorden Afbeelding weergeven in het veld
Omschrijving in:
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Wat vervolgens moet worden gedaan is afhankelijk van uw besturingssysteem, dus kies de toepasselijke koers
om te volgen:

• Windows
Klik op de keuzelijst Type en kies Open.

• Ubuntu Linux
Onder Actie, schrijf eog voor de Gnome Image Viewer, of schrijf display om ImageMagick te
gebruiken. Onthoud om een spatie achter de opdracht te plaatsen!

• macOS
1. Klik op de keuzelijst Type en kies Mac.
2. Onder Actie, schrijf open. Vergeet niet een spatie achter de opdracht te plaatsen!

Nu kunt u doorgaan met het schrijven van de opdracht.
U wilt de afbeelding openen en QGIS weet waar de afbeelding staat. Alles wat het moet doen is is de Actie
vertellen waar de afbeelding staat.

3. Selecteer afbeelding uit de lijst:
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4. Klik op de knop Toevoegen. QGIS zal de frase [% "image" %] toevoegen aan het veld Tekst voor actie.
5. Klik op OK om het dialoogvenster Nieuwe actie toevoegen te sluiten
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6. Klik op OK om het dialoogvenster Laageigenschappen te sluiten
Nu is het tijd om de nieuwe actie testen:

1. Klik op de laag school_property in het paneel Lagen zodat die wordt geaccentueerd.

2. Zoek de knop Object-actie uitvoeren (op de werkbalk Attributen);
3. Klik op de pijl naar beneden aan de rechterkant van deze knop. Er is tot nu slechts één actie gedefinieerd voor

deze laag, die u zojuist gemaakt heeft.

4. Klik op de knop zelf om dit gereedschap te activeren.
5. Klik, met behulp van dit gereedschap, op één van de de drie schooleigendommen.

De afbeelding voor dat eigendom zou moeten openen.

5.4.3 Follow Along: Zoeken op het internet

Laten we aannemen dat we naar de kaart kijken en meer willen weten over een gebied waar een boerderij in ligt.
Veronderstel dat u niets weet van het betreffende gebied en dat u algemene informatie erover wilt weten. Uw eerste
impuls, overwegende dat u op dit moment een computer gebruikt, zou waarschijnlijk zijn de naam van het gebied te
googelen. Laten we dus QGIS vertellen om dat automatisch voor ons te doen!

1. Open de attributentabel voor de laag landuse.
We zullen het veld name gebruiken voor elk van onze gebieden voor grondgebruik om met Google te zoeken.

2. Sluit de attributentabel.
3. Ga terug naar Acties in Laageigenschappen.
4. Klik op de knop Standaard acties maken om enkele vooraf gedefinieerde acties toe te voegen.
5. Verwijder alle acties, behalve de actie URL openen met de verkorte naam Zoeken op het web met behulp van

attribuutwaarde, met de knop De geselecteerde actie verwijderen eronder.
6. Dubbelklik op de resterende actie om die te bewerken
7. Wijzig de Omschrijving naar Google zoeken, en verwijder de inhoud van het veld Verkorte naam.
8. Zorg er voor dat Kaartvenster bij de geselecteerde Bereiken actie staat.

Wat vervolgens moet worden gedaan is afhankelijk van uw besturingssysteem, dus kies de toepasselijke koers
om te volgen:

• Windows
Kies, onder Type, Open. Dit zal Windows vertellen om een internetadres te openen in uw standaard
browser, zoals Internet Explorer.

• Ubuntu Linux
OnderActie, schrijf xdg-open. Dit zal Ubuntu vertellen om een Internetadres te openen in uw standaard
browser, zoals Chrome of Firefox.

• macOS
Onder Actie, schrijf open. Dit zal macOS vertellen om een Internetadres te openen in uw standaard
browser, zoals Safari.
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Nu kunt u doorgaan met het schrijven van de opdracht
Welke opdracht u hierboven ook gebruikte, u moet het vervolgens vertellen welk internetadres geopend moet
worden. U wilt Google bezoeken en automatisch naar een frase zoeken.
Wanneer u gewoonlijk Google gebruikt, voert u uw zoekvraag in de zoekbalk van Google in. Maar in dit geval
wilt u dat uw computer dat voor u doet. De manier waarop u Google vertelt naar iets te zoeken (als u niet
direct de zoekbalk wilt gebruiken) is door uw internetbrowser het adres https://www.google.com/
search?q=SEARCH_PHRASE, waar `SEARCH_PHRASE is waarnaar u wilt zoeken, op te geven. Omdat
we nog niet weten naar welke frase we gaan zoeken, voeren we alleen het eerste gedeelte (zonder de te zoeken
frase) in.

9. Schrijf, in het veld Actie, https://www.google.com/search?q=. Onthoud om een spatie toe te
voegen aan uw initiële opdracht, vóórdat u dit schrijft!
Nu wilt u dat QGIS aan de browser vertelt dat Google moet zoeken naar de waarde van name voor het object
waarop u klikt.

10. Selecteer het veld name.
11. Klik op de knop Toevoegen
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Wat dit betekent is dat QGIS de browser gaat openen en het gaat verzenden naar het adres https://www.
google.com/search?q=[% "name" %]. [% "name" %] vertelt QGIS om de inhoud van het veld
[% "name" %] te gebruiken als de frase om naar te zoeken.
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Dus als, bijvoorbeeld, het gebied voor grondgebruik waarop u klikt, is genaamd Marloth Nature
Reserve, dan zal QGIS de browser sturen naar https://www.google.com/search?
q=Marloth%20Nature%20Reserve, wat er voor zal zorgen dat uw browser Google bezoekt dat
op zijn beurt zal zoeken naar “Marloth Nature Reserve”.

12. Als u dat nog niet gedaan heeft, stel dan alles in zoals hierboven is uitgelegd.
13. Klik op OK om het dialoogvenster Nieuwe actie toevoegen te sluiten
14. Klik op OK om het dialoogvenster Laageigenschappen te sluiten

Testen van de nieuwe actie.

1. Klik, met de laag landuse actief in het paneel Lagen, op de pijlknop rechts naast de knop Object-actie uitvoeren,
en selecteer de enige voor deze laag gedefinieerde actie (Google zoeken).

2. Klik op een willekeurig gebied voor grondgebruik dat u kunt zien op de kaart. Uw browser zal nu openen en
zal een zoekactie van Google starten voor de stad die is opgenomen als de waarde name voor dat gebied.

Notitie: Als uw actie niet werkt, controleer dan of alles juist is ingevoerd; typefouten komen veel voor bij dit soort
werk!

5.4.4 Follow Along: Een webpagina direct in QGIS openen

Hierboven heeft u gezien hoe u een webpagina opent in een externe browser. Er zijn enkele tekortkomingen aan deze
benaderingmet dien verstande dat het een onbekende afhankelijkheid toevoegt – hebben de eindgebruikers de vereiste
software om de actie op hun systeem uit te kunnen voeren? Zoals u heeft gezien hebben zij niet noodzakelijkerwijze
dezelfde soort basisopdracht voor hetzelfde soort actie, als u niet weet welk OS zij zullen gebruiken. Met sommige
versies van een OS, zouden de bovenstaande opdrachten mogelijk helemaal niet werken. Dit zou een onoverkomelijk
probleem kunnen zijn.
QGIS staat echter bovenop de ongelooflijk krachtige en veelzijdige bibliotheek Qt. Ook kunnen acties van QGIS
willekeurige, getokeniseerde (d.i. variabele informatie gebruikend, gebaseerd op de inhoud van een veldattribuut)
opdrachten van Python zijn!
Nu zult u zien hoe u een actie van Python gebruikt om een webpagina weer te geven. Het is hetzelfde algemene idee
als het openen van een site in een externe browser, maar het vereist geen browser op het systeem aan de zijde van de
gebruiker, omdat het de klasse Qt QWebView gebruikt (wat een op een webkit gebaseerd HTML-widget is) om de
inhoud in een pop-upvenster weer te geven.
Laten we deze keer Wikipedia gebruiken. Dus de URL die u nodig heeft, zal er uitzien als deze:
https://wikipedia.org/wiki/SEARCH_PHRASE

De laag-actie maken:
1. Open het dialoogvenster Laageigenschappen en ga naar de tab Acties.
2. Start een nieuwe actie met de volgende eigenschappen:

• Type: Python
• Omschrijving: Wikipedia
• Tekst voor actie (alles op één regel):

from qgis.PyQt.QtCore import QUrl; from qgis.PyQt.QtWebKitWidgets import␣
↪→QWebView; myWV = QWebView(None); myWV.load(QUrl('https://wikipedia.org/
↪→wiki/[%name%]')); myWV.show()
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Er gebeuren hier een aantal verschillende dingen:
• Alle code voor Python staat in één enkele regel met door punt-komma’s gescheiden opdrachten (in plaats
van nieuwe regels, de normale manier om opdrachten voor Python te scheiden).

• [%name%] zal worden vervangen door de feitelijke waarde van het attribuut wanneer de actie wordt
uitgevoerd (zoals eerder).

• De code maakt eenvoudigweg een nieuwe instance van QWebView, stelt de URL ervan in en roept dan
show() aan om het als een venster zichtbaar te maken op het bureaublad van de gebruiker.

Onthoud dat dit een ietwat bedrieglijk voorbeeld is. Python werkt met semantisch significant inspringen, dus
het scheiden van dingen door punt-komma’s is niet de beste manier om het te schrijven. Dus, in de echte wereld,
zou u meer waarschijnlijk uw logica importeren vanuit een module van Python en dan een functie aanroepen
met een veldattribuut als parameter.
U zou deze benadering ook kunnen gebruiken om een afbeelding weer te geven, zonder het vereiste dat
gebruikers een bepaald programma voor het bekijken van die afbeelding op hun systeem hebben staan.

3. Probeer de hierboven beschreven methoden te gebruiken om een pagina van Wikipedia te laden met de actie
Wikipedia die u zojuist gemaakt heeft.
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5.4.5 In Conclusion

Acties stellen u in staat uw kaart extra functionaliteit te geven, handig voor de eindgebruiker die dezelfde kaart bekijkt
in QGIS.Wegens het feit dat u shell-opdrachten kunt gebruiken voor elk besturingssysteem, als ook Python, is er geen
limiet in termen van functies die u zou kunnen inbouwen!

5.4.6 What’s Next?

Nu u verschillende methoden voor het maken van vectorgegevens heeft gedaan, zult u leren hoe u deze gegevens
analyseert om problemen op te lossen. Dat is het onderwerp van de volgende module.
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Module: Vectoranalyse

Nu u enkele objecten heeft bewerkt, zou u moeten willen weten wat er nog meer mee gedaan kan worden. Het hebben
van objecten met attributen is aardig, maar als alles is gezegd en gedaan, vertelt dit u eigenlijk niet meer of minder
dan een normale kaart zonder GIS.
Het belangrijkste voordeel van een GIS is dit: een GIS kan vragen beantwoorden.

Voor de drie volgende modules, zullen we trachten een onderzoeksvraag te beantwoorden met behulp van functies van
GIS. Bijvoorbeeld; u bent een makelaar en u zoekt naar een woonhuis in Swellendam voor cliënten die de volgende
criteria hebben:

1. Het moet in Swellendam liggen.
2. Het moet op een redelijke rijafstand van een school (zeg 1 km) liggen.
3. Het moet meer dan 100 vierkant meter in grootte zijn.
4. Dichter dan 50 m vanaf een hoofdweg.
5. Dichter dan 500 m vanaf een restaurant.

Binnen de volgende modules, zullen we de kracht van gereedschappen voor analyse in GIS optuigen om geschikte
boerderijen voor deze nieuwe ontwikkeling tot woonhuis te lokaliseren.

6.1 Lesson: Gegevens opnieuw projecteren en transformeren

Laten we het nog eens hebben over Coördinaten ReferentieSystemen (CRS-en).We hebben dit eerder kort behandeld,
maar we hebben niet besproken wat het in de praktijk betekent.
Het doel voor deze les: Vector-gegevenssets opnieuw projecteren en transformeren.

175



QGIS Training Manual

6.1.1 Follow Along: Projecties

Het CRS waarin alle gegevens en ook de kaart nu staan wordtWGS84 genoemd. Dit is een vrij algemeen Geografisch
CoördinatenSysteem (GCS) voor het weergeven van gegevens. Maar er is een probleem, zoals we zullen zien.

1. Sla uw huidige kaart op
2. Open dan de wereldkaart die u kunt vinden onder exercise_data/world/world.qgs.
3. Zoom in naar Zuid Afrika met behulp van het gereedschap Inzoomen

4. Probeer een schaal in te stellen in het veld Schaal, dat in de Statusbalk staat, aan de onderzijde van het scherm.
Terwijl u boven Zuid Afrika bent, stel deze waarde in op 1:5 000 000 (één tot vijf miljoen).

5. Schuif over de kaart terwijl u een oogje houdt op het veld Schaal

Ziet u dat de schaal verandert? Dat komt omdat u zich verplaatst vanaf het ene punt waarop u inzoomde met 1:5
000 000, dat in het midden van uw scherm stond. Voor alles rondom dat punt is de schaal anders.
Denk aan een wereldbol om dit te begrijpen. Die heeft lijnen lopen van Noord naar Zuid. Deze lijnen voor de
lengtegraad staan ver van elkaar af aan de evenaar, maar ontmoeten elkaar aan de polen.
In een GCS werkt u met deze bol, maar uw scherm is plat. Wanneer u de bol op een plat oppervlak probeert weer te
geven, treedt vervorming op, soortgelijk aan die welke zal optreden als u een tennisbal opent en die probeert plat te
maken. Wat dit betekent op een kaart is dat de lijnen voor de lengtegraad op gelijke afstand van elkaar blijven, zelfs
aan de polen (waar zij verondersteld worden samen te komen). Dit betekent dat, als u op uw kaart vanaf de evenaar
weg reist, de schaal van de objecten die u ziet groter en groter worden. Wat dit voor ons in de praktijk betekent is dat
er geen constante schaal op uw kaart is!
Laten we in plaats daarvan een geProjecteerd Coördinaten Systeem (PCS) gebruiken, om dit op te lossen. Een PCS
“projecteert” of converteert de gegevens op een manier die het mogelijk maakt dat de schaal wijzigt en corrigeert
die. Daarom, om de schaal constant te houden, zouden we onze gegevens opnieuw moeten projecteren en een PCS
gebruiken.

6.1.2 Follow Along: “Direct” opnieuw projecteren

Standaard projecteert QGIS uw gegevens “direct” opnieuw. Wat dit betekent is dat, zelfs als de gegevens zelf in een
ander CRS staan, QGIS ze kan projecteren alsof ze in een CRS van uw keuze staan.

U kunt het CRS van het project wijzigen door te klikken op de knop Huidig CRS aan de rechteronderzijde van QGIS.
1. Typ, in het dialoogvenster dat verschijnt, het woord global in het veld Filter. Een aantal CRS-en zouden in

het veld Vooraf gedefinieerde Coördinaten ReferentieSystemen eronder moeten verschijnen.
2. SelecteerWGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 door erop te klikken, en klik dan op OK.

Merk op hoe de vorm van Zuid Afrika verandert. Alle projecties werken door de uiterlijke vormen van objecten
op aarde te wijzigen.

3. Zoom opnieuw in naar een schaal van 1:5 000 000, zoals eerder.
4. Schuif over de kaart.

Merk op dat de schaal nu hetzelfde blijft!
“Direct” opnieuw projecteren wordt ook gebruikt voor het combineren van gegevenssets die in verschillende CRS-en
staan.

1. Voeg een andere vectorlaag aan uw kaart toe die alleen gegevens voor Zuid Afrika heeft. U vindt die als
exercise_data/world/RSA.shp.

2. Laad die. Een snelle manier om het CRS ervan te zien is door met de muis over de laag in de legenda te gaan.
Het is EPSG:3410.
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Wat valt u op?
De laag is zichtbaar, zelfs als het een ander CRS heeft dan die van continents.

6.1.3 Follow Along: Een gegevensset opslaan in een ander CRS

Soms moet u een bestaande gegevensset exporteren naar een ander CRS. Zoals we zullen zien in de volgende les, als u
afstandsberekeningen moet maken op de laag, is het altijd beter om de laag in een geprojecteerd coördinatensysteem
te hebben.
Onthoud dat ‘direct’ opnieuw projecteren is gerelateerd aan het project en niet aan enkelvoudige lagen. Dit betekent
dat een laag een ander CRS kan hebben dan het project, zelfs al ziet u het op de correcte positie.
U kunt de laag gemakkelijk exporteren naar een ander CRS.

1. Voeg de gegevensset buildings uit training_data.gpkg toe
2. Klik met rechts op de laag buildings in het paneel Lagen
3. Selecteer Exporteren► Objecten opslaan als… in het menu dat verschijnt. U zult het dialoogvenster Vectorlaag

opslaan als… te zien krijgen.
4. Klik op de knop Bladeren naast het veld Bestandsnaam.
5. Navigeer naar exercise_data/ en specificeer de naam voor de nieuwe laag als

buildings_reprojected.shp.
6. Wijzig de waarde van het CRS. Alleen de recent gebruikte CRS-en zullen worden weergegeven in het

keuzemenu. Klik op de knop CRS selecteren naast het keuzemenu.
7. Het dialoogvenster Keuze Coördinaten ReferentieSysteem zal nu verschijnen. Zoek in het veld Filter daarvan

naar 34S.
8. SelecteerWGS 84 / UTM zone 34S | EPSG:32734 uit de lijst
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9. Laat de andere opties ongewijzigd. Het dialoogvenster Vectorlaag opslaan als… ziet er nu als volgt uit:
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10. Klik op OK

U kunt nu de oude en nieuwe projecties van de laag vergelijken en zien dat zij in twee verschillende CRS-en staan,
maar dat zij elkaar nog steeds overlappen.
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6.1.4 Follow Along: Uw eigen projectie maken

Er zijn nog veel meer projecties dan die welke standaard zijn opgenomen in QGIS. U kunt ook uw eigen projecties
maken.

1. Begin een nieuwe kaart
2. Laad de gegevensset world/oceans.shp
3. Ga naar Extra ► Aangepaste projecties… en u zult dit dialoogvenster zien:

4. Klik op de knop Nieuw CRS toevoegen om een nieuwe projectie te maken
5. Een interessante projectie om te gebruiken is genaamd Van der Grinten I. Voer die naam in in het veld

Naam.
Deze projectie geeft de Aarde weer op een cirkelvormig veld in plaats van op een rechthoekig, zoals de meeste
andere projecties doen.

6. SelecteerWKT (Aanbevolen) in Formaat.
7. Voeg de volgende tekenreeks toe aan het veld Parameters:

PROJCRS["unknown",
BASEGEOGCRS["unknown",

DATUM["unknown",
ELLIPSOID["unknown",6371000,0,

LENGTHUNIT["metre",1,
ID["EPSG",9001]]]],

PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
CONVERSION["unknown",

METHOD["Van Der Grinten"],
PARAMETER["Longitude of natural origin",0,

ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8802]],

PARAMETER["False easting",0,
LENGTHUNIT["metre",1],
ID["EPSG",8806]],

PARAMETER["False northing",0,
LENGTHUNIT["metre",1],
ID["EPSG",8807]]],

CS[Cartesian,2],
AXIS["(E)",east,

ORDER[1],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]],
AXIS["(N)",north,

ORDER[2],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]]]

8. Klik op OK

9. Klik op de knop Huidig CRS aan de rechterkant van de statusbalk om het CRS voor het project te wijzigen
10. Kies uw nieuwe gedefinieerde projectie (zoek naar de naam ervan in het veld Filter)
11. Bij het toepassen van deze projectie, zal de kaart opnieuw geprojecteerd worden als:
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6.1.5 In Conclusion

Verschillende projecties zijn handig voor verschillende doeleinden. Door de juiste projectie te kiezen kunt u er voor
zorgen dat de objecten op uw kaart nauwkeurig worden weergegeven.

6.1.6 Further Reading

Materiaal voor het gedeelte Gevorderd van deze les is afkomstig uit dit artikel.
Lees meer informatie over Coördinaten ReferentieSystemen.

6.1.7 What’s Next?

In de volgende les zult u leren hoe u vectorgegevens kunt analyseren met de verschillende gereedschappen voor
vectoranalyse in QGIS.

6.2 Lesson: Vectoranalyse

Vectorgegevens kunnen ook worden geanalyseerd om te onthullen hoe verschillende objecten met elkaar omgaan in
de ruimte. Er zijn vele aan analyse gerelateerde functies, dus zullen we ze niet allemaal behandelen. In plaats daarvan
zullen we een vraag stellen en die proberen op te lossen met behulp van de gereedschappen die QGIS verschaft.
Het doel voor deze les. Een vraag stellen en die beantwoorden met behulp van gereedschappen voor analyse.
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6.2.1 Het proces GIS

Vóór we beginnen zou het handig zijn om een kort overzicht te geven van een proces dat gebruikt kan worden om elk
probleem op te lossen. De manier om dat te doen is:

1. Benoem het probleem
2. Haal de gegevens op
3. Analyseer het probleem
4. Geef de resultaten weer

6.2.2 Het probleem

Laten we het proces beginnen door een probleem te benoemen om op te lossen. U bent bijvoorbeeld een makelaar
en u zoekt naar een woning in Swellendam voor cliënten die de volgende criteria hebben:

1. Het moet in Swellendam liggen
2. Het moet op een redelijke rijafstand van een school (zeg 1 km) liggen
3. Het moet meer dan 100 vierkante meter in grootte zijn
4. Dichter dan 50 m vanaf een hoofdweg
5. Minder dan 500 m vanaf een restaurant

6.2.3 De gegevens

We hebben de volgende gegevens nodig om deze vragen te kunnen beantwoorden:
1. De woningen (gebouwen) in het gebied
2. De wegen in en rondom de stad
3. De locaties van scholen en restaurants
4. De grootte van gebouwen

Deze gegevens zijn beschikbaar viaOSMen u zou kunnen besluiten dat ook de gegevensset die u voor deze handleiding
heeft gebruikt voor deze les ook kan worden gebruikt.
Als u gegevens van een ander gebied wilt downloaden, ga dan naar Hoofdstuk Introductie om te lezen hoe dat te doen.

Notitie: Hoewel downloads van OSM consistente velden voor de gegevens hebben, kunnen de bedekking en de
details variëren. Als u ziet dat de door u gekozen regio, bijvoorbeeld, geen informatie bevat over restaurants, zou u
misschien een andere regio moeten kiezen.
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6.2.4 Follow Along: Een project beginnen en de gegevens ophalen

We moeten eerst de gegevens laden om mee te werken.
1. Begin een nieuw project binnen QGIS
2. Als u wilt, kunt u een achtergrondkaart toevoegen. Open de Browser en laad de kaart voor de achtergrond OSM

uit het menu XYZ Tiles.

3. In de database voor GeoPackage training_data.gpkg vindt u de meeste gegevenssets die we zullen
gebruiken voor dit hoofdstuk:
1. buildings
2. roads
3. restaurants
4. schools

Laad ze, en ook landuse.sqlite.
4. Zoom in op het bereik van de laag om Swellendam, Zuid-Afrika te kunnen zien.

Voor we doorgaan moeten we de laag roads filteren om slechts een paar specifieke typen wegen te hebben om
mee te werken.
Enkele wegen in de gegevenssets van OSM zijn vermeld als unclassified, tracks, path en footway.
We willen die uit onze gegevensset van wegen weglaten en focussen op de andere typen wegen, meer geschikt
voor deze oefening.
Meer nog, de gegevens van OSM zouden niet overal bijgewerkt kunnen zijn en we willen ook de waarden NULL
uitsluiten.

5. Klik met rechts op de laag roads en kies Filteren….
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6. In het dialoogvenster dat opent filteren we deze objecten met de volgende expressie:

"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS␣
↪→NOT NULL

De samenvoeging van de twee operatoren NOT en IN sluit alle objecten uit die deze attribuutwaarden in het
veld highway hebben staan.
IS NOT NULL gecombineerd met de operator AND sluit wegen zonder waarde in het veld highway uit.

Merk het pictogram op naast de laag roads. Het helpt u te onthouden dat op deze laag een filter is geactiveerd
en dat enkele objecten dus niet beschikbaar zouden kunnen zijn in het project.

De kaart met alle gegevens zou er ongeveer als volgt uit moeten zien:

6.2.5 Try Yourself CRS van een laag converteren

We moeten we het CRS van de lagen wijzigen, omdat we binnen onze lagen afstanden gaan meten. We moeten, om
dit te doen, elke laag op zijn beurt selecteren, de laag opslaan naar een nieuwe met onze nieuwe projectie, en dan die
nieuwe laag in onze kaart importeren.
U heeft veel verschillende opties, u kunt bijvoorbeeld elke laag exporteren als een nieuw gegevensset in de indeling
ESRI Shapefile, u kunt de lagen toevoegen aan een bestaand bestand van GeoPackage of u kunt een nieuw bestand
voor GeoPackage maken en dat vullen met de nieuw geprojecteerde lagen. We zullen de laatste optie laten zien, zodat
training_data.gpkg schoon blijft. Het staat u vrij de beste werkwijze voor uzelf te kiezen.

Notitie: In dit voorbeeld gebruiken we het CRS WGS 84 / UTM zone 34S, maar u zou een UTM CRS moeten
gebruiken dat meer toepasselijk is voor uw regio.

1. Klik met rechts op de laag roads in het paneel Lagen
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2. Klik op Exporteren –> Objecten opslaan als…

3. Kies in het dialoogvenster Vectorlaag opslaan als GeoPackage als Indeling
4. Klik op… van de Bestandsnaam en noem het nieuwe GeoPackage vector_analysis
5. Wijzig de Laagnaam naar roads_34S
6. Wijzig het CRS naarWGS 84 / UTM zone 34S

7. Klik op OK:

Dit zal de nieuwe database voor GeoPackage maken en de laag roads_34S toevoegen.
8. Herhaal dit proces voor elke laag door een nieuwe laag te maken in het bestand van GeoPackage

vector_analysis.gpkg met “_34S” toegevoegd aan de originele naam en elk van de oude lagen uit
het project te verwijderen.
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Notitie: Wanneer u ervoor kiest om een laag op te slaan naar een bestaand GeoPackage, zal QGIS die laag
toevoegen aan dat GeoPackage.

9. Als u eenmaal het proces voor alle lagen heeft voltooid, klik dan met rechts op een laag en klik op Zoom naar
laag om de kaart te focussen op het gebied waarin we geïnteresseerd zijn.

Nuwe de gegevens vanOSMhebben geconverteerd naar eenUTM-projectie, kunnenwe onze berekeningen beginnen.

6.2.6 Follow Along: Analyseren van het probleem: Afstanden van
scholen en wegen

QGIS stelt u in staat afstanden te berekenen tussen elk vectorobject.
1. Zorg er voor dat alleen de lagen roads_34S en buildings_34S zichtbaar zijn (om de kaart te

vereenvoudigen, terwijl u werkt).
2. Klik op Processing ► Toolbox om de analytische bron van QGIS te openen. Als basis: alle algoritmen (voor

vector- en raster-) analyses zijn in deze Toolbox beschikbaar.
3. We beginnen met het gebied te berekenen rondom roads_34S door het algoritme Buffer te gebruiken. U

kunt dat vinden in de groep Vector geometrie.
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Of u kunt buffer typen in het zoekmenu in het bovenste gedeelte van de Toolbox:

4. Dubbelklik erop om het dialoogvenster van het algoritme te openen
5. Selecteer roads_34S als Invoerlaag, stel Afstand in op 50 en gebruik de standaardwaarden voor de rest van

de parameters.
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6. De standaard Afstand is in meters, omdat onze gegevensset voor invoer in een geprojecteerd Coördinaten
Systeem staat dat meter gebruikt als zijn basis maateenheid. U kunt het combinatievak gebruiken om andere
geprojecteerde eenheden te gebruiken, zoals kilometers, yards, etc.

Notitie: Als u probeert een buffer te maken op een laag met een Geografisch CoördinatenSysteem,
zal Processing u waarschuwen en voorstellen om de laag opnieuw te projecteren in een metrisch
CoördinatenSysteem.

7. Standaard maakt Processing tijdelijke lagen en voegt die toe aan het paneel Lagen. U kunt het resultaat ook
toevoegen aan de database van GeoPackage door:
1. Te klikken op de knop… en te kiezen voor Opslaan naar GeoPackage…

2. Noem de nieuwe laag roads_buffer_50m
3. Sla het op in het bestand vector_analysis.gpkg
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8. Klik op Uitvoeren, en sluit dan het dialoogvenster Buffer
Nu zal uw kaart er ongeveer zo uitzien:
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Als uw nieuwe laag boven in de lijst Lagen staat, zal het waarschijnlijk veel van uw kaart verbergen, maar dit geeft u
alle gebieden in uw regio die binnen 50 m van een weg liggen.
Merk op dat er binnen uw buffer bepaalde gebieden zijn, die overeenkomen met elke weg. Om dit probleem op te
lossen:

1. Deselecteer de laag roads_buffer_50m en maak de buffer opnieuw met Resultaten samenvoegen ingeschakeld:
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2. Sla de uitvoer op als roads_buffer_50m_dissolved

3. Klik op Uitvoeren en sluit het dialoogvenster Buffer
Als u de laag eenmaal aan het paneel Lagen heeft toegevoegd, zal het er zo uitzien:
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Nu zijn er geen onnodige onderverdelingen meer.

Notitie: De Verkorte Help aan de rechterkant van het dialoogvenster legt uit hoe het algoritme werkt. Als u meer
informatie nodig hebt, klik dan gewoon op de knop Help in het onderste gedeelte om een meer gedetailleerde
handleiding voor het algoritme te openen.

6.2.7 Try Yourself Afstand van scholen

Gebruik dezelfde benadering als hierboven en maak een buffer voor uw scholen.
Het moet een straal van 1 km hebben. Sla de nieuwe laag op in het bestand vector_analysis.gpkg als
schools_buffer_1km_dissolved.
Controleer uw resultaten

6.2.8 Follow Along: Overlappende gebieden

Nu hebben we gebieden geïdentificeerd waar de weg minder dan 50 m verwijderd is en gebieden waar een school
binnen 1 km ligt (directe lijn, niet via de weg). Maar natuurlijk willen we alleen de gebieden waar aan beide criteria
wordt voldaan. We zullen het gereedschap Kruising moeten gebruiken om dat te kunnen doen. U vindt het onder de
groep Vector op elkaar leggen in Processing –> Toolbox.

1. Gebruik de twee lagen met buffers als Invoerlaag en Overleglaag, kies vector_analysis.gpkg
GeoPackage in Kruisingmet Laagnaam road_school_buffers_intersect. Laat de rest zoals wordt
voorgesteld (standaard).
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2. Klik op Uitvoeren.
In de afbeelding hieronder, de blauwe gebieden zijn waar aan beide criteria voor de afstand wordt voldaan.
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3. U kunt de twee bufferlagen verwijderen en alleen die ene behouden waar zij overlappen, omdat dat is wat we
in eerste instantie echt wilden weten:

196 Hoofdstuk 6. Module: Vectoranalyse



QGIS Training Manual

6.2.9 Follow Along: De gebouwen uitnemen

Nu heeft u het gebied dat de gebouwen moet overlappen. Vervolgens wilt u de gebouwen in dat gebied uitnemen.
1. Zoek naar het menuitem Vector selectie ► Extract by location in de Toolbox van Processing
2. Selecteer buildings_34S in Objecten uitnemen uit. Selecteer kruisen met inWaar de objecten (geometrisch

voorvoegsel), selecteer de laag met de kruisingen van de buffers in Door objecten te vergelijken van. Sla op naar
vector_analysis.gpkg, en noem de laag well_located_houses.

3. Klik op Uitvoeren en sluit het dialoogvenster
4. U zult waarschijnlijk vinden dat er niet veel lijkt te zijn veranderd. Als dat zo is, verplaats dan de laag

well_located_houses tot boven in de lagenlijst en zoom dan in.
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De rode gebouwen zijn die welke voldoen aan onze criteria, terwijl de groene gebouwen er niet aan voldoen.
5. Nu heeft u twee afzonderlijke lagen en kunt u buildings_34S uit de lagenlijst verwijderen.

6.2.10 Try Yourself Onze gebouwen verder filteren

We hebben nu een laag die ons alle gebouwen binnen 1 km van een school en binnen 50 m vanaf een weg toont. We
moeten nu die selectie verkleinen om ons alleen gebouwen te tonen die binnen 500 m vanaf een restaurant liggen.
Maak, met behulp van de hierboven beschreven processen, een nieuwe laag, genaamd houses_restaurants_500m die
uw laag well_located_houses verder filtert om alleen die gebouwen te laten zien die binnen 500 m van een restaurant
liggen.
Controleer uw resultaten

6.2.11 Follow Along: Selecteren van gebouwen met de juiste grootte

We moeten hun grootte berekenen om te zien welke gebouwen de juiste grootte hebben (groter dan 100 vierkante
meter).

1. Selecteer de laag houses_restaurants_500m en open Veldberekening door te klikken op de knop
Veldberekening openen in de hoofdwerkbalk of in het venster van de attributentabel

2. Selecteer Nieuw veld aanmaken, stel de Naam voor veld in op AREA, kies Decimaal getal (real) als Type voor
veld, en kies $area uit de groep Geometrie.
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Het nieuwe veld AREA zal de oppervlakte van elk gebouw in vierkante meters bevatten.
3. Klik op OK. Het veld AREA is toegevoegd aan het einde van de attributentabel.

4. Klik opnieuw op de knop Bewerken aan/uitzetten om het bewerken te voltooien en sla uw gegevens op als daarnaar
gevraagd wordt.

5. Stel, op de tab Bron van de laageigenschappen, het Provider objectfilter in op "AREA >= 100.
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6. Klik op OK.
Uw kaart zou nu alleen die gebouwen moeten laten zien die overeenkomen met uw begincriteria en die groter zijn
dan 100 vierkante meter.

6.2.12 Try Yourself

Sla uw oplossing op als een nieuwe laag, met de benadering die u hierboven hebt geleerd om dat te doen. Het bestand
zou moeten worden opgeslagen in dezelfde database van GeoPackage, met de naam solution.

6.2.13 In Conclusion

Met de benadering van probleemoplossing voor GIS, samen met de gereedschappen voor vectoranalyse van QGIS,
was u in staat een probleem met meerdere criteria snel en gemakkelijk op te lossen.
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6.2.14 What’s Next?

In de volgende les, zullen we kijken naar de berekening van de kortste afstand over wegen, van het ene punt naar een
ander.

6.3 Lesson: Netwerkanalyse

Berekenen van de kortste afstand tussen twee punten is een veel voorkomend gebruik voor GIS. Gereedschappen
hiervoor zijn te vinden in de Toolbox van Processing.
Het doel voor deze les: leren algoritmen voor Netwerk-analyses te gebruiken.

6.3.1 Follow Along: De gereedschappen en de gegevens

U vindt alle algoritmen voor netwerkanalyses in het menu Processing ► Netwerkanalyse. U kunt zien dat er vele
gereedschappen beschikbaar zijn:

6.3. Lesson: Netwerkanalyse 201



QGIS Training Manual

Open het project exercise_data/network_analysis/network.qgz. Het bevat twee lagen:
• network_points

• network_lines

De laag network_lines heeft al een stijl die u helpt het netwerk van wegen te begrijpen.
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Het gereedschap Kortste pad verschaft manieren om ofwel het kortste of het snelste pad te berekenen tussen twee
opgegeven punten van een netwerk:

• begin- en eindpunten geselecteerd op de kaart
• beginpunt geselecteerd op de kaart en eindpunten genomen uit een puntenlaag
• beginpunten genomen uit een puntenlaag en eindpunt geselecteerd op de kaart

Laten we beginnen.

6.3.2 Kortste pad (punt naar punt) berekenen

Het menu Netwerkanalyse ► Kortste pad (punt naar punt) stelt u in staat de kortste afstand te berekenen tussen twee
handmatig geselecteerde punten op de kaart.
In dit voorbeeld zullen we het kortste (niet snelste) pad tussen twee punten.

1. Open het algoritme Kortste pad (punt naar punt)

2. Selecteer network_lines voor Vectorlaag die netwerk weergeeft

3. Kies Kortste in Te berekenen type pad

Gebruik deze twee punten als begin- en eindpunt voor de analyse:
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4. Klik op de knop… naast Startpunt en kies de locatie die is getagd met Starting Point in de afbeelding.
Het veld wordt gevuld met de coördinaten van het aangeklikte punt.

5. Doe hetzelfde, maar kies nu de locatie die is getagd met Ending point voor Eindpunt
6. Klik op de knop Uitvoeren:
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7. Een nieuwe lijnenlaag wordt gemaakt die het kortste pad weergeeft tussen de gekozen punten. Deselecteer de
laag network_lines om het resultaat beter te kunnen zien:

8. Open de attributentabel van de uitvoerlaag. Die bevat drie velden, die de coördinaten van het start- en eindpunt
weergeven en de kosten.
We kozen Kortste als Te berekenen type pad, dus vertegenwoordigen de kosten de afstand, in
kaarteenheden, tussen de twee locaties.
In ons geval is de kortste afstand tussen de twee gekozen punten ongeveer 1000 meter:

Nu u weet hoe het gereedschap te gebruiken, test nog enkele andere locaties.
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6.3.3 Try Yourself Snelste pad

Probeer, met dezelfde gegevens van de eerdere oefening, het snelste pad tussen de twee punten te berekenen.
Hoeveel tijd heeft u nodig om van het begin- naar het eindpunt te gaan?
Controleer uw resultaten

6.3.4 Follow Along: Gevorderde opties

Laten we nog enkele andere opties van het gereedschap Netwerkanalyse verkennen. In de vorige oefening berekenden
we de snelste route tussen twee punten. Zoals u zich kunt voorstellen, is de tijd afhankelijk van de snelheid waarmee
u reist.
We zullen dezelfde lagen en begin- en eindpunten gebruiken als in de vorige oefeningen.

1. Open het algoritme Kortste pad (punt naar punt)

2. Vul Invoerlaag, Beginpunt (x, y) en Eindpunt (x, y) in zoals we eerder deden
3. Kies Snelste als het Te berekenen type pad

4. Open het menu Gevorderde parameters

5. Wijzig de Standaard snelheid (km/u) van de standaardwaarde 50 naar 4

6. Klik op Uitvoeren
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7. Sluit, als het algoritme is voltooid, het dialoogvenster en open de attributentabel van de uitvoerlaag.
Het veld cost bevat de waarde overeenkomstig de parameter voor de snelheid die u hebt gekozen. We kunnen
het veld cost converteren van uren met fracties naar de meer leesbare waarde minuten.

8. Open Veldberekening door te klikken op het pictogram en voeg het nieuwe veld minuten toe door het veld
cost te vermenigvuldigen met 60:

Dat is alles! Nu weet u hoeveel minuten u nodig hebt om van het ene punt bij het andere te komen.
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6.3.5 Kortste pad met snelheidsbeperking

Het gereedschap Netwerkanalyse heeft nog andere interessante opties. Als we kijken naar de volgende kaart:

we zouden de snelste route willen weten, rekening houdende met de snelheidsbeperkingen voor elke weg (de labels
geven de maximumsnelheid in km/u weer). Het kortste pad zonder rekening te houden met de snelheidsbeperkingen
zou natuurlijk het paarse pad zijn. Maar op die weg is de maximumsnelheid 20 km/u, terwijl u op de groene weg 100
km/u mag!
Zoals we in de eerste oefening deden zullen we Netwerkanalyse ► Kortste pad (punt naar punt) gebruiken en zullen
we handmatig de begin- en eindpunten kiezen.

1. Open het algoritme Netwerkanalyse ► Kortste pad (punt naar punt)

2. Selecteer network_lines voor de parameter Vectorlaag die netwerk weergeeft

3. Kies Snelste als het Te berekenen type pad

4. Klik op de knop… naast Startpunt en kies het beginpunt.
5. Doe hetzelfde voor Eindpunt
6. Open het menu Gevorderde parameters

7. Kies het veld speed als de parameter Snelheidsveld. Met deze optie zal het algoritme rekening houden met de
snelheidsbeperkingen op elke weg.
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8. Klik op de knop Uitvoeren

9. Schakel de laag network_lines uit, om het resultaat beter te kunnen zien
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Zoals u kunt zien komt de snelste route niet overeen met de kortste.

6.3.6 Servicegebied (vanuit laag)

Het algortimeNetwerkanalyse► Servicegebied (vanuit laag) kan antwoord geven op de vraag: gegeven een puntenlaag,
wat zijn alle te bereiken gebieden binnen een opgegeven afstand of tijdwaarde?

Notitie: Het algoritme Netwerkanalyse ► Servicegebied (vanaf punt) is hetzelfde algoritme, maar stelt u in staat
handmatig het punt op de kaart te kiezen.

Gegeven een afstand van 250 meter willen we weten hoever we vanuit elk punt het netwerk op kunnen gaan op de
laag network_points.

1. Deselecteer alle lagen, behalve network_points
2. Open het algoritme Netwerkanalyse ► Servicegebied (vanuit laag)

3. Selecteer network_lines voor Vectorlaag die netwerk weergeeft

4. Kies network_points voor Vectorlaag met startpunten

5. Kies Kortste in Te berekenen type pad

6. Voer 250 in voor de parameter Reiskosten
7. Klik op Uitvoeren en sluit het dialoogvenster
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De uitvoerlaag geeft het maximale pad aan dat u kunt bereiken vanuit de puntobjecten, gegeven een afstand
van 250 meter:
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Leuk hè?

6.3.7 In Conclusion

Nu weet u hoe u het algoritme Netwerkanalyse kunt gebruiken om problemen met kortste en snelste paden op te
lossen.
We zijn nu klaar om enkele ruimtelijke statistieken uit te voeren op gegevens van vectorlagen. Daar gaan we!

6.3.8 What’s Next?

Vervolgens zult u zien hoe u algoritmen voor ruimtelijke statistieken uitvoert op vector gegevenssets.

6.4 Lesson: Ruimtelijke statistieken

Notitie: Les ontwikkeld door Linfiniti en S Motala (Cape Peninsula University of Technology)

Ruimtelijke statistieken stellen u in staat te analyseren en te begrijpen wat er gaande is in een bepaalde vector
gegevensset. QGIS bevat vele nuttige gereedschappen voor statistische analyses.
Het doel voor deze les: Weten hoe de ruimtelijke statistische gereedschappen in de Toolbox van Processing te
gebruiken.

6.4.1 Follow Along: Een test-gegevensset maken

We zullen een willekeurige set punten maken, om een gegevensset te krijgen waar we mee kunnen werken.
U heeft, om dat te doen, een polygoon gegevensset nodig die het bereik van het gebied, waarin u de punten wilt
maken, definieert.
We zullen het gebied gebruiken dat wordt bedekt door straten.

1. Begin een nieuw project.
2. Voeg uw laag roads toe, als ook srtm_41_19 (hoogtegegevens) te vinden in exercise_data/

raster/SRTM/.

Notitie: U zou kunnen merken dat de laag SRTMDEM een ander CRS heeft dan die van de laag roads. QGIS
projecteert beide lagen in één enkel CRS. Voor de volgende oefeningen is dit verschil niet van belang, maar
het staat u vrij een laag opnieuw te projecteren (zoals eerder weergegeven in deze module).

3. Open de Toolbox van Processing

4. Gebruik het gereedschap Vector geometrie ► Minimum begrenzing geometrie om een gebied te maken dat alle
wegen omsluit door Convex Hull te kiezen als Type geometrie:
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Zoals u weet maakt Processing , als u geen uitvoer specificeert, tijdelijke lagen. Het is aan u om de lagen
onmiddellijk op te slaan of op een later moment.

Willekeurige punten genereren

• Maak in dit gebied 100 willekeurige punten met het gereedschap Vector maken ► Willekeurige punten binnen
grenzen van laag, met een minimum afstand van 0.0:
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Notitie: Het gele waarschuwingsteken vertelt u dat die parameter afstanden betreft. De laag Begrenzing
geometrie staat in een Geografisch coördinatensysteem en het algoritme herinnert u daar slechts aan. Voor
dit voorbeeld zullen we deze parameter niet gebruiken, dus kunt u het negeren.

Verplaats, indien nodig, de gemaakte willekeurige punten naar bovenaan in de legenda om hem beter te kunnen zien:
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Een monster uit de gegevens

U dient het algoritme Rasteranalye ► Monster rasterwaarden te gebruiken om een gegevensset met monsters uit het
raster te nemen. Dit gereedschap neemt monsters uit het raster op de locaties van de punten en voegt de rasterwaarden
toe in nieuwe veld(en), afhankelijk van het aantal banden in het raster.

1. Open het dialoogvenster voor het algoritme Monsters rasterwaarden

2. Selecteer Willekeurige punten als de laag die de monsterpunten bevat en het SRTM-raster als de
band waaruit de waarden moeten komen. De standaardnaam voor het nieuwe veld is rvalue_N, waar N het
nummer is van de rasterband. U kunt de naam van het voorvoegsel wijzigen als u dat wilt.

3. Klik op Uitvoeren

Nu kunt u de gegevens voor het monster uit het rasterbestand controleren in de attributentabel van de laag
Monsterpunten.Zij zullen in een nieuw veld staan, met de naam die u hebt gekozen.
Een mogelijke laag voor het monster wordt hier weergegeven:
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De monsterpunten zijn op hun veld rvalue_1 geclassificeerd, zodat rode punten op een hogere hoogte liggen.
U zult deze monsterlaag gaan gebruiken voor de rest van de statistische oefeningen.

6.4.2 Follow Along: Basisstatistieken

Nu nog de basisstatistieken voor deze laag ophalen.

1. Klik op het pictogram Statistisch overzicht weergeven op de werkbalk Attributen. Een nieuw paneel zal openen.
2. Specificeer, in het dialoogvenster dat verschijnt, de laag Monsterpunten als de bron.
3. Selecteer het veld rvalue_1 in het combinatievak voor velden. Dit is het veld waarvoor u de statistieken wilt

berekenen.
4. Het paneel Statistieken zal automatisch worden bijgewerkt met de berekende statistieken:
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Notitie: Ukunt de waarden kopiëren door te klikken op de knop Statistieken naar klembord kopiëren en de resultaten
in een werkblad plakken.

5. Sluit het paneel Statistieken indien gereed
Veel verschillende statistieken zijn beschikbaar:
Telling Het aantal monsters/waarden.
Som De waarden bij elkaar opgeteld.
Gemiddelde De gemiddelde waarde is eenvoudigweg de som van de waarden, gedeeld door het aantal waarden.
Mediaan Als u alle waarden schikt van de kleinste tot de grootste, is de middelste waarde (of het gemiddelde van

de twee middelste waarden als N een even getal is) de mediaan van de waarden.
St afw (pop) De standaardafwijking. Geeft een indicatie over hoe dicht de waarden zijn geclusterd rondom het

gemiddelde. Hoe kleiner de standaardafwijking, hoe meer waarden neigen naar het gemiddelde.
Minimum De laagste waarde.
Maximum De hoogste waarde.
Bereik Het verschil tussen de laagste en de hoogste waarden.
Kw1 Eerste kwartiel van de gegevens.
Kw3 Derde kwartiel van de gegevens.
Ontbrekende (null) waarden Het aantal ontbrekende waarden.

6.4.3 Follow Along: Statistieken berekenen van afstanden tussen
punten

1. Maak een nieuwe tijdelijke puntenlaag.
2. Ga naar modus Bewerken en digitaliseer drie punten ergens tussen de andere punten.

Gebruik, als alternatief, dezelfde methode voor het maken van willekeurige punten als hiervoor, maar
specificeer slechts drie punten.

3. Sla uw nieuwe laag op als distance_points in de indeling die u wilt.
Statistieken maken over de afstand tussen punten in de twee lagen:

1. Open het gereedschap Vector-analyse ► Afstandsmatrix.
2. Selecteer de laag distance_points als de invoerlaag en de laag Monsterpunten als de doellaag.
3. Stel het als volgt in:
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4. Als u wilt, kunt u de uitvoerlaag opslaan als een bestand of alleen het algoritme uitvoeren en de tijdelijke
uitvoerlaag later opslaan.

5. Klik op Uitvoeren om de laag voor de afstandsmatrix te maken.
6. Open de attributentabel van de gemaakte laag: waarden verwijzen naar de afstanden tussen de objecten van

Afstandsmatrix en hun twee dichtstbijzijnde punten op de laag Monsterpunten:

Met deze parameters berekent het gereedschap Afstandsmatrix statistieken over de afstanden voor elk punt van
de invoerlaag, ten opzichte van de dichtstbijzijnde punten van de doellaag. De velden van de uitvoerlaag bevatten
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gemiddelde, standaardafwijking, minimum en maximum voor de afstanden tot de dichtstbij gelegen buren van de
punten op de invoerlaag.

6.4.4 Follow Along: ‘Dichtstbijzijnde buur’-analyse (in laag)

Een ‘Dichtstbijzijnde buur’-analyse uitvoeren op een puntenlaag:
1. Kies Vector-analyse ► ‘Dichtstbijzijnde buur’-analyse.
2. Selecteer, in het dialoogvenster dat verschijnt, de laag Random samples en klik op Uitvoeren.
3. De resultaten zullen verschijnen in het paneel van Processing Resultaten bekijken.

4. Klik op de blauwe link om de HTML- pagina met de resultaten te bekijken:
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6.4.5 Follow Along: Gemiddelde coördinaten

De gemiddelde coördinaten van een gegevensset verkrijgen:
1. Start Vector-analyse ► Gemiddelde coördin(a)t(en)

2. Specificeer, in het dialoogvenster dat verschijnt,Willekeurige punten als Invoerlaag, en laat de optionele keuzen
ongewijzigd.

3. Klik op Uitvoeren.
Laten we dit eens vergelijken met de centrale coördinaat van de polygoon die werd gebruikt om het willekeurige
monster te maken.

1. Start Vector geometrie ► Zwaartepunten

2. Selecteer, in het dialoogvenster dat verschijnt, Begrenzing geometrie als de invoerlaag.
Zoals u kunt zien vallen de gemiddelde coördinaten (roze punt) en het middelpunt van het gebruikte gebied (in groen)
niet noodzakelijkerwijze samen.
Het zwaartepunt is het barycenter van de laag (het barycenter van een vierkant is het midden van het vierkant), terwijl
de gemiddelde coördinaten het gemiddelde weergeven van alle coördinaten van de knopen.
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6.4.6 Follow Along: Histogrammen van afbeeldingen

Het histogram van een gegevensset geeft de verdeling van de waarden ervan weer. De eenvoudigste manier om dit in
QGIS te demonstreren is via het histogram van een afbeelding, beschikbaar in het dialoogvenster Laageigenschappen
van elke afbeeldingslaag (raster gegevensset).

1. Klik, in uw paneel Lagen, met rechts op de laag srtm_41_19.
2. Selecteer Eigenschappen
3. Kies de tabHistogram. U moet misschien op de knopHistogram herberekenen klikken om de grafiek te maken.

U zult een grafiek zien die verdeling van de frequentie van de rasterwaarden weergeeft.
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4. De grafiek kan met de knop Plot opslaan worden geëxporteerd als een afbeelding
5. U kunt meer gedetailleerde informatie over de laag vinden op de tab Informatie (het gemiddelde en maximum

waarde zijn geschat, en zouden niet exact kunnen zijn).
De gemiddelde waarde is 332.8 (geschat op 324.3), en de maximum waarde is 1699 (geschat op 1548)! U kunt
zoomen in het histogram. Het histogram ziet er verticaal gecomprimeerd uit, omdat er heel veel pixels met de waarde
0 zijn. Door in te zoomen om alles, behalve de piek op 0, te bedekken zult u meer details zien:
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Notitie: Als de waarden gemiddelde enmaximum niet hetzelfde zijn als hierboven, kan dat komen door de berekening
van de waarden min/max. Open de tab Symbologie en vergroot het menu Instellingen min / max waarden. Kies
Min / max en klik op Apply.

Onthoud dat een histogram u de verdeling van de waarden laat zien en dat niet alle waarden noodzakelijkerwijze ook
zichtbaar zijn in de grafiek.
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6.4.7 Follow Along: Ruimtelijke interpolatie

Laten we zeggen dat u een collectie monsterpunten heeft van waaruit u gegevens wilt extrapoleren. U heeft misschien
toegang tot de gegevenssetMonsterpunten die we eerder gemaakt hebben en wil een idee krijgen over hoe het terrein
eruit ziet.

1. Start, om te beginnen, het gereedschap GDAL ► Rasteranalyse ► Raster (IDW met zoeken naar Nearest
neighbor) in de Toolbox van Processing.

2. Selecteer ``Monsterpunten``als Puntenlaag
3. Stel Gewogen macht in op 5.0
4. Stel, in Gevorderde parameters, rvalue_1 in voor Z-waarde uit veld

5. Klik tenslotte op Uitvoeren en wacht tot de verwerking is voltooid.
6. Sluit het dialoogvenster

Hier is een vergelijking van de originele gegevensset (links) met die welke we hebben gemaakt uit onze monsterpunten
(rechts). Die van u kan er anders uitzien vanwege de willekeurige herkomst van de locatie van de monsterpunten.

Zoals u kunt zien zijn 100 monsterpunten niet echt genoeg om een gedetailleerde impressie van het terrein te maken.
Het geeft een zeer algemeen idee, maar het kan ook misleidend zijn.

6.4.8 Try Yourself Verschillende methoden voor interpolatie

1. Gebruik de hierboven weergegeven processen om een nieuwe set van 10.000 willekeurige punten te maken

Notitie: Als het aantal punten echt heel groot is kan de verwerkingstijd behoorlijk oplopen.

2. Gebruik deze punten om een monster te nemen uit de originele DEM
3. Gebruik het gereedschap Raster (IDW met zoeken naar Nearest neighbor) op deze gegevensset
4. Stel Macht en Afvlakken respectievelijk in op 5.0 en 2.0.

De resultaten (afhankelijk van de positie van uw willekeurige punten) zal er min of meer zo uitzien:
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Dit is een betere weergave van het terrein, vanwege de hogere dichtheid van monsterpunten. Onthoud: meer monsters
geven betere resultaten.

6.4.9 In Conclusion

QGIS heeft een aantal gereedschappen voor het analyseren van ruimtelijke statistische eigenschappen van
gegevenssets.

6.4.10 What’s Next?

Nu we vectoranalyse hebben behandeld, waarom niet eens kijken wat er met rasters gedaan kan worden? Dat is wat
we zullen gaan doen in de volgende module!
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Module: Rasters

We hebben eerder rasters gebruikt voor het digitaliseren, maar rastergegevens kunnen ook direct worden gebruikt. In
deze module zult u zien hoe dat wordt gedaan in QGIS.

7.1 Werken met rastergegevens

Rastergegevens zijn heel anders dan vectorgegevens. Vectorgegevens hebben verschillende objecten met geometrieën
die zijn geconstrueerd uit punten en misschien verbonden met lijnen en/of gebieden. Rastergegevens echter zijn als
een afbeelding. Hoewel het verschillende eigenschappen van objecten in de echte wereld kan weergeven, bestaan
deze objecten niet als afzonderlijke objecten. In plaats daarvan worden zij weergegeven door pixels met verschillende
waarden.
Gedurende deze module gaat u rastergegevens gebruiken om uw bestaande GIS-analyse aan te vullen.
Het doel voor deze les: Leren hoe te werken met rastergegevens in QGIS.

7.1.1 Follow Along: Rastergegevens laden

Rastergegevens kunnen met dezelfde methoden worden geladen als die we gebruikten voor vectorgegevens. We
adviseren echter het paneel Browser te gebruiken.

1. Open het paneel Browser en breidt de map exercise_data/raster uit.
2. Laadt alle gegevens in deze map:

• 3320C_2010_314_RGB_LATLNG.tif

• 3320D_2010_315_RGB_LATLNG.tif

• 3420B_2010_328_RGB_LATLNG.tif

• 3420C_2010_327_RGB_LATLNG.tif

U zou de volgende kaart moeten zien:
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Daar hebben we ze - vier luchtfoto’s die ons gehele gebied bedekken.

7.1.2 Follow Along: Een virtueel raster maken

Zoals u hier kunt zien ligt uw laag voor de oplossing over alle vier de foto’s. Wat dit betekent is dat u altijd moet
werken met alle vier rasters. Dat is niet ideaal; het zou beter zijn om slechts één bestand te hebben ommee te werken.
Gelukkig stelt QGIS u in staat om exact dat te doen en zonder de noodzaak om feitelijk een nieuw rasterbestand te
maken. U kunt een Virtueel rastermaken. Dit wordt vaak een Catalogus genoemd, wat zijn functie verklaart. Het is
niet echt een nieuw raster. In plaats daarvan is het een manier om uw bestaande rasters te beheren in één catalogus:
één bestand voor gemakkelijke toegang.
Voor het maken van een catalogus zullen we de Processing ► Toolbox gebruiken.

1. Open het algoritme Virtueel raster bouwen uit GDAL ► Raster diversen;
2. Klik, in het dialoogvenster dat verschijnt, op de knop… naast de parameter Input layers en selecteer alle lagen

of gebruik de knop Alles selecteren;
3. Deselecteer Place each input file into a separate band. Let op het tekstveld onderin. Wat dit dialoogvenster in

feite doet, is dat het die tekst voor u schrijft. Het is een lange opdracht die QGIS gaat uitvoeren.

Notitie: Onthoud dat u de tekst kunt kopiëren en plakken in de OSGeo Shell (Windows-gebruiker) of
Terminal (Linux- en OSX-gebruikers) om de opdracht uit te voeren. U kunt ook een script maken voor
elke opdracht van GDAL. Dit is bijzonder handig wanneer de procedure veel tijd vergt of wanneer u specifieke
taken in schema wilt zetten. Gebruik de knopHelp ommeer hulp te krijgen voor de syntaxis van de opdrachten.

4. Klik tenslotte op Uitvoeren.

Notitie: Zoals u al weet uit de eerdere modules maakt Processing standaard tijdelijke lagen. Klik op de knop… om
het bestand op te slaan.
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Ukunt nu de originele vier rasters uit het paneel Lagen verwijderen en alleen het uitvoerraster van de virtuele catalogus
behouden.
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7.1.3 Rastergegevens transformeren

De bovenstaande methoden stellen u in staat gegevenssets virtueel samen te voegen met behulp van een catalogus
en ze opnieuw “direct” te projecteren. Echter, als u gegevens instelt die u geruime tijd niet zal gebruiken, zou het
meer efficiënt zijn om nieuwe rasters te maken die al samengevoegd en opnieuw geprojecteerd zijn. Dat verbetert de
uitvoering bij het gebruiken van de rasters in een kaart, maar het kan enige tijd duren om het in het begin in te stellen.

Rasters opnieuw projecteren

OpenWarp (opnieuw projecteren) uit GDAL ► Rasterprojecties.
U kunt ook virtuele rasters (catalogussen) opnieuw projecteren, multithreaded verwerken inschakelen, en meer.
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Rasters samenvoegen

Wanneer u een nieuwe rasterlaag moet maken en die op schijf opslaan kunt u het algoritme Merge gebruiken.

Notitie: Afhankelijk van hoeveel rasterbestanden u samenvoegt en hun resolutie, kan het nieuw gemaakte
rasterbestand behoorlijk groot zijn. Overweeg daarom om een rastercatalogus te maken, zoals beschreven in het
gedeelte Een virtueel raster maken.

1. Klik op het algoritme Merge uit het menu GDAL ► Raster diversen.
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2. Gebruik, zoals we deden voor het Een virtueel raster maken, de knop … om te kiezen welke lagen u wilt
samenvoegen.
U kunt ook een Virtueel raster als invoer specificeren, en dan zullen alle rasters waaruit dat bestaat worden
verwerkt.

3. Als u de bibliotheek GDAL kent, kunt u ook uw eigen opties toevoegen door het menu Gevorderde parameters
te openen.
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7.1.4 In Conclusion

QGIS maakt het eenvoudig om rastergegevens in uw huidige projecten op te nemen.

7.1.5 What’s Next?

Vervolgens zullen we rastergegevens gebruiken die geen luchtfoto’s zijn en zien hoe symboliseren ook handig is in het
geval van rasters.

7.2 Lesson: Symbologie van rasters wijzigen

Niet alle rastergegevens zijn luchtfoto’s. Er zijn vele andere vormen van rastergegevens en, in veel van deze gevallen,
is het essentieel om ze juist te symboliseren, zodat zij op de juiste manier zichtbaar en bruikbaar worden.
Het doel voor deze les De symbologie voor een rasterlaag wijzigen.

7.2.1 Try Yourself

1. Gebruik het paneel Browser en laadt srtm_41_19.tif, te vinden onder exercise_data/raster/
SRTM/.

2. Zoom naar het bereik van deze laag door er met rechts op te klikken in het paneel Lagen en te selecteren Op
kaartlaag inzoomen.

Deze gegevensset is een Digital Elevation Model (DEM). Het is een kaart van de hoogte van het terrein, wat ons
bijvoorbeeld in staat stelt te zien waar de bergen en valleien zijn.
Waar elke pixel van de gegevensset uit het vorige gedeelte kleurinformatie bevatte, in een DEM bevat elke pixel
waarden voor hoogte.
Als de DEM eenmaal is geladen, zult u zien dat het een weergave in grijswaarden is:
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QGIS heeft automatisch de pixelwaarden van de afbeelding opgerekt om redenen van visualisatie en we zullen meer
leren over hoe dit werkt als we doorgaan.

7.2.2 Follow Along: Symbologie van rasterlagen wijzigen

U heeft twee verschillende opties om de symbologie van het raster te wijzigen:
1. In het dialoogvenster Laageigenschappen, door met rechts te klikken op de laag in de boom met lagen en de

optie Eigenschappen te selecteren. Schakel dan over naar de tab Symbologie

2. Door te klikken op de knop Paneel Laag opmaken openen direct boven het paneel Lagen (sneltoets F7). Dit zal

het paneel Laag opmaken openen waar u kunt schakelen naar de tab Symbologie.
Kies de methode die uw voorkeur heeft om mee te werken.
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7.2.3 Follow Along: Enkelbands grijs

Wanneer u een rasterbestand laadt, is het geen fotoafbeelding zoals die uit het vorige gedeelte, de standaard stijl is
ingesteld op een grijswaarden kleurverloop.
Laten we enkele van de mogelijkheden van deze renderer verkennen.

Het standaard kleurverloop Kleurovergang is ingesteld op Zwart naar wit, wat betekent dat pixels met lage
waarden zwart zijn en pixels met hoge waarden zijn wit. Probeer deze instelling te wijzigen naar Wit naar zwart
en bekijk de resultaten.
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Zeer belangrijk is de parameter Contrastverbetering: standaard is die ingesteld op 'Stretch' tot MinMax, wat
betekent dat de pixelwaarden zijn uitgestrekt tot de minimum- en maximumwaarden.
Kijk naar het verschil met de verbetering (links) en zonder (rechts):

Maar wat zijn de minimale en maximale waarden die zouden moeten worden gebruikt voor het uitrekken? Die
zijn momenteel vermeld onder Instellingen min / max-waarden. Er zijn veel manieren om de minimum- en
maximumwaarden te berekenen en te gebruiken voor het uitstrekken:

1. Door gebruiker gedefinieerd: u voert de waarden Min en Max handmatig in
2. Cumulatieve telling deel: dit is nuttig als u enkele extreem lage of hoge waarden hebt. Het deelt de 2% (of de

waarde die u kiest) van deze waarden
3. Min / max: de echte of geschatte minimum en maximum waarden van het raster;
4. Gemiddelde +/- standaard afwijking: de waarden zullen worden berekend overeenkomstig de gemiddelde

waarde en de standaardafwijking

7.2.4 Follow Along: Enkelbands pseudokleur

Grijswaarden zijn niet altijd geweldige stijlen voor rasterlagen. Laten we eens proberen de laag DEM wat meer kleur
te geven.

• Wijzig het Rendertype naar een Enkelbands pseudokleur. Selecteer een ander Kleurverloop, als de geladen
standaardkleuren u niet bevallen

• Klik op de knop Classificeren om een nieuwe kleurclassificatie te maken
• Als het nog niet automatisch is gemaakt, klik dan op de knop OK om deze classificatie toe te passen op de
DEM
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U zult zien dat het raster er als volgt uitziet:
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Dit is een interessante manier om naar de DEM te kijken. U zult nu zien dat de waarden van het raster weer opnieuw
juist zijn weergegeven, van blauw voor de lagere gebieden naar rood voor de hogere.

7.2.5 Follow Along: Transparantie wijzigen

Soms kan het wijzigen van de transparantie van de gehele rasterlaag u helpen om andere lagen te zien die worden
bedekt door het raster zelf en het te bestuderen gebied beter te begrijpen.
Schakel, om de transparantie van het gehele raster te wijzigen, over naar de tab Transparantie en gebruik de schuif
van Globale doorzichtbaarheid om de doorzichtbaarheid te verlagen:
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Nog interessanter is het wijzigen van de transparantie van enkele pixelwaarden. Bijvoorbeeld in het raster dat we
gebruikten kunt u een homogene kleur zien in de hoeken. Ga naar to Aangepaste opties voor transparantie ` op de tab
:guilabel:`Transparantie om deze pixels als transparant in te stellen.

• Door te klikken op de knop Voeg handmatig waarden in kunt u een bereik vanwaarden toevoegen en het percentage
voor hun transparantie instellen

• Voor enkele waarden is de knop Waarden uit weergave toevoegen nog nuttiger

• Klik op de knop Waarden uit weergave toevoegen. Het dialoogvenster verdwijnt en u kunt interactief met de kaart
werken;

• Klik op de homogene kleur in een hoek van de DEM
• U zult zien dat de tabel van de transparantie wordt gevuld met de aangeklikte waarden:
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• Klik op OK om het dialoogvenster te sluiten en uw wijzigingen te bekijken.

Ziet u? De hoeken zijn nu 100% transparant.
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7.2.6 In Conclusion

Dit zijn enkele van de basisfuncties om u te laten beginnen met symbologie voor rasters. QGIS geeft u nog veel
meer andere opties, zoals het symboliseren van een laag met paletten/unieke waarden die verschillende banden in
verschillende kleuren in eenmultispectrale afbeelding weergeven of een automatisch effect van schaduw op de heuvels
maken (alleen nuttig met rasterbestanden van DEM).

7.2.7 Verwijzing

De gegevensset van SRTM werd verkregen vanaf http://srtm.csi.cgiar.org/

7.2.8 What’s Next?

Nuwe kunnen zien dat onze gegevens juist zijn weergegeven, kunnen we onderzoeken hoe ze verder zijn te analyseren.

7.3 Lesson: Terreinanalyse

Bepaalde typen rasters stellen u in staat meer inzicht te verkrijgen over het terrein dat zij weergeven. Digital
Elevation Models (DEM’s) zijn in dit opzicht in het bijzonder bruikbaar. In deze les zult u gereedschappen voor
terreinanalyses gebruiken om meer uit te vinden over het te bestuderen gebied voor het eerder voorgestelde te
ontwikkelen woongebied.
Het doel voor deze les: Gereedschappen voor terreinanalyses gebruiken om meer informatie over het terrein te
verkrijgen.

7.3.1 Follow Along: Een schaduw voor heuvels berekenen

We gaan dezelfde DEM-laag gebruiken als in de vorige les. Als u nieuw aan dit hoofdstuk begint, gebruik dan het
paneel Browser en laad het bestand raster/SRTM/srtm_41_19.tif.
DeDEM-laag toont u de hoogten in het terrein, maar het kan er somswat abstract uitzien. Het bevat alle 3D-informatie
over het terrein die u nodig heeft, maar het ziet er niet uit als een 3D-object. Het is mogelijk een schaduw voor heuvels
te berekenen, wat een raster is dat de kaart weergeeft met behulp van licht en een schaduw om het uiterlijk van een
3D-afbeelding aan te nemen, om een betere indruk van het terrein te krijgen.
We gaan de algoritmen in het menu Raster ► Raster terreinanalyse gebruiken.

1. Klik op het menu Schaduw voor heuvels

2. Het algoritme stelt u in staat de positie van de lichtbron te specificeren: Azimut heeft waarden van 0 (Noord)
via 90 (Oost), 180 (Zuid) en 270 (West), terwijl de Verticale hoek instelt hoe hoog de lichtbron is (0 tot en met
90 graden).

3. We zullen de volgende waarden gebruiken:
• Z factor op 1.0
• Azimut (horizontale hoek) op 300.0°
• Verticale hoek op 40.0°
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4. Sla het bestand op in een nieuwe map exercise_data/raster_analysis/ met de naam
hillshade

5. Klik tenslotte op Uitvoeren

U zult nu een nieuwe laag, genaamd hillshade, hebben die er uitziet zoals dit:
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Dat ziet er leuk en 3D uit, maar kunnen we dit verbeteren? Op zichzelf ziet de schaduw voor de heuvels er uit als een
gipsafdruk. Kunnen we het op een of andere manier gebruiken met onze, meer kleurrijke, rasters? Natuurlijk kunnen
we dat, door de schaduw voor de heuvels er overheen te leggen.

7.3.2 Follow Along: Schaduw voor heuvels gebruiken door er overheen
te leggen

Een schaduw voor heuvels kan heel bruikbare informatie verschaffen over het zonlicht op een bepaald moment van de
dag. Maar het kan ook voor esthetische doeleinden gebruikt worden om de kaart er beter uit te laten zien. De sleutel
hiertoe is de schaduw voor de heuvels in te stellen op bijna geheel transparant.

1. Wijzig de symbologie van de originele laag srtm_41_19 om het schema Pseudokleur te gebruiken, zoals in de
eerdere oefening.

2. Verberg alle lagen met uitzondering van de lagen srtm_41_19 en hillshade.
3. Klik en sleep srtm_41_19 tot onder de laag hillshade in het paneel Lagen.
4. Stel de laag hillshade in op transparant door te klikken op de tab Transparantie in de Laageigenschappen.
5. Stel de Globale transparantie in op 50%:

U krijgt een resultaat zoals dit:

6. Schakel de laag hillshade uit en weer in in het paneel Lagen om het verschil dat het maakt te zien.
Met het op deze manier gebruiken van een schaduw voor heuvels, is het mogelijk de topografie van het landschap te
verbeteren. Als het effect voor u niet sterk genoeg lijkt te zijn, kunt u de transparantie van de laag hillshade vergroten;
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maar natuurlijk geldt: hoe helderder de schaduw van de heuvels wordt, hoe vager de kleuren erachter zullen zijn. U
dient een balans te vinden die voor u werkt.
Onthoud om het project op te slaan als u gereed bent.

7.3.3 Follow Along: De beste gebieden zoeken

Denk even terug aan het probleem van de makelaar dat we bespraken in de les Vectoranalyse. Laten we ons eens
voorstellen dat de kopers een gebouw willen kopen en een kleinere woning willen bouwen op het land. We weten dat,
in de zuidelijke hemisfeer, een ideaal gebied voor ontwikkeling gebieden erin moet hebben die:

• uitkijken op het noorden
• met een helling van minder dan 5 graden
• Maar als de helling minder is dan 2 graden, dan is het aspect niet van belang.

Laten we de beste gebieden voor ze zoeken.

7.3.4 Follow Along: Berekenen van de helling

Helling informeert u over hoe steil het terrein is. Als u bijvoorbeeld huizen wilt bouwen op het land daar, heeft u land
nodig dat relatief vlak is.
U moet het algoritme Helling van Processing ► Raster terreinanalyse gebruiken om de helling te berekenen.

1. Open het algoritme
2. Kies srtm_41_19 als de Hoogtelaag

3. Houd de Z factor op 1.0
4. Sla de uitvoer op als een bestand met de naam slope in dezelfde map als de laag hillshade
5. Klik op Uitvoeren

Nu zult u de helling van het terrein zien, elke pixel bevat de overeenkomende waarde voor de helling. Zwarte pixels
geven vlak terrein aan en witte pixels steil terrein:
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7.3.5 Try Yourself Berekenen van het aspect

Aspect is de richting van het kompas waarop de helling van het terrein uitkijkt. Een aspect van 0 betekent dat de
helling uitkijkt op het noorden, 90 op het oosten, 180 op het zuiden en 270 op het westen.
Omdat deze studie plaatsvindt in de zuidelijke hemisfeer, zouden gebouwen ideaal gesprokenmoeten worden gebouwd
op een helling die uitkijkt op het noorden, zodat zij in het zonlicht blijven.
Gebruik het algoritme Aspect van Processing► Raster terreinanalyse om de laag aspect te krijgen en die op te slaan
naast slope.
Controleer uw resultaten

7.3.6 Follow Along: Het aspect zoeken dat op het noorden uitkijkt

Nu heeft u rasters die u zowel de helling als het aspect weergeven, maar u heeft geen manier om te weten te komen
waar tegelijkertijd aan ideale voorwaarden wordt voldaan. Hoe zou deze analyse worden uitgevoerd?
Het antwoord ligt in de Rasterberekeningen.
QGIS heeft verschillende rasterberekeningen beschikbaar:

• Raster ► Rasterberekeningen

• In Processing:
– Rasteranalyse ► Raster calculator
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– GDAL ► Raster diversen ► Rasterberekeningen

– SAGA ► Raster calculus ► Raster calculator

Elk gereedschap leidt tot dezelfde resultaten, maar de syntaxis kan enigszins verschillen en de beschikbaarheid van
operatoren kan variëren.
We zullen Rasteranalyse ► Raster calculator in de Toolbox van Processing gebruiken

1. Open het gereedschap door er dubbel op te klikken.
• Het bovenste gedeelte aan de linkerkant van het dialoogvenster vermeldt alle geladen rasterlagen als
name@N waar name de naam is van de laag en N de band is.

• In het bovenste gedeelte aan de rechterkant ziet u veel verschillende operatoren. Neem even de tijd om
er aan te denken dat een raster een afbeelding is. U zou het moeten zien als een 2D-matrix, gevuld met
getallen.

2. Noord ligt op 0 (nul) graden, dus voor het terrein dat op het noorden uitkijkt moet het aspect groter zijn dan
270 graden of minder dan 90 graden. Daarom is de formule:

aspect@1 <= 90 OR aspect@1 >= 270

3. Nu dient u de details voor het raster in te stellen, zoals de celgrootte, bereik en CRS. Dat kan handmatig
worden gedaan of het kan automatisch worden ingesteld door een Referentielaag te kiezen. Kies voor
deze laatste optie door te klikken op de knop… naast de parameter Reference layer(s).

4. Kies in het dialoogvenster voor de laag aspect, omdat we een laag willen met dezelfde resolutie.
5. Sla de laag op als aspect_north.

Het dialoogvenster zou er nu zo uit moeten zien:
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6. Klik tenslotte op Uitvoeren.
Uw resultaat zal dit zijn:

De waarden voor de uitvoer zijn 0 of 1. Wat betekent dat? Voor elke pixel in het raster geeft de formule die we
schreven terug of die overeenkomt met de voorwaarden of niet. Daarom zal het uiteindelijke resultaat False (0) en
True (1) zijn.

7.3.7 Try Yourself Meer criteria

Nu u het aspect heeft gedaan, maak twee nieuwe lagen uit de DEM.
• De eerste zal gebieden identificeren waar de helling minder is dan of gelijk is aan 2 graden.
• De tweede is soortgelijk, maar de helling zou minder of gelijk moeten zijn aan 5 graden.
• Sla ze op onder exercise_data/raster_analysis/ als slope_lte2.tif en slope_lte5.
tif.

Controleer uw resultaten
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7.3.8 Follow Along: Resultaten van rasteranalyses combineren

Nu heeft u drie rasterlagen gemaakt uit de DEM:
• aspect_north: het terrein kijkt uit op het noorden
• slope_lte2: de helling is 2 graden of minder
• slope_lte5: de helling is 5 graden of minder

Waar aan de voorwaarde wordt voldaan, is de pixelwaarde 1. Ergens anders is het 0. Daarom, als u deze rasters
vermenigvuldigt, zullen de pixels, die een waarde van 1 voor allemaal hebben, een waarde van 1 krijgen (de rest zal
0 krijgen).
De voorwaarden, waaraan moet worden voldaan, zijn:

• gelijk aan of minder dan 5 graden helling, het terrein moet op het noorden liggen
• gelijk aan of minder dan 2 graden helling, de richting waarop het terrein uitkijkt is niet van belang.

Daarommoet u zoeken naar gebieden waar de helling vijf graden of minder is AND het terrein uitkijkt op het noorden;
OR de helling is 2 graden of minder. Dergelijk terrein zou geschikt zijn voor ontwikkeling.
De gebieden berekenen die voldoen aan deze criteria:

1. Open opnieuw de Raster calculator opnieuw
2. Gebruik deze expressie in Expressie:

( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

3. Stel de parameter Reference layer(s) in als aspect_north (het maakt niet uit of u een andere kiest - zij zijn
allemaal berekend vanuit srtm_41_19)

4. Sla de uitvoer op onder exercise_data/raster_analysis/ als all_conditions.tif.
5. Klik op Uitvoeren

Het resultaat:
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Hint: De eerdere stappen zouden kunnen worden vereenvoudigd met de volgende opdracht:

((aspect@1 <= 90 OR aspect@1 >= 270) AND slope@1 <= 5) OR slope@1 <= 2

7.3.9 Follow Along: Het raster vereenvoudigen

Zoals u in bovenstaande afbeelding kunt zien, staan in de gecombineerde analyse vele kleine gebieden die voldoen
aan de voorwaarden (in wit). Maar deze zijn niet echt bruikbaar voor onze analyse, omdat ze te klein zijn om er iets
op te bouwen. Laten we deze kleine onbruikbare gebieden verwijderen.

1. Open het gereedschap Sieve (GDAL ► Rasteranalyse in de :guilabel:` Toolbox` van Processing)
2. Stel Invoerlaag in op all_conditions, en Gezeefd op all_conditions_sieve.tif (onder

exercise_data/raster_analysis/).
3. Stel Drempel in op 8 (minimaal acht aaneengesloten pixels), en selecteer 8-connectedness gebruiken.
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Als de verwerking is voltooid, zal de nieuwe laag worden geladen.
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Wat is er aan de hand? Het antwoord ligt in de metadata van het nieuwe rasterbestand.
4. Bekijk de metadata onder de tab Informatie van het dialoogvenster Laageigenschappen. Kijk naar de waarde

STATISTICS_MINIMUM:

7.3. Lesson: Terreinanalyse 251



QGIS Training Manual

Dit raster, net zoals die waaruit het is afgeleid, zou alleen de waarden 1 en 0 zou moeten hebben, maar het
heeft ook een heel groot negatief getal. Onderzoek van de gegevens geeft aan dat dit getal optreedt als een
waarde null. Omdat we alleen gebieden willen die niet uitgefilterd werden, zullen we deze waarden null op nul
instellen.

5. Open de Raster calculator en bouw deze expressie:

(all_conditions_sieve@1 <= 0) = 0

Dit zal alle niet-negatieve waarden behouden, en de negatieve getallen instellen op nul, wat alle gebieden met
de waarde 1 intact zal laten.

6. Sla de uitvoer op onder exercise_data/raster_analysis/ als all_conditions_simple.
tif.

Uw uitvoer ziet er uit zoals dit:

Dit is wat er verwacht werd: een vereenvoudigde versie van de eerdere resultaten. Onthoud dat als de resultaten die u
van een gereedschap krijgt niet zijn wat u er van verwacht, het bekijken van de metadata (en vectorattributen indien
van toepassing) essentieel kan blijken te zijn om het probleem op te lossen.

7.3.10 Follow Along: Het raster opnieuw classificeren

We hebben het gereedschap Raster calculator gebruikt om berekeningen op rasterlagen te maken. Er is nog een ander
krachtig gereedschap dat we kunnen gebruiken om informatie uit bestaande lagen uit te nemen.
Terug naar de laag aspect. We weten nu dat die numerieke waarden heeft in het bereik van 0 tot en met 360.
Wat we willen doen is om deze laag opnieuw te classificeren naar andere afzonderlijke waarden (van 1 tot en met 4),
afhankelijk van het aspect:

• 1 = Noord (van 0 tot 45 en van 315 tot 360);
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• 2 = Oost (van 45 tot 135)
• 3 = Zuid (van 135 tot 225)
• 4 = West (van 225 tot 315)

Deze bewerking kan worden uitgevoerd met de Raster calculator, maar de formule zou enorm lang worden.
Het alternatieve gereedschap is het gereedschap Opnieuw classificeren op tabel in Rasteranalyse in de Toolbox van
Processing.

1. Open het gereedschap
2. Kies aspect als de Rasterlaag
3. Klik op de … van Tabel voor opnieuw classificeren. Een tabel-achtig dialoogvenster zal openen waar u de

minimum, maximum en nieuwe waarden voor elke klasse kunt kiezen.
4. Klik op de knop Regel toevoegen en voeg 5 rijen toe. Vul elke rij in zoals in de volgende afbeelding en klik op

OK:

De door het algoritme gebruikte methode, hoe de drempelwaarden van elke klasse te behandelen, wordt
gedefinieerd door Grenzen bereik.

5. Sla de laag op als reclassified.tif in de map exercise_data/raster_analysis/
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6. Klik op Uitvoeren

Wanneer u de eigen laag aspect vergelijkt met de reclassified, zijn er geen grote verschillen. Maar door eens naar de
legenda te kijken, kunt u zien dat de waarden lopen van 1 tot en met 4 .
Laten we deze laag eens een betere stijl geven.

1. Open het paneel Laag opmaken

2. Kies Gepaletteerd/Unieke waarden, in plaats van Enkelbands grijs
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3. Klik op de knop Classificeren om automatisch de waarden op te halen en ze nieuwe willekeurige kleuren toe te
wijzen:

De uitvoer zou er nu ongeveer zo uit moeten zien (u kunt andere kleuren hebben omdat die willekeurig werden
gemaakt):
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Met dit opnieuw classificeren en de toegepaste gepaletteerde stijl op de laag kunt u direct de gebieden van aspect
onderscheiden.

7.3.11 Follow Along: Het raster bevragen

Anders dan vectorlagen hebben rasterlagen geen attributentabel. Elke pixel bevat één of meer numerieke waarden
(afhankelijk van enkelbands of multiband rasters).
Alle rasterlagen die we gebruikten in deze oefening bestaan uit slechts één enkele band. Afhankelijk van de laag
zouden pixelwaarden de waarden voor hoogte, aspect of helling weer kunnen geven.

Hoe kunnen we de rasterlaag bevragen om de waarde van één enkele pixel op te halen? We kunnen de knop
Objecten identificeren gebruiken!

1. Selecteer het gereedschap op de werkbalk Attributen.
2. Klik op een willekeurige locatie op de laag srtm_41_19. Identificatieresultaten zal verschijnen met de waarde

van de band op de aangeklikte locatie:
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3. U kunt de uitvoer van het paneel Identificatieresultaten wijzigen van de huidige modus boom naar een tabel
door Tabel te selecteren in het menuWeergave aan de onderzijde van het paneel:

Klikken op elke pixel om de waarde van het raster te verkrijgen zou op den duur vervelend kunnen worden. We
kunnen de plug-in Value Tool gebruiken om dit probleem op te lossen.

1. Ga naar Plug-ins ► Plug-ins beheren en installeren…

2. Typ, op de tab Alles, value t in het zoekvak
3. Selecteer de plug-in Value Tool, druk op Plug-in installeren en dan Close het dialoogvenster.
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Het nieuwe paneel Value Tool zal verschijnen.

Tip: Als u het paneel sluit kunt u het opnieuw openen door het in te schakelen in het menu Beeld ► Panelen
► Value Tool of door te klikken op het nieuwe pictogram op de werkbalk.

4. Selecteer, om de plug-in te gebruiken, het keuzevak Enable en zorg er voor dat de laag srtm_41_19 actief
(geselecteerd) is in het paneel Lagen.

5. Verplaats de cursor over de kaart om direct de waarde van de pixels te zien.
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6. Maar er is meer. De plug-in Value Tool maakt het voor u mogelijk alle actieve rasterlagen in het paneel Lagen
te bevragen. Stel de lagen aspect en slope opnieuw in als actief en ga met de muis over de kaart:

7.3.12 In Conclusion

U heeft gezien hoe u alle soorten analyseproducten uit een DEM kunt halen. Dit omvat berekeningen voor schaduw
voor heuvels, helling en aspect. U heeft ook gezien hoe de rasterberekeningen te gebruiken voor verdere analyses
en het combineren van deze resultaten. Tenslotte leerde u hoe een laag opnieuw te classificeren en de resultaten te
bevragen.

7.3.13 What’s Next?

Nu heeft u twee analyses: de vectoranalyse die u de potentieel geschikte bouwplaatsen laat zien, en de rasteranalyse die
u het potentieel geschikte terrein laat zien. Hoe kunnen deze worden gecombineerd om tot een uiteindelijk resultaat
voor dit rp0obleem te komen? Dat is het onderwerp voor de volgende les, die begint in de volgende module.
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Module: De analyse completeren

U heeft nu twee halve analyses: een gedeelte vector en een gedeelte raster. In deze module zult u zien hoe ze te
combineren. U zult de analyse voltooien en de uiteindelijke resultaten presenteren.

8.1 Lesson: Conversie van raster naar vector

Converteren tussen de indelingen raster en vector stelt u in staat gebruik te maken van zowel raster- als vectorgegevens
bij het oplossen van een probleem in GIS, als ook het gebruiken van de verschillende methoden voor analyse uniek
voor deze twee vormen van geografische gegevens. Dit vergroot de flexibiliteit die u heeft voor het overwegen van
gegevensbronnen en verwerkingsmethoden voor het oplossen van een probleem in GIS.
U moet het ene type gegevens converteren naar het andere om een raster- en vectoranalyse te combineren. Laten we
het rasterresultaat uit de vorige les converteren naar een vector.
Het doel voor deze les: Het rasterresultaat in een vector krijgen die kan worden gebruikt om de analyse te voltooien.

8.1.1 Follow Along: Het gereedschap Raster naar vector

Begin met de kaart uit de vorige module, raster_analysis.qgs. Daar zou u all_conditions_simple.
tif moeten hebben die werd berekend gedurende de vorige oefeningen.

• Klik op Raster ► Conversie ► Vectoriseren (Raster naar vector). Het dialoogvenster van het gereedschap zal
verschijnen.

• Stel het in zoals dit:
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• Wijzig de veldnaam (die de waarden van het raster beschrijft) naar suitable.
• Sla de laag op onder exercise_data/residential_development als all_terrain.shp.

Nu heeft u een vectorbestand dat alle waarden van het raster bevat, maar de enige gebieden waarin u geïnteresseerd
bent zijn die welke geschikt zijn; d.i. die polygonen waarvan de waarde van suitable 1 is. U kunt de stijl van deze laag
wijzigen als u een betere visualisatie ervan wilt.

8.1.2 Try Yourself

Bekijk de module over vectoranalyse nog eens.
• Maak een nieuw vectorbestand dat alleen de polygonen bevat waar suitable de waarde 1 heeft.
• Sla het nieuwe bestand op onder exercise_data/residential_development/ als
suitable_terrain.shp.

Controleer uw resultaten
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8.1.3 Follow Along: Het gereedschap Vector naar raster

Hoewel niet nodig voor ons huidige probleem, is het handig om de tegengestelde conversie van die welke we hiervoor
hebben uitgevoerd te kennen. Converteer het vectorbestand suitable_terrain.shp dat u zojuist in de vorige
stap heeft gemaakt naar raster.

• Klik op Raster ► Conversie ► Rasteriseren (Vector naar raster) om dit gereedschap te starten, en stel het dan
in zoals in de schermafdruk hieronder:

• Invoerlaag is all_terrain.
• Veldnaam is suitable.
• Eenheden grootte uitvoerraster is Pixels.
• Breedte en Hoogte zijn respectievelijk 837 en 661.
• Haal het Uitvoerbereik op vanaf de laag all_terrain.
• Stel uitvoerbestand Gerasteriseerd in op exercise_data/residential_development/
raster_conversion.tif.
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Notitie: De grootte van de uitgevoerde afbeelding is hier gespecificeerd om hetzelfde te zijn als het originele raster
dat werd geconverteerd naar een vector. Open de metadata (tabMetadata in de Laag-eigenschappn) om de dimensies
van een afbeelding te bekijken.

• Klik op OK in het dialoogvenster om het conversieproces te beginnen.
• Wanneer het voltooid is, bewonder dan het succes door het nieuwe raster te vergelijken met het originele. Zij
zouden exact gelijk moeten zijn, pixel voor pixel.

8.1.4 In Conclusion

Converteren tussen indelingen voor raster en vector stelt u in sraat de toepasbaarheid van gegevens te vergroten en
hoeft niet te leiden tot verlies van gegevens.

8.1.5 What’s Next?

Nu we de resultaten van de terreinanalyse beschikbaar hebben in vectorindeling, kunnen zij worden gebruikt om het
probleem op te lossen van welke gebouwen te overwegen voor de stedelijke ontwikkeling.

8.2 Lesson: Combineren van de analyses

Het gebruiken van de gevectoriseerde resultaten van de rasteranalyse stelt u in staat alleen die gebouwen te selecteren
die op geschikt terrein staan.
Het doel voor deze les: De gevectoriseerde terreinresultaten gebruiken om geschikte bouwplaatsen te selecteren.

8.2.1 Try Yourself

1. Sla uw huidige kaart op (raster_analysis.qgs).
2. Open de kaart waarin eerder de vectoranalyse is uitgevoerd (u zou het bestand moeten hebben opgeslagen als

analysis.qgs).
3. Schakel, in het paneel Lagen, deze lagen in:

• hillshade,
• solution (of buildings_over_100)

4. In aanvulling op deze lagen, die al in de kaart zouden moeten zijn geladen van toen u daarin nog werkte, voeg
ook de gegevensset suitable_terrain.shp toe.

5. Als u enkele lagen mist zou u ze moeten vinden in exercise_data/residential_development/
6. Gebruik het gereedschap Kruising (Vector► Geoprocessing-gereedschap) om een nieuwe vectorlaag, genaamd

new_solution.shp, te maken die alleen die gebouwen bevat die kruisen met de laag suitable_terrain.
U zou nu een laag moeten hebben die bepaalde gebouwen als uw oplossing laat zien, bijvoorbeeld:
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8.2.2 Try Yourself Inspecteren van de resultaten

Kijk naar elk gebouw in uw laag new_solution. Vergelijk ze met de laag suitable_terrain door de symbologie voor de
laag new_solution te veranderen zodat het alleen de omtrekken heeft. Wat valt u op aan sommige gebouwen? Zijn zij
alleen geschikt omdat zij kruisen met de laag suitable_terrain? Waarom wel of waarom niet? Welke zou u beoordelen
als ongeschikt?
Controleer uw resultaten

8.2.3 Try Yourself De analyse opnieuw definiëren

U kunt uit de resultaten aflezen dat sommig gebouwen die werden opgenomen niet echt geschikt waren, dus kunnen
we nu de analyse verfijnen.
We willen er zeker van zijn dat onze analyse alleen die gebouwen oplevert die geheel binnen de laag suitable_terrain
vallen. Hoe zou u dit bereiken? Gebruik één of meer gereedschappen voor Vectoranalyse en onthoud dat onze
gebouwen allemaal groter zijn dan 100 m².
Controleer uw resultaten

8.2.4 In Conclusion

U heeft nu de originele onderzoeksvraag beantwoord, en kunt een mening bieden (met redenen omkleed,
geruggesteund door de analyses) voor een aanbeveling met betrekking tot welk gedeelte te ontwikkelen.
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8.2.5 What’s Next?

Vervolgens zult u deze resultaten presenteren als deel van uw tweede opdracht.

8.3 Opdracht

Maak, met behulp van de afdruklay-out, een nieuwe kaart die de resultaten van uw analyse weergeeft. Neem deze
lagen er in op:

• places (met labels),
• hillshade,
• solution (of new_solution),
• roads en
• ofwel aerial_photos of DEM.

Schrijf een korte verklarende tekst om erbij te voegen. Neem in die tekst de criteria op die werden gebruikt in de
overweging om een huis aan te kopen en aanvullend te ontwikkelen, als ook een verklaring voor uw aanbeveling over
welke gebouwen geschikt zijn.

8.4 Lesson: Extra oefening

In deze les zult u door een volledige analyse in QGIS worden geleid.

Notitie: Les ontwikkeld door Linfiniti Consulting (Zuid-Afrika) en Siddique Motala (Cape Peninsula University of
Technology)

8.4.1 Definitie van het probleem

U krijgt de taak om gebieden in en rondom Cape Peninsula te vinden die een geschikte woonomgeving zijn voor een
zeldzame fijnbos plantensoort. Het bereik van uw onderzoeksgebied bedekt Kaapstad en de Cape Peninsula tussen
Melkbosstrand in het noorden en Strand in het zuiden. Botanisten hebben u voorzien van de volgende voorkeuren
voor de betreffende plantensoort:

• Het groeit op hellingen die uitkijken op het oosten
• Het groeit op hellingen met een verloop tussen 15% en 60%
• Het groeit in gebieden die een totale jaarlijkse regenval hebben van > 1000 mm
• Het kan alleen worden gevonden op een afstand van tenminste 250 m van een menselijke nederzetting
• Het gebied met vegetatie waarin het voorkomt zou tenminste een omvang moeten hebben van 6000m2

Als student aan de universiteit heeft u er in toegestemd de plant te zoeken op vier verschillende geschikte stukken
land vanaf uw. U wilt de vier geschikte gebieden gebruiken die het dichtst bij de Universiteit van Kaapstad zijn, ten
opzichte van waar u woont. Gebruik uw vaardigheden in GIS om te bepalen waar u zou moeten zoeken.
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8.4.2 Overzicht van de oplossing

De gegevens voor deze oefening zijn te vinden in de map exercise_data/more_analysis.
U gaat de vier meest geschikte gebieden zoeken die het dichtst bij de universiteit van Kaapstad liggen.
De oplossing zal omvatten:

1. Analyseren van een DEM om de hellingen te zoeken die uitkijken op het oosten en de hellingen met het juiste
verloop

2. Analyseren van een raster voor de regenval om de gebieden te vinden met de juiste hoeveelheid regen
3. Analyseren van de vectorlaag Zoning om gebieden te vinden die verwijderd liggen van menselijke

nederzettingen en van de juiste grootte zijn

8.4.3 Follow Along: Instellen van de kaart

1. Klik op de knop Huidig CRS in de uiterste rechterbenedenhoek van het scherm. Gebruikg, onder de tab CRS
van het scherm dat verschijnt, het gereedschap “Filter” om te zoeken naar “33S”. Selecteer het itemWGS 84 /
UTM zone 33S (met EPSG-code 32733).

2. Klik op OK

3. Sla het project op door te klikken op de knop op de werkbalk Project opslaan, of gebruik het menu-item Project
► Opslaan als….
Sla het op in een nieuwe map genaamd Rasterprac, die u ergens op uw computer zou moeten maken. U
zou in die map ook alle lagen die u maakt moeten opslaan. Sla het project op als uw_naam_fynbos.qgs.

8.4.4 Gegevens in de kaart laden

In order to process the data, you will need to load the necessary layers (street names, zones, rainfall, DEM, districts)
into the map canvas.

Voor vectors…

1. Klik op de knop Databronnen beheren openen op de werkbalk Databronnen beheren en schakel naar de tab
Vector in het dialoogvenster dat verschijnt, of gebruik het menuitem Kaartlagen ► Laag toevoegen ►
Vectorlaag toevoegen….

2. Zorg er voor dat Bestand is geselecteerd
3. Klik op de knop… om te bladeren naar vector gegevensset(s)
4. Open, in het dialoogvenster dat verschijnt, de map exercise_data/more_analysis/Streets.
5. Selecteer het bestand Street_Names_UTM33S.shp
6. Klik op Openen.

Het dialoogvenster sluit en geeft het originele dialoogvenster weer, met het bestandspad gespecificeerd in het
tekstveld naast Vector databron(nen). Dit stelt u in staat er voor te zorgen dat het juiste bestand is geselecteerd.
Het is ook mogelijk het bestandspad handmatig in het veld in te voeren, als u dat zou willen.

7. Klik op Toevoegen. De vectorlaag zal worden geladen in uw kaart. De kleur ervan wordt automatisch
toegewezen. U zult die later wijzigen.

8. Hernoem de laag naar Streets
1. Klik er met rechts op in het paneel Lagen (standaard is dat het paneel aan de linkerkant van het scherm)
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2. Klik op Laag hernoemen in het dialoogvenster dat verschijnt en hernoem het, druk op de toets Enter
indien gereed

9. Herhaal het proces van het toevoegen van de vector, maar selecteer deze keer het bestand
Generalised_Zoning_Dissolve_UTM33S.shp in de map Zoning.

10. Hernoem het naar Zoning.
11. Laad ook de vectorlaag admin_boundaries/Western_Cape_UTM33S.shp in uw kaart.
12. Hernoem die naar Districts.

Voor rasters…

1. Klik op de knop Databronnen beheren openen en schakel naar de tab Raster in het dialoogvenster dat verschijnt,
of gebruik het menuitem Kaartlagen ► Laag toevoegen ► Rasterlaag toevoegen…

2. Zorg er voor dat Bestand is geselecteerd
3. Navigeer naar het toepasselijke bestand, selecteer het en klik op Openen

4. Doe dit voor elk van de twee rasterbestanden, DEM/SRTM.tif en Rainfall/reprojected/
rainfall.tif.

5. Hernoem het raster SRTM naar DEM en het raster voor de regenval naar Rainfall (met een hoofdletter aan
het begin)

8.4.5 Wijzigen van de volgorde van lagen

Klik en sleep de lagen op en neer in het paneel Lagen om de volgorde waarin zij verschijnen op de zodanig dat u
zoveel mogelijk lagen kunt zien.
Nu alle gegevens zijn geladen en op de juiste wijze zichtbaar zijn, kan de analyse beginnen. Het is het beste als de
bewerking clippen als eerste wordt uitgevoerd. Dit om er voor te zorgen dat er geen verwerkingskracht wordt verspilt
in het berekenen van waarden in gebieden die toch niet gebruikt gaan worden.

8.4.6 Zoek naar de juiste districten

Vanwege het eerder vermelde gebied van onderzoek moeten we onze districten beperken tot de volgende:
• Bellville

• Cape

• Goodwood

• Kuils River

• Mitchells Plain

• Simon Town

• Wynberg

1. Klik met rechts op de laag Districts in het paneel Lagen.
2. Selecteer, in het menu dat verschijnt, het menu-item Filteren…. Het dialoogvenster Querybouwer verschijnt.
3. U zult nu een query gaan bouwen om alleen de kandidaat-districten te selecteren:

1. Dubbelklik, in de lijst Velden, op het veld NAME_2 om het te laten verschijnen in het tekstveld Provider-
specifieke filter-expressie onderin

2. Klik op de knop IN om het toe te voegen aan de SQL-query
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3. Open de haakjes
4. Klik op de knop Alles onder de (momenteel lege) lijstWaarden.

Na korte tijd zal dit de lijstWaarden vullen met de waarden van het geselecteerde veld (NAME_2).
5. Dubbelklik op de waarde Bellville in de lijstWaarden om die toe te voegen aan de SQL-query.
6. Voeg een komma toe en dubbelklik om het district Cape toe te voegen
7. Herhaal de vorige stap voor de resterende districten
8. Sluit de haakjes

De uiteindelijke query zoumoeten zijn (de volgorde van de districten binnen de haakjes is niet van belang):

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
'Mitchells Plain', 'Simon Town', 'Wynberg')

Notitie: U zou ook de operator OR kunnen gebruiken, de query zou er dan zo uitzien:

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR
"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'

9. Klik twee keer op OK.
De in uw kaart weergegeven districten beperken zich nu tot die in de lijst hierboven.

8.4.7 Clippen van de rasters

Nu u een beperkt gebied heeft, kunt u de rasters tot dit gebied clippen.
1. Open het dialoogvenster om te clippen door het menuitem Raster► Extractie► Raster op maskerlaag clippen…

te selecteren.
2. Selecteer, in de keuzelijst Invoerlaag, de laag DEM.
3. Selecteer, in de keuzelijst Maskeerlaag, de laag Districts.
4. Scroll naar beneden en specificeer een locatie voor de uitvoer in het tekstveld Geclipt (masker) door te klikken

op de knop Selecteren… en te kiezen voor. Opslaan als bestand…

1. Navigeer naar de map Rasterprac
2. Voer een bestandsnaam in - DEM_clipped.tif
3. Sla op

5. Zorg er voor dat het vak Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Klik op Uitvoeren

Laat, nadat de bewerking voor het clippen is voltooid, het dialoogvenster Raster op maskerlaag clippen open,
om in staat te zijn het geclipte gebied opnieuw te gebruiken

7. Selecteer de rasterlaag Rainfall in de keuzelijst Invoerlaag en sla uw uitvoer op als
Rainfall_clipped.tif

8. Wijzig geen van de andere opties. Laat alles hetzelfde en klik op Uitvoeren.
9. Nadat de tweede bewerking om te clippen is voltooid, kunt u het dialoogvenster Raster op maskerlaag clippen

sluiten
10. Sla de kaart op
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Uitlijnen van de rasters

Voor onze analyse moeten de rasters hetzelfde CRS hebben en moeten zij worden uitgelijnd.
Eerst wijzigen we de resolutie van onze gegevens voor de regenval naar 30 meter (pixelgrootte):

1. Klikmet rechts op de laagRainfall_clipped en selecteerExporteren►Opslaan als… in het contextmenu.
2. Stel, onder Resolutie, de resoluties Horizontaal en Verticaal in op 30 (meter).
3. Sla het bestand op als Rainfall30.tif in rainfall/reprojected (bestandsnaam)

Daarna lijnen we de DEM uit:
1. Klik met rechts op de laag DEM_clipped en selecteer Exporteren► Opslaan als… in het contextmenu.
2. Kies voor CRS WGS 84 / UTM zone 33S (EPSG-code 32733)
3. Stel, onder Resolutie, de resoluties Horizontaal en Verticaal in op 30 (meter).
4. Klik, onder Bereik, op Uit laag berekenen en kies Rainfall30
5. Sla het bestand op als DEM30.tif in DEM/reprojected (bestandsnaam)

De symbologie voor de lagen moet gewijzigd worden om op de juiste wijze te kunen zien wat er gebeurt,

8.4.8 Wijzigen van de symbologie van vectorlagen

1. Klik met rechts, in het paneel Lagen, op de laag Streets

2. Selecteer Eigenschappen uit het menu dat tevoorschijn komt
3. Schakel naar de tab Symbologie in het dialoogvenster dat verschijnt
4. Klik op het item Vulling in de bovenste widget
5. Selecteer een symbool uit de lijst eronder of stel een nieuwe in (kleur, transparantie, …)
6. Klik op OK om het dialoogvenster Laageigenschappen te sluiten. Dit zal het renderen van de laag Streets

wijzigen.
7. Volg een soortgelijk proces voor de laag Zoning en kies er een toepasselijke kleur voor

8.4.9 Wijzigen van de symbologie van rasterlagen

Symbologie voor rasterlagen is enigszins anders.
1. Open het dialoogvenster Laageigenschappen voor de rasterlaag Rainfall30

2. Schakel naar de tab Symbologie. U zult zien dat dit dialoogvenster voor de stijl heel anders is dan de versie die
werd gebruikt voor vectorlagen.

3. Vergroot Instellingen min / max waarden

4. Zorg er voor dat de knop Gemiddelde +/- standaardafwijking is geselecteerd
5. Zorg er voor dat de waarde in het toepasselijke vak 2.00 is
6. Voor Contrastverbetering, zorg er voor dat er staat ‘Stretch’ tot MinMax

7. Voor Kleurovergang, wijzig het naarWit naar zwart

8. Klik op OK

Het raster “Rainfall30” zou, indien zichtbaar, van kleur moeten veranderen, wat u in staat stelt de verschillende
waarden voor helderheid voor elke pixel te zien

9. Herhaal dit proces voor de laag DEM30, maar stel de standaardafwijking die moet worden gebruikt voor het
uitrekken in op 4.00.
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8.4.10 De kaart opruimen

1. Verwijder de originele lagen Rainfall en DEM, als ook Rainfall_clipped en DEM_clipped, uit
het paneel Lagen:

• Klik met rechts op deze lagen en selecteer Verwijder.

Notitie: Dit zal niet de gegevens uit uw opslagapparaat verwijderen, ze worden alleen uit uw kaart
verwijderd.

2. Sla de kaart op
3. U kunt nu de vectorlagen verbergen door het vak naast ze in het paneel Lagen leeg te maken. Dit zorgt er voor

dat de kaart sneller wordt gerenderd en u enige tijd bespaart.

8.4.11 De schaduw voor heuvels maken

U zult een algoritme moeten gebruiken dat speciaal werd geschreven voor dit doel om de schaduw voor heuvels te
maken.

1. Zorg er voor dat, in het paneel Lagen, DEM30 de actieve laag is (d.i. hij is geaccentueerd door erop te klikken).
2. Klik op het menu-item Raster ► Analyse ► Schaduw voor heuvels… om het dialoogvenster Schaduw voor

heuvels te openen
3. Scroll naar beneden naar Schaduw voor heuvels en sla de gegevens op in uw map Rasterprac als

hillshade.tif

4. Zorg er voor dat het vak Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
5. Klik op Uitvoeren

6. Wacht tot de verwerking is voltooid.
De nieuwe laag hillshade is verschenen in het paneel Lagen.

1. Klik met rechts op de laag hillshade in het paneel Lagen en roep het dialoogvenster Eigenschappen op
2. Klik op de tab Transparantie en stel de schuifbalk Globale doorzichtbaarheid in op 20%
3. Klik op OK

4. Let op het effect als de transparante hillshade wordt weergegeven over de geclipte DEM. U zou misschien de
volgorde van uw lagen moeten wijzigen, of de laag Rainfall30 uit moeten schakelen om het effect te zien.

8.4.12 Helling

1. Klik op het menu-item Raster ► Analyse ► Helling… om het dialoogvenster voor het algoritme Helling te
openen

2. Selecteer DEM30 als Invoerlaag

3. Selecteer Helling weergeven in procenten in plaats van in graden. Helling kan worden uitgedrukt in
verschillende eenheden (percentage of graden). Onze criteria suggereren dat de plant, waarin we geïnteresseerd
zijn, groeit op hellingen met een verloop tussen 15% en 60%. We moeten er dus voor zorgen dat de gegevens
voor onze helling worden weergegeven als procenten.

4. Specificeer een toepasselijke bestandsnaam en locatie voor uw uitvoer.
5. Zorg er voor dat het vak Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Klik op Uitvoeren
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De afbeelding voor de helling wordt berekend en toegevoegd aan de kaart. Zoals gewoonlijk is het gerenderd in
grijswaarden. Wijzig de symbologie naar een meer kleurrijke:

1. Open het dialoogvenster Eigenschappen voor de laag (zoals gewoonlijk via het menu voor rechts-klikken van
de laag)

2. Klik op de tab Symbologie

3. Waar het zegt Enkelbands grijs (in de keuzelijst Rendertype), wijzig die naar Enkelbands pseudokleur
4. Kies Gemiddelde +/- standaardafwijking x voor Instellingen min / max waarden met een waarde van 2.0
5. Selecteer een geschikt Kleurverloop
6. Klik op Uitvoeren

8.4.13 Try Yourself Ligging

Gebruik dezelfde benadering als voor het berekenen van de helling, maar selecteer Aspect… in het menu Raster ►
Analyse.
Denk er aan om het project regelmatig op te slaan.

8.4.14 Rasters opnieuw classificeren

1. Kies Raster ► Rasterberekeningen…

2. Specificeer uw map Rasterprac als de locatie voor de Uitvoerlaag (klik op de knop …), en sla het op als
slope15_60.tif

3. Zorg er voor dat het vak Voeg resultaat toe aan project is geselecteerd.
In de lijst Rasterbanden aan de linkerkant, ziet u alle rasterlagen in uw paneel Lagen. Als uw laag voor de
helling is genaamd slope, zal die zijn vermeld als slope@1. Dat geeft band 1 van het raster slope aan.

4. De helling moet tussen 15 en 60 graden zijn.
Bouw, met behulp van de items in de lijst en de knoppen in de interface, de volgende expressie:

(slope@1 > 15) AND (slope@1 < 60)

5. Stel het veld Uitvoerbestand in op een toepasselijke locatie en bestandsnaam.
6. Klik op Uitvoeren.

Zoek nu naar het juiste aspect (uitkijkend op het oosten: tussen 45 en 135 graden) met behulp van dezelfde
benadering.

1. Bouw de volgende expressie:

(aspect@1 > 45) AND (aspect@1 < 135)

U zult weten of het heeft gewerkt als alle hellingen die op het oosten uitkijken wit zijn gekleurd in het resulterende
raster (het lijkt er bijna op alsof zij worden verlicht door het zonlicht in de morgen).
Zoek op dezelfde manier naar de juiste regenval (meer dan 1000 mm). Gebruik de volgende expressie:

Rainfall30@1 > 1000

Nu u alle drie criteria elk in afzonderlijke rasters heeft, moet u ze combineren om te zien welke gebieden voldoen
aan alle criteria. De rasters zullen met elkaar worden vermenigvuldigd om dat te doen. Wanneer dit gebeurt zullen
alle overlappende pixels met de waarde 1 de waarde 1 behouden (d.i. de locatie voldoet aan de criteria), maar als een
pixel in één van de drie rasters de waarde 0 heeft (d.i. de locatie voldoet niet aan de criteria), dan zal het 0 zijn in het
resultaat. Op deze manier zal het resultaat alleen de overlappende gebieden bevatten die voldoen aan alle toepasselijke
criteria.
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8.4.15 Rasters combineren

1. Open de Rasterberekeningen (Raster ► Rasterberekeningen…)
2. Bouw de volgende expressie (met de toepasselijke namen voor uw lagen):

[aspect45_135] * [slope15_60] * [rainfall_1000]

3. Stel de locatie voor de uitvoer in op de map Rasterprac
4. Noem het uitvoerraster aspect_slope_rainfall.tif

5. Zorg er voor dat Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Klik op Uitvoeren

Het nieuwe raster geeft nu op de juiste manier de gebieden weer waar aan alle drie criteria wordt voldaan.
Sla het project op.
Het volgende criterium waaraan moet worden voldaan is dat het gebied 250 m van stedelijke gebieden moet liggen.
We zullen aan dit vereiste voldoen door er voor te zorgen dat de gebieden die we berekenen binnen landelijke gebieden
liggen en 250 m of meer vanaf de rand van het gebied ligt. Maar, dan moeten we wel eerst de landelijke gebieden
zoeken.

8.4.16 Landelijke gebieden zoeken

1. Verberg alle lagen in het paneel Lagen
2. Geef de vectorlaag Zoning weer
3. Klik er met rechts op en open het dialoogvenster Attributentabel. Merk de vele verschillende manieren op

waarin het land is opgedeeld. We willen de landelijke gebieden isoleren. Sluit de Attributentabel.
4. Klik met rechts op de laag Zoning en selecteer Filteren… om het dialoogvenster Querybouwer op te roepen
5. Bouw de volgende query:

"Gen_Zoning" = 'Rural'

Bekijk de eerdere instructies als u het even niet weet.
6. Klik op OK om het dialoogvenster Querybouwer te sluiten. De query zou één object terug moeten geven.

U zou de polygonen voor landelijke gebieden moeten zien uit de laag Zoning. U zult deze op moeten slaan.
1. Selecteer, in het contextmenu van Zoning, Exporteren ► Objecten opslaan als….
2. Sla uw laag op in de map Rasterprac
3. Noem het uitvoerbestand rural.shp
4. Klik op OK

5. Sla het project op
Nu moet u de gebieden uitsluiten die binnen 250m vanaf de rand van de landelijke gebieden liggen. Doe dat door
een negatieve buffer te maken, zoals hieronder uitgelegd.
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8.4.17 Een negatieve buffer maken

1. Klik op het menu-item Vector ► Geoprocessing-gereedschap ► Buffer…

2. Selecteer, in het dialoogvenster dat verschijnt, de laag rural als uw invoer vectorlaag (Alleen geselecteerde
objecten gebruiken zou niet moeten zijn geselecteerd)

3. Stel Afstand in op -250. De negatieve waarde betekent dat de buffer een interne buffer zal zijn. Zorg er voor
dat in het keuzemenu de eenheden in meters zijn.

4. Selecteer Resultaat samenvoegen

5. Plaats, in Gebufferd, het uitvoerbestand in de map Rasterprac, en noem het rural_buffer.shp
6. Klik op Opslaan

7. Klik op Uitvoeren en wacht tot de verwerking is voltooid
8. Sluit het dialoogvenster Buffer.

Zorg er voor dat uw buffer correct werkte door te zien hoe de laag rural_buffer verschilt van de laag
rural. U moet misschien de volgorde van tekenen veranderen om het verschil te kunnen zien.

9. Verwijder de laag rural
10. Sla het project op

Nu moet u uw vectorlaag rural_buffer combineren met het raster aspect_slope_rainfall. We zullen
de gegevensindeling van een van de lagen moeten wijzigen om ze te kunnen combineren. In dit geval zult u de raster
vectoriseren, omdat vectorlagen handiger zijn als we gebieden willen berekenen.

8.4.18 Het raster vectoriseren

1. Klik op het menu-item Raster ► Conversie ► Polygoniseren (raster naar vector)….
2. Selecteer het raster aspect_slope_rainfall als Invoerlaag
3. Stel Naam van het te maken veld in op geschikt (de standaard veldnaam is DN - Digitaal nummergegevens)
4. Sla de uitvoer op. Onder Gevectoriseerd, selecteer Opslaan als bestand. Stel de locatie in op Rasterprac en

noem het bestand aspect_slope_rainfall_all.shp.

5. Zorg er voor dat Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Klik op Uitvoeren

7. Sluit het dialoogvenster als de verwerking voltooid is
Alle gebieden van het raster zijn gevectoriseerd, dus u moet alleen de gebieden selecteren die de waarde 1 in het veld
suitable hebben. (Digital Number)

1. Open het dialoogvenster Querybouwer (klik met rechts op - Filteren…) voor de nieuwe vectorlaag
2. Bouw deze query:

"suitable" = 1

3. Klik op OK

4. Nadat u er zeker van bent dat de query voltooid is (en alleen de gebieden die voldoen aan alle drie criteria,
d.i. met een waarde van 1, zichtbaar zijn), maak een nieuw vectorbestand uit de resultaten, met Exporteren –>
Objecten opslaan als… in het contextmenu van de laag

5. Sla het bestand op in de map Rasterprac
6. Noem het bestand aspect_slope_rainfall_1.shp
7. Verwijder de laag aspect_slope_rainfall_all uit uw kaart
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8. Sla uw project op
Wanneer we een algoritme gebruiken om een raster te vectoriseren, maakt het algoritme soms wat wordt genoemd
“Ongeldige geometrieën”, d.i. er zijn lege polygonen, of polygonen met fouten erin, die in de toekomst moeilijk te
analyseren zullen zijn. We moeten dus het gereedschap “Geometrieën repareren” gebruiken.

8.4.19 Geometrieën repareren

1. Zoek, in de Processing Toolbox, naar “Geometrieën repareren”, en druk op Uitvoeren…

2. Selecteer voor de Invoerlaag aspect_slope_rainfall_1
3. Onder Gerepareerde geometrieën, selecteer Opslaan als bestand. Stel de locatie in op Rasterprac en noem

het bestand fixed_aspect_slope_rainfall.shp.

4. Zorg er voor dat Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
5. Klik op Uitvoeren

6. Sluit het dialoogvenster als de verwerking voltooid is
Nu u het raster hebt gevectoriseerd, en de resulterende geometrieën hebt gerepareerd, kunt u de criteria voor ligging,
helling en regenval combineren met het criterium voor de afstand tot een menselijke nederzetting door de kruisingen
te zoeken van de laag fixed_aspect_slope_rainfall en de laag rural_buffer.

8.4.20 Bepalen van de kruising van vectors

1. Klik op het menu-item Vector ► Geoprocessing-gereedschap ► Kruising…

2. Selecteer, in het dialoogvenster dat verschijnt, de laag rural_buffer als Invoerlaag
3. Selecteer voor de Overleglaag de laag fixed_aspect_slope_rainfall
4. Plaats, in Kruising, het uitvoerbestand in de map Rasterprac
5. Noem het uitvoerbestand rural_aspect_slope_rainfall.shp
6. Klik op Opslaan

7. Klik op Uitvoeren en wacht tot de verwerking is voltooid
8. Sluit het dialoogvenster Kruising.

Zorg er voor dat het zoeken van de kruisingen juist heeft gewerkt door te zien dat alleen de overlappende
gebieden zijn overgebleven.

9. Sla het project op
Het volgende criteria op de lijst is dat het gebied groter moet zijn dan 6000 m2. U zult nu de polygoon-gebieden
berekenen om de gebieden te identificeren die de juiste grootte hebben voor dit project.

8.4.21 Het gebied voor elke polygoon berekenen

1. Open het rechtsklik-menu van de nieuwe vectorlaag
2. Selecteer Attributentabel openen

3. Klik op de knop modus Bewerken aan-/uitzetten aan de linkerbovenzijde van de tabel, of druk op Ctrl+e.

4. Klik op de knop Veldberekening openen op de werkbalk aan de bovenzijde van de tabel, of druk op Ctrl+i

5. Zorg er voor dat, in het dialoogvenster dat verschijnt, Nieuw veld aanmaken is geselecteerd, en stel de
Naam voor veld in op area. Het type voor het veld zou een decimaal getal (real) moeten zijn. Stel Precisie in
op 1 (één decimaal).
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6. Typ in het gebied Expressie:

$area

Dit betekent dat de veldberekening het gebied van elke polygoon in de vectorlaag zal berekenen en ze dan zal
vermelden in een nieuwe kolom met een geheel getal (genaamd area) met de berekende waarde.

7. Klik op OK

8. Herhaal deze stap voor een ander veld genaamd id. Typ in het gebied Expressie:

$id

Dit zorgt er voor dat elke polygoon een unieke ID heeft ter identificatie.

9. Klik opnieuw op de knop modus Bewerken aan-/uitzetten en sla uw gegevens op als daarnaar gevraagd wordt

8.4.22 Gebieden met een bepaalde grootte selecteren

Nu de gebieden bekend zijn:
1. Bouw een query (zoals gewoonlijk) om alleen de polygonen te selecteren die groter zijn dan 6000 m². De

query is:

"area" > 6000

2. Sla de selectie op in de map Rasterprac als een nieuwe vectorlaag, genaamd suitable_areas.shp.
U heeft nu de geschikte gebieden die voldoen aan alle criteria voor de habitat van de zeldzame fynbos-plant, waaruit
u de vier gebieden kunt kiezen die het dichtst bij de universiteit van Kaapstad liggen.

8.4.23 Digitaliseren van de universiteit van Kaapstad

1. Maak, net als eerder, een nieuwe vectorlaag in de map Rasterprac, maar selecteer deze keer de waarde
Punt als Type geometrie en noem de laag university.shp

2. Zorg er voor dat het in het juiste CRS (Project CRS:EPSG:32733 - WGS 84 / UTM zone 33S)
staat

3. Voltooi het maken van de nieuwe laag (klik op OK)
4. Verberg alle lagen, met uitzondering van de nieuwe laag university en de laag Streets.
5. Voeg een achtergrondkaart toe (OSM):

1. Ga naar het paneel Browser en navigeer naar XYZ Tiles ► OpenStreetMap

2. Sleep en zet het item OpenStreetMap neer aan de onderzijde van het paneel Lagen
Zoek, met uw internetbrowser, de locatie op van de universiteit van Kaapstad. Gegeven de unieke topografie
van Kaapstad, is de universiteit een zeer herkenbare locatie. Onthoud, voordat u teruggaat naar QGIS, waar de
universiteit is gelegen en wat er in de buurt ligt.

6. Zorg er voor dat op de laag Streets is geklikt, en dat de laag university is geaccentueerd in het paneel
Lagen

7. Navigeer naar het menu-item Beeld ►Werkbalken en zorg er voor dat Digitaliseren is geselecteerd. U zou dan
een pictogram voor de werkbalk moeten zien met een potlood erop ( Bewerken aan-/uitzetten). Dat is de knop
Bewerken aan-/uitzetten.

8. Klik op de knop Bewerken aan-/uitzetten om naar demodus Bewerken te gaan. Dat stelt u in staat een vectorlaag
te bewerken

9. Klik op de knop Object Punt toevoegen, die dichtbij de knop Bewerken aan/uitzetten zou moeten staan
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10. Met het gereedschap Object Punt toevoegen geactiveerd, klik met links op uw beste schatting voor de locatie
van de universiteit van Kaapstad

11. Geef een uniek geheel getal op als daarnaar gevraagd wordt voor de id
12. Klik op OK

13. Klik op de knop Wijzigingen laag opslaan

14. Klik op de knop Bewerken aan-/uitzetten om uw sessie voor bewerkingen te beëindigen
15. Sla het project op

8.4.24 Zoek de locaties die het dichtst bij de universiteit van Kaapstad liggen

1. Ga naar de Toolbox van Processing, zoek naar het algoritme Koppel attributen op dichtstbijzijnde (Vector
algemeen ► Koppel attributen op dichtstbijzijnde) en voer het uit

2. Invoerlaag zou university moeten zijn, en Invoerlaag 2 suitable_areas

3. Stel een toepasselijke locatie voor de uitvoer en een naam in (Samengevoegde laag)
4. Stel Maximum dichtstbijzijnde buren in op 4

5. Zorg er voor dat Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Laat de rest van de parameters op hun standaard instellingen staan
7. Klik op Uitvoeren

De resulterende puntenlaag zal vier objecten bevatten - zij zullen allemaal de locatie van de universiteit hebben en de
attributen daarvan, en, in aanvulling daarop, de attributen van de nabijgelegen geschikte gebieden (inclusief de id),
en de afstand tot die locatie.

1. Open de attributentabel van het resultaat van het samenvoegen
2. Onthoud de id van de vier meest nabij gelegen geschikte gebieden, en sluit dan de attributentabel
3. Open de attributentabel van de laag suitable_areas
4. Bouw een query om alleen de vier geschikte gebieden te selecteren die het dichtst bij de universiteit liggen

(selecteer ze met het veld id)
Dit is het uiteindelijke antwoord op de onderzoeksvraag.
Maak, voor als u het inlevert, een volledig gelabelde lay-out die de semi-transparante laag hillshade over een
aantrekkelijk raster van uw keuze (zoals de DEM of de laag slope bijvoorbeeld) bevat. Neem ook de polygoon
en de laag suitable_areas, waarop de vier geschikte gebieden, die het dichtst bij de universiteit liggen, zijn
geaccentueerd. Volg alle best practices voor cartografie bij het maken van uw kaart voor de uitvoer.
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Module: Plug-ins

Plug-ins stellen u in staat de functionaliteit die QGIS biedt uit te breiden. In deze module zal u worden getoond hoe
plug-ins te activeren en te gebruiken.

9.1 Lesson: Plug-ins installeren en beheren

U zult moeten weten hoe u ze moet downloaden, installeren en activeren om te kunnen beginnen met het gebruiken
van plug-ins, U zult leren hoe u Plug-in installeren en Plug-in Manager moet gebruiken om dit te doen.
Het doel voor deze les: Het systeem van plug-ins in QGIS begrijpen en gebruiken

9.1.1 Follow Along: Plug-ins beheren

1. Klik op het menu-item Plug-ins ► Plug-ins beheren en installeren om Plug-ins te openen.
2. Zoek, in het dialoogvenster dat opent, naar de plug-in Processing:
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3. Klik in het vak naast deze plug-in en deselecteer het om hem te deactiveren.
4. Klik op Sluiten.
5. Kijkend naar het menu zult u zien dat het menu Processing nu is verdwenen. Dit betekent dat veel van de functies

voor het verwerken, die u eerder gebruikt heeft, zijn verdwenen! Kijk bijvoorbeeld naar de menu’s Vector ►
en Raster ►. Dit komt omdat zij deel uitmaken van de plug-in Processing, die moet zijn geactiveerd om hem
te kunnen gebruiken.

6. Open opnieuw Plug-ins beheren en installeren en activeer de plug-in Processing opnieuw door te klikken in het
keuzevak ernaast.

7. Close het dialoogvenster. Het menu Processing zou weer beschikbaar moeten zijn.

9.1.2 Follow Along: Nieuwe plug-ins Installeren

De lijst met plug-ins die u kunt activeren en deactiveren wordt gevormd door de plug-ins die u momenteel heeft
geïnstalleerd. Nieuwe plug-ins installeren:

1. Selecteer de optieNiet geïnstalleerd in het dialoogvenster Plug-ins beheren en installeren. De voor u beschikbare
plug-ins om te installeren zullen hier zijn vermeld. Deze lijst zal variëren afhankelijk van de instelling van uw
bestaande systeem.
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2. Zoek informatie over de plug-in door die te selecteren in de lijst.

3. Installeer plug-ins, die u wilt gebruiken, door te klikken op de knop Plug-in installeren onder het paneel met
informatie over de plug-in.

Notitie: Als de plug-in een fout heeft zal die zijn vermeld op de tab Ongeldig. U kunt dan contact opnemen met de
eigenaar van de plug-in om het probleem te repareren.
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9.1.3 Follow Along: Aanvullende opslagplaatsen voor plug-ins
configureren

De plug-ins die voor u beschikbaar zijn om te installeren zijn afhankelijk van welke opslagplaatsen voor plug-ins u
heeft geconfigureerd om te gebruiken.
Plug-ins voor QGIS worden online opgeslagen in opslagplaatsen. Standaard is alleen de officiële opslagplaats actief,
wat betekent dat u alleen toegang heeft tot plug-ins die daar zijn vermeld. Gegeven de diversiteit van de beschikbare
gereedschappen zal deze opslagplaats aan de meeste van uw behoeften kunnen voldoen.
Het is echter mogelijk om meer plug-ins uit te proberen dan alleen de standaard. U zult om te beginnen aanvullende
opslagplaatsen moeten configureren. Om dat te doen:

1. Open de tab Extra in het dialoogvenster Plug-ins beheren en installeren:

2. Klik op Toevoegen om een nieuwe opslagplaats te zoeken en toe te voegen.
3. Geef een Naam en URL op voor de nieuwe opslagplaats die u wilt configureren en zorg er voor dat het vak

Ingeschakeld is geselecteerd.
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4. U zult nu de nieuwe opslagplaats voor plug-ins zien vermeld in de lijst met geconfigureerde opslagplaatsen voor
plug-ins

5. U kunt ook de optie selecteren om Experimentele plug-ins weer te geven door het vak Ook de experimentele
plug-ins tonen te selecteren.

6. Als u nu terugschakelt naar de tab Niet geïnstalleerd, zult u zien dat aanvullende plug-ins beschikbaar zijn om
te installeren.
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7. Klik, om een plug-in te installeren, er op in de lijst en dan op de knop Plug-in installeren.

9.1.4 In Conclusion

Installeren van plug-ins in QGIS zou eenvoudig en effectief moeten zijn!

9.1.5 What’s Next?

Vervolgens zullen we u als voorbeelden enkele handige plug-ins laten zien.

9.2 Lesson: Handige plug-ins voor QGIS

Nu u plug-ins kunt installeren, inschakelen en uitschakelen, kunnen we eens zien hoe dat u in de praktijk kan helpen
door naar enkele voorbeelden van handige plug-ins te kijken.
Het doel voor deze les: Uzelf bekend te laten worden met de interface voor plug-ins en enkele handige plug-ins te
leren kennen.

9.2.1 Follow Along: De plug-in QuickMapServices

De plug-inQuickMapServices is een eenvoudige en gemakkelijk te gebruiken plug-in die basiskaarten toevoegt aan uw
project van QGIS. Hij heeft veel verschillende opties en instellingen, laten enkele van zijn mogelijkheden verkennen.

1. Begin een nieuwe kaart en voeg de laag roads uit het GeoPackage training_data.
2. Installeer de plug-in QuickMapServices.
3. Open de tab Zoeken van de plug-in door te klikken op Web ► QuickMapServices ► Search QMS. Deze optie

van de plug-in stelt u in staat de beschikbare basiskaarten te filteren op het huidige bereik of het kaartvenster.
4. Klik op Filter by extent en u zou zien dat één service beschikbaar is.
5. Klik op de knop Add naast de kaart om die te laden.
6. De basiskaart zal worden geladen en u zult een satellietachtergrond hebben voor de kaart.

De plug-in QuickMapServices maakt veel basiskaarten beschikbaar.
1. Sluit het paneel Search QMS dat we eerder openden

284 Hoofdstuk 9. Module: Plug-ins



QGIS Training Manual

2. Klik opnieuw opWeb► QuickMapServices. Het eerste menu vermeld verschillende providers van kaarten met
beschikbare kaarten:

Maar er is meer.
Als de standaard kaarten niet voldoende voor u zijn, kunt u andere providers van kaarten toevoegen.

1. Klik opWeb ► QuickMapServices ► Settings en ga naar de tab More services.
2. Lees het bericht op deze tab zorgvuldig door en als u daarmee akkoord gaat, klik dan op de knopGet Contributed

pack.
Als u nu het menu Web ► QuickMapServices opent zult u zien dat er meer providers beschikbaar zijn. Kies degene
die het beste aan uw wensen voldoet!

9.2.2 Follow Along: De plug-in QuickOSM

De plug-in QuickOSM stelt u in staat gegevens van OpenStreetMap te downloaden met een ongelofelijk eenvoudige
interface.

1. Begin een nieuwe leeg project en voeg de laag roads uit het GeoPackage training_data.
2. Installeer de plug-inQuickOSM plugin. De plug-in voegt twee nieuwe knoppen toe aan de werkbalk van QGIS

en is toegankelijk vanuit het menu Vector ► QuickOSM.
3. Open het dialoogvenster van QuickOSM. De plug-in heeft veel verschillende tabs: wij zullen de Snel query

gebruiken.
4. U kunt specifieke objecten downloaden door een algemene Sleutel te kiezen of meer specifiek zijn en een

specifiek paar Sleutel enWaarde kiezen.

Tip: als u niet bekend bentmet het systeem van Sleutel enWaarde, klik dan op de knopHulpmet sleutel/waarde.
Het zal een webpagina openen met een volledige beschrijving van dit concept van OpenStreetMap.

5. Zoek naar railway in het menu Sleutel en laat het veld Waarde leeg: we gaan dus alle objecten railway
downloaden, zonder enige waarden te specificeren.

6. Selecteer Layer Extent in de volgende keuzelijst en kies roads.
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7. Klik op de knop Query uitvoeren.

Na enkele seconden zal de plug-in alle objecten die in OpenStreetMap zijn getagd als railway downloaden en ze
direct in de kaart laden.
Niets meer! Alle lagen zijn geladen in de legenda en worden weergegeven in het kaartvenster.

Waarschuwing: QuickOSM maakt een tijdelijke laag bij het downloaden van de gegevens. Als u ze permanent
wilt opslaan, klik op het pictogram naast de laag en kies die optie die uw voorkeur heeft. Als alternatief kunt
u het menu Geavanceerd in QuickOSM openen en in het menu Map kiezen waar u de gegevens wilt opslaan.

9.2.3 Follow Along: Het programma voor de query van QuickOSM

De snelste manier om gegevens te downloaden vanuit de plug-in QuickOSM is met de tab Snel query en enkele
parameters in te stellen. Maar wat als u meer specifieke gegevens nodig hebt?
Als u een OpenStreetMap querymeester bent kunt u de plug-in QuickOSM ook gebruiken met uw persoonlijke
query’s.
QuickOSM heeft een ongelofelijke parser voor gegevens die, samen met het fantastische programma voor de query
van Overpass, u gegevens laten downloaden voor uw specifieke wensen.
Bijvoorbeeld: we willen de bergpieken downloaden die behoren tot een specifieke berggebied, bekend als de
Dolomieten.
U kunt deze taak niet naar behoren uitvoeren met de tab Snel query, u dient meer specifiek te zijn en uw eigen query
te schrijven. Laten we eens proberen dat te doen.
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1. Begin een nieuw project.
2. Open de plug-in QuickOSM en klik op de tab Query.
3. Kopieer en plak de volgende code in het venster van de query:

<!--
This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
-->
<osm-script output="json">
<!-- search the area of the Dolomites -->
<query type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<!-- get all peaks in the area -->
<query type="node">
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->
<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

Notitie: Deze query is geschreven in een XML-achtige taal. Als u meer gewend bent aan Overpass QL dan
kunt u uw query in die taal schrijven.

4. En klik op Query uitvoeren:

9.2. Lesson: Handige plug-ins voor QGIS 287



QGIS Training Manual

De laag met bergpieken zal worden gedownload en weergegeven in QGIS:

U kunt complexe query’s schrijven met de taal voor Overpass Query. Bekijk een aantal voorbeelden en probeer de
taal voor de query te verkennen.

9.2.4 Follow Along: De plug-in DataPlotly

De plug-inDataPlotly stelt u in staat omD3-plots te maken van gegevens van vectorattributen dankzij de bibliotheekl
plotly.

1. Begin een nieuw project.
2. Laad de laag sample_points uit de map exercise_data/plugins
3. Installeer de plug-in door de handleiding te volgen zoals beschreven in FollowAlong: Nieuwe plug-ins Installeren

en zoek naar Data Plotly

4. Open de plug-in door te klikken op het nieuwe pictogram in de werkbalk of in het menu Plug-ins►Data Plotly

In het volgende voorbeeld maken we een eenvoudig Spreidingsdiagram van twee velden uit de laag
sample_points. In het paneel DataPlotly:
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1. Kies sample_points in het veld Laag, cl voor het X-veld en mg voor het Y-veld:

2. Als u dat wilt kunt u de kleuren wijzigen, het type markering, de transparantie en nog veel meer instellingen:
probeer enkele parameters te wijzigen om het plot te krijgen zoals hieronder.
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3. Klik, als alle parameters eenmaal zijn ingesteld, op de knop Maak diagram om het plot te maken.
Het plot is interactief: dit betekent dat u alle bovenste knoppen kunt gebruiken om de grootte aan te passen, te
verplaatsen, of in/uit te zoomen op het kaartvenster van het plot. Meer nog, elk element van het plot is interactief:
door één of meer punten in het plot te selecteren of er op te klikken zullen de betreffende punten worden geselecteerd
in het kaartvenster van het plot.

U kunt het plot opslaan als een statische afbeelding in png of als een HTML-bestand door te klikken op de knop
of de knop in de rechter benedenhoek van het plot.
Er is meer. Soms kan het nuttig zijn om twee (of meer) plots verschillende typen plots te laten zien met verschillende
variabelen op dezelfde pagina. Laten we dat eens doen!
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1. Ga terug naar de tab voor de hoofdinstellingen voor het plot door te klikken op de knop in de
linkerbovenhoek van het paneel Plug-in

2. Wijzig het Diagramtype naar Boxplot
3. Kies group als Grouping Field en ph as Y-veld
4. Wijzig, in het onderste gedeelte van het paneel, hetDiagramtype van Enkelvoudig diagram naar Subdiagrammen

en laat de standaard optie Plot in rijen geselecteerd.
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5. Als dat gedaan is, klik dan op de knop Maak diagram om het plot te tekenen

Nu worden zowel het spreidingsdiagram als het boxplot weergegeven op dezelfde plotpagina. U heeft nog steeds de
kans om op elk item van het plot te klikken en de corresponderen objecten in het kaartvenster te selecteren.

Tip: Elk plot heeft zijn eigen pagina voor de handleiding beschikbaar op de tab . probeer alle typen plots te
verkennen en bekijk alle andere beschikbare instellingen.
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9.2.5 In Conclusion

Er zijn vele handige plug-ins beschikbaar voor QGIS. U kunt naar nieuwe plug-ins zoeken en optimaal gebruik van
ze maken met behulp van de ingebouwde gereedschappen voor het installeren en beheren van deze plug-ins, .

9.2.6 What’s Next?

Vervolgens zullen we kijken naar hoe we lagen gebruiken die op dat moment worden gehost op servers op afstand.
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Module: Online bronnen

Bij het overwegen van gegevensbronnen voor een kaart is er geen reden om te zijn beperkt tot gegevens die u heeft
opgeslagen op de computer waarop u werkt. Er zijn gegevensbronnen online waaruit u gegevens kunt laden zolang u
bent verbonden met het internet.
In deze module zullen we twee soorten web-gebaseerde GIS-services behandelen: Web Mapping Services (WMS) en
Web Feature Services (WFS).

10.1 Lesson: Web Mapping Services

Een Web Mapping Service (WMS) is een service die wordt gehost op een server op afstand. Net als met een website
kunt u er toegang tot verkrijgen, zolang u een verbinding met de server heeft. Met behulp van QGIS kunt u eenWMS
direct in uw bestaande kaart laden.
Uit de les over plug-ins zult u hebben onthouden dat het mogelijk is een nieuwe rasterafbeelding te laden vanaf,
bijvoorbeeld, Google. Dat is echter een eenmalige transactie: als u de afbeelding eenmaal heeft gedownload, wijzigt
die niet meer. Een WMS is anders in die zin dat het een live service is die automatisch zijn weergave zal vernieuwen
als u op de kaart inzoomt of erover schuift.
Het doel voor deze les: Een WMS gebruiken en de beperkingen ervan begrijpen.

10.1.1 Follow Along: Een WMS-laag laden

Voor deze oefening kunt ofwel de basiskaart gebruiken die u aan het begin van de cursus heeft gemaakt, of gewoon
een nieuwe kaart beginnen en er enkele bestaande lagen in laden. Voor dit voorbeeld gebruikten we een nieuwe kaart
en laden de originele lagen places, landuse en protected_areas en pasten de symbologie aan:
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1. Laad deze lagen nu in een nieuwe kaart, of gebruik uw originele kaart met alleen deze lagen zichtbaar.
2. Deactiveer eerst “Gelijktijdige CRS-transformatie gebruiken” vóórdat u begintmet het toevoegen van deWMS-

laag (Project ► Eigenschappen… ► tab CRS, selecteer Geen CRS (of onbekende/niet aardse projectie). Dit kan
er voor zorgen dat de lagen elkaar niet langer juist overlappen, maar geen zorgen: dat repareren we later.

3. Klik, om WMS-lagen toe te voegen, op de knop om het dialoogvenster Databronnen beheren te openen
en schakel naar de tab WMS/WMTS.
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Weet u nog hoe u verbonden was met een database van SpatiaLite of GeoPackage aan het begin van de cursus?.
De lagen landuse, buildings en roads zijn opgeslagen in een database. U moest eerst verbinden met de database
om die lagen te kunnen gebruiken. Een WMS gebruiken is soortgelijk, met de uitzondering dat de lagen op een
server op afstand staan.

4. Klik op de knop Nieuw om een nieuwe verbinding naar een WMS te maken.
U heeft een adres voor een WMS nodig om door te gaan. Er zijn verschillende gratis servers voor
WMS beschikbaar op het internet. Een daarvan is terrestris, die gebruik maakt van de gegevensset van
OpenStreetMap.

5. Stel, om gebruik te maken van deze WMS, het als volgt in in uw huidige dialoogvenster:
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• De waarde van het veld Naam zou terrestris moeten zijn.
• De waarde van het veld URL zou ``https://ows.terrestris.de/osm/service` moeten zijn.

6. Klik op OK. U zou de nieuwe server voor WMS moeten zien vermeld:
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7. Klik op Verbinden. In de lijst hieronder zou u nu deze nieuwe items zien geladen:

Dit zijn alle lagen die worden gehost door de server van deze WMS.
8. Klik eenmaal op de laag OSM-WMS. Dit zal het CoördinatenReferentieSysteem ervan weergeven:
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Laten we eens kijken naar alle CRS-en waaruit we kunnen kiezen, omdat we WGS 84 niet voor onze kaart
gebruiken.
1. Klik op de knop Wijizgen…. U zult een standaard dialoogvenster zien voor Keuze Coördinaten

ReferentieSysteem.
2. We willen een geprojecteerd CRS, dus laten we kiezen voorWGS 84 / Pseudo Mercator.

1. Voer de waarde pseudo in in het veld Filter:
2. KiesWGS 84 / Pseudo Mercator (met EPSG:3857) uit de lijst.
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3. Klik op OK. Het Coördinaten ReferentieSysteem dat is geassocieerd met het item is gewijzigd.
9. Klik op Toevoegen en de nieuwe laag zal in uw kaart verschijnen als OpenStreetMap WMS - by terrestris.
10. Sluit het dialoogvenster Databronnen beheren, als het dat al niet automatisch doet.
11. Klik in het paneel Lagen en sleep het tot onderin de lijst.
12. Zoomuit om een globaal overzicht van de lagen te krijgen. Het zal u opvallen dat uw lagen niet juist zijn geplaatst

(nabij het westen van Afrika). Dat komt omdat de projectie “Gelijktijdige CRS-transformatie gebruiken” is
uitgeschakeld.
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13. Laten we het opnieuw projecteren opnieuw inschakelen, maar laten we dezelfde projectie gebruiken als de laag
OpenStreetMap WMS, watWGS 84 / Pseudo Mercator is.
1. Open de tab Project ► Eigenschappen… ► CRS

2. Deselecteer Geen CRS (of onbekende/niet aardse projectie)

3. KiesWGS 84 / Pseudo Mercator uit de lijst.
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4. Klik op OK.
14. Klik nu met rechts op uw eigen lagen in het paneel Lagen en klik op Zoom naar laag. U zou het gebied

Swellendam moeten zien:
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Zie nu hoe de straten van de WMS-laag en uw eigen straten elkaar overlappen. Dat is een goed teken!

De natuur en beperkingen van WMS

Het zou u inmiddels opgevallen kunnen zijn dat dezeWMS-laag in feite vele objecten in zich draagt. Het heeft straten,
rivieren, natuurreservaten, enzovoort. Maar verder, zelfs alsof het eruit ziet alsof het is gemaakt uit vectoren, het lijkt
een raster te zijn, maar u kunt de symbologie ervan niet veranderen. Waarom is dat?
Dit is hoe een WMS werkt: Het is een kaart, soortgelijk aan een normale kaart op papier, die u ontvangt als een
afbeelding. Wat gewoonlijk gebeurd is dat u vectorlagen heeft, die QGIS rendert als een kaart. Maar bij het gebruiken
van een WMS, bevinden die vectorlagen zich op de server van WMS, die het als een kaart rendert en die kaart naar
u verzendt als een afbeelding. QGIS kan deze afbeelding weergeven, maar kan de symbologie ervan niet wijzigen,
omdat dat allemaal wordt afgehandeld op de server.
Dit heeft verschillende voordelen, omdat u zich geen zorgen hoeft te maken over de symbologie. Dat is allemaal al
verwerkt, en zal goed genoeg zijn om te bekijken op elk competent ontworpen WMS.
Aan de andere kant kunt u de symbologie niet wijzigen als die u niet bevalt, en als er dingen wijzigen op de server
van WMS, dan zullen zij ook op uw kaart wijzigen. Dat is waarom soms in plaats daarvan een Web Feature Service
(WFS) wilt gebruiken, die u afzonderlijke vectorlagen geeft en niet als deel van een kaart in WMS-stijl.
Dit zal echter worden behandeld in de volgende les. Laten we eerst een andere WMS-laag van de WMS-server
terrestris toevoegen.

10.1.2 Try Yourself

1. Verberg de laag OSM-WSM in het paneel Lagen.
2. Voeg de server voor WMS “ZAF CGS 1M Bedrock Lithostratigraphy” op deze URL: http://196.33.

85.22/cgi-bin/ZAF_CGS_Bedrock_Geology/wms toe.

3. Laad de laag BEDROCKGEOLOGY in de kaart (u kunt ook de knop Kaartlagen ► Laag toevoegen ►
WMS/WMTS-laag toevoegen… gebruiken om het dialoogvenster Databronnen beheren te openen). Denk er aan
om die in dezelfde projectieWGS 84 / World Mercator te plaatsen als de rest van uw kaart!

4. U wilt misschien Afbeeldingsformaat instellen op JPEG en de optie Tile-grootte op 200 bij 200, zodat het
sneller laadt:
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Controleer uw resultaten

10.1.3 Try Yourself

1. Verberg alle andere WMS-lagen om te voorkomen dat ze op de achtergrond onnodig zullen worden gerenderd.
2. Voeg de server voor WMS “OGC” op deze URL toe: http://ogc.gbif.org:80/wms
3. Voeg de laag bluemarble toe.

Controleer uw resultaten

10.1.4 Try Yourself

Een deel van de moeilijkheid van het gebruiken van WMS is het vinden van een goede (gratis) server.
• Zoek een nieuwe WMS op directory.spatineo.com (of ergens anders online). Het moet geen geassocieerde
kosten of beperkingen hebben en moet dekking hebben voor het te onderzoeken gebied Swellendam.
Onthoud dat het enige wat u nodig heeft om een WMS te gebruiken is alleen de URL ervan (en bij voorkeur
een soort beschrijving).

Controleer uw resultaten

10.1.5 In Conclusion

U kunt inactieve kaarten om op terug te vallen toevoegen aan uw bestaande gegevens voor uw kaarten door eenWMS
te gebruiken,.

10.1.6 Further Reading

• Spatineo Directory
• OpenStreetMap.org lijst met servers voor WMS

10.1.7 What’s Next?

Nu u een inactieve kaart om op terug te vallen heeft toegevoegd, zult u blij zijn te weten dat het ook mogelijk is om
objecten (zoals de andere vectorlagen die u eerder toevoegd) kunt toevoegen. Toevoegen van objecten vanaf servers
op afstand is mogelijk door een Web Feature Service (WFS) te gebruiken. Dat is het onderwerp van de volgende les.

10.2 Lesson: Web Feature Services

Een Web Feature Service (WFS) verschaft zijn gebruikers GIS-gegevens in indelingen die direct in QGIS kunnen
worden geladen. Anders dan een WMS, die u alleen een kaart verschaft die u niet kunt bewerken, geeft een WFS u
toegang tot de objecten zelf.
Het doel voor deze les: Een WFS gebruiken en begrijpen hoe die verschilt van een WMS.
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10.2.1 Follow Along: Een WFS-laag laden

1. Begin een nieuwe kaart. Deze is alleen om te demonstreren en wordt niet opgeslagen.

2. Klik op de knop Databronnen beheren openen.

3. Schakel naar de tab WFS / OGC API - objecten.
4. Klik op de knop Nieuw.
5. Voer, in het dialoogvenster dat verschijnt, de Naam in als nsidc.org en de URL als https://nsidc.org/cgi-

bin/atlas_south?version=1.1.0`.

6. Klik op OK en de nieuwe verbinding zal verschijnen in uw Server-verbindingen.
7. Klik op de knop Verbinden. Een lijst met beschikbare lagen zal verschijnen:
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8. Deselecteer de optie Alleen objecten bevragen die het huidige zichtbare bereik overlappen onder de lijst met
lagen, omdat uw huidige kaartvenster niet ons interessegebied zou kunnen bedekken: Antarctica.

9. Zoek naar de laag antarctica_country_border. U kunt het vak Filter bovenin gebruiken.
10. Klik op de laag om die te selecteren:
11. Zoek en selecteer ook de laag south_poles_wfs. U moet misschien Ctrl ingedrukt houden.

12. Klik op Toevoegen.
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Het kan even duren voordat de lagen zijn geladen. Als zij zijn geladen zullen zij verschijnen op de kaart, de
omtrek van Antarctica en enkele punten daarop weergevend.

Waarin verschilt dit van een WMS-laag?
13. Selecteer een willekeurige laag en u zult merken dat de gereedschappen voor het selecteren van objecten en

van de attributentabel zijn ingeschakeld. Dit zijn vectorlagen.
14. Selecteer de laag south_poles_wfs en open de attributentabel ervan. U zult dit zien:

Omdat de punten attributen hebben, kunnen we ze labelen, als ook hun symbologie wijzigen. Hier is een
voorbeeld:
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Verschillen met WMS-lagen

EenWeb Feature Service geeft de laag zelf terug, niet slechts een daaruit gerenderde kaart. Dit geeft u directe toegang
tot de gegevens, wat betekent dat u hun symbologie kunt wijzigen en analyse-functies erop kunt uitvoeren. Dat gaat
echter ten koste van heel veel gegevens die moeten worden verzonden. Dit zal speciaal duidelijk zijn als de lagen die
u laadt gecompliceerde vormen hebben, enorm veel attributen, of veel objecten; of zelfs als alleen maar veel lagen
laadt. WFS-lagen hebben hierom sowieso veel tijd nodig om te laden.

10.2.2 Follow Along: Een WFS-laag bevragen

Hoewel het mogelijk is een query uit te voeren op een WFS-laag nadat die is geladen, is het vaak efficiënter om de
query uit te voeren voordat hij is geladen. Op die manier vraagt u alleen de objecten op die u wilt, wat betekent dat
u veel minder bandbreedte gebruikt.
Op de server vanWFS die wemomenteel gebruiken is bijvoorbeeld een laag genaamd countries (excluding Antarctica).
Laten we zeggen dat we willen weten waar Zuid-Afrika ligt, relatief ten opzichte van de laag south_poles_wfs (en
misschien ook de laag antarctica_country_border) die al is geladen.
Er zijn twee manieren om dit te doen. U kunt de gehele laag countries … laden, en dan zoals gewoonlijk een query
bouwen als hij is geladen. Echter, het verzenden van de gegevens voor alle landen in de wereld en dan alleen de
gegevens voor Zuid-Afrika gebruiken lijkt een verspilling van bandbreedte. Afhankelijk van uw verbinding kan het
enkele minuten duren om deze gegevensset te laden.
Het alternatief is om de query als een filter te bouwen vóór zelfs de laag te laden vanaf de server.

1. Schakel naar de tabWFS / OGC API Objecten in het dialoogvenster Databronnen beheren

2. Verbind met de server die we eerder hebben gebruikt en u zou de lijst met beschikbare lagen moeten zien.
3. Zoek en dubbelklik op de laag countries (excluding Antarctica). De laagnaam is

country_borders_excluding_antarctica. U kunt ook de laag selecteren en drukken op
de knop Query maken aan de onderzijde van het dialoogvenster:
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4. Typ, in het dialoogvenster dat verschijnt, de volgende query SELECT * FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa'
in het vak SQL-argument.

5. Druk op OK.
6. De gebruikte expressie zal verschijnen als de waarde Sql van de doellaag:
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7. Klik op Toevoegen met de laag geselecteerd zoals hierboven. Alleen het land met de waarde Countryeng
die South Africa is zal worden geladen vanuit die laag:

Hebt u het pictogram opgemerkt naast de laag country_borders_excluding_antarctica ? Het geeft aan dat
de geladen laag is gefilterd en niet al zijn objecten weergeeft in het project.

8. U hoeft het niet te doen, maar als u beide methoden heeft gebruikt, zult u merken dat dit een stuk sneller is dan
het laden van alle landen vóórdat u ze gefilterd heeft!

10.2. Lesson: Web Feature Services 311



QGIS Training Manual

Opmerkingen over de beschikbaarheid van WFS

Het is zeldzaam een host voor WFS te vinden die de objecten host die u nodig heeft, als u hele specifieke behoeften
heeft. De reden waaromWeb Feature Services relatief zeldzaam zijn is vanwege de grote hoeveelheden gegevens die
moeten worden verzonden om een geheel object te beschrijven. Het is daarom niet erg kosteneffectief om een WFS
te hosten in plaats van een WMS, dat alleen afbeeldingen verzendt.
Het meest voorkomende type WFS dat u daarom zult tegenkomen zal daarom waarschijnlijk op een lokaal netwerk
staan of zelfs op uw eigen computer, in plaats van op het internet.

10.2.3 In Conclusion

WFS-lagen hebben de voorkeur boven WMS-lagen als u directe toegang nodig heeft tot de attributen en geometrieën
van de lagen. Echter de hoeveelheid gegevens in aanmerking nemende die moet worden gedownload (wat leidt tot
problemen met de snelheid en ook een gebrek aan eenvoudig beschikbare publieke servers voorWFS) is het niet altijd
mogelijk een WFS te gebruiken in plaats van een WMS.

10.2.4 What’s Next?

Vervolgens zullen we u laten zien hoe u QGIS Server kunt gebruiken om services van OGC te verschaffen.
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Module: QGIS Server

Deze module is bijgedragen door Tudor Bărăscu.
In deze module zullen we behandelen hoe QGIS Server te installeren en te gebruiken.
Lees de QGIS-Server-manual om meer te leren over QGIS Server.

11.1 Lesson: QGIS Server installeren

Het doel voor deze les: Leren hoe QGIS Server te installeren op Debian Stretch. Met verwaarloosbare variaties
kunt u dit ook volgen voor elke distributie die is gebaseerd op Debian, zoals Ubuntu en de afgeleiden daarvan.

Notitie: In Ubuntu kunt u uw gewone gebruiker gebruiken, sudo vooraf laten gaan aan opdrachten die rechten van
de admin vereisen. In Debian kunt u werken als admin (root), zonder sudo te gebruiken.

11.1.1 Follow Along: Installeren vanuit pakketten

In deze les doen we alleen het installeren vanuit pakketten zoals hier is weergegeven.
QGIS Server installeren met:

apt install qgis-server --no-install-recommends --no-install-suggests

# if you want to install server plugins, also:
apt install python-qgis

QGIS Server zou in productie moeten worden gebruikt zonder geïnstalleerde QGIS Desktop (met de daarbij
behorende X Server) op dezelfde machine.
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11.1.2 Follow Along: QGIS Server uitvoerbare bestand

Het voor QGIS Server uitvoerbare ebstand is qgis_mapserv.fcgi. U kunt controleren waar het is geïnstalleerd
door find / -name 'qgis_mapserv.fcgi' uit te voeren wat iets uit zou moeten uitvoeren als /usr/
lib/cgi-bin/qgis_mapserv.fcgi.
Indien u, optioneel, op dit moment een test op de opdrachtregel wilt uitvoeren, kunt u de opdracht /usr/lib/
cgi-bin/qgis_mapserv.fcgi die iets uit zou moeten voeren als:

QFSFileEngine::open: No file name specified
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment␣
↪→variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment␣
↪→variable.
Content-Length: 206
Content-Type: text/xml; charset=utf-8

<ServiceExceptionReport version="1.3.0" xmlns="https://www.opengis.net/ogc">
<ServiceException code="Service configuration error">Service unknown or␣
↪→unsupported</ServiceException>
</ServiceExceptionReport>

Dat is goed, het vertelt u dat we op het juiste spoor zitten omdat de server zegt dat we niet hebben gevraagd naar een
ondersteunde service. We zullen later zien hoe verzoeken voor WMS te maken.

11.1.3 HTTP serverconfiguratie

We moeten een HTTP-server gebruiken om toegang te krijgen tot de geïnstalleerde QGIS-server via een
internetbrowser. Het installatieproces voor Apache HTTP Server wordt in detail beschreven in het gedeelte httpserver.

Notitie: Indien u QGIS Server installeerde zonder een X Server uit te voeren (opgenomen in Linux Desktop) en
indien u ook de opdracht GetPrint wilt gebruiken dan zou u een namaak- X Server moeten installeren en QGIS
Server moeten vertellen om die te gebruiken. U kunt dat doen door het Xvfb installatieproces te volgen.

11.1.4 Follow Along: Een andere virtuele host maken

Laten we eens een andere Apache virtuele host maken die verwijst naar QGIS Server. U kunt elke naam kiezen die u
wilt (coco.bango, super.duper.training, example.com, etc.) maar omwille van de eenvoud gaan wij
myhost gebruiken.

• Laten we de naam myhost instellen om te verwijzen naar het IP van de localhost IP door 127.0.0.1 x
toe te voegen aan het bestand /etc/hosts met de volgende opdracht: sh -c "echo '127.0.0.1
myhost' >> /etc/hosts" of door handmatig te bewerken met gedit /etc/hosts.

• We kunnen controleren of myhost verwijst naar de localhost door in de terminal de opdracht ping myhost
uit te voeren die terug zou moeten geven:

qgis@qgis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp_seq=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seq=2 ttl=64 time=0.029 ms
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• Laten we eens proberen of we toegang kunnen krijgen tot QGIS Server vanaf de site van myhost door uit te
voeren: curl http://myhost/cgi-bin/qgis_mapserv.fcgi of door toegang te krijgen tot de
URL via de browser van uw Debianbox. U zult waarschijnlijk terugkrijgen:

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</h1>
<p>The requested URL /cgi-bin/qgis_mapserv.fcgi was not found on this server.</p>
<hr>
<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>
</body></html>

• Apache weet niet dat het geacht wordt verzoeken te beantwoorden die verwijzen naar de server genaamd
myhost. De meest eenvoudige manier om de virtuele host in te stellen zou zijn om een bestand myhost.
conf te maken in de map /etc/apache2/sites-available die dezelfde inhoud heeft als het bestand
qgis.demo.conf met uitzondering van de regel ServerName die zou moeten zijn ServerName
myhost. U zou ook kunnen wijzigen waar de logboeken naartoe moeten worden gestuurd, omdat anders
de logboeken voor de twee virtuele hosts zouden worden gedeeld maar dit is optioneel.

• Laten we nu de virtuele host inschakelen met apt-get a2ensite myhost.conf en dan de Apache-
service opnieuw laden met service apache2 reload.

• Als u probeert toegang te krijgen tot de URL http://myhost/cgi-bin/qgis_mapserv.fcgi zult u merken dat nu
alles werkt!

11.1.5 In Conclusion

U heeft geleerd verschillende versies van QGIS Server vanuit pakketten te installeren, hoe Apache te configureren
met QGIS Server, op distributies voor Linux die zijn gebaseerd op Debian.

11.1.6 What’s Next?

Nu u QGIS Server hebt geïnstalleerd en het toegankelijk is via het protocol HTTP, moeten we leren hoe toegang
te krijgen tot enkele services die het biedt. Het onderwerp van de volgende les is hoe te leren toegang te krijgen tot
WMS-services van QGIS Server.

11.2 Lesson: Server voor WMS

De voor deze oefening gebruikte gegevens zijn beschikbaar in de submap qgis-server-tutorial-data van
de training data die u hebt gedownload. Voor het gemak en om mogelijke problemen met rechten te vermijden, gaan
we er van uit dat deze bestanden zijn opgeslagen in de map /home/qgis/projects. Pas daarom de volgende
instructies aan naar uw eigen pad.
De demogegevens bevatten een project voor QGIS project genaamd world.qgs dat al is voorbereid om te kunnen
werken met QGIS Server. Als u uw eigen project wilt gebruiken of wilt leren hoe een project wordt voorbereid, bekijk
dan het gedeelte Creatingwmsfromproject.

Notitie: Deze module geeft de URL’s weer zodat het publiek gemakkelijk onderscheid kan maken tussen de
parameters en de waarden van de parameters. Hoewel de normale indeling is:

...&field1=value1&field2=value2&field3=value3

gebruikt deze handleiding:
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&field1=value1
&field2=value2
&field3=value3

Plakken hiervan in Mozilla Firefox werkt correct, maar andere webbrowsers, zoals Chrome, zouden ongewenste
spaties kunnen toevoegen tussen de paren veld:parameter. Dus, als u dit probleem tegenkomt dient u ofwel
Firefox te gebruiken of de URL’s aan te passen zodat zijn in de indeling voor op één regel staan.

Laten we een verzoek voor WMS GetCapabilities maken in de webbrowser of met curl:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

In de configuratie voor Apache uit e vorige les stelt de variabele QGIS_PROJECT_FILE het standaard project in op
/home/qgis/projects/world.qgs. Echter, in het bovenstaande verzoek gebruikten we de parametermap
parameter om expliciet te zijn en om aan te geven dat het kan worden gebruikt om naar een punt in elk project te
kunnen verwijzen. Indien u de parameter map verwijdert uit het bovenstaande verzoek zal QGIS Server hetzelfde
antwoord teruggeven.
Door een WMS-cliënt laten verwijzen naar de URL GetCapabilities, krijgt de cliënt als antwoord een XML-
document met metadata van de informatie van de Web Map Server, bijv. welke lagen het bevat, de geografische
bedekking, in welke indeling, welke versie van WMS etc.
Omdat QGIS zelf ook een ogc-wms is kunt u een nieuwe serververbinding voor WMS maken met de hulp van de
bovenstaande URL GetCapabilities. Bekijk de gedeelten Lesson: Web Mapping Services of ogc-wms-servers over hoe
dit te doen.
Door het toevoegen van de WMS-laag countries aan uw project van QGIS zou u een afbeelding moeten krijgen
zoals hieronder:
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Fig. 11.1: QGIS Desktop verwerkt de QGIS Server WMS-service laag countries

Notitie: QGIS Server verwerkt lagen die zijn gedefinieerd in het project world.qgs. Door het project te openen
met QGIS kunt u zien dat er verschillende stijlen zijn voor de laag countries. QGIS Server is zich daar ook van
bewust en u kunt in uw verzoek de stijl kiezen die u wilt. De stijl classified_by_population werd voor
bovenstaande afbeelding gekozen.
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11.2.1 Loggen

Wanneer u een server instelt, zijn de logboeken altijd belangrijk omdat zij weergeven wat er gebeurt. We hebben in
het bestand *.conf de volgende logboeken ingesteld:

• QGIS Server log op /logs/qgisserver.log
• qgisplatform.demo Apache access log op qgisplatform.demo.access.log
• qgisplatform.demo Apache error log op qgisplatform.demo.error.log

De bestanden voor de logboeken zijn eenvoudigweg tekstbestanden, dus u kunt een tekstbewerker gebruiken om ze te
bekijken. U kunt ook de opdracht tail in a terminal gebruiken: sudo tail -f /logs/qgisserver.log.
Dit zal doorlopend uitvoer geven in de terminal over wat er in dat logbestand staat geschreven. U kunt ook drie
terminals geopend hebben voor elk logbestand, als volgt:

Fig. 11.2: De opdracht tail gebruiken om de uitvoer van de logs van QGIS Server te visualiseren

Wanneer u de QGIS Desktop gebruikt om de WMS-services van QGIS Server WMS te verwerken zul;t u alle
verzoeken zien die QGIS verstuurt naar de Server in het access log, de fouten van QGIS Server in het QGIS Server
log etc.
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Notitie:
• Als u kijkt naar de logs in de volgende gedeelten zult u beter begrijpen wat er gebeurt.
• Door Apache opnieuw te starten terwijl u kijkt naar het log van QGIS Server, vindt u enkele extra aanwijzingen
over hoe dingen werken.

11.2.2 Verzoeken GetMap

QGIS Desktop gebruikt, om de laag countries weer te geven,, net als elke andere WMS-cliënt, verzoeken
GetMap.
Een eenvoudig verzoek ziet er uit als:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries
&FORMAT=image/jpeg

Het bovenstaande verzoek zal de volgende afbeelding teruggeven:
Afbeelding: eenvoudig verzoek GetMap aan QGIS Server
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Fig. 11.3: Antwoord van Qgis Server na een eenvoudig verzoek GetMap

11.2.3 Try Yourself De parameters Image en Layers wijzigen

Laten we, gebaseerd op het bovenstaande verzoek, de laag countries vervangen door een andere.
U zou, om te kunnen zien welke andere lagen beschikbaar zijn, het project world.qgs kunnen openen in QGIS
en kijken naar de inhoud. Onthoud echter dat de WMS-cliënten geen toegang hebben tot het project van QGIS, zij
kijken slechts naar de inhoud van het document capabilities.
Ook is er een optie in de configuratie die enkele bestaande lagen in het project van QGIS laat negeren door QGIS als
de WMS-service wordt bediend.
U zou dus kunnen kijken naar de lagenlijst als u QGIS Desktop verwijst naar de URL GetCapabilities of u
zou zelf andere namen kunnen proberen te vinden in het XML-antwoord GetCapabilities.
Eén van de laagnamen die u zou kunnen vinden en die werktcountries_shapeburst. U zou ook andere kunnen
vinden maar onthoud dat sommige niet zichtbaar zouden kunnen zijn op een dergelijke kleine schaal, dus zou u een
blanco afbeelding als antwoord kunnen krijgen.
U kunt ook nog met enkele andere parameters hierboven kunnen experimenteren, zoals het wijzigen van het type
afbeelding naar image/png.
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11.2.4 Follow Along: Filteren, transparantie en parameters Stijlen
gebruiken

Laten we een ander verzoek doen dat een andere laag toevoegt, enkele van de parameters extra-getmap-parameters,
FILTER en OPACITIES, maar ook de standaard parameter STYLES gebruikt.

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&FORMAT=image/jpeg
&LAYERS=countries,countries_shapeburst
&STYLES=classified_by_name,blue
&OPACITIES=255,30
&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

Het bovenstaande verzoek zal de volgende afbeelding teruggeven:

Fig. 11.4: Antwoord voor een verzoek GetMap met parameters FILTER en OPACITIES
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Zoals u kunt zien, naast andere dingen, in de bovenstaande afbeelding, vertelden weQGIS Server om alleenGermany
en Italy te renderen uit de laag countries.

11.2.5 Follow Along: Redlining gebruiken

Laten we een ander verzoek GetMap doen dat gebruik maakt van de mogelijkheid qgisserver-redlining en van de
parameter SELECTION die in detail wordt besproken in het gedeelte extra-getmap-parameters:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries,countries_shapeburst
&FORMAT=image/jpeg
&HIGHLIGHT_GEOM=POLYGON((590000 6900000, 590000 7363000, 2500000 7363000, 2500000␣
↪→6900000, 590000 6900000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
↪→<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter␣
↪→name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
↪→SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
↪→LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=QGIS Tutorial
&HIGHLIGHT_LABELSIZE=30
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=3
&SELECTION=countries:171,65

Plakken van het bovenstaande verzoek in uw webbrowser zou de volgende afbeelding terug moeten geven:
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Fig. 11.5: Antwoord op een verzoek met de mogelijkheid REDLINING en de parameter SELECTION

U kunt in de bovenstaande afbeelding zien dat de landen met de ID’s 171 en 65 in geel zijn geaccentueerd (Roemenië
en Frankrijk) met behulp van de parameter SELECTION en we gebruikten de mogelijkheid REDLINING om er
een label met QGIS Tutorial overheen te leggen.

11.2.6 Verzoeken GetPrint

Een bijzonder aardige mogelijkheid van QGIS Server is dat het gebruik maakt van de QGIS Desktop afdruklay-outs.
U kunt daar meer over leren in het gedeelte server_wms_getprint.
Als u het project world.qgs opent met QGIS Desktop zult u een afdruklay-out vinden, genaamd Population
distribution. Een vereenvoudigd verzoek GetPrint dat een voorbeeld is van deze fantastische mogelijkheid
is:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?map=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0&
REQUEST=GetPrint
&FORMAT=pdf
&TRANSPARENT=true
&SRS=EPSG:3857
&DPI=300
&TEMPLATE=Population distribution

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
&map0:extent=-432786,4372992,3358959,7513746
&LAYERS=countries

Fig. 11.6: Geeft de resulterende PDF weer van bovenstaand verzoek GetPrint

Natuurlijk is het moeilijk om uw verzoeken GetMap, GetPrint etc. te schrijven.
QGISWebClient of QWC is eenWebcliëntproject dat naast QGIS Server kan werken zodat u uw projecten op het web
kunt publiceren of u kan helpen verzoeken voor QGIS Server te maken voor een beter begrip over de mogelijkheden.
U kunt het als volgt installeren:

• Ga, als gebruiker qgis, naar de thuismap met cd /home/qgis.
• Download het QWCproject vanaf hier en pak het uit.
• Maak een symbolische koppeling naar de map /var/www/html omdat dat de DocumentRoot is die we
hebben ingesteld in de configuratie van de virtuele host. Als u het archief heeft uitgepakt onder/home/qgis/
Downloads/QGIS-Web-Client-master kunnen we dat doen met sudo ln -s /home/qgis/
Downloads/QGIS-Web-Client-master /var/www/html/.

• Ga naar http://qgisplatform.demo/QGIS-Web-Client-master/site/qgiswebclient.html?map=/home/qgis/
projects/world.qgs vanuit uw webbrowser.

Nu zou u de kaart moeten kunnen zien zoals die in de volgende afbeelding:
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Fig. 11.7: QGIS Web Client verwerkt het project world.qgs

Als u klikt op de knop Print in QWC kunt u interactief verzoeken GetPrint maken. U kunt ook klikken op het
pictogram ? in QWC om toegang te verkrijgen tot de beschikbare Help zodat u de mogelijkheden van QWC beter
kunt ontdekken.

11.2.7 In Conclusion

U heeft geleerd QGIS Server WMS-services te laten verschaffen.
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11.2.8 What’s Next?

Vervolgens zullen we u laten zien hoe u QGIS kunt gebruiken als startpunt voor het beroemde GRASS GIS.
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Module: GRASS

GRASS (Geographic Resources Analysis Support System) is een bekend open bron GIS met een brede variëteit
aan handige functies voor GIS. Het werd voor het eerst uitgegeven in 1984 en heeft sindsdien veel verbeteringen
ondergaan en aanvullende functionaliteit gekregen. QGIS stelt u in staat direct gebruik te maken van de krachtige
gereedschappen voor GIS in GRASS.

12.1 Lesson: GRASS instellen

GRASS gebruiken in QGIS vereist dat u op een enigszins andere manier naar de interface kijkt. Onthoud dat u niet
direct werkt in QGIS, maar dat u werkt in GRASS via QGIS. Daarom dient u er voor te zorgen dat u QGIS Desktop
hebt geïnstalleerd met ondersteuning voor Grass.

Voor het openen van een sessie van QGIS met GRASS, beschikbaar op Windows, dient u te klikken op het
pictogram QGIS Desktop with GRASS.
Het doel voor deze les: Een project in GRASS beginnen in QGIS.

12.1.1 Follow Along: Een nieuwe sessie in GRASS beginnen

U moet, net als met elke andere plug-in, het activeren om GRASS te kunnen starten vanuit QGIS:
1. First, open a new QGIS project.
2. Schakel, in Plug-ins beheren en installeren… Manager, GRASS in in de lijst:
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De werkbalk voor GRASS en het paneel GRASS zullen verschijnen:

Fig. 12.1: GRASS werkbalk

328 Hoofdstuk 12. Module: GRASS



QGIS Training Manual

Fig. 12.2: Paneel GRASS

Het paneel GRASS is niet actief omdat u, vóórdat u GRASS kunt gebruiken, u een Mapset dient te maken. GRASS
werkt altijd in een databaseomgeving, wat betekent dat u alle gegevens die u wilt gebruiken moet importeren in een
database van GRASS.
De database voor GRASS heeft een vrij eenvoudige structuur, zelfs als die er op het eerste oog zeer gecompliceerd
uitziet. Het meest belangrijke ding dat u zou moeten weten is dat het bovenste niveau van de database de Location
is. Elke Location mag meerdere Mapset’s bevatten: in elke Mapset vindt u de Mapset PERMANENT omdat
die standaard wordt gemaakt door GRASS. Elke Mapset bevat de gegevens (raster, vector, etc) in een bepaalde
structuur, maar geen zorgen, GRASS zal, voor u, daarvoor zorgen.
Onthoud gewoon: Location bevat Mapset dat de gegevens bevat. Voor meer informatie, bezoek de website van
GRASS.
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Fig. 12.3: GRASS databasestructuur (uit documenten van GRASS)

12.1.2 Follow Along: Een nieuw project in GRASS beginnen

1. Klik op het menu Plug-ins –> GRASS –> Nieuwe mapset:

U zult worden gevraagd naar om de locatie van de database van GRASS te kiezen.
2. Stel het in als de map die door GRASS zal worden gebruikt om de database ervan in te stellen:
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3. Klik op Next.
GRASS moet een Location maken, die het maximale bereik beschrijft van het geografische gebied waarin u zult
werken, ook wel bekend als Region in Grass.

Notitie: de Region is extreem belangrijk voor GRASS omdat het het gebied beschrijft waarin met alle lagen rekening
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wordt gehouden voor GRASS. Alles wat er buiten ligt zal niet in overweging worden genomen. Geen zorgen, u kunt
altijd het bereik van de Region van GRASS wijzigen, nadat de Location is gemaakt

1. Noem de nieuwe locatie SouthAfrica:

2. Klik op Next.
3. We zullen werken met WGS 84, dus zoek naar en selecteer dit CRS:
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4. Klik op Next.
5. Selecteer nu de regio South Africa uit de keuzelijst en klik op Toepassen:
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6. Klik op Next.
7. Maak een mapset, wat het bestand met kaarten is waarmee u zult werken.
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Als u gereed bent, zult u een dialoogvenster zien dat u een samenvatting geeft van de ingevoerde informatie.
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8. Klik op Finish.
9. Klik op OK in het dialoogvenster.

U zult zien dat het paneel GRASS actief zal worden en u kunt beginnen met het gebruiken van alle gereedschappen
voor GRASS.
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12.1.3 Follow Along: Vectorgegevens in GRASS laden

U heeft nu een blanco kaart en voordat u van start gaat met het gebruiken van alle gereedschappen van GRASS, dient
u gegevens te laden in de database van GRASS database, specifiek in de mapset. U kunt geen gereedschappen van
GRASS gebruiken met lagen die niet zijn geladen in een mapset van GRASS.
Er zijn vele manieren om gegevens in de database van GRASS te laden. Laten we beginnen meet de eerste.

Follow Along: Gegevens laden met de QGIS Browser

In het gedeelte Het paneel Browser zagen we dat de gemakkelijkste en snelste manier de gegevens in QGIS te laden
het paneel Browser is.
Gegevens voor GRASS worden vanuit de QGIS Browser herkend als echte gegevens voor GRASS en u kunt dat zien

omdat u het pictogram van GRASS naast de mapset van GRASS zult zien. Meer nog, u zult het pictogram naast
de geopende mapset zien staan.

Notitie: U zult een replicatie vand GRASS Location als een normale map zien: gegevens van GRASS mapset zijn
die in de map

U kunt gemakkelijk lagen slepen en laten vallen uit mappen naar de mapset van GRASS.
Laten we de laag roads proberen te importeren in de mapset grass_mapset van de Location SouthAfrica.
Ga naar de Browser en sleep eenvoudigweg de laag roads uit het bestand voor GeoPackage training_data.
gpkg in de mapset grass_mapset.
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Dat is alles! Als u de mapset vergroot zult u de geïmporteerde laag roads zien. U kunt nu de geïmporteerde laag in
QGIS laden, net als alle andere lagen.

Tip: U kunt ook lagen laden uit het paneel Legenda van de lagen in de mapset in het paneel Browser. Dit zal uw
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werkstroom enorm versnellen!

Follow Along: Gegevens laden met het paneel GRASS

We zullen nu de lange methode gebruiken om de laag rivers.shp in dezelfde mapset te laden.
1. Laad gegevens zoals gewoonlijk in QGIS. Gebruik de gegevensset rivers.shp (te vinden in de map

exercise_data/shapefile/).
2. Klik, zodra die is geladen, op het vak Filter van het paneel GRASS en zoek naar het gereedschap voor het

importeren van vector door de term v.in.ogr.qgis in te voeren:

Waarschuwing: Er zijn 2 soortgelijke gereedschappen:v.in.ogr.qgis env.in.ogr.qgis.loc.
We zoeken de eerste.

De v staat voor vector, in betekent een functie om gegevens te importeren in de database van GRASS,
ogr is de softwarebibliotheek die wordt gebruikt om de vectorgegevens te lezen, en qgis betekent dat het
gereedschap zal zoeken naar een vector naast de vectoren die al zijn geladen in QGIS.

3. Als u dit gereedschap eenmaal hebt gevonden, klik er dan op om het gereedschap zelf te activeren. Kies de
laag rivers in het van Geladedn laag en typ en noem die g_rivers om verwarring te voorkomen:
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Notitie: Let op de extra opties voor importeren die worden verschaft onder Geavanceerde opties
tonen. Deze omvatten de mogelijkheid om een clausule WHERE toe te voegen aan de SQL-query die wordt
gebruikt voor het importeren van de gegevens.

4. Klik op Uitvoeren om het importeren te starten.
5. Klik, als het voltooid is, op de knop Uitvoer bekijken om de nieuw geïmporteerde laag voor GRASS in de kaart

te bekijken.
6. Sluit eerst het gereedschap voor het importeren (klik op de knop Close direct rechts naast Uitvoer bekijken), en

sluit het venster GRASS-gereedschap.
7. Verwijder de originele laag rivers.

Nu heeft u alleen nog de geïmporteerde laag van GRASS weergegeven in uw kaart van QGIS.
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12.1.4 Follow Along: Rastergegevens in GRASS laden

U kunt een rasterlaag op dezelfde manier importeren als hoe we vectorlagen importeerden.
We gaan in de mapset van GRASS de laag srtm_41_19_4326.tif importeren.

Notitie: de rasterlaag staat al in het juiste CRS, WGS 84. Als u lagen in een ander CRS hebt, dient u die eerst
opnieuw te projecteren naar hetzelfde CRS als dat van de mapset van GRASS

1. Laad de laag srtm_41_19_4326.tif in QGIS
2. Open opnieuw het dialoogvenster GRASS-gereedschap.
3. Klik op de tab Moduleslijst.
4. Zoek naar r.in.gdal.qgis en dubbelklik op het gereedschap om het dialoogvenster van het gereedschap

te openen.
5. Stel het zo in dat de invoerlaag srtm_41_19_4326.tif is en de uitvoer g_dem is.

12.1. Lesson: GRASS instellen 341



QGIS Training Manual

6. Klik op Uitvoeren.
7. Als het proces is voltooid, klik op Uitvoer bekijken.
8. Close de huidige tab en Close dan het gehele dialoogvenster.
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9. U kunt nu de originele laag srtm_41_19_4326.tif verwijderen.

12.1.5 Try Yourself Lagen toevoegen aan mapset

Probeer in de mapset van GRASS Mapset de vectorlagen water.shp en places.shp uit de map
exercise_data/shapefile/ te importeren. Hernoem, zoals we al deden voor rivers, de geïmporteerde
laag als g_water en g_places om verwarring te voorkomen
Controleer uw resultaten

12.1.6 Een bestaande maspet van GRASS openen

Als u al een bestaande mapset voor GRASS hebt, kunt u die gemakkelijk heropenen in een andere sessie van QGIS.
U heeft verscheidene methoden om een mapset voor GRASS te openen, laten we enkele daarvan verkennen.
Laten we de mapset sluiten door te klikken op de knop Mapset sluiten van het venster van GRASS-gereedschap.

Follow Along: De plug-in GRASS gebruiken

1. Klik op het menu Plug-ins –> GRASS –> Mapset openen naast het menu Plugeins –> GRASS –> Nieuwe mapset
dat we in het vorige gedeelte zagen.

2. Blader naar de map van de database van GRASS: wees voorzichtig! U moet de oudermap selecteren, niet die
van de mapset voor GRASS. GRASS zal inderdaad alle Locations van de database lezen en alle Mapsets
van elke Location:
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3. Kies de Location SouthAfrica en de mapset grass_mapset die we eerder hebben gemaakt.
Dat is alles! Het paneel GRASS zal actief worden wat betekent dat de mapset correct is geopend.

Follow Along: De QGIS Browser gebruiken

Nog sneller en gemakkelijker is het openen van een mapset met de QGIS Browser:
1. Sluit de mapset (als die geopend is) door te klikken op de knop Mapset sluiten van het venster GRASS-

gereedschap.
2. Blader, in de QGIS Browser, naar de map van de database van GRASS.

3. Klik met rechts op de mapset (onthoud dat de mapset het pictogram GRASS naast zich heeft staan). U
zult enkele opties zien.

4. Klik op Mapset openen:
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De mapset is nu geopend en klaar om te gebruiken!

Tip: Klikken met rechts op een mapset van GRASS biedt u een groot aantal verschillende instellingen. Probeer ze
te verkennen en bekijk alle nuttige opties.
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12.1.7 In Conclusion

De werkstroom voor GRASS voor het binnenhalen van gegevens is enigszins anders dan de methode van QGIS omdat
GRASS zijn gegevens in een ruimtelijke databasestructuur laad. Door echter QGIS als startpunt te gebruiken, kunt
u het instellen van een mapset voor GRASS eenvoudiger maken door bestaande lagen in QGIS te gebruiken als
gegevensbronnen voor GRASS.

12.1.8 What’s Next?

Nu de gegevens zijn geïmporteerd in GRASS kunen we kijken naar de geavanceerde analysebewerkingen die GRASS
bied.

12.2 Lesson: GRASS-gereedschap

In deze les zullen we een selectie van gereedschappen presenteren om u een idee van de mogelijkheden van GRASS
te geven.

12.2.1 Follow Along: Een kaart van de ligging maken

1. Open de tab GRASS-gereedschap

2. Laad de rasterlaag g_dem uit de mapset grass_mapset

3. Zoek naar de module r.aspect door er naar te zoeken in het veld Filter van de tab Modules

4. Open het gereedschap en stel het in zoals hier en klik op de knop Uitvoeren:
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5. Als het proces is voltooid klik dan op Uitvoer bekijken om de resulterende laag in het kaartvenster te laden:
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De laag g_aspect is opgeslagen in de mapset grass_mapset dus u kunt de laag uit het kaartvenster verwijderen en
opnieuw laden wanneer u wilt.

12.2.2 Follow Along: Basisstatistieken van de rasterlaag verkrijgen

We willen enkele basisstatistieken van de rasterlaag g_dem weten.
1. Open de tab GRASS-gereedschap

2. Laad de rasterlaag g_dem uit de mapset grass_mapset

3. Zoek naar de module r.info door er naar te zoeken in het veld Filter van de tab Modules

4. Stel het gereedschap in zoals hier en klik op Uitvoeren:
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5. Op de tab Uitvoer zult u enige informatie over het raster zien afgedrukt, zoals het pad naar het bestand, het
aantal rijen en kolommen en andere nuttige informatie:
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12.2.3 Follow Along: Het gereedschap Reclass

Opnieuw classificeren van een rasterlaag is een bijzonder nuttige taak.We hebben zojuist de laag g_aspect gemaakt
uit de g_dem. Het bereik van de waarden gaat van 0 (Noord) langs 90 (Oost), 180 (Zuid), 270 (West) en tenslotte
naar 360 (Noord opnieuw).We kunnen de laag g_aspect opnieuw classificeren om slechts 4 categorieën te hebben
door specifieke regels te volgen (Noord = 1, Oost = 2, Zuid = 3 en West = 4).
Het gereedschap Reclassify van Grass accepteert een bestand txt met de gedefinieerde regels. Het schrijven van de
regels is erg eenvoudig en de handleiding van GRASS bevat een hele goede beschrijving.

Tip: Elk gereedschap van GRASS heeft zijn eigen tab Handleiding. Neem de tijd om de beschrijving van het
gereedschap dat u gaat gebruiken door te lezen om nuttige parameters niet te missen

1. Laad het bestand g_aspect of, als u dat niet gemaakt hebt, ga terug naar het gedeelte Follow Along: Een
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kaart van de ligging maken.
2. Zoek naar de module r.reclass door er naar te zoeken in het veld Filter van de tab Modules

3. Open het gereedschap en stel het in zoals op de volgende afbeelding. Het bestand dat de regels bevat, in de
map exercise_data/grass/, is genaamd reclass_aspect.txt.

4. Klik op Uitvoeren en wacht tot het proces is voltooid:

5. Klik op Uitvoer bekijken om het opnieuw geclassificeerde raster in het kaartvenster te laden

12.2. Lesson: GRASS-gereedschap 351



QGIS Training Manual

De nieuwe laag is opgemaakt met slechts 4 waarden (1, 2, 3, en 4) en het is gemakkelijker te beheren en te
verwerken.

Tip: Open het bestand reclass_aspect.txt met een tekstbewerker om de regels te bekijken en er aan te
wennen. Meer nog, bekijk de handleiding van GRASS wat nader: veel verschillende voorbeelden zijn beschikbaar.

12.2.4 Try Yourself Opnieuw classificeren met uw regels

Probeer de laag g_dem opnieuw te classificeren in 3 nieuwe categorieën:
• van 0 tot 1000, nieuwe waarde = 1
• van 1000 tot 1400, nieuwe waarde = 2
• vanaf 1400 tot de maximum rasterwaarde, nieuwe waarde = 3

Controleer uw resultaten

12.2.5 Follow Along: Het gereedschap Mapcalc

Het gereedschap Mapcalc is soortgelijk aan de Rasterberekeningen van QGIS. U kunt rekenkundige bewerkingen
uitvoeren op een of meer rasterlagen en het uiteindelijke resultaat zal een nieuwe laag zijn met de berekende waarden.
Het doel van de volgende oefening is om de waarden die groter zijn dan 1000 uit de rasterlaag g_dem uit te nemen.

1. Zoek naar de module r.mapcalc door er naar te zoeken in het veld Filter van de tab Modules

2. Start het gereedschap.
Het dialoogvensterMapcalc stelt u in staat een reeks analyses te construeren die moeten worden uitgevoerd op
een raster, of collectie rasters. U zult deze gereedschappen gebruiken om dat te doen:
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In volgorde zijn dat:
• Kaart toevoegen: Voeg een rasterbestand uit uw huidige mapset van GRASS toe.
• Constante toevoegen: Een constante waarde toevoegen die moet worden gebruikt in functies, 1000 in dit
geval.

• Operator of functie toevoegen: Een operator of functie toevoegen die moet worden verbonden met de
invoer en uitvoer. We zullen de operator groter dan of is gelijk aan gebruiken.

• Verbinding toevoegen: Verbindt elementen. Klik en sleep, met dit gereedschap, van de ene rode punt op
het ene item naar de rode punt op een ander item. Punten die juist zijn verbonden met een verbindingslijn
zullen grijs worden. Als de lijn of punt rood is, is die niet juist verbonden!

• Item selecteren: Selecteert een item en geselecteerde items verplaatsen.
• Verwijder geselecteerde item: Verwijdert het geselecteerde item uit het huidige blad voor mapcalc, maar
niet uit de mapset (als het een bestaand raster is)

• Openen: Een bestaand bestand openen met de gedefinieerde bewerking
• Opslaan: Alle bewerkingen opslaan in een bestand
• Opslaan als: Alle bewerkingen opslaan in een nieuw bestand op de schijf.

3. Construeer het volgende algoritme met deze gereedschappen:
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4. Klik op Uitvoeren en dan op Uitvoer bekijken om de uitvoer te zien weergegeven in uw kaart:
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Dit geeft alle gebieden weer waar het terrein hoger is dan 1000 meter.

Tip: U kunt ook de formule die u hebt gemaakt opslaan en laden in een ander project van QGIS door te klikken op
de laatste knop van de werkbalk van GRASS Mapcalc.

12.2.6 In Conclusion

In deze les hebben we slechts een paar van de vele gereedschappen behandeld die GRASS te bieden heeft. Open
het dialoogvenster GRASS-gereedschap en scroll door de Modules om de mogelijkheden van GRASS voor uzelf te
verkennen. OF, voor een meer gestructureerde benadering, kijk onder de tab Modules, waar de gereedschappen op
type zijn vermeld.
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Module: Beoordeling

Gebruik uw eigen gegevens voor dit gedeelte. U zult nodig hebben:
• een punt-vectorgegevensset van interessante punten (POIi’s), met namen voor de punten en meerdere
categorieën

• een lijn-vectorgegevensset van wegen
• een polygoon-vectorgegevensset van grondgebruik (met behulp van grenzen voor eigendommen)
• een afbeelding met visueel-spectrum (zoals een luchtfoto)
• een DEM (te downloaden vanaf de CGIAR-CSI als u er zelf geen heeft)

13.1 Een basiskaart maken

Vóórdat u een gegevensanalyse doet, heeft u een basiskaart nodig, die u de resultaten van de analyse met context
verschaft.

13.1.1 De puntlaag toevoegen

• Voeg de puntlaag toe. Gebaseerd op het niveau waarop u de cursus doet, doet u alleen wat vermeld is in het
toepasselijke gedeelte hieronder:

• Label de punten overeenkomstig een uniek attribuut, zoals plaatsnamen. Gebruik een klein lettertype en houd
de labels nauwelijks leesbaar. De informatie zou beschikbaar moeten zijn, maar zou geen hoofdonderdeel van
de kaart uit moeten maken.

• Classificeer de punten zelf in verschillende kleuren, gebaseerd op een categorie. Categorieën zouden,
bijvoorbeeld, kunnen omvatten “toeristische bestemming”, “politiebureau” en “stadscentrum”.
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• Doe hetzelfde als in het gedeelte .
• Classificeer de punten op belangrijkheid: hoe meer belangrijk een object is, hoe groter de punt ervan.
Overschrijd echter niet de grootte 2.00 voor de punt.

• Voor objecten die niet zijn geplaatst op één punt (bijvoorbeeld provinciale/regionale namen, of namen van
steden op een grote schaal), wijst u in het geheel geen punt toe.

• Gebruik helemaal geen puntsymbolen om de laag te symboliseren. Gebruik in plaats daarvan labels die zijn
gecentreerd over de punten; de symbolen punt zelf zouden geen grootte moeten hebben.

• Gebruik Data-bepaalde eigenschappen om de labels op te maken in betekenisvolle categorieën.
• Voeg, indien nodig, toepasselijke kolommen toe aan de attributengegevens. Maak, als u dat doet, geen fictionele
gegevens - maar, gebruik de Veldberekening om de nieuwe kolommen te vullen, gebaseerd op toepasselijk
bestaande waarden in de gegevensset.

13.1.2 Voeg de lijnlaag toe

• Voeg de laag met wegen toe en wijzig dan de symbologie daarvan. De wegen krijgen geen label.

• Wijzig de symbologie van de weg naar een lichte kleur met een brede lijn. Maak het ook iets transparant.

• Maak een symbool met meerdere symboollagen. Het resulterende symbool zou er als een echte weg uit moeten
zien. U kunt hier een eenvoudig symbool voor gebruiken; bijvoorbeeld een zwarte lijn met een dunne witte lijn
die door het midden ervan loopt. Het mag ook meer uitgewerkt zijn, maar de resulterende kaart zou er niet te
druk uit moeten zien.

• Als uw gegevensset een hoge dichtheid aan wegen heeft op de schaal waarop u de kaart wilt weergeven, zou u
twee lagen met wegen moeten hebben: de uitgewerkte met het symbool dat op een weg lijkt en een eenvoudiger
symbool voor kleinere schalen. (Gebruik schaalafhankelijke zichtbaarheid om ze uit te laten schakelen op de
toepasselijke schalen.)

• Alle symbolen zouden meerdere symboollagen moeten hebben. Gebruik symbolen om ze juist te laten
weergeven.
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• Doe hetzelfde als in het gedeelte hierboven.
• In aanvulling daarop zouden de wegenmoeten worden geclassificeerd. Bij het gebruiken van realistische wegen-
achtige symbolen, zou elk type weg een toepasselijk symbool moeten hebben; een snelweg zou bijvoorbeeld
twee rijstroken in elke richting moeten hebben.

13.1.3 Voeg de polygoonlaag toe

• Voeg de laag voor grondgebruik toe en wijzig de symbologie daarvan.

• Classificeer de laag overeenkomstig het grondgebruik. Gebruik volle kleuren.

• Classificeer de laag overeenkomstig het grondgebruik. Waar van toepassing, verwerk symboollagen,
verschillende typen symbolen, etc. laat echter de resultaten er gematigd en uniform uitzien. Onthoud dat dit
een deel is van de achtergrond!

• Gebruik op regels gebaseerde classificatie om het grondgebruik in algemene categorieën te verdelen, zoals
“stedelijk”, “landelijk”, “natuarreservaat”, etc.

13.1.4 Maak de raster-achtergrond

• Maak een schaduw voor heuvels uit de DEM en gebruik die als een transparant op een geclassificeerde versie
van de DEM zelf. U zou ook de plug-in Reliëf kunnen gebruiken (zoals weergegeven in de les over plug-ins).

13.1.5 Voltooien van de basiskaart

• Maak met behulp van de genoemde bronnen een basiskaart door enkele of alle lagen te gebruiken. De kaart
dient alle basisinformatie te bevatten die nodig is ter orientatie en dient visueel eenduidig en attractief te zijn.
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13.2 De gegevens analyseren

• U zoekt naar een eigendom dat voldoet aan bepaalde criteria.
• U mag beslissen op basis van uw eigen criteria, die u wel moet documenteren.
• Er zijn enkele richtlijnen voor deze criteria:

– het doel-eigendom zou deel moeten zijn van (een) bepaalde type(n) grondgebruik
– het zou binnen een bepaalde afstand van wegen moeten liggen, of worden gekruist door een weg
– het zou binnen een bepaalde afstand van enige categorie van punten moeten liggen, zoals bijvoorbeeld
een ziekenhuis

13.2.1 /

• Neem rasteranalyse op in uw resultaten. Overweeg ten minste één afgeleide eigenschap van het raster,zoals het
aspect of de helling ervan.

13.3 Uiteindelijke kaart

• Gebruik de Afdruklay-out om een uiteindelijke kaart te maken, waarin uw analyseresultaten zijn verwerkt.
• Neem de kaart op in een document en vul aan met extra documentatie. Wanneer de kaart visueel te druk wordt
dan is het mogelijk lagen te deselecteren.

• Uw kaart moet een titel en een legenda bevatten.
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Module: Toepassing Bosbouw

In demodules 1 tot enmet 13 heeft u al heel veel geleerd over QGIS en hoe ermee te werken. Als u bent geïnteresseerd
om iets meer te leren over enkele basistoepassingen voor bosbouw van GIS, zal het volgen van deze module u de
mogelijkheid geven toe te passen wat u heeft geleerd en zal u enkele nieuwe handige gereedschappen tonen.

De ontwikkeling van deze module is gesponsord door de Europese Unie.

14.1 Lesson: Presentatie module Bosbouw

Het volgen van deze module over een toepassing voor bosbouw vereist de kennis die u heeft geleerd in de modules 1
tot en met 11 van deze trainingshandleiding. De oefeningen in de volgende lessen gaan er van uit dat u al in staat bent
veel van de basisbewerkingen in QGIS uit te voeren en alleen gereedschappen die nog niet eerder werden gebruikt
zullen meer in detail worden gepresenteerd.
Niettegenstaande dat volgt de module een basisniveau door de lessen zodat, als u eerdere ervaringen heeft met QGIS,
u de instructies waarschijnlijk zonder problemen kunt volgen.
Merk op dat u een aanvullend pakket met gegevens moet downloaden voor deze module.
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14.1.1 Voorbeeldgegevens Bosbouw

Notitie: De voorbeeldgegevens die in deze module worden gebruikt maken deel uit van de gegevensset voor de
Trainingshandleiding en is beschikbaar in de map exercise_data\forestry\.

De aan bosbouw gerelateerde voorbeeldgegevens (kaart over bosbouw, gegevens over bosbouw), zijn verschaft door
de EVO-HAMK school voor bosbouw. De gegevenssets zijn aangepast om aan de behoeften voor de lessen te voldoen.
De algemene voorbeeldgegevens (luchtfoto’s, gegevens van LiDAR, basiskaarten) zijn verkregen van deNational Land
Survey of Finland open data service, en aangepast voor de doelen van deze lessen. Toegang tot de downloadservice
voor het open gegevensbestand kan, in het Engels, hier. worden verkregen.

Waarschuwing: Net als voor de rest van de trainingshandleiding bevat deze module instructies over het
toevoegen, verwijderen en wijzigen van gegevenssets voor GIS. We hebben voor dit doel trainingssets verschaft.
Zorg er voor dat u altijd goede back-ups heeft vóórdat u de hier beschreven technieken toepast op uw eigen
gegevens!

14.2 Lesson: Geoverwijzingen in een kaart

Een veelvoorkomende taak in de bosbouw zou het bijwerken kunnen zijn van de informatie over een gebied met
bosbouw. Het is mogelijk dat de eerdere informatie voor dat gebied al van jaren geleden is en analoog ( dat is: op
papier) werd verkregen of dat het werd gedigitaliseerd maar dat alles wat u nog heeft de papieren versie van de
gegevens van de inventarisatie is.
Heel waarschijnlijk zou u die informatie in uw GIS willen gebruiken om, bijvoorbeeld, later te vergelijken met latere
inventarisaties. Dit betekent dat u de voor de hand liggende informatie moet digitaliseren met uw software voor GIS.
Maar voordat u kunt beginnen met digitaliseren, is er een belangrijke eerste stap die moet worden uitgevoerd, scannen
en aanbrengen van geoverwijzingen in uw papieren kaart.
Het doel voor deze les: Het gereedschap Georeferencer in QGIS leren gebruiken.

14.2.1 De kaart scannen

De eerste taak die u zult moeten uitvoeren is het scannen van uw kaart. Als uw kaart te groot is, dan kunt u hem scannen
in verschillende delen maar onthoudt dat u de taken voor het voorverwerken en aanbrengen van geoverwijzingen voor
elk deel moet herhalen. Dus, indien mogelijk, scan de kaart in zo min mogelijk delen.
Als u een andere kaart gaat gebruiken dan die welke is verschaft voor deze handleiding, gebruik dan uw eigen scanner
om de kaart als een afbeeldingsbestand te scannen, een resolutie van 300 DPI is voldoende. Als uw kaart kleuren
heeft,m scan hem dan in kleur zodat u later die kleuren kunt gebruiken om informatie uit de kaart te halen voor
verschillende lagen (bijvoorbeeld, bosopstand, contourlijnen, wegen…).
Voor deze oefening zult u een eerder gescande kaart gebruiken, u vindt die als rautjarvi_map.tif in de
gegevensmap exercise_data/forestry
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14.2.2 Follow Along: De gescande kaart voorzien van geoverwijzingen

Open QGIS en stel het CRS van het project in op ETRS89 / ETRS-TM35FIN in Project ► Eigenschappen… ►
CRS, wat het huidige in Finland gebruikte CRS is.

Sla het project van QGIS op als map_digitizing.qgs.
U zult de plug-in voor geoverwijzingen gebruiken vanuit QGIS, de plug-in is al geïnstalleerd in QGIS. Activeer de
plug-in met behulp van de Plug-in Manager zoals u al in eerdere modules heeft gedaan. De plug-in is genaamd
Georeferencer GDAL.
Geoverwijzingen aanbrengen in de kaart:

• Open het gereedschap Georeferencer, Raster ► Georeferencer ► Georeferencer.
• Voeg het afbeeldingsbestand van de kaart, :kdb:`rautjarvi_map.tif`, in als de afbeelding die moet worden
voorzien van geoverwijzingen, Bestand ► Raster openen.

• Indien daarnaar gevraagd, zoek en selecteer het CRS KKJ / Finland zone 2, dat is het CRS dat werd
gebruikt in Finland in 1994 toen deze kaart werd gemaakt.

• Klik op OK.
Vervolgens zou u de instellingen voor de transformatie moeten definiëren voor het aanbrengen van geoverwijzingen
in de kaart:

• Open Extra ► Transformatie instellingen.
• Klik op het pictogram naast het vak Uitvoer rasterbestand, ga naar de map en maak de map
exercise_data\forestry\digitizing en noem het bestand rautjarvi_georef.tif.

• Stel de rest van de parameters in zoals hieronder weergegeven.
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• Klik op OK.
De kaart bevat verschillende kruisdraden die de coördinaten op de kaart markeren, we zullen die gebruiken om
geoverwijzingen aan te brengen in deze afbeelding. U kunt, zoals u gewoonlijk ook doet in QGIS, de gereedschappen
zoomen en pannen gebruiken om de afbeelding in het venster van Georeferencer te inspecteren.

• Zoom in op de linker benedenhoek van de kaart en merk op dat daar een kruisdraad staat met een paar
coördinaten, X en Y, die, zoals eerder is vermeld, staan in CRS KKJ / Finland zone 2. U zult dit punt gebruiken
als het eerste grondcontrolepunt voor het aanbrengen van de geoverwijzingen in uw kaart.

• Selecteer het gereedschap Punt toevoegen en klik op de kruising van de kruisdraad (pan en zoom zoals nodig
is).

• Vermeld, in het dialoogvenster Voer kaartcoördinaten in, de coördinaten die in de kaart verschijnen (X:
2557000 en Y: 6786000).

• Klik op OK.
Het eerste coördinaat voor het aanbrengen van geoverwijzingen is nu klaar.
Zoek naar andere kruisdraden in de afbeelding met zwarte lijnen, zij liggen op 1000 meter van elkaar, zowel in
noordelijke als in oostelijke richting. U zou in staat moeten zijn de coördinaten van deze punten te berekenen in
relatie tot het eerste.
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Zoom uit van de afbeelding en ga naar rechts totdat u een andere kruisdraad vindt en schat hoeveel kilometers u bent
verplaatst. Probeer grondcontrolepunten te vinden die zo ver mogelijk van andere liggen als mogelijk. Digitaliseer ten
minste nog drie grondcontrolepunten op dezelfde manier als u dat deed met het eerste. U zou moeten eindigen met
iets dat lijkt op dit:

Met al drie gedigitaliseerde grondcontrolepunten zult u in staat zijn om de afwijking voor de geoverwijzing als een
rode lijn vanuit de punten te zien. De afwijking in pixels kan ook worden bekeken in de GCP tabel in de kolommen
dX[pixels] en dY[pixels]. De afwijking in pixels zou niet hoger moeten zijn dan 10 pixels, als dat wel zo is zou u de
punten die u heeft gedigitaliseerd en de coördinaten die u heeft ingevoerd opnieuw moeten bekijken om te zien wat
het probleem is. U kunt de afbeelding hierboven gebruiken als richtlijn.
Als uw grondcontrolepunten eenmaal naar wens zijn, dan kunt u ze opslaan om ze later nog eens te gebruiken:

• Bestand ► GCP -punten opslaan als….
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• In de map exercise_data\forestry\digitizing, noem het bestand file
:kdb:`rautjarvi_map.tif.points`.

Tenslotte, aanbrengen van geoverwijzingen op uw kaart:
• Bestand ► Georeferencer starten.
• Onthoud dat u het bestand al rautjarvi_georef.tif heeft genoemd toen u de instellingen voor de
Georeferencer bewerkte.

Nu kunt u de kaart in het project van QGIS zien als een raster met geoverwijzingen. Merk op dat het raster licht
geroteerd lijkt te zijn, maar dat komt doordat de gegevens in KKJ / Finland zone 2 staan en uw project in
ETRS89 / ETRS-TM35FIN.
U kunt de luchtfoto in demapexercise_data\forestry, genaamdrautjarvi_aerial.tif openen om
te controleren of uw gegevens op de juiste manier zijn voorzien van geoverwijzingen. Uw kaart en deze afbeelding
zouden redelijk goed overeen moeten komen. Stel de transparantie voor de kaart in op 50% en vergelijk die met de
luchtfoto.
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Sla de wijzigingen in uw project van QGIS op, u zult vanaf dit punt doorgaan naar de volgende les.
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14.2.3 In Conclusion

U heeft nu een papieren kaart voorzien van geoverwijzingen, wat het mogelijk maakt die te gebruiken als kaartlaag
in QGIS.

14.2.4 What’s Next?

In de volgende les zult u de bosopstanden in uw kaart digitaliseren als polygonen en de gegevens van de inventarisatie
er aan toevoegen.

14.3 Lesson: Bosopstanden digitaliseren

Tenzij u uw kaart met geoverwijzingen gaat gebruiken als een eenvoudige afbeelding voor de achtergrond, is de
volgende logische stap om de elementen erin te digitaliseren. U heeft dat al gedaan in de oefeningen over het maken
van vectorgegevens in Lesson: Een nieuwe vector gegevensset maken, toen u de velden van de school digitaliseerde. In
deze les gaat u de grenzen van de bosopstanden digitaliseren die als groene lijnen op de kaart staan, maar in plaats
van het te doen met behulp van een luchtfoto, zult u uw kaart met geoverwijzingen gebruiken.
Het doel voor deze les: Een techniek leren om te helpen bij de taak van het digitaliseren, bosopstanden digitaliseren
en tenslotte de gegevens van de inventarisatie er aan toevoegen.

14.3.1 Follow Along: De grenzen van de bosopstanden uitnemen

Open uw project map_digitizing.qgs, dat u in de vorige les heeft opgeslagen, in QGIS.
Als u eenmaal uw kaart heeft gescand en voorzien van geoverwijzingen zou u direct kunnen beginnenmet digitaliseren
door naar de kaart te kijken als een hulpmiddel. Dat zou, zeer waarschijnlijk, de manier om te doen als de afbeelding
van waaruit u gaat digitaliseren, bijvoorbeeld, een luchtfoto is.
Als wat u gaat gebruiken voor het digitaliseren een goed kaart is, zoals in ons geval, is het aannemelijk dat de informatie
duidelijk wordt weergegeven als lijnen met verschillende kleuren voor elk type element. Deze kleuren kunnen relatief
eenvoudig worden uitgenomen als individuele afbeeldingen met behulp van een software voor het bewerken van
afbeeldingen, zoals GIMP. Dergelijke afzonderlijke afbeeldingen kunnen worden gebruikt om te assisteren bij het
digitaliseren, zoals u hieronder zult zien.
De eerste stap zal zijn om GIMP te gebruiken om een afbeelding te verkrijgen die alleen de bosopstanden bevat, dat
is, alle groene lijnen die u zou kunnen zien in de originele gescande kaart:

• Open GIMP (als u het nog niet geïnstalleerd heeft,, download het vanaf het internet of vraag uw leraar).
• Open de originele kaartafbeelding, Bestand ► Openen, rautjarvi_map.tif in de map
exercise_data/forestry folder. Onthoud dat de bosopstanden als groene lijnen worden weergegeven
(met het nummer van de bosopstand ook in groen binnen elke polygoon).
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Nu kunt u de pixels in de afbeelding selecteren die de grenzen van de bosopstanden vormen (de groenachtige pixels):
• Open het gereedschap Selecteren ► Op kleur.
• Zoom, met het gereedschap actief, in op de afbeelding (Ctrl + muiswiel) zodat een lijn van een bosopstand
dichtbij genoeg is om de pixels die de lijn vormen te onderscheiden. Zie de linker afbeelding hieronder.

• Klik en sleep de muiscursor in het midden van de lijn zodat het gereedschap verscheidene kleurwaarden van
de pixels zal verzamelen.

• Laat de muisknop los en wacht enkele seconden. De pixels die overeenkomenmet de kleuren die zijn verzameld
door het gereedschap zullen vanuit de gehele afbeelding worden geselecteerd.

• Zoom uit om te zien hoe de groenachtige pixels zijn geselecteerd in de gehele afbeelding.
• Als u niet tevreden bent met het resultaat, herhaal dan de bewerking klikken en slepen.
• Uw selectie van pixels zou er ongeveer uit moeten zien als op de rechter afbeelding hieronder.
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Als u eenmaal klaar bent met het selecteren moet u deze selectie als een nieuwe laag kopiëren en die dan opslaan als
een afzonderlijk afbeeldingsbestand:

• Kopieer (Ctr+C) de geselecteerde pixels.
• En plak de pixels direct (Ctr+V), GIMP zal de geplakte pixels weergeven als een nieuwe tijdelijke laag in het
paneel Lagen - Penselen als een Zwevende Selectie (Geplakte laag).

• Klik met rechts op die tijdelijke laag en selecteer Naar nieuwe laag.
• Klik op het pictogram “oog” naast de originele afbeeldingslaag om die uit te schakelen, zodat alleen deGeplakte

laag zichtbaar is:

370 Hoofdstuk 14. Module: Toepassing Bosbouw



QGIS Training Manual

• Selecteer tenslotte Bestand ► Exporteren als…, stel Selecteer bestandstype (Volgens extensie) in als een TIFF-
afbeelding, selecteer de map digitizing en noem het rautjarvi_map_green.tif. Selecteer Geen
compressie indien daarnaar gevraagd wordt.

U zou hetzelfde proces kunnen uitvoeren met andere elementen in de afbeelding, bijvoorbeeld de zwarte lijnen
uitnemen die wegen weergeven of de bruine die de contourlijnen van het terrein weergeven. Maar voor ons zijn
de bosopstanden voldoende.

14.3.2 Try Yourself De afbeelding met groene pixels voorzien van
geoverwijzingen

Zoals u al in de vorige les deed dient u deze nieuwe afbeelding te voorzien van geoverwijzingen om in staat te zijn
om hem te kunnen gebruiken met de rest van uw gegevens.
Onthoud dat u de grondcontrolepunten niet meer hoeft te digitaliseren omdat deze afbeelding nagenoeg hetzelfde is
als de originele afbeelding, voor zover het het gereedschap Georeferencer betreft. Hier zijn enkele dingen die u zou
moeten onthouden:

• Deze afbeelding is, natuurlijk, ook in het CRS KKJ / Finland zone 2 CRS.
• U zou de grondcontrolepunten moeten gebruiken die u heeft opgeslagen, bestand ► GCP-ounten laden.
• Onthoud om de Transformatie instellingen opnieuw te bekijken.
• Noem het uitvoerraster rautjarvi_green_georef.tif in de map digitizing.

Controleer of het nieuwe raster netjes past op de originele kaart.

14.3.3 Follow Along: Ondersteunende punten voor digitaliseren maken

Met de gereedschappen voor digitaliseren in QGIS in gedachten, zou u misschien al kunnen denken dat het handig
zou zijn aan die groene pixels te ‘snappen’ tijdens het digitaliseren. Dat is precies wat u als volgende gaat doen, punten
maken uit die pixels om ze later te kunnen gebruiken om de grenzen van de bosopstanden te volgen tijdens het
digitaliseren, met behulp van de beschikbare gereedschappen voor snappen in QGIS.

• Gebruik het gereedschap Raster ► Conversie ► Vectoriseren (Raster naar vector) om uw groene lijnen naar
polygonen te vectoriseren. Als u niet meer weet hoe, kunt u het nog eens bekijken in Lesson: Conversie van
raster naar vector.

• Sla op als rautjarvi_green_polygon.shp in de map digitizing.
Zoom in en zie hoe de polygonen eruit zien. U zult iets hebben zoals dit:
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De volgende optie is om punten van deze polygonen te maken om hun zwaartepunten te vinden:
• Open Vector ► Geometrie-gereedschap ► Zwaartepunten polygonen.
• Stel de polygoonlaag die u zojuist had in als het invoerbestand voor het gereedschap.
• Noem het uitvoerbestand green_centroids.shp in de map digitizing.
• Selecteer Resultaat aan kaartvenster toevoegen.
• Voer het gereedschap uit om de zwaartepunten voor de polygonen te berekenen.
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Nu kunt u de laag rautjarvi_green_polygon uit de lagenlijst verwijderen.
Wijzig de symbologie van de laag met zwaartepunten naar:

• Open de Laageigenschappen voor green_centroids.
• Ga naar de tab Symbologie.
• Stel de Eenheid in op Kaarteenheid.
• Stel de Grootte in op 1.

Het is niet nodig om de verschillende punten van elkaar te differentiëren, u heeft ze daar alleen maar nodig om ze
te laten gebruiken door de gereedschappen voor ‘snappen”. U kunt deze punten nu gebruiken om de originele lijnen
veel makkelijker te volgen dan zonder ze.
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14.3.4 Follow Along: De bosopstanden digitaliseren

Nu bent u klaar om met het eigenlijke werk van digitaliseren te beginnen. U zou moeten beginnen met het maken
van een vectorbestand van het :guilabel:` type polygoon`, maar, voor deze oefening, is er een shapefile met daarin
een gedeelte van het interessegebied dat al is gedigitaliseerd. U zult het digitaliseren voltooien voor de heflt van de
bosopstanden die zijn overgelaten tussen de belangrijke wegen (brede roze lijnen) en het meer:

• Ga naar de map digitizing met behulp van uw browser voor bestandsbeheer.
• Sleep en laat het vectorbestand forest_stands.shp op uw kaart vallen.
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Wijzig de symbologie van de nieuwe laag zodat het gemakkelijker te zien is welke polygonen reeds gedigitaliseerd
zijn:

• De vulling van de polygoon naar groen.
• De randen van de polygonen naar 1 mm.
• en stel de transparantie in op 50%.

Nu, als u de voorgaande modules heeft onthouden, moeten we de opties voor “snappen” instellen en activeren:
• Ga naar Project ► ‘Opties voor snappen….
• Activeer het snappen voor de lagen green_centroids en de lagen forest_stands.
• Stel hun Tolerantie in op 5 kaarteenheden.
• Selecteer het vak Kruisingen vermijden voor de laag forest_stands.
• Selecteer ‘Topologie bewerken’ aanzetten.
• Klik op Apply.

Met deze instellingen voor snappen, altijd wanneer u aan het digitaliseren bent en dicht genoeg bij een van de punten
in de laag met zwaartepunten of een punt van uw gedigitaliseerde polygonen komt, zal een roze kruis verschijnen op
het punt waaraan zal worden gesnapd.
Schakel tenslotte de zichtbaarheid van alle lagen, met uitzondering van forest_stands en
rautjarvi_georef uit. Zorg er voor dat de kaartafbeelding geen transparantie meer heeft.
Een paar belangrijke dingen om te onthouden vóórdat u begint met digitaliseren:

• Probeer niet te nauwkeurig te zijn bij het digitaliseren van de randen.
• Als een rand een rechte lijn is, digitaliseer die dan met slechts twee knopen. In het algemeen: gebruik bij het
digitaliseren zo min mogelijk knopen.

• Zoom alleen in om gebieden te sluiten als u denkt dat u nauwkeurig moet zijn, bijvoorbeeld, op sommige hoeken
of wanneer u een polygoon wilt verbinden met een andere polygoon op ene bepaalde knoop.

• Gebruik de middelste knop van de muis om in of uit te zoomen en te pannen als u digitaliseert.
• Digitaliseer slechts één polygoon per keer.
• Na het digitaliseren van een polygoon, schrijf dan het ID van de bosopstand dat u kunt zien in de kaart.

Nu kunt u beginnen met digitaliseren:
• Lokaliseer de bosopstand 357 in het kaartvenster.
• Schakel Bewerken aan-/uitzetten in voor de laag forest_stands.shp.
• Selecteer het gereedschap Object toevoegen.
• Start het digitaliseren van bosoptand 357 door enkele van de punten te verbinden.
• Merk de roze kruisen op die het snappen aangeven.
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• Wanneer u gereed bent, klik dan met rechts om het digitaliseren voor dat polygoon te beëindigen.
• Voer de ID voor de bosopstand in (in dit geval 357).
• Klik op OK.

Als u niet werd gevraagd naar het id voor de polygoon toen u het digitaliseren voltooide, ga naar Extra ► Opties ►
Digitaliseren en zorg er voor dat Voorkom tonen van attributenformulier na intekenen object niet is geselecteerd.
Uw gedigitaliseerde polygoon zal er ongeveer zo uitzien:
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Voor de tweede polygoon gebruiken we bosopstand 358. Zorg er voor dat Kruisingen vermijden. is geselecteerd voor
de laag forest_stands. Deze optie staat geen kruisende polygonen toe bij het digitaliseren, dus als u digitaliseert
over een bestaande polygoon, zal de nieuwe polygoon worden afgebroken op de rand van de al bestaande polygonen.
U kunt deze karakteristiek gebruiken om automatisch een gezamenlijke rand te krijgen.

• Begin het digitaliseren van bosopstand 358 op één van de gemeenschappelijke knopen met de bosopstand 357.
• Ga dan normaal door totdat u bij de volgende gemeenschappelijke knoop voor beide bosopstanden komt.
• Digitaliseer tenslotte een aantal punten binnen polygoon 357 er zorg voor dragend dat de gemeenschappelijk
rand niet wordt gekruist. Zie de linker afbeelding hieronder.

• Klik met rechts om het bewerken van bosopstand 358 te voltooien.
• Voer als id in 358.
• Klik op OK, uw nieuwe polygoon zou nu een gemeenschappelijk rand moeten weergeven met de bosopstand
357, zoals u kunt zien in de afbeelding rechts.
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Het gedeelte van de polygoon dat de bestaande polygoon overlapte is automatisch afgebroken en u blijft achter met
een gemeenschappelijk rand, wat uw bedoeling was.

14.3.5 Try Yourself Digitaliseren van de bosopstanden voltooien

Nu heeft u twee bosopstanden voltooid. En een goed idee over hoe u verder moet gaan. Ga in uw eigen tempo door met
digitaliseren totdat u alle bosopstanden, die worden begrensd door de hoofdweg en het meer, heeft gedigitaliseerd.
Het lijkt heel veel werk te zijn, maar u zult er snel aan gewend raken om de bosopstanden te digitaliseren. Het zou u
ongeveer 15 minuten moeten kosten.
Gedurende het digitaliseren moet u misschien knopen bewerken of verwijderen, polygonen splitsen of samenvoegen.
U heeft over de benodigde gereedschappen geleerd in Lesson: Topologie voor objecten, nu is het waarschijnlijk een
goed moment om het nog eens na te lezen.
Onthoud dat met Topologie bewerken activeren geactiveerd, u in staat bent knopen te verplaatsen die
gemeenschappelijk zijn voor twee polygonen zodat de gezamenlijke rand tegelijkertijd wordt bewerkt voor beide
polygonen.
Uw resultaat zal er uitzien zoals dit:
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14.3.6 FollowAlong: De gegevens voor de bosopstanden samenvoegen

Het is mogelijk dat de gegevens van de inventarisatie van het bos die u voor uw kaart heeft ook op papier zijn
geschreven. In dat geval zou u eerst de gegevens naar een tekstbestand of werkblad moeten wegschrijven. Voor deze
oefening is de informatie van de inventarisatie voor 1994 (dezelfde inventarisatie als de kaart) al aanwezig als een
komma-gescheiden tekstbestand (csv).
Open het bestand rautjarvi_1994.csv uit de map exercise_data\forestry in een tekstbewerker en
merk op dat het gegevensbestand van de inventarisatie een attribuut heeft, genaamd ID dat de nummers van de
bosopstanden bevat. Deze nummers zijn hetzelfde als de ID’s voor de bosopstanden die u voor uw polygonen heeft
ingevoerd en kunnen worden gebruikt om de gegevens uit het tekstbestand te koppelen aan uw vectorbestand. U kunt
de metadata voor deze gegevens van inventarisatie bekijken in het bestand rautjarvi_1994_legend.txt in
dezelfde map.

• Open de .csv in QGIS met het gereedschap Kaartlagen ► Tekstgescheiden kaartlaag toevoegen…. Stel het
dialoogvenster als volgt in:
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De gegevens uit het .csv-bestand toevoegen:
• Open de Laageigenschappen voor de laag forest_stands.
• Ga naar de tab Koppelingen.
• Klik op het plusteken onder in het vak van het dialoogvenster.
• Selecteer rautjarvi_1994.csv als de Koppelingslaag en ID als het veld Koppelveld.
• Zorg er voor dat ook het veld Doelveld is ingesteld op id.
• Klik tweemaal op OK.

De gegevens uit het tekstbestand zouden nu moeten zijn gekoppeld aan uw vectorbestand. Open de attributentabel
voor de laag forest_stands om te zien wat er is gebeurd. U kunt zien dat alle attributen van het gegevensbestand
voor de inventarisatie nu zijn gekoppeld aan uw gedigitaliseerde vectorlaag.

14.3.7 Try Yourself Namen voor attributen hernoemen en gebied en
begrenzing toevoegen

De gegevens uit het .csv-bestand zijn slechts gekoppeld aan uw vectorbestand. U moet de laag forest_stands
als een nieuw vectorbestand opslaan om deze koppeling permanent te maken, zodat de gegevens feitelijk worden
opgenomen in het vectorbestand. Sluit de attributentabel en klik met rechts op de laag forest_stands om die op te
slaan als forest_stands_1994.shp.
Open uw nieuwe forest_stands_1994.shp in uw kaart als u die al nog niet heeft toegevoegd. Open dan de
attributentabel. U zult zien dat de namen van de kolommen die u zojuist heeft toegevoegd niet erg bruikbaar zijn. Om
dit op te lossen:
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• Voeg de plug-in Table Manager toe zoals u eerder ook met andere plug-ins heeft gedaan.
• Zorg ervoor dat de plug-in is geactiveerd.
• Selecteer, in de inhoudsopgave, de laag forest_stands_1994.shp.
• Ga dan naar Vector ► Table Manager ► Table manager.
• Gebruik het vak van het dialoogvenster om de namen van de kolommen te bewerken om overeen te komen met
die in het .csv-bestand.

• Klik op Save.
• Selecteer Yes om de stijl van de laag te behouden.
• Sluit het dialoogvenster van de Table Manager.

U wilt misschien het gebied en de begrenzingen van de bosopstanden berekenen om het verzamelen van de informatie
gerelateerd aan deze bosopstanden. U heeft gebieden voor polygonen al berekend in Lesson: Extra oefening. Ga terug
naar die les als dat nodig is en bereken de gebieden voor de bosopstanden, noem het nieuwe attribuut Area en zorg
er voor dat de waarden worden berekend in hectares.
Nu is uw laag forest_stands_1994.shp gereed en verpakt met alle beschikbare informatie.
Sla uw project op om de huidige presentatie van de kaart te behouden voor het geval u daar later terug moet komen.
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14.3.8 In Conclusion

Het heeft een aantal muisklikken gekost maar u heeft nu uw oude gegevens van de inventarisatie in digitale indeling
en gereed voor gebruik in QGIS.

14.3.9 What’s Next?

U zou nu kunnen beginnen met het uitvoeren van verschillende analyses met uw brandnieuwe gegevensset, maar u
bent misschien meer geïnteresseerd in het uitvoeren van analyses op een meer up to date gegevensset. Het onderwerp
van de volgende les zal het maken van bosopstanden zijn, met behulp van recente luchtfoto’s en het toevoegen van
enige relevante informatie aan uw gegevensset.

14.4 Lesson: Bijwerken van de bosopstanden

Nu u de informatie uit de oude inventariskaarten heeft gedigitaliseerd en de overeenkomende informatie aan de
bosopstanden heeft toegevoegd, zou de volgende stap de inventaris van de huidige status van het bos te maken.
U zult nieuwe bosopstanden vanaf nul digitaliseren door middel van een luchtfoto van dat bosgebied. De kaart van
het bos die u in de vorige les digitaliseerde werd gemaakt vanuit een infrarood gekleurde luchtfoto (CIR). Dit type
afbeeldingen, waarbij het infrarode licht wordt opgenomen in plaats van het blauwe licht, worden breed gebruikt om
begroeide gebieden te bestuderen. U zult in deze les ook een CIR-afbeelding gebruiken.
Na het digitaliseren van de bosopstanden, zult u informatie toevoegen, zoals nieuwe beperkingen, opgelegd door
regelgeving met betrekking tot het behouden ervan.
Het doel voor deze les: Een nieuwe set bosopstanden digitaliseren vanuit CIR-luchtfoto’s en informatie toevoegen
vanuit andere gegevenssets.

14.4.1 Oude bosopstanden met huidige luchtfoto’s vergelijken

De National Land Survey van Finland heeft een beleid voor open gegevens die u in staat stellen een groot
scala aan geografische gegevens, zoals luchtfoto’s, traditionele topografische kaarten, DEM, LiDAR-gegevens,
etc, te downloaden. Toegang tot de service kan ook hier in het Engels worden verkregen. De in deze oefening
gebruikte luchtfoto is gemaakt uit twee orthogerectificeerde CIR-afbeeldingen, gedownload vanaf die service
(M4134F_21062012 en M4143E_21062012).

• Open QGIS en stel het CRS van het project in op ETRS89 / ETRS-TM35FIN in Project ► Eigenschappen… ►
CRS.

• Voeg, vanuit de map exercise_data\forestry\, de CIR-afbeelding rautjarvi_aerial.tif
toe dat de gedigitaliseerde meren bevat.

• Sla dan het project van QGIS op als digitizing_2012.qgs.
De CIR-afbeeldingen zijn van 2012. U kunt de bosopstanden die werden gemaakt in 1994 vergelijken met de situatie
bijna 20 jaar later.

• Voeg uw laag forest_stands_1994.shp toe.
• Stel de opmaak zo in dat u door uw polygonen heen kunt kijken.
• Bekijk hoe de oude bosopstanden volgen (of niet) wat u visueel als een homogeen bos zou interpreteren.

Zoom en pan over het gebied. U zult waarschijnlijk opmerken dat sommige van de oude bosopstanden nog steeds
zullen corresponderen met de afbeeldingen maar dat andere dat niet doen.
Dit is een normale situatie, omdat 20 jaar is verstreken en verschillende bewerkingen in de bossen zijn uitgevoerd
(oogsten, uitdunnen…). Het is ook mogelijk dat de bosopstanden er in 1992 homogeen uitzagen voor de persoon die
ze digitaliseerde maar dat sommige bossen zich, bij het verstrijken van de tijd, op verschillende manieren hebben
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ontwikkeld. Of de prioriteiten voor het inventariseren van de bossen waren eenvoudigweg anders dan dat zij vandaag
de dag zijn.
Vervolgens zult u nieuwe bosopstanden maken voor deze afbeelding, zonder de oude te gebruiken. Later kunt u ze
vergelijken om de verschillen te bekijken.

14.4.2 De CIR-afbeelding interpreteren

Laten we hetzelfde gebied digitaliseren als dat wat werd bedekt door de oude inventarisatie, begrensd door de wegen
en het meer. U hoeft niet het gehele gebied te digitaliseren, net zoals in de vorige oefening kunt u beginnen met een
vectorbestand dat al de meeste bosopstanden bevat.

• Verwijder de laag forest_stands_1994.shp.
• Voeg de laag forest_stands_2012.shp toe, die zich bevind in de map exercise_data\
forestry\.

• Stel de opmaak van deze laag zo in dat de polygonen geen vulling hebben en de randen zichtbaar zijn.
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U kunt zien dat een regio in het noordelijke gedeelte van het gebied van de inventarisatie nog ontbreekt. Dat zal uw
taak zijn, het digitaliseren van de ontbrekende bosopstanden.
Maar, voordat u begint, besteed enige tijd aan het bekijken van de reeds gedigitaliseerde bosopstanden en de
overeenkomende bossen in de afbeelding. Probeer een idee te vormen over hoe de grenzen van de bosopstanden
worden bepaald, het helpt als u enige kennis over bosbouw heeft.
Enkele ideeën over wat u uit de afbeeldingen zou kunnen identificeren:

• Welke bossen zijn loofbomen (in Finland meestal berkenbossen) en welke zijn coniferen (in deze regio
den of spar). In CIR-afbeeldingen zullen loofbomen veelal een heldere rode kleur hebben, waar coniferen
donkergroene kleuren geven.

• Als de leeftijd van een bosopstand wijzigt, door te kijken naar de grootte van de boomkruinen die kunnen
worden geïdentificeerd in de afbeelding.
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• De dichtheid van de verschillende bosopstanden, een bosopstand waar recent werd uitgedund bijvoorbeeld zal
duidelijk ruimte weergeven tussen de boomkruinen en zou eenvoudig te herkennen moeten zijn van de andere
bosopstanden er omheen.

• Blauwachtige gebieden geven onvruchtbaar terrein, wegen en stedelijke gebieden , gewassen die nog niet zijn
gaan groeien etc. aan.

• Gebruik geen zoom die te dicht op de afbeelding komt bij het proberen te identificeren van bosopstanden.
Een schaal tussen 1 : 3.000 en 1 : 5.000 zou voor deze afbeeldingen voldoende moeten zijn. Zie de afbeelding
hieronder (schaal 1:4000):

14.4.3 Try Yourself Bosopstanden vanuit CIR-afbeeldingen
digitaliseren

Bij het digitaliseren van bosopstanden zou u moeten proberen bosgebieden te krijgen die zo homogeen mogelijk zijn
in termen van boomsoorten, leeftijd van het bos, dichtheid van de bosopstand… Wees echter niet te gedetailleerd,
of u eindigt met het maken van honderden kleine bosopstanden die in het geheel niet bruikbaar zijn. U zou moeten
proberen opstanden te krijgen die betekenisvol zijn in de context van bosbouw, niet te klein (ten minste 0,5 ha) maar
ook niet te groot (niet meer dan 3 ha).
Met deze indicaties in gedachten kunt u nu de ontbrekende bosopstanden digitaliseren.

• Schakel Bewerken aan/uitzetten in voor forest_stands_2012.shp.
• Stel de opties voor snappen en topologie in zoals in de afbeelding.
• Vergeet niet op Apply of OK te klikken.
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Beginmet het digitaliseren zoals u dat deed in de vorige les, met als enige verschil dat u nu geen puntlaag heeft waaraan
u kunt snappen. Voor dit gebied zou u ongeveer 14 nieuwe bosopstanden moeten krijgen. Vul het veld Stand_id
met nummers, beginnend met 901, tijdens het digitaliseren.
Wanneer u gered bent zou uw laag er ongeveer als volgt uit moeten zien:

Nu heeft u een nieuwe set polygonen die de verschillende bosopstanden definiëren voor de huidige situatie zoals die
kan worden geïnterpreteerd vanuit de CIR-afbeeldingen. Maar u mist duidelijk nog de gegevens van de inventarisatie
van de bossen, toch? Daarvoor dient u nog steeds naar het bos te gaan en monstergegevens te verzamelen die u zult
gebruiken om de attributen voor de bossen in te schatten voor elk van de bosopstanden. U zult in de volgende les zien
hoe u dat doet.
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Op dit moment kunt u nog steeds uw vectorlaag verbeteren met enige extra informatie die u heeft over regelgeving
voor natuurbehoud waarmee in dit gebied rekening zou moeten worden gehouden.

14.4.4 Follow Along: Bosopstanden bijwerken met informatie over
natuurbehoud

Voor het gebied waarmee u werkt is onderzocht dat met de volgende regels met betrekking tot natuurbehoud rekening
moet worden gehouden bij het maken van de planning voor de bossen:

• Twee locaties van een beschermde soort gewone vliegende eekhoorn (Pteromys volans) zijn geïdentificeerd.
Overeenkomstig de regelgeving dient een gebied van 15 meters rondom die plaatsen onaangetast te blijven.

• Een aan de oever gelegen bos met speciale betekenis langs een stroom in het gebied moet worden beschermd.
Tijdens veldonderzoek is vastgesteld dat 20 meter aan beide zijden van de stroom beschermd moet worden.

U heeft een vectorbestand dat de informatie bevat over de locaties van de eekhoorns en een ander dat de
gedigitaliseerde stroom bevat die in het noordelijke gedeelte naar het meer stroomt. Voeg, vanuit de map
exercise_data\forestry\ , de vectorbestanden squirrel.shp en stream.shp toe.
Voor het beschermen van de locaties van de eekhoorns gaat u een nieuw attribuut (kolom) toevoegen aan uw nieuwe
bosopstanden, die informatie zal bevatten over de puntlocaties die moeten worden beschermd. Die informatie zal later
beschikbaar zijn wanneer er een bewerking in het bos moet worden gepland, en het team in het veld, vóór het werk
begint, in staat stellen het gebied te markeren dat onaangetast moet blijven.

• Open de attributentabel voor de laag squirrel.
• U kunt zien dat er twee locaties zijn gedefinieerd voor de gewone vliegende eekhoorn, en dat het gebied dat
moet worden beschermd is aangegeven door een afstand van 15 meter vanaf die locaties.

Voor het samenvoegen van de informatie over de eekhoorns met die van de bosopstanden kunt u Attributen op basis
van plaats bijeenbrengen gebruiken:

• Open Vector ► Datamanagement-gereedschap ► Attributen op basis van plaats bijeenbrengen.
• Stel de laag forest_stands_2012.shp in als de Doel vectorlaag.
• Selecteer als Join vectorlaag de puntenlaag squirrel.shp.
• Noem het uitvoerbestand stands_squirrel.shp.
• Selecteer, in Uitvoer tabel, Alle rijen behouden (ook de niet-passende doelrijen). Zodat u alle bosopstanden in
de laag behoudt in plaats van alleen die te behouden die ruimtelijk zijn gerelateerd aan de locaties van de
eekhoorns.

• Klik op OK.
• Selecteer Yes als gevraagd wordt om de laag toe te voegen aan de inhoudsopgave.
• Sluit het dialoogvenster.
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Nu heeft u een nieuwe laag met bosopstanden, stands_squirrel met nieuwe attributen die overeenkomen met
de informatie voor natuurbehoud die is gerelateerd aan de gewone vliegende eekhoorn.
Open de tabel van de nieuwe laag enmaak de volgorde dusdanig dat de bosopstandenmet informatie over het attribuut
Protection bovenaan staan. U zou nu twee bosopstanden moeten hebben waar de eekhoorn zich bevindt:
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Hoewel deze informatie genoeg kan zijn, keek eens naar welke gebieden, gerelateerd aan de eekhoorns, beschermd
zou moeten zijn. U weet dat u een buffer van 15 meter rondom de locaties van de eekhoorns moet hebben:

• Open Vector ► Geoprocessing-gereedschap ► Buffer.
• Maak een buffer van 15 meter voor de laag squirrel.
• Noem het resultaat squirrel_15m.shp.
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U zult opmerken dat als u inzoomt op de locatie in het noordelijke gedeelte van het gebied, de gebied van de buffer
zich ook uitstrekt tot in de aanliggende bosopstand. Dit betekent dat wanneer er een bewerking van het bos plaats zou
vinden in die bosopstand, ook rekening gehouden zou moeten worden met de beschermde locatie.

Vanuit uw eerdere analyse werd die bosopstand niet verkregen om informatie te registreren over de beschermde status.
Dit probleem oplossen:

• Voer het gereedschap Attributen op basis van plaats bijeenbrengen opnieuw uit.
• Maar gebruik deze keer de laag squirrel_15m als join vectorlaag.
• Noem het uivoerbestand stands_squirrel_15m.shp.
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Open de attributentabel voor deze nieuwe laag en merk op dat u nu drie bosopstanden heeft die informatie hebben
over de beschermde locaties. De informatie in de gegevens voor de bosopstanden zullen aan de beheerder van het bos
duidelijk maken dat er rekening moet worden gehouden met regels over natuurbehoud. Dan kan hij of zij de locatie
ophalen uit de gegevensset squirrel, en het gebied bezoeken om de overeenkomende buffer rondom de locatie te
markeren, zodat de veldwerkers kunnen voorkomen dat zij de woonomgeving van de eekhoorns verstoren.

14.4.5 Try Yourself Bosopstanden bijwerken met afstand tot de stroom

Door dezelfde benadering, zoals aangegeven voor de beschermde locaties voor de eekhoorns, te volgen kunt u nu uw
bosopstanden bijwerken met de informatie voor de bescherming die is gerelateerd aan de stroom die is geïdentificeerd
in het veld:

• Vergeet niet dat de buffer in dit geval 20 meter rondom is.
• U wilt alle informatie over de bescherming in hetzelfde vectorbestand, gebruik dus de laag
stands_squirrel_15m als het doel.

• Noem uw uitvoerbestand forest_stands_2012_protect.shp.
Open de attributentabel voor de nieuwe vectorlaag en stel vast dat u nu alle informatie heeft over bescherming voor de
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bosopstanden die worden geraakt door de beschermingsmaatregelen voor het aan de oever gelegen bos, geassocieerd
met de stroom.
Sla uw project van QGIS op.

14.4.6 In Conclusion

U heeft gezien hoe u CIR-afbeeldingen kunt interpreteren om bosopstanden te digitaliseren. Natuurlijk zou het enige
praktijkervaring vergen om meer nauwkeurige bosopstanden te maken en gewoonlijk zou het gebruiken van andere
informatie,zoals kaarten van de bodem, betere resultaten geven, maar u kent nu de basis voor dit type taak. Toevoegen
van informatie uit andere gegevenssets bleek een onbeduidende taak te zijn.

14.4.7 What’s Next?

De bosopstanden die u heeft gedigitaliseerd zullen worden gebruikt voor het plannen van bewerkingen in de bossen
in de toekomst, maar u moet nog steeds meer informatie over het bos krijgen. In de volgende les zult u zien hoe u een
aantal monsterplaatsen plant om het bosgebied dat u zojuist heeft gedigitaliseerd te inventariseren, en een algehele
indruk te krijgen over de parameters van het bos.

14.5 Lesson: Systematisch ontwerpen van monsters

U heeft al een set polygonen gedigitaliseerd die de bosopstanden weergeven, maar u heeft op dit moment nog geen
informatie over het bos. Voor dat doel kunt u een enquête ontwerpen om het gehele bosgebied te inventariseren en
dan de parameters daarvan in te schatten. In deze les zult u een systematische set van monsterplaatsen maken.
Wanneer u begint met het plannen van de inventarisatie van het bos, is het belangrijk om de doelen helder te
definiëren, de typen monsterplaatsen die zullen worden gebruikt, en de gegevens die zullen worden verzameld om
de doelen te bereiken. Voor elk individueel geval zullen deze afhangen van het type bos en de beheersdoeleinden; en
zouden zorgvuldig moeten worden gepland door iemand met kennis van bosbouw. In deze les zult u een theoretische
inventarisatie implementeren, gebaseerd op een systematisch ontwerp van monsterplaatsen.
Het doel voor deze les: Een systematisch ontwerp van monsterplaatsen maken om het bosgebied te onderzoeken.

14.5.1 Inventariseren van het bos

Er bestaan verscheidene methoden om bossen te inventariseren, elk daarvan voor verschillende doeleinden en met
andere voorwaarden. Een zeer nauwkeurige manier om bijvoorbeeld een bos te inventariseren (als u alleen kijkt naar
soorten bomen) zou zijn om het bos te bezoeken en een lijst te maken van elke boom en de karakteristieken daarvan.
Zoals u zich kunt voorstellen is dat, met uitzondering van enkele kleine gebieden of in speciale situaties, niet algemeen
toe te passen.
De meest voorkomende manier om een bos te onderzoeken is door er monsters van te nemen, dat is, metingen
verrichten op verschillende locaties in het bos en die informatie te veralgemeniseren voor het gehele bos. Deze
metingen worden vaak verricht op monsterplaatsen wat kleinere bosgebieden zijn die gemakkelijk bemeten kunnen
worden. De monsterplaatsen kunnen elke grootte zijn (bijv. 50 m2, 0,5 ha) en vorm (bijv. cirkelvormig, rechthoekig,
variabele grootte), en kunnen op verschillende manieren in het bos liggen (bijv. willekeurig, systematisch, langs
lijnen). De grootte, vorm en locatie van de monsterplaatsen worden gewoonlijk bepaald aan de hand van statistische,
economische en praktische overwegingen. Als u geen kennis heeft over bosbouw, bent u misschien geïnteresseerd in
het lezen van dit artikel op Wikipedia.
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14.5.2 Follow Along: Een systematisch ontwerp van monsterplaatsen
implementeren

Voor het bos waarmee u werkt heeft de beheerder besloten dat een systematisch ontwerp van monsterplaatsen het
meest toepasselijk is voor dit bos en heeft besloten dat een vaste afstand van 80 meter tussen de monsterplaatsen
en monsterlijnen betrouwbare resultaten zal opleveren (voor dit geval een gemiddelde foutmarge van +- 5% bij een
waarschijnlijkheid van 68%). Besloten is dat monsterplaatsen met een variabele grootte de meest effectieve methode
voor deze inventarisatie zijn, voor groeiende en volwassen bosopstanden, maar monsterplaatsen met een vaste straal
van 4 meter zal worden gebruikt voor bosopstanden met zaailingen.
In de praktijk dient u eenvoudigweg de monsterplaatsen weer te geven als punten, die later zullen worden gebruikt
door de teams in het veld:

• Open uw project digitizing_2012.qgs uit de vorige les.
• Verwijder alle lagen, met uitzondering van forest_stands_2012.
• Sla uw project nu op als forest_inventory.qgs

Nu moet u een rechthoekig raster van punten maken die 80 meter van elkaar liggen:
• Open Vector ► Onderzoeks-gereedschap ► Regelmatige punten.
• Selecteer Invoer grenslaag in de definities Vlak.
• En stel als invoerlaag de laag forest_stands_2012 in.
• Selecteer, in de instellingen Tussenruimte raster, Gebruik deze tussenruimte voor punten en stel die in op 80.
• Sla het uitvoerbestand op als systematic_plots.shp in de map forestry\sampling\.
• Selecteer Resultaat aan kaartvenster toevoegen.
• Klik op OK.

Notitie: De voorgestelde Regelmatige punten maakt de systematische punten, beginnend in de linkerbovenhoek
van het bereik van de geselecteerde polygoonlaag. Indien u enige willekeurigheid aan deze regelmatige punten wilt
toevoegen, zou u eenwillekeurig berekend getal tussen 0 en 80 (80 is de afstand tussen onze punten) kunnen gebruiken,
en dan op te geven als de parameter Beginwaarde voor hoek (LH kant) in het dialoogvenster van het gereedschap.

U zult gemerkt hebben dat het gereedschap het gehele bereik van uw laag met bosopstanden heeft gebruikt om een
rechthoekig raster van punten te genereren. Maar u bent alleen geïnteresseerd in de punten die feitelijk binnen uw
bosgebied liggen (bekijk de afbeeldingen hieronder):
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• Open Vector ► Geoprocessing-gereedschap ► Clip.
• Selecteer systematic_plots als Invoer vectorlaag.
• Stel forest_stands_2012 in als de Cliplaag.
• Sla het resultaat op als systematic_plots_clip.shp.
• Selecteer Resultaat aan kaartvenster toevoegen.
• Klik op OK.

U heeft nu de punten die de teams in het veld zullen gebruiken om naar de locaties van de ontworpen monsterplaatsen
te navigeren. U kunt deze punten nog steeds voorbereiden zodat ze meer bruikbaar zijn voor het veldwerk. U zult
tenminste betekenisvolle namen moeten toevoegen aan de punten en ze exporteren naar een indeling die kan worden
gebruikt in hun GPS-apparaten.
Laten we beginnen met het benoemen van de monsterplaatsen. Als u de Attributentabel voor de monsterplaatsen
binnen het bosgebied controleert, kunt u zien dat het standaard veld id automatisch is gegenereerd door het
gereedschap Regelmatige punten. Label de punten om ze op de kaart te zien en overweeg of u deze nummers als
deel voor de namen van uw monsterplaatsen kunt gebruiken:

• Open de Laageigenschappen –> Labels voor uw systematic_plots_clip.
• Selecteer Deze laag labelen met en selecteer het veld ID.
• Ga naar de opties Buffer en selecteer Teken tekstbuffer, stel Grootte in op 1.
• Klik op OK.

Bekijk nu de labels op uw kaart. U kunt zien dat de punten zijn gemaakt en genummerd van Oost naar West en
vervolgens van Noord naar Zuid. Als u opnieuw naar de attributentabel kijkt, zult u zien dat de volgorde in de tabel
ook dat patroon volgt. Tenzij u een reden hebt om de monsterplaatsen een andere naam te geven, is het benoemen
ervan op de wijze van West-Oost/Noord-Zuid een logische volgorde en is een goede optie.
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Notitie: Als u ze in een andere volgorde of met een andere naam zou willen hebben, zou u een werkblad kunnen
gebruiken om in staat te zijn rijen en kolommen op een andere manier te ordenen en te combineren.

Niettegenstaande dat zijn de nummerwaarden in het veld id niet zo goed. Het zou beter zijn als de namen iets zouden
zijn van p_1, p_2.... U kunt een nieuwe kolom maken voor de laag systematic_plots_clip:

• Ga naar de Attributentabel voor systematic_plots_clip.
• Schakel de modus Bewerken in.
• Open de Veldberekening en noem de nieuwe kolom Plot_id.
• Stel het Type voor veld in op Tekst (string).
• In the Expression field, write, copy or construct this formula concat('P_', $rownum ). Remember that
you can also double click on the elements inside the Function list. The concat function can be found under
String and the $rownum parameter can be found under Record.

• Klik op OK.
• Schakel de modus Bewerken uit en sla uw wijzigingen op.

Nu heeft u een nieuwe kolom met namen voor plaatsen die betekenis voor u hebben. Wijzig, voor de laag
systematic_plots_clip, het veld dat wordt gebruikt voor de labels naar uw nieuwe veld Plot_id.
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14.5.3 Follow Along: Monsterplaatsen in GPX-indeling exporteren

De teams in het veld zullen waarschijnlijk een GPS-apparaat gebruiken om de monsterplaatsen te vinden die u
heeft gepland. De volgende stap is om de punten die u gemaakt heeft te exporteren in een indeling die uw GPS
kan lezen. QGIS stelt u in staat uw gegevens voor punt- en lijnvector te exporteren in GPS eXchange Format
(GPX)<https://en.wikipedia.org/wiki/GPS_Exchange_Format>, wat een standaard GPS-gegevensindeling is die kan
worden gelezen door de meeste gespecialiseerde software. U moet voorzichtig zijn bij het selecteren van het CRS
wanneer u uw gegevens opslaat:

• Klik met rrechts op systematic_plots_clip en selecteer Opslaan als.
• Selecteer GPS eXchange Format [GPX] in Formaat.
• Sla de uitvoer op als plots_wgs84.gpx.
• Selecteer Geselecteerd CRS in CRS.
• Blader naar WGS 84 (EPSG:4326).

Notitie: De indeling GPX accepteert alleen dit CRS. Als u een ander selecteert zal QGIS geen foutmelding geven,
maar u krijgt een leeg bestand.

• Klik op OK.
• Selecteer, in het dialoogvenster dat opent, alleen de laag waypoints (de rest van de lagen zijn leeg).
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De monsterplaatsen voor de inventarisatie staan nu in een standaardindeling die door de meeste GPS-software kan
worden afgehandeld. De teams in het veld kunnen nu de locaties van de monsterplaatsen uploaden naar hun apparaten.
Dat zou moeten worden gedaan met behulp van de eigen software voor de specifieke apparaten en het bestand
plots_wgs84.gpx dat u zojuist heeft opgeslagen. Een andere optie zou zijn om de plug-in GPS-gereedschap
te gebruiken maar daarbij zou het zeer waarschijnlijk inhouden dat het gereedschap moet worden ingesteld om te
werken met uw specifieke GPS-apparaat. Als u werkt met uw eigen gegevens en wilt zien hoe het gereedschap werkt,
kunt u er meer informatie over vinden in het gedeelte working_gps in de QGIS Gebruikershandleiding.
Sla nu uw project van QGIS op.
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14.5.4 In Conclusion

U zag zojuist hoe eenvoudig u een systematisch ontwerp voor monstername kunt maken dat gebruikt kan worden
worden voor de inventarisatie van een bos. Het maken van andere typen ontwerpen voor het nemen van monsters zal
het gebruiken van andere gereedschappen binnen QGIS behelzen, werkbladen of scripten om de coördinaten van de
monsterplaatsen te berekenen, maar het algemene idee blijft hetzelfde.

14.5.5 What’s Next?

In de volgende les zult u zien hoe u de mogelijkheden voor Atlas in QGIS kunt gebruiken om automatisch
gedetailleerde kaarten te genereren die teams in het veld zullen gebrukken om naar de monsterplaatsen te navigeren
die aan hen zijn toegewezen.

14.6 Lesson: Gedetailleerde kaarten maken met het gereedschap
Atlas

Het systematisch ontwerp voor het nemen van monsters is gereed en de teams in het veld hebben de GPS-coördinaten
in hun navigatieapparaten geladen. Zij hebben ook een formulier met veldgegevens waarop zij de informatie zullen
verzamelen die zij hebben gemeten op elke monsterplaats. Zij hebben een aantal gedetailleerde kaarten gevraagd
waarop enige informatie over het terrein duidelijk zichtbaar is, tezamen met een kleinere subset van monsterplaatsen
en enige informatie over het gebied van de kaart om eenvoudiger hun weg naar elke monsterplaats te vinden. U kunt
het gereedschap Atlas gebruiken om automatisch een aantal kaarten in een gelijke indeling te generen.
Het doel voor deze les: Het gereedschap Atlas in QGIS leren gebruiken om gedetailleerde af te drukken kaarten te
genereren om te helpen bij de inventarisatie in het veld.

14.6.1 Follow Along: De afdruklay-out voorbereiden

Vóór we de gedetailleerde kaarten van het bosgebied en onze monsterplaatsen kunnen automatiseren, moeten we
een kaartsjabloon maken met alle elementen die we nuttig achten voor het werk in het veld. Natuurlijk is het meest
belangrijke dat het goed opgemaakt is, maar, zoals u al eerder heeft gezien, u zult ook heel veel andere elementen
moeten toevoegen die de afgedrukte kaart completeren.
Open het project forest_inventory.qgs van QGIS vanuit de vorige les. U zou ten minste de volgende lagen
moeten hebben:

• forest_stands_2012 (met een transparantie van 50%, groene vulling en donkergroene lijnen als rand).
• systematic_plots_clip.
• rautjarvi_aerial.

Sla het project op onder de nieuwe naam map_creation.qgs.
Onthoud dat u Lay-out beheren: gebruikt om een kaart te maken die kan worden afgedrukt,

• Open Project ► Lay-out beheren….
• In het dialoogvenster Lay-out beheren.
• Klik op de knop Toevoegen en noem uw lay-out forest_map.
• Klik op OK.
• Klik op de knop Tonen.

Stel de printeropties zo in dat uw kaarten en marges op uw papier passen, voor een A4-tje:
• Open menuselection:Lay-out –> Pagina-instellingen….
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• Grootte is A4 (217 x 297 mm).
• Oriëntatie is Landschap.
• Marges (millimeters) worden allemaal ingesteld op 5.

Ga, in het venster Lay-out, naar de tab Lay-out (in het paneel rechts) en zorg er voor dat deze instellingen voor Papier
en kwaliteit hetzelfde zijn als die welke u definieerde voor de printer:

• Voorinstellingen: A4 (210x297mm).
• Oriëntatie: Liggend.
• Export resolutie: 300dpi.

Het maken van een kaart gaat eenvoudiger als u gebruikt maakt van het kaartraster om de verschillende elementen te
plaatsen. Bekijk de instellingen voor het raster van afdruklay-out:

• Vergroot, op de tab Lay-out, het gebied Hulplijnen en raster.
• Controleer of Rasterafstand is ingesteld op 10 mm.
• En dat Tolerantie voor ‘snappen’ is ingesteld op 2 mm.

U dient het gebruiken van het raster te activeren:
• Open het menu Beeld.
• Klik op Grid tonen.
• Selecteer Aan grid snappen.
• Merk op dat de opties voor het gebruiken van hulplijnen standaard zijn geselecteerd, wat u in staat stelt rode
hulplijnen te zien wanneer u elementen in de lay-out verplaatst.

Nu kunt u beginnen met het toevoegen van elementen aan uw lay-out. Voeg eerst een kaartelement toe zodat u kunt
bekijken hoe het kaartvenster er uitziet als u wijzigingen in de symbologie van de kaart maakt:

• Klik op de knop Kaart toevoegen.
• Klik en sleep een rechthoek op het kaartvenster zodat de kaart het grootste deel daarvan bedekt.
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Merk op hoe de muiscursor snapt aan het kaartraster. Gebruik deze functie als u andere elementen toevoegt. Als u
nauwkeuriger wilt werken, wijzig dan de instelling Rasterafstand voor het raster. Als u om enige reden niet op een
bepaald punt niet zou willen snappen aan het raster, kunt u het altijd in- of uitschakelen in het menu Beeld.

14.6.2 Follow Along: Een achtergrondkaart toevoegen

Laat de lay-out open maar ga terug naar de kaart. Laten we enige achtergrondgegevens toevoegen en enige opmaak
maken zodat de inhoud van de kaart zo duidelijk als maar mogelijk is.

• Voeg het raster voor de achtergrond basic_map.tif toe dat u kunt vinden in de map exercise_data\
forestry\.

• Selecteer het CRS ETRS89 / ETRS-TM35FIN CRS voor het raster als daarnaar gevraagd wordt.
Zoals u kunt zien is de kaart voor de achtergrond al opgemaakt. Dit type direct te gebruiken cartografie-raster is
vrij algemeen. Het wordt gemaakt vanuit vectorgegevens, opgemaakt in een standaard indeling en opgeslagen als een
raster zodat u zich niet bezig hoeft te houden met het opmaken van verscheidene vectorlagen en u geen zorgen hoeft
te maken of u wel een goed resultaat krijgt.

• Zoom nu in op uw monsterplaatsen, zodat u alleen nog vier of vijf lijnen met monsterplaatsen ziet.
De huidige opmaak van de monsterplaatsen is niet al te best, maar hoe ziet het er in de lay-out uit?:

Gedurende de laatste oefeningen was de witte buffer boven op de luchtfoto OK, maar nu dat de achtergrondafbeelding
meest wit is kunt u de labels nog nauwelijks zien. U kunt ook controleren hoe het eruit ziet in de lay-out:

• Ga naar het venster Lay-out.

• Gebruik de knop om het kaartelement te selecteren in de lay-out.
• Ga naar de tab Item-eigenschappen.
• Klik, onder Bereik, op Toon bereik in kaartvenster.
• Klik onder Algemene eigenschappen op de knop Voorvertoning bijwerken als u het element moet vernieuwen.

Dit is duidelijk niet voldoende, u wilt de nummers van de monsterplaatsen zo zichtbaar mogelijk maken voor de teams
in het veld.
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14.6.3 Try Yourself De symbologie van de lagen wijzigen

InModule: Een basiskaart maken en verkennen is gewerkt met symbologie en inModule: Vectorgegevens classificeren
met labels. Het is aan te raden deze delen van de handleiding nog even door te lezen. Doel is om locaties en namen
van monsterplaatsen zichtbaar te maken op een manier waarbij de ondergrond ook zichtbaar blijft. Onderstaande
afbeelding geeft een mogelijk resultaat:

U zult later de groene opmaak van de laag forest_stands_2012 gebruiken. Om die te behouden en een
visualisatie er van te hebben die alleen de randen van de bosopstanden weergeeft:

• Klik met rechts op forest_stands_2012 en selecteer Dupliceren

• U krijgt een nieuwe laag, genaamd forest_stands_2012 kopiëren, die u kunt gebruiken om een
andere stijl te definiëren, bijvoorbeeld zonder vulling en met rode randen.

Nu heeft u twee verschillende visualisaties van de bosopstanden en kunt u beslissen welke weer te geven voor uw
detailkaart.
Ga vaak terug naar het venster Lay-out om te zien hoe de kaart er uit zou komen te zien. Voor het doel gedetailleerde
kaarten te maken, zoekt u naar een symbologie die er niet goed uitziet op de schaal van het gehele bosgebied
(linker afbeelding hieronder) maar op een kleinere schaal (rechter afbeelding hieronder). Vergeet niet Voorvertoning
bijwerken en Aanpassen aan kaartformaat te gebruiken wanneer u de zoomfactor wijzigt in uw kaart of de lay-out.
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14.6.4 Try Yourself Een sjabloon voor een basiskaart maken

Als u eenmaal een symbologie heeft die u bevalt, bent u klaar om meer informatie aan uw af te drukken kaart toe te
voegen. Voeg ten minste de volgende elementen toe:

• Titel.
• Een schaalbalk.
• Een raster voor uw kaart.
• Coördinaten aan de zijkanten van het raster.

U heeft een soortgelijke lay-out al gemaakt in composition already in Module: De kaarten opmaken. Ga terug naar
die module als dat nodig is. U kunt deze voorbeeldafbeelding als verwijzing gebruiken:

Exporteer uw kaart als een afbeelding en bekijk hem.
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• Lay-out ► Als afbeelding exporteren.
• Gebruik de JPG format voor het voorbeeld.

Dat is hoe het er uit zal zien na het afdrukken.

14.6.5 Follow Along: Meer elementen aan de lay-out toevoegen

Zoals u waarschijnlijk al is opgevallen in de voorgestelde voorbeelden voor afbeeldingen van sjablonen, is er ruim
voldoende ruimte aan de rechterzijde van het kaartvenster. Laten we eens zien wat daar nog meer zou kunnen worden
geplaatst. Voor het doel van onze kaart is een legenda niet echt nodig, maar een overzichtskaart en enkele tekstvakken
zouden waarde aan de kaart kunnen toevoegen.
Een overzichtskaart zou de teams in het veld helpen de gedetailleerde kaart binnen het algehele bosgebied te plaatsen:

• Voeg een ander kaartelement toe aan het kaartvenster, rechts onder de tekst voor de titel.
• Open, op de tab Item-eigenschappen, de keuzelijst Overzichtskaarten.
• Stel het Kaartframe in op Kaart 0. Dit maakt een geschaduwde rechthoek over de kleinere kaart die het bereik
weergeeft dat zichtbaar is in de grotere kaart.

• Selecteer ook de optie Frame met een zwarte kleur en een Dikte van 0.30.

Merk op dat uw overzichtskaart niet echt een overzicht geeft van het gehele bosgebied, wat is wat u wilt. U
wilt dat deze kaart het gehele bosgebied weergeeft en u wilt dat het alleen de achtergrondkaart en de laag
forest_stands_2012 weergeeft, en niet de monsterplaatsen. Ook wilt u dat zijn weergave wordt vergrendeld
zodat die niet meer wijzigt wanneer u de zichtbaarheid of volgorde van de lagen wijzigt.

• Ga terug naar de kaart, maar sluit de Lay-out niet.
• Klik met rechts op de laag forest_stands_2012 en klik op Op kaartlaag inzoomen.
• Deactiveer alle lagen met uitzondering van basic_map en forest_stands_2012.
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• Ga terug naar de Lay-out.
• Klik, met de kleine kaart geselecteerd, op Aanpassen aan kaartformaat om zijn bereik in te stellen op wat u
ziet in het kaartvenster.

• Vergrendel de weergave voor de overzichtskaart door te selecteren Lagen vastzetten voor kaartonderdeel onder
Algemene eigenschappen.

Nu is uw overzichtskaart meer zoals u verwachtte en de weergave ervan zal niet meer wijzigen. Maar, natuurlijk, nu
geeft uw gedetailleerde kaart de randen van de bosopstanden niet meer weer, noch de monsterplaatsen. Laten we dat
repareren:

• Ga opnieuw naar het kaartvenster en selecteer de lagen die zichtbaar moeten zijn
(systematic_plots_clip, forest_stands_2012 kopiëren en Basic_map).

• Zoom opnieuw in zodat slechts een paar lijnen met monsterplaatsen zichtbaar zijn.
• Ga terug naar het venster Lay-out.

• Selecteer de grotere kaart in uw lay-out ( ).
• Klik, in Item-eigenschappen op Voorvertoning bijwerken en Aanpassen aan kaartformaat.

Merk op dat alleen de grotere kaart de huidige kaartweergave toont, en dat de kleinere overzichtskaart dezelfde
weergave heeft als toen u die vergrendelde.
Merk ook op dat de overzichtskaart een geschaduwd frame weergeeft voor het bereik dat wordt weergegeven in de
detailkaart.

Uw sjabloon voor de kaart is bijna voltooid. Voeg nu twee tekstvakken onder de kaart toe, één met de tekst
‘Gedetailleerde kaart zone: ‘ en de andere met ‘Opmerking: ‘. Plaats ze zoals u kunt zien in bovenstaande afbeelding.
U kunt ook een Noordpijl toevoegen aan de overzichtskaart:
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• Gebruik het gereedschap Afbeelding toevoegen, .
• Klik in de rechterbovenhoek van de overzichtskaart.
• Open, in Item-eigenschappen, Mappen doorzoeken en blader naar een afbeelding van een pijl.
• Selecteer, onder Rotatie afbeelding, Met kaart synchroniseren en selecteer Kaart 1 (de overzichtskaart).
• Deselecteer Achtergrond.
• Wijzig de grootte van de afbeelding van de pijl zodat die er goed uitziet op een kleine kaart.

De lay-out voor de basiskaart is nu gereed, nu wilt u gebruikmaken van het gereedschapAtlas om zoveel gedetailleerde
kaarten in deze indeling te generen als u nodig vindt.

14.6.6 Follow Along: Een Atlas-bedekking genereren

De Atlas dekking is slechts een vectorlaag die zal worden gebruikt om de gedetailleerde kaarten te genereren, één
kaart voor elk object in de dekking. Hier is een volledige set van gedetailleerde kaarten voor het bosgebied om een
idee te krijgen van wat vervolgens zal worden gedaan.

De bedekking zou elke bestaande laag kunnen zijn, maar gewoonlijk is het verstandiger er een te maken voor dit
specifieke doel. Laten we een raster van polygonen maken die het bosgebied bedekken:

• Open, in de kaartweergave van QGIS, Vector ► Onderzoeks-gereedschap ► Vectorgrid.
• Stel het gereedschap in zoals in deze afbeelding:
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• Sla de uitvoer op als atlas_coverage.shp.
• Maak de nieuwe laag atlas_coverage zo op dat de polygonen geen vulling hebben.

De nieuwe vlakken bedekken het hele gebied van het bos en geven een indruk van wat elke kaart (gemaakt van
individuele vlakken) bevat.
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14.6.7 Follow Along: Het gereedschap Atlas instellen

De laatste stap is om het gereedschap Atlas in te stellen:
• Ga terug naar de Lay-out.
• Ga, in het paneel rechts, naar de tab Atlas-generatie.
• Stel de opties als volgt in:
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Dat vertelt het gereedschap Atlas om de objecten (polygonen) binnen atlas_coverage te gebruiken als de focus
voor elke gedetailleerde kaart. Het zal één kaart uitvoeren voor elk object in de laag. De Verborgen bedekkingslaag
vertelt de Atlas om de polygonen niet weer te geven op de uitgevoerde kaarten.
Er moet nog één ding worden gedaan. U moet het gereedschap Atlas vertellen welk kaartelement moet worden
bijgewerkt voor elke uitgevoerde kaart. U kunt nu waarschijnlijk wel raden dat het kaartonderdeel dat voor elke
kaart moet worden bijgewerkt dat is welk u heeft voorbereid om detailweergaven te bevatten van de monsterplaatsen,
dat is het grotere kaartelement in uw kaartvenster:

• Selecteer het grotere kaartelement.
• Ga naar de tab Item-eigenschappen.
• Selecteer in de lijst Beheerd door Atlas.
• En stel Marge rond object in op 10%. Het bereik voor de weergave zal 10% groter zijn dan de polygonen, wat
betekent dat uw gedetailleerde kaarten elkaar 10% overlappen.
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Nu kunt u het gereedschap Voorvertoning voor Atlas-kaarten gebruiken om te zien hoe uw kaarten eruit zullen komen
te zien:

• Activeer de voorbeelden van Atlas met behulp van de knop of, als uw werkbalk Atlas niet zichtbaar is, via
Atlas ► Voorbeeld Atlas.

• U kunt de pijlen in de werkbalk Atlas gebruiken of die in het menu Atlas om door de te maken kaarten te
verplaatsen.

Merk op dat sommige ervan niet interessant zijn. Laten we daar iets aan doen en enkele bomen sparen door die
onbruikbare kaarten niet af te drukken.

14.6.8 Follow Along: De bedekkingslaag bewerken

Naast het verwijderen van de polygonen voor die gebieden die niet interessant zijn, kunt u ook de tekstlabels in uw
te generen kaart aanpassen met inhoud uit de Attributentabel van uw bedekkingslaag:

• Ga terug naar de kaartweergave.
• Schakel Bewerken in voor de laag atlas_coverage.
• Selecteer de polygonen die zijn geselecteerd (in geel) in onderstaande afbeelding.
• Verwijder de geselecteerde polygonen.
• Schakel Bewerken uit en sla de wijzigingen op.
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U kunt nu terug gaan naar de Lay-out en controleren of de voorbeelden van Atlas alleen de polygonen gebruiken die
zijn overgebleven op de laag.
De bedekkingslaag die u gebruikt heeft nog geen bruikbare informatie die u zou kunnen gebruiken om de inhoud van
de labels op uw kaart aan te passen. De eerste stap is om ze te maken, u kunt bijvoorbeeld een code voor de zone
toevoegen voor de gebieden van de polygonen en een veld met enkele opmerkingen voor de teams in het veld om
rekening mee te houden:

• Open de Attributentabel voor de laag atlas_coverage.
• Schakel Bewerken in.

• Gebruik de veldberekening om de volgende twee velden te maken en in te vullen.
• Maak een veld genaamd Zone en typ Geheel getal (integer).
• In het vak Expressie schrijf/kopieer/construeer $rownum.
• Maak een ander veld, genaamd Opmerking:,van het type Tekst (string) en een breedte van 255.
• Schrijf, in het vak Expressie, 'Geen opmerkingen.'. Dat zal de standaard waarde instellen voor alle
polygonen.
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De beheerder van het bos zal enige informatie hebben over het gebied die bruikbaar is bij het bezoeken van het
gebied.Bijvoorbeeld de aanwezigheid van een brug, een moeras of de locatie van een beschermde soort. De laag
atlas_coverage staat waarschijnlijk nog steeds in de modus Bewerken, voeg de volgende tekst toe in het veld
Opmerking voor de overeenkomende polygonen (dubbelklik op de cel om die te bewerken):

• Voor de Zone 2: Brug ten noorden van monsterplaats 19. Gewone vliegende
eekhoorn tussen p_13 en p_14..

• Voor de Zone 6: Moeilijk te verplaatsen in het moeras ten noorden van het
meer..

• Voor de Zone 7: Gewone vliegende eekhoorn ten zuiden van p_94..
• Schakel Bewerken uit en sla uw wijzigingen op.

Bijna klaar. Nu moet u het gereedschap Atlas vertellen dat u wilt dat enkele tekstlabels de informatie uit de
attributentabel van de laag atlas_coverage gebruiken.

• Ga terug naar de Lay-out.
• Selecteer het tekstlabel dat Gedetailleerde kaart... bevat.
• Stel de grootte van Lettertype in op 12.
• Zet de cursor aan het einde van de tekst in het label.
• Klik, in de Algemene eigenschappen op de tab Item-eigenschappen, op Een expressie invoeren of bewerken….
• Dubbelklik, in de Functielijst, op het veld Zone onder Velden en waarden.
• Klik op OK.
• De tekst in het vak in de Item-eigenschappen zou nu Gedetailleerde kaart zone [% "Zone" %]
moeten weergeven. Onthoud dat [% "Zone" %] zal worden vervangen door de waarde van het veld Zone
voor het overeenkomende object uit de laag atlas_coverage.

Test de inhoud van het label door te kijken naar de verschillende voorbeelden van de kaarten in Atlas.
Doe hetzelfde voor de labels met de tekst Opmerking: door het veld met de informatie voor de zone te gebruiken.
U kunt een regeleinde invoegen vóór u de expressie invoert. U kunt het resultaat voor het voorbeeld van zone 2 zien
in de afbeelding hieronder:
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Gebruik de voorbeelden van Atlas om door alle kaarten te bladeren die u nu snel zult maken en geniet ervan!

14.6.9 Follow Along: De kaarten afdrukken

Als laatste maar niet het minste, afdrukken of exporteren van uw kaarten als afbeeldingen of PDF-bestanden. U kunt
Atlas ► Atlas als afbeeldingen exporteren… of Atlas ► Atlas als PDF exporteren… gebruiken. Momenteel werkt het
exporteren naar de indeling SVG nog niet goed en zal een slecht resultaat geven.
Laten we de kaarten als één enkele PDF exporteren die u naar het veldbureau kunt sturen om af te drukken:

• Ga naar de tab Atlas-generatie in het paneel rechts.
• Selecteer, onder Uitvoer, Exporteren naar enkel bestand indien mogelijk. Dit zal alle kaarten bij elkaar in één
PDF stoppen, als deze optie niet wordt geselecteerd krijgt u één bestand voor elke kaart.

• Open Lay-out ► Als PDF exporteren….
• Sla het PDF-bestand op als inventory_2012_maps.pdf in uw map exercise_data\forestry\
samplig\map_creation\.

Open het PDF-bestand om te controleren of alles is gegaan zoals verwacht.
U zou net zo makkelijk afzonderlijke afbeeldingen kunnen maken voor elke kaart (onthoud om het maken van één
enkel bestand uit te schakelen), hier kunt u de miniaturen zien voor de afbeeldingen die gemaakt zullen worden:
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Sla, in de Lay-out, uw kaart op als een sjabloon voor lay-out als forestry_atlas.qpt in uw map
exercise_data\forestry\map_creation\. Gebruik Lay-out► Als sjabloon opslaan. U zult in staat zijn
dit sjabloon steeds opnieuw te gebruiken.
Sluit de Lay-out en sla uw project van QGIS op.

14.6.10 In Conclusion

U bent erin geslaagd een sjabloonkaart te maken die kan worden gebruikt om automatisch gedetailleerde kaarten te
genereren die in het veld kunnen worden gebruikt om naar de verschillende monsterplaatsen te navigeren. Zoals u
heeft gemerkt was dit geen eenvoudige taak maar de voordelen worden duidelijk wanneer u soortgelijke kaarten moet
maken voor andere regio’s en u het sjabloon kunt gebruiken dat u zojuist heeft gemaakt.

14.6.11 What’s Next?

In de volgende les zult u zien hoe u gegevens van LiDAR kunt gebruiken om een DEM te maken en die dan te
gebruiken om de zichtbaarheid van uw gegevens en kaarten te vergroten.

14.7 Lesson: De parameters voor het bos berekenen

Het bepalen van de parameters van het bos is het doel van de inventarisatie van het bos. In aansluiting op het voorbeeld
uit de vorige les, zult u de in het veld verzamelde informatie van de inventarisatie gaan gebruiken om de parameters
voor het bos te berekenen, eerst voor het gehele bos, en dan voor de bosopstanden die u eerder digitaliseerde.
Het doel voor deze les: Parameters voor het bos berekenen, voor het geheel en op niveau van bosopstand.

14.7.1 Follow Along: De resultaten van de inventarisatie toevoegen

De teams in het veld hebben het bos bezocht en, met behulp van de informatie die u heeft verschaft, informatie over
het bos verzameld op elke monsterplaats.
Heel vaak zal de informatie worden verzameld op papieren formulieren in het veld, daarna getypt in een werkblad. De
informatie van de monsterplaatsen is opgenomen in een .csv-bestand dat eenvoudig kan worden geopend in QGIS.
Ga door met het project van QGIS uit de les over het ontwerpen van de inventarisatie. U heeft het waarschijnlijk
forest_inventory.qgs genoemd.
Voeg als eerste de metingen van de monsterplaatsen toe aan uw project van QGIS:

1. Ga naar Laag ► Tekstgescheiden kaartlaag toevoegen….
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2. Blader naar het bestand systematic_inventory_results.csv geplaatst in de map
exercise_data/forestry/results/.

3. Zorg er voor dat de optie Puntcoördinaten is geselecteerd.
4. Stel de velden voor de coördinaten in op de velden X en Y.
5. Klik op OK.
6. Selecteer het CRS ETRS89 / ETRS-TM35FIN CRS als daarnaar gevraagd wordt.
7. Open de Attributentabel voor de nieuwe laag en bekijk de gegevens.

U kunt het type gegevens dat is opgenomen in de metingen op de monsterplaatsen lezen in het tekstbestand
legend_2012_inventorydata.txt dat is geplaatst in de map exercise_data/forestry/
results/.
De laag systematic_inventory_results die u zojuist heeft toegevoegd is in feite slechts een virtuele
weergave van de tekstinformatie in het .csv-bestand. Converteer, vóórdat u doorgaat, de resultaten van de
inventarisatie naar een echte ruimtelijke gegevensset:

1. Klik met rechts op de laag systematic_inventory_results.
2. Blader naar de map exercise_data/forestry/results/.
3. Noem het bestand sample_plots_results.shp.
4. Selecteer Voeg opgeslagen bestand toe aan kaart.
5. Verwijder de laag systematic_inventory_results uit uw project.

14.7.2 Follow Along: Schatting voor parameters voor gehele bos

U kunt de gemiddelden berekenen voor het gehele bosgebied vanuit de resultaten voor de inventarisatie voor enkele
interessante parameters, zoals het volume en het aantal stammen per hectare. Omdat de systematischemonsterplaatsen
gelijke gebieden vertegenwoordigen, kunt u direct de gemiddelden van de volumes en het aantal stammen per hectare
berekenen vanuit de laag sample_plots_results.
U kunt het gemiddelde van een veld in een vectorlaag berekenen met behulp van het gereedschap Basisstatistieken:

1. Open Vector ► Analyse-gereedschap ► Basisstatistieken voor velden.
2. Selecteer sample_plots_results als de Invoer vectorlaag.
3. Selecteer Vol als Doelveld.
4. Klik op OK.

Het gemiddelde volume in het bos is 135.2 m3/ha.
U kunt op dezelfde manier het gemiddelde aantal stammen berekenen, 2745 stammen/ha.
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14.7.3 Follow Along: Parameters voor de bosopstanden schatten

U kunt gebruikmaken van deze zelfde systematische monsterplaatsen schattingen te berekenen voor de verschillende
bosopstanden die u eerder digitaliseerde. Enkele van deze bosopstanden kregen geen monsterplaats en voor hen zult u
dus geen informatie ontvangen. U zou enkele extra monsterplaatsen hebben kunnen plannen toen u de systematische
inventarisatie plande, zodat de teams in het veld voor dit doel een paar extra monsterplaatsen zouden hebben bemeten.
Of u zou later een team het veld ingestuurd kunnen hebben om schattingen voor de ontbrekende bosopstanden te
verkrijgen omde inventarisatie van de bosopstanden te completeren. Niettegenstaande dat, u zult informatie verkrijgen
voor een groot aantal bosopstanden door slechts gebruik te maken van de geplande monsterplaatsen.
Wat u nodig heeft zijn de gemiddelden van de monsterplaatsen die binnen elk van de bosopstanden vallen. Wanneer
u informatie wilt combineren, gebaseerd op hun relatieve locaties, moet u een ruimtelijke join uitvoeren:

1. Open het gereedschap Vector► Datamanagement-gereedschap► Attributen op basis van plaats bijeenbrengen.
2. Stel forest_stands_2012 in als de Doel vectorlaag. De laag waarvan u de resultaten wilt.
3. Stel sample_plots_results in als de Join vectorlaag. De laag waaruit u de schattingen wilt berekenen.
4. Selecteer Samenvatting gebruiken van snijdende objecten.
5. Selecteer om alleen het Gemiddelde te berekenen.
6. Noem het resultaatforest_stands_2012_results.shp en sla het op in demapexercise_data/

forestry/results/.
7. Selecteer tenslotte Alle rijen behouden…, zodat u later kunt controleren welke bosopstanden geen informatie

kregen.
8. Klik op OK.
9. Accepteer, indien daarnaar gevraagd, het toevoegen van de nieuwe laag aan uw project.
10. Sluit het gereedschap Attributen op basis van plaats bijeenbrengen.

Open de Attributentabel voor forest_stands_2012_results en bekijk de resultaten die u heeft. Merk op dat een aantal
bosopstanden NULL hebben als de waarde voor de berekeningen, dat zijn die welke geen monsterplaatsen hebben.
Selecteer ze allemaal en bekijk ze op de kaart, het zijn enkele van de kleinere bosopstanden:
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Laten we nu dezelfde gemiddelden berekenen zoals u eerder voor het gehele bos heeft gedaan, alleen zullen we
deze keer de gemiddelden die u kreeg voor de bosopstanden gebruiken als basis voor de berekening. Onthoud dat
in de eerdere situatie elke monsterplaats een theoretisch bosopstand weergaf van 80x80 m. Nu moet u in plaats
daarvan het gebied van elke bosopstand individueel in ogenschouw nemen. Op die manier worden, opnieuw, de
gemiddelde waarden van de parameters die in, bijvoorbeeld, m³/ha voor de volumes zijn, worden geconverteerd naar
totale volumes voor de bosopstanden.
U moet eerst de gebieden voor de bosopstanden berekenen en dan totale volumes en aantal stammen voor elk ervan
berekenen:

1. Schakel, in de Atributentabel, Bewerken in.
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2. Open de Veldberekening.
3. Maak een nieuw veld, genaamd area.
4. Laat het Type voor veld staan op Decimaal getal (real).
5. Stel Precisie in op 2.
6. Schrijf, in het vak Expressie, $area / 10000. Dit zal het gebied van de bosopstanden berekenen in ha.
7. Klik op OK.

Bereken nu een veld met de total volumes en geschatte anatal stammen voor elke bosopstand:
1. Noem de velden s_vol en s_stem.
2. De velden mogen gehele getallen zijn of u kunt ook real-getallen gebruiken.
3. Gebruik respectievelijk de expressies "area" * "MEANVol" en "area" * "MEANStems" voor totale

volumes en totaal aantal stammen.
4. Sla de wijzigingen op als u gereed bent.
5. Schakel Bewerken uit.

In de eerdere situatie waren de gebieden die door elke monsterplaats werden weergegeven hetzelfde, dus was het
voldoende om het gemiddelde van de monsterplaatsen te berekenen. Voor het berekenen van de schattingen, moet
u nu de som van het volume of het aantal stammen voor de bosopstand delen door de som van de gebieden van de
bosopstanden die informatie bevatten.

1. Selecteer, in de guilabel:Attributentabel voor de laag forest_stands_2012_results, alle
bosopstanden die informatie bevatten.

2. Open Vector ► Analyse-gereedschap ► Basisstatistieken voor velden.
3. Selecteer forest_stands_2012_results als de Invoer vectorlaag.
4. Selecteer area als Veld waarop statistieken moeten worden berekend.
5. Selecteer Alleen geselecteerde objecten

6. Klik op OK.
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Zoals u kunt zien is de totale som van de gebieden van de bosopstanden 66.04 ha. Merk op dat het gebied van de
ontbrekende bosopstanden slechts ongeveer 7 ha is.
Op dezelfde wijze kunt u berekenen dat het totale volume voor deze bosopstanden 8908 m3/ha is en het totale
aantal stammen is 179594 stammen.
Het gebruiken van de informatie voor de bosopstanden, in plaats van die direct vanuit demonsterplaatsen te gebruiken,
geeft de volgende schattingen voor de gemiddelden:

• 184.9 m3/ha en
• 2719 stammen/ha.

Sla uw project voor QGIS op, forest_inventory.qgs.

14.7.4 In Conclusion

U bent er in geslaagd schattingen voor het gehele bos te berekenen met behulp van de informatie uit uw systematische
monsterplaatsen, eerst zonder de karakteristieken van het bos in overweging te nemen en ook met behulp van de
interpretatie van de luchtfoto naar bosopstanden. En u heeft ook enige waardevolle informatie verkregen over de
afzonderlijke bosopstanden, wat zou kunnen worden gebruikt om het beheer van het bos te plannen voor de komende
jaren.
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14.7.5 What’s Next?

In de volgende les zult u eerst een achtergrond met schaduw voor een heuvel maken vanuit een gegevensset van
LiDAR die u zult gebruiken om een kaartweergave voor te bereiden met de resultaten voor het bos die u zojuist heeft
berekend.

14.8 Lesson: DEM vanuit gegevens van LiDAR

U kunt het uiterlijk van uw kaarten verbeteren door gebruik te maken van verschillende achtergrondafbeeldingen. U
zou de basiskaart of de luchtfoto kunnen gebruiken die u eerder heeft gebruikt, maar een raster met schaduw voor
heuvels van het terrein zal er in sommige situaties beter uitzien.
U zult LAStools gebruiken om een DEM uit een gegevensset van LiDAR te nemen en dan een raster met een schaduw
voor heuvels maken om later in uw kaartweergave te gebruiken.
Het doel voor deze les: LAStools installeren en een DEM berekenen vanuit gegevens van LiDAR en een raster met
schaduw voor heuvels.

14.8.1 Follow Along: LAStools installeren

Beheren van gegevens van LiDAR in QGIS is mogelijk met het framewerk Processing en de algoritmen die worden
verschaft door LAStools.
Een digitaal hoogtemodel (DEM) kan worden gemaakt op basis van een LiDAR puntenwolk. Vervolgens kunnen
eventueel schaduwen worden gegenereerd voor presentatiedoeleinden. De instellingen van het framework Processing
dienen als volgt te worden ingesteld om met LAStools aan de slag te gaan:

• Sluit QGIS, als u dat al heeft gestart.
• Een oudere plug-in voor LiDAR zou al standaard geïnstalleerd kunnen zijn op uw systeem in de map C:/
Program Files/QGIS Valmiera/apps/qgis/python/plugins/processing/.

• Als u een map heeft die is genaamd lidar, verwijder die. Dit geldt voor sommige installaties van QGIS 2.2
en 2.4.
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• Ga naar de map exercise_data\forestry\lidar\, daar vindt u het bestand
QGIS_2_2_toolbox.zip. Open het en pak de map lidar uit om die, welke u zojuist heeft verwijderd,
te vervangen.

• Als u een andere versie van QGIS gebruikt, kunt u meer instructies voor de installatie vinden in deze
handleiding.

Nu moet u de LAStools op uw computer installeren. Haal de nieuwste versie van LAStools hier op en pak de inhoud
van het bestand lastools.zip uit in een map op uw systeem, bijvoorbeeld, c:\lastools\. Het pad naar de
map lastools mag geen spaties of speciale tekens bevatten.

Notitie: Lees het bestand LICENSE.txt in de map LAStools. Sommige van de LAStools zijn open bron en
andere zijn gesloten en vereisen een licentie voor meestal commercieel en gebruik door de overheid. Voor educatieve
en evaluatie-doeleinden mag u LAStools gebruiken en testen zoveel u wilt.

De plug-in en de actuele algoritmen zijn nu geïnstalleerd op uw computer en bijna klaar om te gebruiken, u dient
alleen nog het framework Processing in te stellen om ze te kunnen gebruiken:

• Open een nieuw project in QGIS.
• Stel het CRS van het project in op ETRS89 / ETRS-TM35FIN.
• Sla het project op als forest_lidar.qgs.

De LAStools instellen in QGIS:
• Ga naar Processing ► Opties en configuratie.
• Ga, in het dialoogvenster Processing opties, naar Providers en dan naar Tools for LiDAR data

• Selecteer Activate.
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• Stel voor LAStools folder in c:\lastools\ (of de map waarin u LAStools uitpakte).

14.8.2 Follow Along: Een DEM berekenen met LAStools

U heeft de toolbox Processing al gebruikt in Lesson: Ruimtelijke statistieken om enkele algoritmen van SAGA uit te
voeren. Nu gaat u het gebruiken om programma’s van LAStools uit te voeren:

• Open Processing ► Toolbox.
• Selecteer, in het keuzemenu onderaan, Advanced interface.
• U zou de categorie Tools for LiDAR data moeten zien.
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• Vergroot het om de beschikbare gereedschappen te zien, en vergroot ook de categorie LAStools (het aantal
algoritmen kan variëren).

• Scroll naar beneden totdat u het algoritme lasview vindt, dubbelklik er op om hte te openen.
• Voor Input LAS/LAZ file, blader naar exercise_data\forestry\lidar\ en selecteer het bestand
rautjarvi_lidar.laz.

• Klik op Run.
Nu kunt u de gegevens van LiDAR zien in het dialoogvenster just a little LAS and LAZ viewer:
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Er zijn vele dingen die u kunt doen binnen deze viewer, maar voor nu kunt u in de viewer klikken en daarin slepen n
de puntenwolk van LiDAR om te zien hoe die er uit ziet.

Notitie: Als u meer details wilt weten over hoe de LAStools werken, kunt u de README tekstbestanden lezen over
elk van de gereedschappen, in de map C:\LAStools\bin\. Handleidingen en andere materialen zijn beschikbaar
op de webpagina van Rapidlasso.

• Sluit de viewer als u klaar bent.
Het maken van een DEM met LAStools kan worden gedaan in twee stappen, de eerste om de puntenwolk te
classificeren in punten ground en no ground en dan een DEM berekenen met behulp van slechts de punten
ground.

• Ga terug naar de Processing Toolbox.
• In het vak Zoek…, schrijf lasground.
• Dubbelklik om het gereedschap lasground te openen en stel het in zoals in deze afbeelding:
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• Het uitvoerbestand wordt opgeslagen in dezelfde map als waar rautjarvi_lidar.laz is geplaatst en
wordt genoemd rautjarvi_lidar_1.las.

U kunt het openen met lasview als u het wilt controleren.

14.8. Lesson: DEM vanuit gegevens van LiDAR 425



QGIS Training Manual

De bruine punten zijn de punten die zijn geclassificeerd als grond en de grijze zijn de rest, u kunt op de letter g klikken
om alleen de grondpunten te visualiseren of de letter u om alleen de niet-geclassificeerde punten te zien. Klik op de
letter a om opnieuw alle punten te zien. Bekijk het bestand lasview_README.txt voor meer opdrachten. Als u
bent geïnteresseerd is er ook deze handleiding over het handmatig bewerken van punten in LiDAR, die u verschillende
bewerkingen binnen de viewer zal laten zien.

• Sluit de viewer opnieuw.
• Zoek, in de Processing Toolbox, naar las2dem.
• Open het gereedschap las2dem en stel het in zoals weergegeven in deze afbeelding:
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De resulterende DEM wordt toegevoegd aan uw kaart met de algemene naam Output raster file.

Notitie: De gereedschappen lasground en las2dem vereisen een licentie. U kunt de niet gelicenseerde gereedschappen
gebruiken zoals aangegeven in het bestand over de licentie, maar u krijgt de diagonalen die u kunt bewonderen in de
afbeelding met de resultaten.

14.8.3 Follow Along: Een terrein met schaduw voor heuvels maken

Voor visualisatie geeft een schaduw voor heuvels, gegenereerd uit een DEM, een betere visualisatie van het
terrein:

• Open Raster ► Terreinanalyse ► Schaduw heuvels.
• Blader, voor de Resultaatlaag, naar exercise_data\forestry\lidar\ en noem het bestand
hillshade.tif.

• Laat de rest van de parameters op de standaard instellingen staan.
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• Selecteer ETRS89 / ETRS-TM35FIN als het CRS als daarnaar gevraagd wordt.
Ondanks de diagonale lijnen die zich in het raster met schaduw voor heuvels bevinden, kunt u duidelijk een nauwkeurig
reliëf van het gebied zien. U kunt zelfs de de verschillende drainages zien die zijn ingegraven in de bossen.
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14.8.4 In Conclusion

Gebruiken van gegevens in LiDAR om een DEM te krijgen, speciaal in beboste gebieden, geeft goede resultaten
zonder veel inspanning. U zou ook uit reeds voltooide DEM’s, afgeleid vanuit LiDAR, kunnen gebruiken of andere
bronnen zoals de SRTM 9m resolution DEMs. Voor beide geldt dat u ze kunt gebruiken om een raster met schaduw
voor heuvels te maken om in presentaties van uw kaarten te gebruiken.
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14.8.5 What’s Next?

In de volgende, en laatste stap in deze module, les zult u het raster met schaduw voor heuvels en de resultaten van de
inventarisatie van het bos gebruiken om een kaartweergave van de resultaten te maken.

14.9 Lesson: Kaartweergave

In de vorige lessen heeft u een oude inventarisatie van een bos geïmporteerd als een project voor GIS, het bijgewerkt
naar de huidige situatie, een inventarisatie voor het bos ontworpen, kaarten gemaakt voor het veldwerk en parameters
voor het bos berekend vanuit de metingen in het veld.
Het is vaak belangrijk om kaarten te maken met de resultaten van een project van GIS. Een kaart die de resultaten
van de inventarisatie van het bos weergeeft zal het voor iedereen eenvoudiger maken om met een snelle blik een goed
idee te krijgen van de resultaten, zonder naar de specifieke getallen te kijken.
Het doel voor deze les: Een kaart maken om de resultaten van de inventarisatie weer te geven met behulp van een
raster met schaduw voor heuvels als achtergrond.

14.9.1 Follow Along: De gegevens voor de kaart voorbereiden

Open het project vanQGIS uit de les over de berekeningen van de parameters,forest_inventory.qgs. Behoud
ten minste de volgende lagen:

• forest_stands_2012_results.
• basic_map.
• rautjarvi_aerial.
• lakes (als u die niet heeft, voeg die dan toe vanuit de map exercise_data\forestry\).

U gaat de gemiddelde volumes van uw bosopstanden in een kaart weergeven. Als u de Attributentabel opent voor de
laag forest_stands_2012_results, lunt u de waarden NULL zien voor de bosopstanden zonder informatie.
Om in staat te zijn ook die bosopstanden in uw symbologie te zien zou u de waarden NULL moeten wijzigen naar,
bijvoorbeeld, -999, wetende dat deze negatieve getallen betekenen dat er geen gegevens zijn voor deze polygonen.
Voor de laag forest_stands_2012_results:

• Open de Attributentabel en schakel Bewerken in.
• Selecteer de polygonen met de waarde NULL.
• Gebruik de veldberekening om de waarden van het veld MEANVol bij te werken naar -999, alleen voor de
geselecteerde objecten.

• Schakel Bewerken uit en sla de wijzigingen op.
Nu kunt u een opgeslagen opmaak voor deze laag gebruiken:

• Ga naar de tab Symbologie.
• Klik op Stijl -► Stijl laden….
• Selecteer forest_stands_2012_results.qml uit de map exercise_data\forestry\
results\.

• Klik op OK.

430 Hoofdstuk 14. Module: Toepassing Bosbouw



QGIS Training Manual

Uw kaart ziet er nu ongeveer zo uit:
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14.9.2 Try Yourself Verschillende mengmodi gebruiken

De stijl die u heeft geladen:
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gebruikt de modus Hard licht voor de Laag blending modus. Merk op dat de verschillende modi verschillende
filters toepassen die de onder- en bovenliggende lagen combineren, in dit geval worden het raster met schaduw voor
heuvels en uw bosopstanden gebruikt. U kunt over deze modi lezen in de Gebruikersgids.
Probeer de verschillende modi en bekijk de verschillen in uw in uw kaart. Kies dan die welke u beter vindt voor uw
uiteindelijke kaart.

14.9.3 Try Yourself Een sjabloon van afdruklay-out gebruiken om het
kaartresultaat te maken

Gebruik een eerder voorbereid sjabloon om de resultaten weer te geven. Het sjabloonforest_map.qpt is geplaatst
in de map exercise_data\forestry\results\. Laad dat met behulp van het dialoogvenster Project ►
Lay-out beheren….
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Open de afdruklay-out en bewerk de uiteindelijke kaart om een resultaat te krijgen waarmee u tevreden bent.
Het kaartsjabloon dat u gebruikt zal een kaart geven soortgelijk aan deze:
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Sla uw project voor QGIS op voor toekomstige verwijzingen.
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14.9.4 In Conclusion

Door middel van deze module heeft u gezien hoe een basisinventarisatie van een bos kan worden gepland en
weergegeven met QGIS. Veel meer analyses voor bossen zijn mogelijk met de variëteit aan gereedschappen waar
u toegang toe heeft, maar hopelijk heeft deze handleiding u een goed startpunt gegeven om te ontdekken hoe u de
specifieke resultaten kunt bereiken die u nodig heeft.
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Module: Concepten van databases met PostgreSQL

Relationele databases zijn een belangrijk onderdeel van elk GIS-systeem. In deze module zult u over concepten van
Relational Database Management System (RDBMS) leren en zult u PostgreSQL gebruiken om een nieuwe database
te maken om gegevens op te slaan, als ook leren over andere typische functies voor RDBMS.

15.1 Lesson: Introductie voor databases

Laten we, voordat we PostgreSQL gebruiken, onze basis vaststellen door algemene theorie over databases te
behandelen. U hoeft geen voorbeeldcode in te voeren; het is er alleen ter illustratie.
Het doel voor deze les: Fundamentele concepten voor databases begrijpen.

15.1.1 Wat is een database?

Een database bestaat uit een georganiseerde verzameling gegevens voor één of meer doeleinden, gewoonlijk in digitale
vorm. - Wikipedia

Een database management system (DBMS) bestaat uit software die werkt op databases, opslag, toegang, beveiliging,
back-up en andere faciliteiten verschaft. - Wikipedia

15.1.2 Tabellen

In relationele databases en platte databases, is een tabel een verzameling gegevenselementen (waarden) die is
georganiseerd met behulp van een model van verticale kolommen (die worden geïdentificeerd door hun naam) en
horizontale rijen. Een tabel heeft een gespecificeerd aantal kolommen, maar kunnen elk willekeurig aantal rijen
hebben. Elke rij wordt geïdentificeerd door de waarden die verschijnen in een bepaalde subset van kolommen die
wordt geïdentificeerd als een kandidaat-sleutel. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)

In databases van SQL staat een tabel ook bekend als een relatie.
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15.1.3 Kolommen / Velden

Een kolom is een verzameling gegevenswaarden van een bepaald eenvoudig type, één voor elke rij van de tabel. De
kolommen verschaffen de structuur waarin de rijen overeenkomstig worden samengesteld. De term veld wordt vaak
uitwisselbaar gebruik met kolom, hoewel velen het meer correct vinden om veld (of veldwaarde) te gebruiken om
specifiek te verwijzen naar het enkele item dat bestaat op de kruising van één rij en één kolom. - Wikipedia

Een kolom:

| name |
+-------+
| Tim |
| Horst |

Een veld:

| Horst |

15.1.4 Records

Een record is de informatie die is opgeslagen in een rij van een tabel. Elk record zal een veld hebben voor elk van de
kolommen in de tabel.

2 | Horst | 88 <-- one record

15.1.5 Datatypen

Datatypen beperken het soort informatie dat kan worden opgeslagen in een kolom. - Tim en Horst

er bestaan vele soorten datatypen. Laten we focussen op de meest voorkomende:
• String - om tekstgegevens in de vorm van vrije tekst op te slaan
• Integer - om gehele getallen op te slaan
• Real - om decimale getallen op te slaan
• Date - om de verjaardag van Horst op te slaan zodat niemand die vergeet
• Boolean - om eenvoudige waarden ja/nee op te slaan

U kunt de database vertellen om u ook toe te staan niets in een veld op te slaan. Als er niets in een veld staat, dan
wordt naar de veldinhoud verwezen als een ‘null’-waarde:

insert into person (age) values (40);

select * from person;

Resultaat:

id | name | age
---+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

Er zijn nog veel meer datatypen die u kunt gebruiken - bekijk de handleiding van PostgreSQL!
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15.1.6 Een adresdatabase modelleren

Laten we een eenvoudig geval bekijken om te zien hoe een database is opgebouwd. We willen een adresdatabase
maken.

Try Yourself

Schrijf de eigenschappen op waaruit een eenvoudig adres bestaat en die we zouden willen opslaan in onze database.
Controleer uw resultaten

Structuur van een adres

De eigenschappen die een adres beschrijven zijn de kolommen. Het type informatie dat wordt opgeslagen in elke
kolom is het datatype. In het volgende gedeelte zullen we onze conceptuele adrestabel analyseren om te zien hoe we
het beter kunnen maken!

15.1.7 Database theorie

Het proces van het maken van een database omvat het maken van een model van de echte wereld; concepten uit de
echte wereld nemen en die in de database weer te geven als entiteiten.

15.1.8 Normalisatie

Eén van de belangrijkste ideeën in een database is om duplicatie / herhaling van gegevens te vermijden. Het proces
van het verwijderen van herhaling uit een database wordt Normalisatie genoemd.
Normalisatie is een systematische manier om er voor te zorgen dat een structuur van een database geschikt is
voor bevragingen van algemene aard en vrij van bepaalde ongewenste karakteristieken - afwijkingen bij invoegen,
bijwerken en verwijderen - die zouden kunnen leiden tot verlies van de integriteit van gegevens. - Wikipedia

Er bestaan verschillende ‘vormen’ van normalisatie.
Laten we eens naar een eenvoudig voorbeeld kijken:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
---+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)
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Veronderstel dat u veel vrienden heeft met dezelfde straatnaam of stad. Elke keer dat deze gegevens worden
gedupliceerd, nemen zij ruimte in. Erger nog, als een naam van een stad wijzigt, moet u veel werk uitvoeren om
uw database bij te werken.

15.1.9 Try Yourself

Ontwerp de bovenstaande theoretische tabel people opnieuw om duplicatie te verminderen en de structuur van de
gegevens te normaliseren.
U kunt hier meer lezen over normalisatie van databases
Controleer uw resultaten

15.1.10 Indexen

Een index voor een database is een gegevensstructuur die de snelheid van bewerkingen voor het ophalen van gegevens
uit een databasetabel verhoogt. - Wikipedia

Veronderstel dat u een tekstboek aan het lezen bent en zoekt naar de uitleg over een concept - en dat het tekstboek
geen index heeft! U zult met lezen moeten beginnen bij het voorblad en u geheel door het boek moeten werken totdat
u de informatie vindt die u nodig heeft. De index aan het einde van het boek helpt u om snel naar de pagina met de
relevante informatie te springen:

create index person_name_idx on people (name);

Zoekacties op namen zullen nu sneller zijn:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Reeksen

Een reeks is een generator voor unieke nummers. Het wordt normaal gesproken gebruikt om een unieke identificatie
te maken voor een kolom in een tabel.
In dit voorbeeld is id een reeks - het nummer wordt opgehoogd, elke keer als een record aan de tabel wordt toegevoegd:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122
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15.1.12 Entiteit Relaties Diagrammen

In een genormaliseerde database heeft u gewoonlijk vele relaties (tabellen). Het entiteit-relatie diagram (ERDiagram)
wordt gebruikt om de logische afhankelijkheden tussen de relaties te ontwerpen. Denk aan onze niet-genormaliseerde
tabel people eerder in deze les:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Met weinig werk kunnen we die splitsen in twee tabellen, waarbij we de noodzaak om de straatnaam te herhalen voor
mensen die in dezelfde straat wonen verwijderen:

select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

en:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

We kunnen dan de twee tabellen koppelen met behulp van de ‘sleutels’ streets.id en people.streets_id.
Als we een ER Diagram tekenen voor deze twee tabellen zou het er ongeveer zo uitzien:

Het ER Diagram helpt ons om ‘één tot veel’-relaties uit te drukken. In dit geval geeft het pijlsymbool aan dat in één
straat veel mensen zouden kunnen leven.

Try Yourself

Ons model people heeft nog steeds enige problemen met normalisatie - probeer eens of u het verder kunt normaliseren
en geef uw gedachten weer door middel van een ER Diagram.
Controleer uw resultaten
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15.1.13 Beperkingen, Primaire sleutels en Vreemde sleutels

Een beperking voor een database wordt gebruikt om er voor te zorgen dat de gegevens in een relatie overeenkomt met
de weergave van het model over hoe die gegevens zouden moeten worden opgeslagen. Een beperking op uw postcode
zou er, bijvoorbeeld, voor kunnen zorgen dat de getallen vallen tussen 1000 en 9999.
Een Primaire sleutel zijn één of meer veldwaarden die een record uniek maken. Gewoonlijk wordt de primaire sleutel
id genoemd en is een reeks.
Een vreemde sleutel wordt gebruikt om te verwijzen naar een uniek record in een andere tabel (met behulp van de
primaire sleutel van de andere tabel).
In ER Diagrammen wordt de koppeling tussen tabellen gewoonlijk gebaseerd op het koppelen van Vreemde sleutels
aan Primaire sleutels.
Als we naar ons voorbeeld people kijken geeft de definitie van de tabel weer dat de kolom street een vreemde sleutel
is die verwijst naar de primaire sleutel van de tabel streets:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

15.1.14 Transacties

Bij het toevoegen, wijzigen of verwijderen van gegevens in een database, is het altijd belangrijk dat de database in een
goede status wordt achtergelaten als er iets fout gaat. De meeste databases verschaffen een mogelijkheid, genaamd
ondersteuning voor transacties. Transacties stellen u in staat om een positie vast te stellen voor het terugdraaien
waarnaar u kunt terugkeren als de aanpassingen aan de database niet gingen zoals was gepland.
Neem een scenario waar u een boekhoudsysteem heeft. Umoet fondsen van de ene rekening transfereren en toevoegen
aan de andere rekening. De reeks stappen zou als volgt zijn:

• verwijder R20 van Joe
• voeg R20 toe aan Anne

Als er iets misgaat gedurende het proces (bijv. stroomuitval), zal de transactie worden teruggedraaid.

15.1.15 In Conclusion

Databases stellen u in staat gegevens op een gestructureerde manier te beheren met behulp van eenvoudige
codestructuren.
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15.1.16 What’s Next?

Laten we, nu we hebben gekeken naar hoe databases in theorie werken, een nieuwe database maken om de theorie
die we hebben behandeld te implementeren.

15.2 Lesson: Het gegevensmodel implementeren

Nu we alle theorie hebben behandeld, laten we eens een nieuwe database maken. Deze database zal worden gebruikt
voor onze oefeningen voor de lessen die hierna volgen.
Het doel voor deze les: De vereiste software installeren en die gebruiken om onze voorbeelddatabase te
implementeren.

15.2.1 PostgreSQL installeren

Notitie: U kunt pakketten voor PostgreSQL en installatie-instructies voor uw besturingssysteem vinden op https:
//www.postgresql.org/download/. Onthoud dat de documentatie er van uitgaat dat gebruikers QGIS uitvoeren onder
Ubuntu.

Onder Ubuntu:

sudo apt install postgresql-9.1

U zou een bericht als dit moeten krijgen:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Druk op Y en Enter en wacht tot het downloaden en installeren is voltooid.

15.2.2 Hulp

PostgreSQL heeft hele goede online documentatie.
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15.2.3 Een gebruiker voor de database aanmaken

Onder Ubuntu:
Als de installatie is voltooid, voer deze opdracht uit om de gebruiker postgres te worden en dan een nieuwe gebruiker
voor de database te maken:

sudo su - postgres

Type uw normale wachtwoord voor inloggen in als daar naar gevraagd wordt (u moet rechten hebben voor sudo).
Nu, bij de bash prompt van de gebruiker postgres, maak de gebruiker voor de database aan. Zorg er voor dat de
naam van de gebruiker overeenkomt met uw inlognaam voor unix : het zal uw leven veel eenvoudiger maken, omdat
Postgres u automatisch zal authenticeren wanneer u ingelogd bent als die gebruiker:

createuser -d -E -i -l -P -r -s qgis

Voer een wachtwoord in als daar naar gevraagd wordt. U zou een ander wachtwoord moeten gebruiken dan uw
wachtwoord om in te loggen.
Wat betekenen deze opties?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Nu zou u de omgeving van de bash shell van de gebruiker Postgres moeten verlaten door te typen:

exit

15.2.4 Het nieuwe account verifiëren

psql -l

Zou iets terug moeten geven als dit:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Typ Q om af te sluiten.

15.2.5 Een database maken

De opdracht createdb wordt gebrukt om een nieuwe database te maken. Het zou moeten worden uitgevoerd vanaf
de bash shell prompt:

createdb address -O qgis

U kunt het bestaan van uw nieuwe database verifiëren met behulp van deze opdracht:

psql -l
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Wat iets zoals dit zou moeten teruggeven:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
(4 rows)

Typ Q om af te sluiten.

15.2.6 Een database shell-sessie beginnen

U kunt uw database eenvoudig verbinden door dit:

psql address

Verlaten van de psql database shell, typ:

\q

Voor hulp in het gebruiken van de shell, type:

\?

Voor hulp bij het gebruiken van SQL-opdrachten, typ:

\help

Hulp krijgen over een specifieke opdracht, typ (bijvoorbeeld):

\help create table

Bekijk ook het Psql cheat sheet.

15.2.7 Tabellen in SQL maken

Laten we beginnen met het maken van enkele tabellen! We zullen ons ER Diagram als gids gebruiken. Verbind eerst
met de db address:

psql address

Maak dan een tabel streets:

create table streets (id serial not null primary key, name varchar(50));

serial en varchar zijn datatypen. serial vertelt PostgreSQL om een reeks van een geheel getal te starten
(automatisch nummeren) om id automatisch te vullen voor elk nieuw record. varchar(50) vertelt PostgreSQL
om een veld van 50 tekens in lengte te maken.
Het zal u opvallen dat elke opdracht eindigt met een ; - alle opdrachten voor SQL zouden op deze manier moeten
worden beëindigd. Wanneer u op Enter drukt, zal psql iets rapporteren als dit:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq"
for serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
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"streets_pkey" for table "streets"

CREATE TABLE

Dat betekent dat uw tabel met succes werd gemaakt, met een primaire sleutel streets_pkey met behulp van
streets.id.
Opmerking: Als u op Return drukte zonder een; in te voeren, dan zult u een prompt zoals deze krijgen:address-#.
Dit omdat PG van u meer invoer verwacht. Voer ; in om uw opdracht uit te voeren.
U kunt dit doen om uw schema van de tabel te bekijken:

\d streets

Wat er ongeveer uit zou moeten zien zoals dit:

Table "public.streets"
Column | Type | Modifiers
--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('streets_id_seq'::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

U kunt dit doen om de inhoud van uw tabel te bekijken:

select * from streets;

Wat er ongeveer uit zou moeten zien zoals dit:

id | name
---+------
(0 rows)

Zoals u kunt zien is onze tabel momenteel leeg.

Try Yourself

Gebruik de hierboven weergegeven benadering om een tabel, genaamd people, te maken:
Voeg velden toe zoals telefoonnummer, adres, naam, etc. Zorg dat de velden een geldige veldnaam krijgen (geen
spaties). Geef de tabel een kolom ID met hetzelfde datatype als hierboven.
Controleer uw resultaten

15.2.8 Sleutels maken in SQL

Het probleem met onze oplossing hierboven is dat de database niet weet dat er een logische relatie bestaat tussen
people en streets. We moeten, om deze relatie aan te geven, een vreemde sleutel definiëren die verwijst naar de
primaire sleutel van de tabel streets.

Er zijn twee manieren om dat te doen:

446 Hoofdstuk 15. Module: Concepten van databases met PostgreSQL



QGIS Training Manual

• De sleutel toevoegen nadat de tabel is gemaakt
• De sleutel definiëren bij het maken van de tabel

Onze tabel is al gemaakt, dus doen we het op de eerste manier:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Dat vertelt de tabel people dat zijn velden street_id moeten overeenkomen met een geldige id voor street uit
de tabel streets.
De meest gebruikte manier om een beperking toe te voegen is om dat te doen wanneer u de tabel maakt:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

Na het toevoegen van de beperking ziet ons schema voor de tabel er nu als volgt uit:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Indexen in SQL maken

We willen zoekacties met de snelheid van het licht op namen van mensen. We kunnen een index op de kolom name
van onze tabel people maken om dat mogelijk te maken:

create index people_name_idx on people(name);

\d people

Wat resulteert in:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | ('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
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"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.10 Tabellen in SQL verwijderen

Als u een tabel wilt verwijderen kunt u gebruk maken van de opdracht drop:

drop table streets;

Notitie: In ons huidige voorbeeld zou de bovenstaande opdracht niet werken. Waarom niet? Bekijk waarom

Als u dezelfde opdracht drop table zou gebruiken op de tabel people, zou die met succes worden uitgevoerd:

drop table people;

Notitie: Als u echt die opdracht invoerde en de tabel people verwijderde, zou nu een goed moment zijn om hem
opnieuw te bouwen, omdat u het in de volgende oefeningen nodig heeft.

15.2.11 Een woord over pgAdmin III

SQL opdrachten van psql worden gebruikt omdat dit een goede manier is om te leren werken met databases. Er zijn
echter eenvoudigere enmogelijk snellere manieren om deze SQL opdrachten uit te voeren, bijvoorbeeld met pgAdmin
III. Dit is een grafische tool waarmee tabellen kunnen worden gemaakt, verwijderd en gewijzigdmet behulp van slepen
en klikken.
Onder Ubuntu kunt u het op deze manier installeren:

sudo apt install pgadmin3

pgAdmin III zal meer detail worden behandeld in een andere module.

15.2.12 In Conclusion

U heeft nu gezien hoe u een nagelnieuwe database maakt, geheel vanaf niets beginnend.

15.2.13 What’s Next?

Vervolgens zult u leren de DBMS te gebruiken om nieuwe gegevens toe te voegen.
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15.3 Lesson: Gegevens aan het model toevoegen

De modellen die we hebben gemaakt moeten nu worden gevuld met de gegevens die zij geacht worden te bevatten.
Het doel voor deze les: Leren hoe nieuwe gegevens in de modellen van de database in te voeren.

15.3.1 Argument Insert

Hoe voegt u gegevens toe aan een tabel? Het argument voor SQL INSERT verschaft daar de functionaliteit voor:

insert into streets (name) values ('High street');

Een aantal dingen om te onthouden:
• Na de naam van de tabel (streets), vermeldt u de kolomnamen die u wilt vullen (in dit geval alleen de kolom
name).

• Na het sleutelwoord values, plaats de lijst met veldwaarden.
• Strings zouden moeten worden omsloten door enkele aanhalingstekens.
• Onthoud dat we geen waarde hebben ingevuld voor de kolom id; dat is omdat het een reeks is en automatisch
wordt gegenereerd.

• Indien u de id handmatig instelt, kunt u ernstige problemen veroorzaken voor de integriteit van uw database.
U zou INSERT 0 1 moeten zien als het met succes is voltooid.
U kunt het resultaat van uw invoeractie zien door alle gegevens in de tabel te selecteren:

select * from streets;

Resultaat:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Try Yourself

Gebruik de opdracht INSERT om een nieuwe straat in te voeren in de tabel streets.
Controleer uw resultaten

15.3.2 Toevoegen van gegevens in overeenstemming met beperkingen

15.3.3 Try Yourself

probeer een object persoon toe te voegen aan de tabel people met de volgende details:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21
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Notitie: Onthoud dat we in dit voorbeeld telefoonnummers hebben gedefinieerd als strings, niet als integers.

Op dit punt zou u een foutbericht moeten krijgen als u dit probeert te doen zonder eerst een record voor Main Street
te hebben gemaakt in de tabel streets.
U zou ook moeten hebben opgemerkt dat:

• U kunt de straat niet toevoegen met behulp van zijn naam
• U kunt geen straat toevoegen met behulp van een id voor de straat zonder eerst het record voor de straat te
hebben gemaakt in de tabel streets

Onthoud dat onze twee tabellen zijn gekoppeld via een paar Primaire/Vreemde sleutel. Dit betekent dat geen geldige
persoon kan worden gemaakt zonder dat er ook een geldig overeenkomend record is voor de straat.
Voeg, met behulp van bovenstaande kennis, de nieuwe persoon toe aan de database.
Controleer uw resultaten

15.3.4 Gegevens selecteren

We hebben u de syntaxis voor het selecteren van records al laten zien. Laten we eens naar nog een aantal voorbeelden
kijken:

select name from streets;

select * from streets;

select * from streets where name='Main Road';

In latere gedeelten zullen we meer in detail ingaan op hoe gegevens te selecteren en te filteren.

15.3.5 Gegevens bijwerken

Wat als u een wijziging wilt maken in enkele bestaande gegevens? Bijvoorbeeld: een straatnaam is gewijzigd:

update streets set name='New Main Road' where name='Main Road';

Wees zeer voorzichtig met het gebruiken van dergelijke argumenten voor bijwerken - als meer dan één record
overeenkomt met uw clausule WHERE, zullen zij allemaal worden bijgewerkt!
Een betere oplossing is om de primaire sleutel van de tabel te gebruiken om te verwijzen naar het record dat moet
worden gewijzigd:

update streets set name='New Main Road' where id=2;

Het zou terug moeten geven UPDATE 1.

Notitie: de criteria voor het argument WHERE zijn hoofdlettergevoelig Main Road is niet hetzelfde als Main
road

450 Hoofdstuk 15. Module: Concepten van databases met PostgreSQL



QGIS Training Manual

15.3.6 Gegevens verwijderen

Gebruik de opdracht DELETE om een object uit een tabel te verwijderen:

delete from people where name = 'Joe Smith';

Laten we nu eens naar onze tabel people kijken:

address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)

15.3.7 Try Yourself

Gebruik de vaardigheden die u heeft geleerd om enkele nieuwe vrienden aan uw database toe te voegen:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 In Conclusion

Nu weet u hoe u nieuwe gegevens moet toevoegen aan de bestaande modellen die u eerder heeft gemaakt. Onthoud
dat als u nieuwe soorten gegevens wilt toevoegen, u misschien moet aanpassen en/of nieuwe modellen moet maken
om die gegevens te kunnen bevatten.

15.3.9 What’s Next?

Nu dat u enkele gegevens heeft toegevoegd, zult u leren hoe u query’s gebruikt om op verschillende manieren toegang
te krijgen tot deze gegevens.

15.4 Lesson: Query’s

Wanneer u een opdracht SELECT ... schrijft staat die algemeen bekend als een query - u bevraagt de database op
informatie.
Het doel voor deze les: Query’s die bruikbare informatie teruggeven leren maken.

Notitie: Als u dat al niet deed in de vorige les, voeg de volgende objecten persoon toe aan uw tabel people. Als
u foutberichten krijgt gerelateerd aan beperkingen voor vreemde sleutels, zult u eerst het object ‘Main Road’ moeten
toevoegen aan uw tabel streets

insert into people (name,house_no, street_id, phone_no)
values ('Joe Bloggs',3,2,'072 887 23 45');

insert into people (name,house_no, street_id, phone_no)
values ('Jane Smith',55,3,'072 837 33 35');

insert into people (name,house_no, street_id, phone_no)
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values ('Roger Jones',33,1,'072 832 31 38');

insert into people (name,house_no, street_id, phone_no)
values ('Sally Norman',83,1,'072 932 31 32');

15.4.1 Resultaten ordenen

Laten we een lijst van mensen ophalen, gesorteerd op hun huisnummers:

select name, house_no from people order by house_no;

Resultaat:

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)

U kunt de resultaten sorteren op de waarden van meer dan één kolom:

select name, house_no from people order by name, house_no;

Resultaat:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)

15.4.2 Filteren

Vaak zult u niet elk afzonderlijk record in de database willen zien - in het bijzonder als er duizenden records zijn en
u alleen geïnteresseerd bent in het bekijken van één of twee.
Hier is een voorbeeld van een numeriek filter wat alleen objecten teruggeeft waarvan het house_no kleiner is dan 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

U kunt filters combineren (gedefinieerd met behulp van de clausule WHERE) met sorteren (gedefinieerd met behulp
van de clausule ORDER BY):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3

(Vervolgt op volgende pagina)
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Roger Jones | 33
(2 rows)

U kunt ook filteren gebaseerd op tekstgegevens:

select name, house_no from people where name like '%s%';

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Hier hebben we de clausule LIKE gebruikt om alle namen met een s erin te vinden. Het zal u zijn opgevallen dat
deze query hoofdlettergevoelig is, dus is het item Sally Norman niet vermeld.
Als u wilt zoeken naar een tekenreeks van letters, ongeacht hoofd- of kleine letters, kunt u een zoekactie uitvoeren
die niet hoofdlettergevoelig is met behulp van de clausule ILIKE:

select name, house_no from people where name ilike '%r%';

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

Die query gaf elk object uit people terug met een r of R in hun naam.

15.4.3 Samenvoegingen (joins)

Wat als u de details van personen en hun straatnaam wilt zien in plaats van de ID? U dient de twee tabellen samen te
voegen in één enkele query om dat te kunnen doen. Laten we eens naar een voorbeeld kijken:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Notitie: Met samenvoegingen (joins) worden twee of meer tabellen of views samengevoegd, in dit geval de tabellen
people en streets. Er dient te worden gespecificeerd welke velden overeen moeten komen (vreemde sleutel & primaire
sleutel). Indien deze velden niet worden gespecificeerd worden alle velden van de tabellen onderling gecombineerd.
Dit resulteert in alle mogelijke combinaties van mensen en straten, maar geeft geen antwoord op de vraag wie in
welke straat woont.

Hier is hoe de juiste uitvoer eruit zal zien:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

We zullen samenvoegingen (joins) opnieuw tegenkomen als we later meer complexe query’s maken. Onthoud alleen
dat zij een eenvoudige manier bieden om de informatie uit twee of meer tabellen te combineren.
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15.4.4 Sub-Select

Sub-selecties stellen u in staat objecten te selecteren uit één tabel, gebaseerd op de gegevens uit een andere tabel die is
gekoppeld met een relatie vreemde sleutel. In ons geval willen we mensen vinden die in een specifieke straat wonen.
Laten we eerst onze gegevens iets aanpassen:

insert into streets (name) values('QGIS Road');
insert into streets (name) values('OGR Corner');
insert into streets (name) values('Goodle Square');
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Laten we even snel kijken naar onze gegevens na deze wijzigingen: we kunnen onze query uit het eerdere gedeelte
opnieuw gebruiken:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Resultaat:

name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)

Nu willen we u een sub-selectie van deze gegevens laten zien. We willen alleen de mensen laten zien die wonen in
street_id nummer 1:

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Resultaat:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Hoewel dit een zeer eenvoudig voorbeeld is en onnodigmet onze kleine sets met gegevens, illustreert het hoe bruikbaar
en belangrijk sub-selecties kunnen zijn bij het bevragen van grote en complexe sets met gegevens.
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15.4.5 Samenvattende query’s

Eén van de krachtige mogelijkheden van een database is zijn mogelijkheid om de gegevens in zijn tabellen samen te
vatten. Deze samenvattingen worden aggregate queries genoemd. Hier is a typisch voorbeeld wat u vertelt hoeveel
objecten people er in uw tabel people staan:

select count(*) from people;

Resultaat:

count
-------

4
(1 row)

Als we de tellingen willen samenvatten op straatnaam kunnen we dit doen:

select count(name), street_id
from people
group by street_id;

Resultaat:

count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)

Notitie: Omdat we geen clausule ORDER BY hebben gebruikt, zou de volgorde van uw resultaten niet overeen
hoeven komen met wat hier is weergegeven.

Try Yourself

Samenvatten van de personen op straatnaam en de feitelijke straatnamen laten zien in plaats van de street_id’s.
Controleer uw resultaten

15.4.6 In Conclusion

U heeft gezien hoe u query’s kunt gebruiken om de gegevens in uw database terug te geven op een manier die u in
staat stelt daaruit bruikbare informatie te halen.

15.4.7 What’s Next?

Vervolgens zult u zien hoe u weergaven kunt maken uit de query’s die u heeft geschreven.
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15.5 Lesson: Weergaven

Wanneer u een query schrijft, spendeert u veel tijd en moeite om die te formuleren. Met weergaven kunt u de definitie
van een query in SQL opslaan in een opnieuw te gebruiken ‘virtuele tabel’.
Het doel voor deze les: Een query al een weergave op te slaan.

15.5.1 Een weergave maken

U kunt een weergave net zo behandelen als een tabel, maar de gegevens ervan vinden hun oorsprong in een query.
Laten we, gebaseerd op bovenstaande, een eenvoudige weergave maken:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

Zoals u kunt zien is het enige dat veranderd is het gedeelte create view roads_count_v as aan het begin.
We kunnen nu gegevens uit die weergave selecteren:

select * from roads_count_v;

Resultaat:

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)

15.5.2 Een weergave aanpassen

Een weergave staat niet vast en bevat geen ‘echte gegevens’. Dit betekent dat u hem eenvoudig kunt wijzigen zonder
dat dat enige impact heeft op de gegevens in uw database:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(Dit voorbeeld toont ook de best practice conventie voor het gebruiken van UPPER CASE voor alle sleutelwoorden
van SQL.)
U zult zien dat we een clausuleORDER BY hebben toegevoegd zodat de rijen van onze weergave netjes zijn gesorteerd:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)
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15.5.3 Een weergave verwijderen

Als u een weergave niet langer nodig heeft, kunt u die op deze manier verwijderen:

drop view roads_count_v;

15.5.4 In Conclusion

Met behulp van weergave kunt u een query opslaan en toegang krijgen tot de resultaten daravan, als was het een tabel.

15.5.5 What’s Next?

Soms, bij het wijzigen van gegevens, wilt u dat uw wijzigingen ook ergens anders in de database effect hebben. De
volgende les zal u tonen doe dat te doen.

15.6 Lesson: Regels

Regels maken het mogelijk de “queryboom” van een inkomende query te herschrijven. Een veel voorkomend gebruik
is om weergaven te implementeren, inclusief een bij te werken weergave. - Wikipedia

Het doel voor deze les:: Leren nieuwe regels voor de database te maken.

15.6.1 Een regel voor loggen maken

Stel dat u elke wijziging van phone_no in uw tabel people wilt loggen in een tabel people_log. Dus maakt u een nieuwe
tabel:

create table people_log (name text, time timestamp default NOW());

Maak, in de volgende stap, een regel die elke wijziging van een telefoonnummer in de tabel people in de tabel
people_log logt:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

Laten we een telefoonnummer aanpassen om te testen of de regel werkt:

update people set phone_no = '082 555 1234' where id = 2;

Controleer of de tabel people juist werd bijgewerkt:

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Dankzij de regel die we hebben gemaakt, zal de tabel people_log er nu zo uitzien:

select * from people_log;

name | time
------------+----------------------------

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Notitie: De waarde van het veld time is afhankelijk van de huidige datum en tijd.

15.6.2 In Conclusion

Regels stellen u in staat automatisch gegevens toe te voegen of te wijzigen in uw database om wijzigingen in andere
delen van de database weer te geven.

15.6.3 What’s Next?

De volgende module brengt u naar het gebruiken van de Ruimtelijke database met behulp van PostGIS, wat deze
concepten overneemt en die toepast op gegevens voor GIS.
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Module: Concepten van een ruimtelijke database met PostGIS

Ruimtelijke databases maken het opslaan van de geometrieën van records in een database mogelijk, als ook het
verschaffen van functionaliteit voor het bevragen en ophalen van de records met behulp van die geometrieën. In deze
module zullen we PostGIS gebruiken, een uitbreiding voor PostgreSQL, om te leren hoe een ruimtelijke database in
te stellen, gegevens importeren in de database en gebruikmaken van de geografische functies die PostGIS biedt.
Gedurende het werken in dit gedeelte wilt u misschien een kopie hebben van het PostGIS spiekblad beschikbaar
vanaf de Boston GIS gebruikersgroep. Een andere bruikbare bron is de online documentatie van PostGIS.
Er zijn ook enkele meer uitgebreide handleidingen over PostGIS en ruimtelijke databases beschikbaar vanaf
Boundless Geo:

• Introduction to PostGIS
• Spatial Database Tips and Tricks

Bekijk ook PostGIS In Action.

16.1 Lesson: Instellen van PostGIS

Instellen van functies voor PostGIS zal u in staat stellen toegang te verkrijgen tot ruimtelijke functies binnen
PostgreSQL.
Het doel voor deze les: Ruimtelijke functies installeren en in het kort hun effecten demonstreren.

Notitie: We gaan er van uit dat we voor deze oefening PostGIS versie 2.1 of nieuwer gebruiken. De installatie en
configuratie van de database zijn anders voor oudere versies, maar de rest van dit materiaal in deze module zal nog
steeds werken. Consulteer de documentatie voor uw platform voor hulp bij de installatie en de configuratie van de
database.
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16.1.1 Installeren onder Ubuntu

Postgis wordt eenvoudig geïnstalleerd vanuit apt.

$ sudo apt install postgresql
$ sudo apt install postgis

Echt, zo eenvoudig is dat…

Notitie: De exacte versies die zullen worden geïnstalleerd zijn afhankelijk van de versie van Ubuntu die u gebruikt en
welke afhankelijkheden u heeft geconfigureerd. U kunt de geïnstalleerde versie controleren door een query select
PostGIS_full_version(); uit te voeren met psql of een ander gereedschap.

U kunt de volgende opdrachten gebruiken om een specifieke versie (bijv, PostgreSQL versie 13 en PostGIS 3) te
installeren.

$ sudo apt install wget ca-certificates
$ sudo lsb_release -a
$ wget --quiet -O - https://www.postgresql.org/media/keys/ACCC4CF8.asc | sudo apt-
↪→key add -
$ sudo sh -c 'echo "deb http://apt.postgresql.org/pub/repos/apt/ `lsb_release -cs`-
↪→pgdg main" >> /etc/apt/sources.list.d/pgdg.list'
$ sudo apt-get update
$ sudo apt install postgis postgresql-13-postgis-3

16.1.2 Installeren onder Windows

Installeren op Windows kan worden gedaan vanuit binaire pakketten met behulp van normale Windows
dialoogvensters voor installeren.
Bezoek eerst de downloadpagina. Volg daarna deze gids.
Meer informatie over het installeren op Windows kan worden gevonden op de website van PostGIS.

16.1.3 Installeren op andere platformen

De downloadwebsite van PostGIS bevat informatie over het installeren op andere besturingssystemen en platformen,
inclusief macOS en andere distributies van Linux.

16.1.4 Databases configureren om PostGIS te gebruiken

Als PostGIS eenmaal is geïnstalleerd, zult u uw database moeten configureren om de extensies te gebruiken. Als u
PostGIS versie > 2.0 heeft geïnstalleerd, is dit zo simpel als de volgende opdracht met psql uit te voeren met behulp
van de adresdatabase uit onze vorige oefening.

$ psql -d address -c "CREATE EXTENSION postgis;"

Notitie: Afhankelijk van uw versie zou u meer instructies over hoe een database ruimtelijk in te schakelen kunnen
vinden op https://postgis.net/docs/postgis_administration.html#create_spatial_db.
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16.1.5 Kijken naar de geïnstalleerde functies van PostGIS

Aan PostGIS kan worden gedacht als aan een collectie van functies binnen de database die de bronmogelijkheden
van PostgreSQL uitbreiden zodat het ruimtelijke gegevens kan afhandelen. Met ‘afhandelen’ bedoelen we opslaan,
ophalen, bevragen en bewerken. Een aantal functies worden in de database geïnstalleerd om dit te kunnen doen.
Onze PostgreSQL database address is nu geo-ruimtelijk ingeschakeld, dankzij PostGIS. We gaan hier in de
komende gedeelten een stuk dieper op in, maar laten we u een klein voorproefje geven. Laten we zeggen dat we
een punt uit tekst willen maken. Eerst gebruiken we de opdracht voor psql om functies te zoeken in relatie tot punten.
Als u nog niet verbonden bent met de database address, doe dat dan nu. Voer dan uit:

\df *point*

Dit is de opdracht waar we naar zoeken: st_pointfromtext. Gebruik de pijl naar beneden om door de lijst te
gaan en druk op Q om terug te gaan naar de shell van psql.
Probeer deze opdracht uit te voeren:

select st_pointfromtext('POINT(1 1)');

Resultaat:

st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Drie dingen om te onthouden:
• We definieerden een punt op de positie 1,1 (we gaan uit van EPSG:4326) met behulp van POINT(1 1),
• We voerden een argument van sql uit, maar niet op een tabel, alleen maar op gegevens ingevoerd vanuit de
SQL-prompt,

• De resulterende rij heeft weinig betekenis.
De resulterende rij is in de indeling OGC, genaamd ‘Well Known Binary’ (WKB). We zullen in het volgende gedeelte
in detail naar deze indeling kijken.
We kunnen een snelle scan doen door de functielijst naar iets dat tekst teruggeeft om de resultaten als tekst terug te
krijgen:

\df *text

De query waar we nu naar zoeken is st_astext. Laten we die combineren met de vorige query:

select st_astext(st_pointfromtext('POINT(1 1)'));

Resultaat:

st_astext
------------

POINT(1 1)
(1 row)

Hier voerden we de tekenreeks POINT(1,1) in, maakten daar een punt van met behulp van
st_pointfromtext(), en maakten er weer een door mensen te lezen vorm van met st_astext(),
wat ons onze originele tekenreeks teruggaf.
Een laatste voorbeeld voor we echt naar de details gaan van het gebruiken van PostGIS:

select st_astext(st_buffer(st_pointfromtext('POINT(1 1)'),1.0));

Wat deed dat? Het maakte een buffer van 1 graad rondom ons punt, en gaf het resultaat als tekst terug.
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16.1.6 Ruimtelijke referentiesystemen

In aanvulling op de functies van PostGIS, bevat de extensie een verzameling definities voor ruimtelijke
referentiesystemen (SRS) zoals gedefinieerd door de European Petroleum Survey Group (EPSG). Deze worden
gebruikt tijdens bewerkingen zoals conversies van coördinaten referentiesystemen (CRS).
We kunnen deze definities voor SRS inspecteren in onze database omdat zij zijn opgeslagen in normale
databasetabellen.
Laten we eerst eens kijken naar het schema van de tabel door de volgende opdracht in te voeren bij de psql prompt:

\d spatial_ref_sys

Het resultaat zou dit moeten zijn:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
Indexes:

"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

U kunt standaard SQL-queries gebruiken (zoals we hebben geleerd uit onze gedeelten ter introductie), om deze tabel
t ebekijken en te bewerken - hoewel het geen goed idee is om records te bewerken of te verwijderen, tenzij u weet
waar u mee bezig bent.
Eén SRID waarin u misschien geïnteresseerd bent is EPSG:4326 - het geografische / lat lon referentiesysteem dat de
ellipsoïde WGS 84 gebruikt. Laten we er eens naar kijken:

select * from spatial_ref_sys where srid=4326;

Resultaat:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

De srtext is de definitie van de projectie in well known text (u zou dit kunnen herkennen van de bestanden .prj in
uw verzameling shapefiles).

16.1.7 In Conclusion

U heeft nu functies van PostGIS geïnstalleerd in uw kopie van PostgreSQL. Hiermee bent u in staat gebruik te maken
van de uitgebreide ruimtelijke functies van PostGIS.
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16.1.8 What’s Next?

Vervolgens zult u leren hoe ruimtelijke objecten worden weergegeven in een database.

16.2 Lesson: Eenvoudig object model

Hoe kunnen we geografische objecten in een database opslaan en weergeven? In deze les zullen we één benadering
behandelen, het Eenvoudige object model zoals dat is gedefinieerd door de OGC.
Het doel voor deze les: Leren wat het Eenvoudig object model is en hoe het te gebruiken.

16.2.1 Wat is OGC?

Het Open Geospatial Consortium (OGC), een internationale organisatie voor standaarden onder vrijwillige
consensus, werd opgericht in 1994. In de OGC werken meer dan 370+ commerciële, overheids-, non-profit-
en onderzoeksorganisaties wereldwijd samen in een proces voor open consensus voor het aanmoedigen van de
ontwikkeling en implementatie van standaarden voor georuimtelijke inhoud en services, het verwerken van gegevens
voor GIS en het delen van gegevens. - Wikipedia

16.2.2 Wat is het SFS-model (Eenvoudig object model)

Het Simple Feature voor SQL (SFS) Model is een niet-topologische manier om georuimtelijke gegevens op te slaan
in een database en definieert functies vooe toegang tot, het bewerken van en het construeren van deze gegevens.

Het model definieert georuimtelijke gegevens vanuit typen Punt, Lijn en Polygoon (en samenvoegingen daarvan naar
Multi-objecten).
Kijk, voor meer informatie, eens naar de standaard OGC Simple Feature for SQL.
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16.2.3 Een veld voor geometrie aan een tabel toevoegen

Laten we een veld point aan onze tabel people toevoegen:

alter table people add column the_geom geometry;

16.2.4 Een beperking, gebaseerd op een type geometrie, toevoegen

U zult opmerken dat het veldtype geometrie niet impliciet het type geometrie voor het veld specificeert - daarvoor
hebben we een beperking (constraint) nodig:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(the_geom) = 'ST_Point'::text
OR the_geom IS NULL);

Dit voegt een beperking aan de tabel toe zodat die alleen een geometrie punt of een waarde null accepteert.

16.2.5 Try Yourself

Maak een nieuwe tabel, genaamd cities, en geef die enkele toepasselijke kolommen, inclusief een veld voor geometrie
voor het opslaan van polygonen (de stadsgrenzen). Zorg er voor dat het een beperking heeft die maakt dat de
geometrieën polygonen zijn.
Controleer uw resultaten

16.2.6 Tabel geometry_columns vullen

Op dit punt zou u ook een item aan de tabel geometry_columns moeten toevoegen:

insert into geometry_columns values
('','public','people','the_geom',2,4326,'POINT');

Waarom? geometry_columns wordt door bepaalde toepassingen gebruikt om bij te houden welke tabellen in de
database gegevens met geometrie bevatten.

Notitie: Als het bovenstaande argument INSERT een fout veroorzaakt, voer dan eerst deze query uit:

select * from geometry_columns;

Als de kolom f_table_name al de waarde people bevat, dan is deze tabel al geregistreerd en hoeft u niets meer
te doen.

De waarde 2 verwijst naar het aantal dimensies; in dit geval twee: X en Y.
De waarde 4326 verwijst naar de projectie die we gebruiken; in dit geval WGS 84, waarnaar wordt verwezen door
het getal 4326 (bekijk de eerdere bespreking van EPSG).
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Try Yourself

Voeg een toepasselijk item voor geometry_columns in voor uw nieuwe laag cities
Controleer uw resultaten

16.2.7 Record met geometrie toevoegen aan tabel met behulp van SQL

Nu onze tabellen ingeschakeld zijn voor geometrie, kunnen we er geometrieën in opslaan:

insert into people (name,house_no, street_id, phone_no, the_geom)
values ('Fault Towers',

34,
3,
'072 812 31 28',
'SRID=4326;POINT(33 -33)');

Notitie: In het nieuwe item hierboven zult u moeten specificeren welke projectie (SRID) u wilt gebruiken. Dit omdat
u de geometrie van het nieuwe punt invoert met behulp van een gewone tekenreeks van tekst, wat niet automatisch
de juiste informatie over de projectie toevoegt. Uiteraard dient het nieuwe punt hetzelfde SRID te gebruiken als de
gegevensset waaraan het wordt toegevoegd, dus u moet het specificeren.
Als u op dit punt een grafische interface zou gebruiken, zou, bijvoorbeeld, het specificeren van de projectie voor elk
punt automatisch gebeuren. Met andere woorden: u hoeft zich gewoonlijk geen zorgen te maken over het gebruiken
van de juiste projectie voor elk punt dat u wilt toevoegen als u het al voor die gegevensset heeft gespecificeerd, zoals
wij eerder al deden.

Nu is het waarschijnlijk een goed moment om QGIS te openen en te proberen uw tabel people te bekijken. Ook
zouden we moeten proberen records te bewerken / toe te voegen / te verwijderen en dan query’s SELECT op de
database uitvoeren om te zien hoe de gegevens zijn gewijzigd.
Een laag van PostGIS laden in QGIS, gebruik de menuoptie Laag ► PostGIS-laag toevoegen of de knop op de
werkbalk:

Dit zal het dialoogvenster openen:
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Klik op de knop Nieuw om dit dialoogvenster te openen:
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Definieer dan een nieuwe verbinding, bijv.:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

Klik op Test verbinding om te zien of QGIS de database address heeft gevonden en of uw gebruikersnaam en
wachtwoord juist zijn. Als het werkt, selecteer dan de vakken naastGebruikersnaam opslaan enWachtwoord opslaan.
Klik dan op OK om deze verbinding te maken.
Terug in het dialoogvenster PostGIS-tabel(len) toevoegen, klik op Verbinden en voeg de lagen zoals gewoonlijk toe
aan uw project.
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Try Yourself

Formuleer een query die de naam, straatnaam en positie (vanuit de kolom the_geom) weergeeft als gewone tekst.
Controleer uw resultaten

16.2.8 In Conclusion

U heeft gezien hoe u ruimtelijke objecten toevoegt aan uw database en ze bekijkt in GIS-software.

16.2.9 What’s Next?

Vervolgens zult u zien hoe u gegevens importeert naar en exporteert vanuit uw database.

16.3 Lesson: Importeren en exporteren

Natuurlijk zou een database zonder eenvoudige manier voor het in en uit migreren van gegevens niet van veel nut
zijn. Gelukkig zijn er een aantal gereedschappen die u gegevens eenvoudig in en uit PostGIS laten verplaatsen.

16.3.1 shp2pgsql

shp2pgsql is een gereedschap voor de opdrachtregel om ESRI-Shapefiles in de database te importeren. Onder Unix
kunt u de volgende opdracht gebruiken voor het importeren van een nieuwe tabel van PostGIS:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Onder Windows dient u het proces van importeren in twee stappen uit te voeren:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

U zou deze fout kunnen tegenkomen:

ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

Dit is een bekend probleem met betrekking tot het in situ maken van een ruimtelijke index voor de gegevens die u
importeert. Sluit de parameter -I uit om deze fout te vermijden. Dit zal betekenen dat er niet direct een ruimtelijke
index wordt gemaakt, en u zult die in de database moeten maken nadat de gegevens zijn geïmporteerd. (Het maken
van een ruimtelijke index zal worden behandeld in de volgende les.)

16.3.2 pgsql2shp

pgsql2shp is een programma voor de opdrachtregel om tabellen, weergaven of SQL SELECT-query’s vanuit PostGIS
te exporteren. Dit doen onder Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>

De gegevens exporteren met behulp van een query:
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pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr is een zeer krachtig gereedschap om gegevens naar en vanuit PostGIS te converteren in vele indelingen.
ogr2ogr is deel van de software van GDAL/OGR en moet afzonderlijk worden geïnstalleerd. U kunt deze opdracht
gebruiken om een tabel vanuit PostGIS naar GML te exporteren:

ogr2ogr -f GML export.gml PG:'dbname=<databasename> user=<username>
host=<hostname>' <Name of PostGIS-Table>

16.3.4 DB Manager

U heeft misschien al een andere optie opgemerkt in het menuDatabase gelabeldDBManager. Dat is een gereedschap
dat een eenduidige interface verschaft voor het werken met ruimtelijke databases inclusief PostGIS. Het stelt u ook
in staat om vanuit databases naar andere indelingen te importeren en exporteren. Omdat de volgende module voor
een groot deel is toegespitst op dit gereedschap, zullen we het hier slechts kort vermelden.

16.3.5 In Conclusion

Importeren en exporteren van gegevens naar en vanuit de database kan op vele verschillendemanieren worden gedaan.
In het bijzonder bij het gebruiken van verscheidene gegevensbronnen, zult u waarschijnlijk deze functies gebruiken
(of andere soortgelijke) op een regelmatige basis.

16.3.6 What’s Next?

Vervolgens zullen we kijken hoe we de gegevens bevragen die we eerder hebben gemaakt.

16.4 Lesson: Ruimtelijke query’s

Ruimtelijke query’s zijn niet anders dan andere query’s voor databases. U kunt de kolom voor geometrie net zo
gebruiken als elke andere kolom in een database. Met de installatie van PostGIS in onze database, hebben we
aanvullende functies om onze database te bevragen.
het doel voor deze les: Zien hoe ruimtelijke functies worden geïmplementeerd, soortgelijk aan “normale” niet
ruimtelijke functies.

16.4.1 Ruimtelijke operatoren

Wanneer u wilt weten welke punten binnen een afstand van 2 graden vanaf een punt(X,Y) liggen, kunt dat doen met:

select *
from people
where st_distance(the_geom,'SRID=4326;POINT(33 -34)') < 2;

Resultaat:

id | name | house_no | street_id | phone_no | the_geom
----+--------------+----------+-----------+---------------+---------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)
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Notitie: waarde the_geom hierboven werd afgebroken voor ruimte op deze pagina. Als u het punt in voor mensen
leesbare coördinaten wilt zien, probeer dan iets soortgelijks als wat u eerder deed in het gedeelte “Bekijk een punt als
WKT”.

Hoe weten we dat de query hierboven alle punten binnen 2 graden teruggeeft? Waarom geen 2 meter? Of elke andere
maateenheid, nu we het er toch over hebben?
Controleer uw resultaten

16.4.2 Ruimtelijke indexen

We kunnen ook ruimtelijke indexen definiëren. Een ruimtelijke index maakt uw ruimtelijke query’s veel sneller.
Gebruik, om een ruimtelijke index op de kolom voor geometrie te maken:

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom);

\d people

Resultaat:

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) = 'ST_Point'::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 Try Yourself

Pas de tabel cities zo aan dat zijn kolom voor geometrie ruimtelijk wordt geïndexeerd.
Controleer uw resultaten

470 Hoofdstuk 16. Module: Concepten van een ruimtelijke database met PostGIS



QGIS Training Manual

16.4.4 Demonstratie ruimtelijke functies van PostGIS

We zullen een nieuwe database maken die enkele (fictionele) gegevens bevat om de ruimtelijke functies van PostGIS
te demonstreren.
Maak, om te beginnen, eerst een nieuwe database (verlaat eerst de shell van psql):

createdb postgis_demo

Vergeet niet de extensies voor PostGIS te installeren:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"

Importeer vervolgens de gegevens die worden verschaft in demapexercise_data/postgis/. Bekijk de vorige
les voor de instructies, maar onthoud dat u een nieuwe PostGIS verbinding moet maken naar de nieuwe database. U
kunt de gegevens importeren vanuit de terminal of via SPIT. Importeer de bestanden in de volgende tabellen van de
database:

• points.shp in building
• lines.shp in road
• polygons.shp in region

Laad deze drie lagen van de database in QGIS via het dialoogvenster PostGIS-laag toevoegen, zoals gewoonlijk.
Wanneer u hun attributentabellen opent, zult u merken dat zij alle een veld id en een veld gid hebben, gemaakt
door het importeren met PostGIS.
Nu de tabellen zijn geïmporteerd, kunnen we PostGIS gebruiken om de gegevens te bevragen. Ga terug naar uw
terminal (opdrachtregel) en voer bij de prompt van psql in:

psql postgis_demo

We zullen enkele van deze argumenten SELECT demonstreren door er weergaven van te maken, zodat u ze in QGIS
kunt openen en hun resultaten kunt zien.

Op locatie selecteren

Alle gebouwen in de regio KwaZulu verkrijgen:

SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'KwaZulu';

Resultaat:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Of, als we er een view van maken:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b

WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'KwaZulu';
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Voeg de view als een laag toe en bekijk deze in QGIS:

Buren selecteren

Geef een lijst weer van de namen van alle regio’s die naast de regio Hokkaido liggen:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

Resultaat:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

Als een view:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE TOUCHES(a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

In QGIS:
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Merk de ontbrekende regio op (Queensland). Dit zou kunnen komen door een fout in de topologie. Artefacten zoals
dit kunnen ons waarschuwen voor potentiële problemen in de gegevens. Om dit enigma op te lossen zonder verstrikt
te raken in de afwijkingen in de gegevens die de gegevens zouden kunnen hebben, zouden we in plaats daarvan een
‘buffer intersect’ kunnen gebruiken:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom
FROM region

WHERE name = 'Hokkaido';

Dit maakt een buffer van 100 meter rondom de regio Hokkaido.
Het donkere gebied is de buffer:
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Selecteer met behulp van de buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.the_geom, b.the_geom)
AND b.name != 'Hokkaido';

In deze query wordt de originele view van de buffer gebruikt zoals elke andere tabel gebruikt zou worden. Het is
het alias a gegeven en het veld voor de geometrie ervan, a.the_geom, wordt gebruik om elke polygoon in de
tabel region (alias b) te selecteren waarmee deze kruist. Echter, Hokkaido zelf wordt uitgesloten van dit argument
SELECT, omdat we die niet willen; we willen alleen de regio’s die er naast liggen.
In QGIS:
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Het is ook mogelijk alle objecten binnen een bepaalde afstand te selecteren, zonder de extra stap van te maken door
eerst een buffer te creëren:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';

Dit levert hetzelfde resultaat op, zonder de noodzaak van een tussenliggende stap voor de buffer:
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Unieke waarden selecteren

Toon een lijst van alle unieke namen van steden voor alle gebouwen in de regio Queensland:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'Queensland';

Resultaat:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Meer voorbeelden …

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_SHORTESTLINE(a.the_geom, b.the_geom)) as text,
ST_SHORTESTLINE(a.the_geom, b.the_geom) AS the_geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_LONGESTLINE(a.the_geom, b.the_geom)) as text,
ST_LONGESTLINE(a.the_geom, b.the_geom) AS the_geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;
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CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM road a

WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM region a

WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER(a.the_geom)
FROM region a
WHERE a.name='Queensland';

SELECT ST_AREA(a.the_geom)
FROM region a
WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;

CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

16.4.5 In Conclusion

U heeft gezien hoe u ruimtelijke objecten kunt bevragen met behulp van de nieuwe databasefuncties van PostGIS.

16.4.6 What’s Next?

Vervolgens gaan we de structuren van meer complexe geometrieën onderzoeken en hoe ze te maken met behulp van
PostGIS.

16.5 Lesson: Construeren van geometrie

In dit gedeelte duiken we een beetje dieper in hoe eenvoudige geometrieën worden geconstrueerd in SQL. In de
realiteit zou u waarschijnlijk een GIS zoals QGIS gebruiken om complexe geometrieën te maken met behulp van hun
gereedschappen voor digitaliseren; echter, begrijpen hoe zij worden geformuleerd kan handig zijn bij het schrijven
van query’s en begrijpen hoe de database is samengesteld.
Het doel van deze les: Beter begrijpen hoe ruimtelijke entiteiten direct in PostgreSQL/PostGIS te maken.
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16.5.1 Lijnen maken

Terug naar onze database address, laten we zorgen dat onze tabel streets overeenkomt met de andere; d.i. een
beperking hebben op de geometrie, een index en een item in de tabel geometry_columns.

16.5.2 Try Yourself

• Pas de tabel streets zo aan dat die een kolom voor geometrie bevat van het type ST_LineString.
• Vergeet niet een update uit te voeren om de geometrie kolom te laten maken.
• Voeg een constraint toe om te voorkomen dat andere geometrie dan lijnen of lege geometrie kan worden
ingevoerd.

• Maak een ruimtelijke index op de nieuwe geometrie kolom
Controleer uw resultaten

Laten we nu een lijn in onze tabel streets maken. In dit geval zullen we een bestaand record voor een straat bijwerken:

update streets
set the_geom = 'SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)'
where streets.id=2;

Bekijk de resultaten in QGIS. (U moet misschien met rechts klikken op de laag streets in het paneel ‘Lagen’ en kiezen
voor ‘Op kaartlaag inzoomen’.)
Maak nu nog enkele items voor streets - enkele in QGIS en enkele vanaf de opdrachtregel.

16.5.3 Polygonen maken

Het maken van polygonen is net zo eenvoudig. Eén ding om te onthouden is dat, bij definitie, polygonen tenminste
vier hoekenpunten hebben, waarvan de eerste en laatste op één lijn liggen:

insert into cities (name, the_geom)
values ('Tokyo', 'SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))');

Notitie: Een polygoon vereist dat er dubbele haken rondom de lijst met coördinaten staat; dat is om het voor u
mogelijk te maken complex polygonen met meerdere niet verbonden gebieden toe te voegen. Bijvoorbeeld

insert into cities (name, the_geom)
values ('Tokyo Outer Wards',

'SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 -30))'

);

Indien u deze stap volgde kunt u controleren wat die deed door de gegevensset cities te laden in QGIS, de
attributentabel ervan te openen en het nieuwe item te selecteren. merk op hoe de twee nieuwe polygonen zich gedragen
als één polygoon.
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16.5.4 Oefening: Steden aan mensen koppelen

Voor deze oefening zou u het volgende moeten doen:
• Alle gegevens uit uw tabel people verwijderen.
• Een kolom voor een vreemde sleutel, die verwijst naar de primaire sleutel van de tabel cities, aan people
toevoegen.

• QGIS gebruiken om enkele steden vast te leggen.
• SQL gebruiken om enkele nieuwe records voor people in te voeren, er zorg voor dragend dat elk daarvan een
geassocieerde straat en stad heeft.

Uw bijgewerkte schema voor people zou er ongeveer zo uit moeten zien:

\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) =

'ST_Point'::text OR the_geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Controleer uw resultaten

16.5.5 Ons schema bekijken

Ons schema zou er nu ongeveer zo uit moeten zien:
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16.5.6 Try Yourself

Maak stadsgrenzen door de minimum convex hull van alle adressen voor die stad te berekenen en een buffer rondom
dat gebied te berekenen.

16.5.7 Toegang tot sub-objecten

Met de functies voor het SFS-model heeft u een breed scala aan opties om toegang te verkrijgen tot sub-objecten van
geometrieën van SFS. Wanneer u het eerste vertexpunt van elke geometrie polygoon in de tabel myPolygonTable wilt
selecteren, moet u dat op de volgende manier doen:

• Transformeer de randen van de polygoon naar een lijn:

select st_boundary(geometry) from myPolygonTable;

• Selecteer het eerste vertexpunt van de resulterende lijn:

select st_startpoint(myGeometry)
from (

select st_boundary(geometry) as myGeometry
from myPolygonTable) as foo;

16.5.8 Gegevens verwerken

PostGIS ondersteunt alle standaard conforme functies van OGC SFS/MM. Al deze functies beginnen met ST_.

16.5.9 Clippen

U kunt de functie ST_INTERSECT() gebruiken om een sub-gedeelte van uw gegevens te clippen. Vermijd lege
geometrieën door te gebruiken:

where not st_isempty(st_intersection(a.the_geom, b.the_geom))
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select st_intersection(a.the_geom, b.the_geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.the_geom,32734),
b.the_geom));
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16.5.10 Geometrieën uit andere geometrieën bouwen

vanuit een opgegeven punttabel wilt u een lijn genereren. De volgorde van de punten wordt gedefinieerd door hun
id. Een andere methode van sorteren zou een tijdstempel kunnen zijn, zoals die welke u krijgt wanneer u waypoints
vastlegt met een GPS-ontvanger.

U kunt de volgende opdracht gebruiken om een lijn uit een nieuwe puntlaag, genaamd ‘points’, te maken:

select ST_LineFromMultiPoint(st_collect(the_geom)), 1 as id
from (

select the_geom
from points
order by id

) as foo;

U zou deze opdracht ook uit kunnen voeren op de laag ‘people’, hoewel dat natuurlijk weinig nut binnen de echte
wereld zou hebben om dit te doen, om te zien hoe het werkt zonder een nieuwe laag te maken.
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16.5.11 Geometrie opruimen

U kunt meer informatie over dit onderwerp krijgen in dit blog-item.

16.5.12 Verschillen tussen tabellen

U kunt het sleutelwoord voor PostgreSQL EXCEPT gebruiken om het verschil tussen twee tabellen met dezelfde
structuur te detecteren:

select * from table_a
except
select * from table_b;

Als resultaat zult u alle records uit table_a verkrijgen die niet zijn opgeslagen in table_b.
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16.5.13 Tabelruimten

U kunt definiëren waar Postgres zijn gegevens op schijf op zou moeten slaan dor tabelruimten te maken:

CREATE TABLESPACE homespace LOCATION '/home/pg';

U kunt u dan, wanneer u een database maakt, specificeren welke tabelruimte gebruikt moet worden bijv.:

createdb --tablespace=homespace t4a

16.5.14 In Conclusion

U heeft geleerd hoe u meer complexe geometrieën maakt met behulp van argumenten van PostGIS. Onthoud dat dit
meer is om uw achtergrondkennis te verbeteren wanneer u werkt met voor geo ingeschakelde databases via een GIS
als startpunt. Gewoonlijk hoeft u deze argumenten niet handmatig in te voeren, maar als u een algemeen idee heeft
van hun structuur zal dat u helpen wanneer u een GIS gebruikt, in het bijzonder als u fouten tegenkomt die anders
nogal cryptisch zouden kunnen lijken.
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De QGIS-gids voor Processing

Deze module is bijgedragen door Victor Olaya en Paolo Cavallini.
Inhoud:

17.1 Introductie

Deze gids beschrijft hoe het framework Processing in QGIS te gebruiken. Het gaat uit van geen eerdere kennis van
het framework Processing of één van de toepassingen waarop het vertrouwt. Het gaat voorts uit van basiskennis van
QGIS. De hoofdstukken over scripten gaan er van uit dat u enige basiskennis heeft van Python en misschien de Python
API van QGIS.
Deze gids is ontworpen voor zelfstudie of om te worden gebruikt in een uit te voeren workshop voor Processing.
Voorbeelden in deze gids gebruiken QGIS 3.4. Zij zouden niet kunnen werken of niet beschikbaar kunnen zijn in
andere versies dan die.
Deze gids is samengesteld uit een verzameling kleine oefeningen met progressieve complexiteit. Indien u nog nooit het
framework Processing heeft gebruikt zou u vanaf het eerste begin moeten starten. Indien u enige eerdere ervaringen
heeft, het staat u vrij om lessen over te slaan. Zij zijn min of meer onafhankelijk van elkaar, en elke introduceert
enige nieuwe concepten of enige nieuwe elementen, welke worden aangegeven in de titel van het hoofdstuk en de
korte introductie aan het begin van elk hoofdstuk. Dat zou het eenvoudiger moeten maken lessen te lokaliseren die
een bepaald onderwerp behandelen.
Voor eenmeer systematische beschrijving van alle componenten van het framework en hun gebruik, wordt aanbevolen
om het overeenkomstige hoofdstuk in de gebruikershandleiding te raadplegen. Gebruik het als ondersteunende tekst
naast deze gids.
Alle oefeningen in deze handleiding maken gebruik van dezelfde gratis en open dataset voor de gehele
trainingshandleiding en waarnaar wordt verwezen in het gedeelte Gegevens. Het te downloaden .zip-bestand bevat
verscheidene mappen voor elk van de lessen in deze gids. In elke map vindt u een QGIS projectbestand. Open het
bestand en u kunt met de oefening beginnen.
Veel plezier!
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17.2 Een belangrijke waarschuwing vóór het beginnen

Net zoals een handleiding voor een tekstverwerker u niet leert om een roman of een gedicht te schrijven, of een
handleiding voor CAD u niet laat zien hoe u de grootte voor een balk voor een gebouw berekent, zal deze gids u geen
ruimtelijke analyses leren. In plaats daarvan zal het u tonen hoe het framework Processing in QGIS te gebruiken, een
krachtig gereedschap voor het uitvoeren van ruimtelijke analyses. Het is aan u om de vereiste concepten te leren die
nodig zijn om dat type analyse te begrijpen. Zonder dat heeft het geen zin om het framework en de algoritmen daarin
te gebruiken, hoewel u misschien in de verleiding komt om het te proberen.
Laten we dit eens aan de hand van een voorbeeld duidelijk maken.
Met opgegeven verzameling punten en een waarde van een opgegeven waarde voor een variabele voor elk punt, kunt u
voor hen een rasterlaag berekenen met behulp van het geo-algoritme Kriging. Het dialoogvenster voor de parameters
van die module ziet eruit zoals het volgende.

Het ziet er ingewikkeld uit, niet?
Door deze handleiding te lezen zult u dingen leren zoals hoe die module te gebruiken, hoe het uit te voeren in een
batch-proces om rasterlagen uit honderden puntlagen te maken in één enkele uitvoering, of wat er gebeurd als op de
invoerlaag enkele punten zijn geselecteerd. Echter, de parameters zelf worden niet uitgelegd. Een ervaren analist met
goede kennis van geo-statistieken zal geen probleem hebben de parameters te begrijpen. Als u niet één van hen bent
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en sill, range, of nugget zijn gene bekende concepten voor u, dan zou u de module Kriging niet moeten gebruiken.
Meer dan dat, u bent nog lang niet klaar om de module Kriging te gebruiken, omdat het leren vereist van concepten
zoals ruimtelijke autocorrelatie of semi-variogrammen, waarvan u waarschijnlijk ook nooit eerder gehoord heeft, of
tenminste nog niet lang genoeg bestudeerd heeft. U zou ze eerst moeten bestuderen en begrijpen, en dan terugkomen
naar QGIS om het feitelijk uit te voeren en de analyse uit te voeren. Negeren hiervan zal leiden tot verkeerde resultaten
en slechte (en zeer waarschijnlijk nutteloze) analyse.
Hoewel niet alle algoritmen zo complex zijn als Kriging (maar sommige ervan zijn nog complexer!), vereisen de
meeste ervan het begrijpen van de fundamentele analyse-ideeën waarop zij zijn gebaseerd. Zonder die kennis zal het
gebruiken ervan zeer waarschijnlijk leiden tot slechts resultaten.
gebruiken van geo-algoritmen zonder een goede fundatie te hebben van ruimtelijke analyse is als het proberen een
roman te schrijven zonder iets af te weten van grammatica of syntaxis, en gene kennis hebben over het vertellen van
verhalen. U zou een resultaat kunnen krijgen, maar het is waarschijnlijk dat er helemaal geen waarde wordt verkregen.
Houd uzelf niet voor de gek door te denken dat u na het lezen van deze gids u al in staat bent een ruimtelijke analyse
uit te voeren en degelijke resultaten te krijgen. U zult ook de ruimtelijke analyse moeten bestuderen.
Hier is een goede verwijzing die u kunt lezen om meer te leren over ruimtelijke gegevensanalyse.
Geospatial Analysis (3rd Edition): A Comprehensive Guide to Principles, Techniques and Software Tools Michael
John De Smith, Michael F. Goodchild, Paul A. Longley
Het is hier online beschikbaar.

17.3 Het framework Processing instellen

Het eerste om te doen, vóór het framework Processing te kunnen gebruiken, is om het te configureren. Er is niet veel
in te stellen, dus dit is een eenvoudige taak.
Later zullen we laten zien hoe de externe toepassingen te configureren die worden gebruikt om de lijst met beschikbare
algoritmen uit te breiden, maar voor nu gaan we alleen met het framework zelf werken.
Het framework Processing is een bronplug-in voor QGIS, wat betekent dat, het al op uw systeem geïnstalleerd zou
moeten zijn, omdat het is opgenomen in QGIS. In het geval dat het actief is zou u een menu, genaamd Processing, in
uw menubalk moeten zien. Daar kunt u toegang krijgen tot alle componenten van het framework.

Als u dat menu niet kunt vinden, dient u de plug-in in te schakelen door te gaan naar Beheer en installeer plug-ins en
het te activeren.

17.3. Het framework Processing instellen 487

https://www.spatialanalysisonline.com/


QGIS Training Manual

Het belangrijkste element waarmee we zullen gaan werken is de Toolbox. Klik op het overeenkomende item van het
menu en u zult de vastgezette Toolbox zien aan de rechterkant van het venster van QGIS.
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De Toolbox bevat een lijst van alle beschikbare algoritmen, opgedeeld in groepen, zogenaamde Providers. Providers
kunnen worden ge(de)activeerd in het Extra ► Options ► Processing. We zullen dat dialoogvenster later in deze
handleiding bespreken.
Standaard zijn alleen providers die niet afhankelijk zijn van toepassingen van derde partijen (dat is, die welke alleen
elementen van QGIS nodig hebben om te worden uitgevoerd) actief. Algoritmen die externe toepassingen nodig
hebben zouden een aanvullende configuratie nodig kunnen hebben. Configureren van providers wordt in een later
hoofdstuk van deze handleiding uitgelegd.
Als u dit punt heeft bereikt bent u er klaar voor om geo-algoritmen te gebruiken. Er is op dit moment geen noodzaak
om nog iets anders te configureren. We kunnen ons eerste algoritme al gaan uitvoeren, wat we ook zullen doen in de
volgende les.
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17.4 Uw eerste algoritme uitvoeren. De Toolbox

Notitie: In deze les zullen we ons eerste algoritme uitvoeren, en ons eerste resultaat daaruit verkrijgen.

Zoals we al hebben besproken kan het framework Processing algoritmen uit andere toepassingen uitvoeren, maar het
bevat ook eigen algoritmen die geen externe software nodig hebben om te worden uitgevoerd. We gaan één van deze
eigen algoritmen uitvoeren om te beginnen met het verkennen van het framework Processing. In het bijzonder gaan
we de middelpunten berekenen van een verzameling polygonen.
Open eerst het project vanQGIS dat correspondeertmet deze les. Het bevat slechts één enkele laagmet twee polygonen

Ga nu naar het tekstvak boven in de Toolbox. Dat is het zoekvak en als u tekst daarin typt, zal het de lijst met
algoritmen filteren, zodat slechts die, welke de ingevoerde tekst bevatten worden weergegeven. Als er algoritmen zijn
die overeenkomen met uw zoekactie, maar toebehoren aan een provider die niet actief is, zal een aanvullend label
worden weergegeven in het onderste gedeelte van Toolbox.
Typ centroids en u zou iets zoals dit moeten zien.
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Het zoekvak is een zeer praktische manier om het algoritme te zoeken dat u nodig hebt. Aan de onderzijde van het
dialoogvenster wordt een aanvullend label weergegeven dat vermeldt dat er algoritmen zijn die overeenkomen met uw
zoekactie, maar aan een provider behoren die niet actief is. Als u klikt op de koppeling in dat label, zal de lijst met
algoritmen ook de resultaten van die niet actieve providers bevatten, die lichtgrijs zullen worden weergegeven. Ook
een koppeling om de niet actieve provider te activeren wordt weergegeven. We zullen later zien hoe andere providers
te activeren.

U hoeft slechts te dubbelklikken op de naam in de Toolbox om een algoritme uit te voeren. Als u dubbelklikt op het
algoritme Polygon centroids, zult u het volgende dialoogvenster zien.
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Alle algoritmen hebben een soortgelijke interface, die als basis parameters voor invoer bevat die u moet invullen en
voor uitvoer die u moet selecteren om de plaats voor opslaan te kiezen. In dit geval is de enige invoer die we hebben
een vectorlaag met polygonen.
Selecteer de laag Polygons als invoer. Het algoritme heeft één enkele uitvoer, wat de laag Centroids is. Er zijn twee
opties om te definiëren waar uitvoer van gegevens wordt opgeslagen: voer ofwel een bestandspad in of sla het op naar
een tijdelijke bestandsnaam
In het geval dat u een bestemming wilt instellen, en het resultaat niet wilt opslaan in een tijdelijk bestand,
wordt de indeling van de uitvoer gedefinieerd door de extensie van de bestandsnaam. Selecteer eenvoudigweg de
corresponderende bestandsextensie (of voeg die toe, als u in plaats daarvan het bestandspad direct intypt) om
een indeling te selecteren. Als de extensie van het bestandspad dat u invoerde niet overeenkomt met een van de
ondersteunde indelingen, zal een standaard extensie (gewoonlijk .dbf voor tabellen, .tif voor rasterlagen en .
shp voor vectorlagen) worden toegevoegd aan het bestandspad, en de bestandsindeling die correspondeert met die
extensie zal worden gebruikt om de laag of de tabel op te slaan.
In alle oefeningen in deze handleiding zullen we de resultaten opslaan naar een tijdelijk bestand, omdat er geen reden
is ze op te slaan voor later gebruik. Het staat u uiteraard vrij om ze op een permanente locatie op te slaan als u dat
wilt.

Waarschuwing: Tijdelijke bestanden worden verwijderd als u QGIS afsluit. Als u een project maakte met een
uitvoer die werd opgeslagen als een tijdelijk bestand, zal QGIS klagen als u later het project weer wilt openen,
omdat het uitvoerbestand niet meer bestaat.

Als u eenmaal het dialoogvenster voor het algoritme heeft geconfigureerd, druk dan op Run om het algoritme uit te
voeren.
U zult de volgende uitvoer krijgen.
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De uitvoer heeft hetzelfde CRS als de invoer. Geo-algoritmen gaan er van uit dat alle invoerlagen hetzelfde CRS delen
en projecteert niets opnieuw. Behalve in het geval van enkele speciale algoritmen (bijvoorbeeld die voor opnieuw
projecteren), de uitvoer zal ook datzelfde CRS hebben. We zullen hier snel meer van zien.
Probeer het zelf op te slaan in verschillende bestandsindelingen (gebruik bijvoorbeeld .shp en geojson als
extensies). Ook kunt u, als u niet wilt dat de laag zal worden geladen in QGIS nadat die is gegenereerd, het keuzevak
deselecteren dat staat onder het vak voor het pad van de uitvoer.

17.5 Meer algoritmen en gegevenstypen

Notitie: In deze les zullen we nog drie algoritmen uitvoeren, leren hoe andere typen voor invoer te gebruiken, en
uitvoer configureren om automatisch te worden opgeslagen in een bepaalde map.

Voor deze lessen zullen we een tabel en een laag voor polygonen nodig hebben. We zullen een puntenlaag gaan maken
gebaseerd op coördinaten in de tabel, en dan het aantal punten in elke polygoon tellen. Als u het project voor QGIS
opent dat correspondeert met deze les, zult u een tabel vinden met X- en Y-coördinaten, maar u zult geen laag voor
polygonen vinden. Geen zorgen, die zullen we maken met behulp van een geo-algoritme van Processing.
Het eerste dat we zullen gaan doen is een puntenlaag maken uit de coördinaten in de tabel, met behulp van het
algoritme Points layer from table. U weet nu hoe u het zoekvak kunt gebruiken, dus zou het voor u niet zo moeilijk
moeten zijn om dat op te zoeken. Dubbelklik erop om het uit te voeren en u krijgt het volgende dialoogvenster.
Dit algoritme, net zoals dat uit de vorige les, genereert slechts één enkele uitvoer, en het heeft drie invoeren:

• Invoerlaag: de tabel met de coördinaten. U zou hier de tabel uit de gegevens voor de les moeten selecteren.
• X- en Y-velden: deze twee parameters zijn gekoppeld aan de eerste. De overeenkomende selectie zal de naam
weergeven van de velden die beschikbaar zijn in de geselecteerde tabel. Selecteer het veld XCOORD voor de
parameter X, en het veld YYCOORD voor de parameter Y.

• doel-CRS: Omdat dit algoritme geen invoerlagen heeft, kan het geen CRS aan de uitvoerlaag toewijzen die daar
op is gebaseerd. In plaats daarvan vraagt het u om handmatig het CRS te selecteren dat de coördinaten in de
tabel gebruiken. Klik op de knop aan de rechterkant om de selectie van CRS voor QGIS te openen, en selecteer

17.5. Meer algoritmen en gegevenstypen 493



QGIS Training Manual

EPSG:4326 als het CRS voor de uitvoer. We gebruiken dat CRS omdat de coördinaten in de tabel in dat CRS
staan.

Uw dialoogvenster zou er nu zo uit moeten zien.

Druk nu op de knop Run om de volgende laag te krijgen (u moet misschien volledig inzoomen om de kaart rondom
de nieuw gemaakte punten te laten zien):
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Het volgende dat we nodig hebben is de polygoonlaag. We gaan een rechthoekig raster van polygonen maken met
behulp van het algoritme Create grid, wat het volgende dialoogvenster voor de parameters heeft.

17.5. Meer algoritmen en gegevenstypen 495



QGIS Training Manual

Waarschuwing: De opties zijn eenvoudiger in recent versies van QGIS; u hoeft slechts de min en max voor X
en Y in te voeren (voorgestelde waarden: -5.696226,-5.695122,40.24742,40.248171)

De vereiste invoeren voor het maken van het raster zijn allemaal getallen. Wanneer u een numerieke waarde dient in
te voeren heeft u twee opties: het direct typen in het overeenkomende vak of klikken op de knop aan de rechterkant
om een dialoogvenster te krijgen zoals dat hieronder wordt weergegeven.
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Het dialoogvenster bevat een eenvoudige calculator, dus u kunt expressies typen zoals 11 * 34.7 + 4.6, en
het resultaat zal worden berekend en in het overeenkomende vak in het dialoogvenster van de parameters worden
geplaatst. Het bevat ook constanten die u kunt gebruiken en waarden uit andere beschikbare lagen.
In dit geval willen we een raster maken dat het bereik van de puntenlaag voor invoer bedekt, dus zouden we de
coördinaten daarvan moeten gebruiken om de coördinaat van het midden van het raster te berekenen en de breedte
en hoogte daarvan, omdat dat de parameters zijn die het algoritme nodig heeft om het raster te kunnen maken. met
een beetje rekenkundige hulp, probeer dat zelf eens te doen met behulp van het dialoogvenster met de calculator en
de constanten van de puntenlaag van de invoer.
Selecteer Rectangles (polygons) in het veld Type.
Net zoals in het geval van het laatste algoritme moeten we hier ook het CRS invullen. Selecteer EPSG:4326 als het
doel-CRS, zoals we al eerder deden.
Uiteindelijk zou u een dialoogvenster voor parameters moeten hebben zoals dit:
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(Het is beter om één afstand toe te voegen voor breedte en hoogte: Horizontal spacing: 0.0001, Vertical spacing:
0.0001, Width: 0.001004, Height: 0.000651, Center X: -5.695674, Center Y: 40.2477955) Het geval van X center
is een beetje gevoelig, zie: -5.696126+(( -5.695222+ 5.696126)/2)
Druk op Run en u zult de laag met het raster krijgen.
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De laatste stap is om de punten te tellen in elke rechthoek van dat raster. We zullen het algoritme Count points in
polygons gebruiken.

Nu hebben we het resultaat dat we zochten.
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Vóórdat we deze les beëindigen: hier is een snelle tip om uw leven eenvoudiger te maken voor het geval u uw gegevens
steeds wilt opslaan. Als u wilt dat al uw gegevens voor de uitvoer worden opgeslagen in één bepaalde map, hoeft u
niet elke keer de naam van de map te typen. Ga, in plaats daarvan, naar het menu Processing en selecteer het item
Opties en configuratie. dat zal het dialoogvenster voor configuratie openen.

In het item Output folder dat u zult vinden in de groep General, typt u het pad naar uw doelmap.
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Wanneer u nu een algoritme uitvoert, gebruik dan slechts de bestandsnaam in plaats van het volledige pad.
Bijvoorbeeld, met de hierboven weergegeven configuratie, als u graticule.shp invoert als het pad voor
uitvoer voor het algoritme dat we zojuist hebben gebruikt, zal het resultaat worden opgeslagen in D:\
processing_output\graticule.shp. U kunt nog steeds een volledig pad invoeren voor de gevallen waarin
u wilt dat het resultaat wordt opgeslagen in een andere map.
Probeer zelf het algoritme Create grid met verschillende grootten raster, en ook met verschillende typen raster.

17.6 CRS-en opnieuw.projecteren

Notitie: In deze les zullen we bespreken hoe Processing CRS-en gebruikt.We zullen ook een zeer bruikbaar algoritme
bekijken: opnieuw projecteren.

CRS-en zijn een grote bron van verwarring voor gebruikers van Processing in QGIS, dus zijn er enkele algemene
regels over hoe zij worden afgehandeld door geo-algoritmen bij het maken van een nieuwe laag.

• Als er invoerlagen zijn, zal het het CRS van de eerste laag gebruiken. Aangenomen wordt dat dat het CRS is van
alle invoerlagen, omdat zij allemaal hetzelfde zouden moeten hebben. Als u lagen gebruikt met CRS-en die niet
overeenkomen, zal QGIS u daarover waarschuwen. Merk op dat het CRS van invoerlagen wordt weergegeven,
tezamen met de naam, in het dialoogvenster voor de parameters.
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• Als er geen invoerlaag is, zal het het CRS van het project gebruiken, tenzij het algoritme een specifiek veld
voor het CRS bevat (zoals gebeurde in de laatste les met het algoritme voor het raster)

Open het project dat correspondeert met dezes les en u zult twee lagen zien, genaamd 23030 en 4326. Zij bevatten
beide dezelfde punten, maar zijn in verschillende CRS-en (EPSG:23030 en EPSG:4326). Zij verschijnen op dezelfde
plaats omdat QGIS direct opnieuw projecteert naar het CRS van het project (EPSG:4326), maar in feite zijn zij niet
dezelfde laag.
Open het algoritme Export/Add geometry columns.

Dit algoritme voegt nieuwe kolommen toe aan de attributentabel van een vectorlaag. De inhoud van de kolommen is
afhankelijk van het type geometrie van de laag. In het geval van punten, voegt het nieuwe kolommen toe met de X-
en Y-coördinaten van elk punt.
In de lijst met beschikbare lagen die u kunt vinden in het veld voor de invoerlaag, zult u elk zien met zijn
overeenkomend CRS. Dat betekent dat, hoewel zij op dezelfde plaats in uw kaartvenster verschijnen, zij verschillend
zullen worden behandeld. Selecteer de laag 4326.
De andere parameter van het algoritme maakt het mogelijk in te stellen hoe het algoritme coördinaten gebruikt om de
nieuwe waarde te berekenen die zal worden toegevoegd aan de resulterende lagen. De meeste algoritmen hebben geen
optie zoals dit, en gebruiken eenvoudigweg direct de coördinaten. Selecteer de laagoptie Layer CRS om de coördinaten
slechts te gebruiken zoals zij zijn. Dit is hoe bijna alle geo-algoritmen werken.
U zou een nieuwe laag moeten krijgen met exact dezelfde punten als de andere twee lagen. Als u met rechts klikt op
de naam van de laag en de eigenschappen ervan opent, zult u zien dat het hetzelfde CRS van de invoerlaag deelt, dat
is, EPSG:4326. Wanneer de laag wordt geladen in QGIS, zult u worden gevraagd het CRS van de laag in te voeren,
omdat QGIS daar al van weet.
Als u de attributentabel van de nieuwe laag opent zult u zien dat het nu twee nieuwe velden bevat met de X- en
Y-coördinaten van elk punt.
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Deze waarden voor de coördinaten zijn in het CRS van de laag, omdat we die optie kozen. Echter, zelfs als u een
andere optie kiest, zou het CRS van de uitvoer van de laag hetzelfde zijn, omdat het CRS van de invoer is gebruikt
om het CRS van de uitvoerlaag in te stellen. Kiezen van een andere optie zal er voor zorgen dat de waarden anders
zijn, maar zal het resulterende punt niet wijzigen of het CRS van de uitvoerlaag te laten verschillen van het CRS van
die van de invoer.
Doe nu dezelfde berekening met behulp van de andere laag. U zou moeten zien dat de resulterende laag op exact
dezelfde plaats is gerenderd als de andere, en het zal het CRS EPSG:23030 hebben, omdat dat die van de invoerlaag
was.
Als u naar de attributentabel ervan gaat, zult u zien dat die anders zijn dan die uit de eerste laag die we maakten.

Dit komt omdat de originele gegevens anders zijn (het gebruikt een ander CRS), en deze coördinaten komen daar uit.
Wat zou u hieruit moeten leren? Het belangrijkste idee achter deze voorbeelden is dat geo-algoritmen de laag
gebruiken zoals die is in zijn originele gegevensbron, en het opnieuw projecteren dat QGIS zou kunnen doen vóór het
renderen volledig negeert. Met andere woorden, vertrouw niet wat u ziet in uw kaartvenster, maar onthoud dat altijd
de originele gegevens zullen worden gebruikt. Dat is in dit geval niet zo belangrijk, omdat we slechts één laag per
keer gebruiken, maar in een algoritme dat er meerdere nodig heeft (zoals een algoritme om te clippen), zouden lagen
die overeenkomen of over elkaar liggen ver uit elkaar kunnen liggen, omdat ze verschillende CRS-en zouden kunnen
hebben.
Algoritmen voeren projecteren niet opnieuw (behalve in het algoritme voor opnieuw projecteren dat we hierna zullen
zien), dus is het aan u om er voor te zorgen dan de lagen overeenkomende CRS-en hebben.
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Een interessante module die werkt met CRS-en is die voor opnieuw projecteren. Het vertegenwoordigt een bijzonder
geval, omdat het een invoerlaag heeft (die welke opnieuw moet worden geprojecteerd), maar het zal niet het
CRSaarvan gebruiken voor de uitvoer.
Open het algoritme Reproject layer.

Selecteer een van de lagen als invoer, en selecteer EPSG:23029 als het doel-CRS. Voer het algoritme uit en u zult
een nieuwe laag krijgen die identiek is aan die van de invoer, maar met een ander CRS. Het zal op dezelfde regio
in het kaartvenster verschijnen, net als de andere, omdat QGIS het direct opnieuw zal projecteren, maar de originele
coördinaten ervan zijn anders. U kunt dat zien door het algoritme Export/Add geometry columns uit te voeren met
deze nieuwe laag als invoer en verifiëren dat de toegevoegde coördinaten verschillen van die in de attributentabellen
van de beide andere twee lagen die we eerder hadden berekend.

17.7 Selectie

Notitie: In deze les zullen we zien hoe algoritmen van Processing selecties in vectorlagen afhandelen die worden
gebruikt als invoer, en hoe een selectie te maken met behulp van een bepaald type algoritme.

Anders dan in andere plug-ins voor analyse in QGIS, zult u in geo-algoritmen van Processing geen keuzevak “Alleen
geselecteerde objecten gebruiken” of iets dergelijks vinden. Het gedrag met betrekking tot selecteren is ingesteld voor
de gehele plug-in en al zijn algoritmen, en niet voor de uitvoering van elk algoritme. Algoritmen volgen de volgende
eenvoudige regels bij het gebruiken van een vectorlaag.

• Als de laag een selectie heeft, worden alleen geselecteerde objecten gebruikt.
• Als er geen selectie is worden alle objecten gebruikt.
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Onthoud dat u dit gedrag kunt wijzigen door de relevante optie te deselecteren in het menu Processing ► Opties ►
Algemeen`.
U kunt dat zelf testen door enkele punten van een van de lagen, die we gebruikten in het laatste hoofdstuk, te selecteren,
en het algoritme voor opnieuw projecteren daarmee uit te voeren. De opnieuw geprojecteerde laag die u zult krijgen
zal alleen de geselecteerde punten bevatten, tenzij er geen selectie was, wat er voor zal zorgen dat de resulterende laag
alle punten uit de originele laag zal bevatten.
U kunt alle beschikbare methoden en gereedschappen in QGIS gebruiken om een selectie te maken. U kunt echter
ook een algoritme gebruiken om dat te doen. Algoritmen voor het maken van een selectie kunnen worden gevonden
in de Toolbox onder Vector/Selection

Open het algoritme Random selection.

Met de standaard waarden zal het 10 punten selecteren uit de huidige laag.
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Het zal u opvallen dat dit algoritme geen uitvoer produceert, maar de invoerlaag aanpast (niet de laag zelf, maar
de selectie ervan). Dit is afwijkend gedrag, omdat alle andere algoritmen nieuwe lagen zullen produceren en niet de
invoerlagen wijzigen.
Omdat de selectie geen deel is van de gegevens zelf, maar iets dat alleen bestaat binnen GIS, moeten deze algoritmen
voor selectie alleen worden gebruikt voor het selecteren van een laag die is geopend in QGIS, en niet met de optie
voor het selecteren van een bestand dat u vindt in het overeenkomende vak voor de waarde van de parameter.
De selectie die we zojuist hebben gemaakt, net zoals de meeste andere zoals die worden gemaakt door de rest van de
algoritmen voor selectie, kan ook handmatig vanuit QGIS worden gemaakt, dus u zou zich af kunnen vragen wat het
nut is van het gebruiken van een algoritme daarvoor. Hoewel dat op dit moment misschien niet zinvol lijkt voor u,
zullen we later zien hoe we modellen en scripts maken. Als u een selectie in het midden van een model wilt maken
(wat een werkstroom voor verwerking definieert), kan alleen een geo-algoritme worden toegevoegd aan een model,
en andere elementen van QGIS en bewerkingen kunnen niet worden toegevoegd. Dat is de reden waarom enkele
algoritmeen voor Processing functionaliteit dupliceren die ook beschiknbaar is in andere elementen van QGIS.
Onthoud op dit moment alleen dat selecties kunnen worden gemaakt met behulp van processing geo-algoritmen voor
Processing, en dat algoritmen alleen de geselecteerde objecten gebruiken als er een selectie aanwezig is, anders worden
alle objecten gebruikt.

17.8 Een extern algoritme uitvoeren

Notitie: In deze les zullen we zien hoe we algoritmen gebruiken die afhankelijk zijn van een toepassing van een
derde partij, in het bijzonder SAGA, die één van de belangrijkste providers van algoritmen is.

Alle algoritmen die we tot dusverre hebben uitgevoerd maken deel uit van het framework Processing. Dat is, zij zijn
eigen algoritmen die zijn geïmplementeerd in de plug-in en worden uitgevoerd door QGIS net zoals de plug-in zelf
wordt uitgevoerd. Echter, één van de grootste mogelijkheden van het framework Processing is dat het algoritmen kan
gebruiken van externe toepassingen en de mogelijkheden van die toepassingen kan uitbreiden. Dergelijke algoritmen
zijn verpakt en opgenomen in de Toolbox, zodat u ze eenvoudig vanuit QGIS kunt gebruiken, en gegevens van QGIS
kunt gebruiken om ze uit te voeren.
Sommig algoritmen die u ziet in de vereenvoudigde weergave vereisen dat toepassingen van derde partijen zijn
geïnstalleerd op uw systeem. Een provider van algoritmen die speciale aandacht behoeft is SAGA (System for
Automated Geospatial Analysis). Eerst moeten we alles configureren zodat QGIS SAGA op de juiste wijze kan
aanroepen. Dit is niet moeilijk, maar het is belangrijk te weten hoe dit werkt. Elke externe toepassing heeft zijn
eigen configuratie, en later in deze zelfde handleiding zullen we enkele van de andere bespreken, maar SAGA zal ons
belangrijkste backend zijn, dus zullen we dat hier bespreken.
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Als u op Windows werkt, is de beste manier om met externe algoritmen te werken om QGIS te installeren met
behulp van het zelfstandige installatieprogramma. Dat zal zorg dragen voor het installeren van alle benodigde
afhankelijkheden, inclusief SAGA, dus als u het heeft gebruikt, is er niets anders te doen. U kunt het dialoogvenster
Instellingen openen en naar de groep Providers/SAGA gaan.

Het pad SAGA zou reeds moeten zijn geconfigureerd en moeten wijzen naar de map waar SAGA is geïnstalleerd.
Als u QGIS heeft geïnstalleerd zonder het zelfstandige installatieprogramma, dan moet u daar het pad naar uw
installatie van SAGA invoeren (wat u afzonderlijk zou moeten hebben geïnstalleerd). De vereiste versie is SAGA
2.1 [dit wijzigt overeenkomstig de uitgaven van SAGA].
Voor het geval u Linux gebruikt hoeft u het pad naar uw installatie van SAGA niet in te stellen in de configuratie
van processing. In plaats daarvan moet u SAGA installeren en er voor zorgen dat de map van SAGA in PATH staat,
zodat het kan worden aangeroepen vanaf de console (open eenvoudigweg een console en typ saga_cmd om het te
controleren). Onder Linux is de doelversie van SAGA ook 2.1, maar in sommige installaties (zoals de OSGeo Live
DVD) heeft u misschien alleen 2.0.8 beschikbaar. er zijn enkele pakketten voor 2.1 beschikbaar, maar zij worden niet
algemeen geïnstalleerd en zouden enkele problemen kunnen hebben, dus als u liever de meer algemene en stabielere
2.0.8 zou willen gebruiken, dan kunt u dat doen door compatibiliteit voor 2.0.8 in te schakelen in het dialoogvenster
voor configuratie, onder de groep SAGA.
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Als SAGA eenmaal is geïnstalleerd, kunt u een algoritme van SAGA starten door dubbel te klikken op de naam ervan,
net als met elk ander algoritme. Omdat we de vereenvoudigde interface gebruiken, weet u niet welke algoritmen zijn
gebaseerd op SAGA of een andere externe toepassing, maar als dubbelklikt op een er van en de overeenkomende
toepassing is niet geïnstalleerd, zult u iets soortgelijks als dit zien.

In ons geval, en er van uit gaande dat SAGA juist is geïnstalleerd en geconfigureerd, zou u dit venster niet zien, en u
zou in plaats daarvan naar het dialoogvenster voor de parameters gaan.
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Laten we het eens proberen met een algoritme dat is gebaseerd op SAGA, dat welke is genaamd Split shapes layer
randomly.

Gebruik de puntenlaag in het project dat bedoeld is voor deze les als invoer, en de standaard waarden voor de
parameters, en u zult iets zoals dit krijgen (de splitsing is willekeurig, dus uw resultaat zou anders kunnen zijn).

De invoerlaag is gesplitst in twee lagen, elk met hetzelfde aantal punten. Dit resultaat is berekend door SAGA, en
later overgenomen door QGIS en toegevoegd aan het project van QGIS.
Als alles goed gaat zult u geen verschil merken tussen dit op SAGA gebaseerde algoritme en een van de andere die we
eerder uitgevoerd hebben. Echter, SAGA zou, om enige reden, niet in staat kunnen zijn een resultaat te produceren
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en niet het bestand genereren dat QGIS verwacht. In dat geval zullen er problemen zijn om het resultaat toe te voegen
aan het project van QGIS, en een foutbericht zoals dit zal worden weergegeven.

Dit soort problemen zouden kunnen voorkomen, zelfs als SAGA (of enige andere toepassing die we aanroepen vanuit
het framework Processing) correct is geïnstalleerd, en het is belangrijk te weten hoe dit af te handelen. Laten we eens
een van deze foutberichten produceren.
Open het algoritme Create graticule en gebruik de volgende waarden.
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We gebruiken waarden voor breedte en hoogte die groter zijn dan het gespecificeerde bereik, dus kan SAGA
geen uitvoer produceren. Met andere woorden, de waarden van de parameters zijn verkeerd, maar zij worden niet
gecontroleerd totdat SAGA ze krijgt en probeert het raster te maken. Omdat het het niet kan maken, zal het niet de
verwachte laag produceren, en u zult het foutbericht dat hierboven wordt weergegeven zien.

Notitie: In SAGA >= 2.2.3 zal de opdracht automatisch verkeerde gegevens voor invoer aanpassen, zodat u geen
fout krijgt. Gebruik negatieve waarden voor delen om een fout uit te lokken.

Het begrijpen van dit soort problemen zal u helpen ze op te lossen en een verklaring te vinden voor wat er gebeurt.
Zoals u in het foutbericht kunt zien wordt een test uitgevoerd om te controleren of de verbinding met SAGA correct
werkt, wat voor u een indicatie zou kunnen zijn dat er een probleem zou kunnen zijn in hoe het algoritme werd
uitgevoerd. Dit is niet alleen van toepassing op SAGA, maar ook op andere externe toepassingen.
In de volgende les zullen we het log van de verwerking introduceren, waar informatie over opdrachten, uitgevoerd
door geo-algoritmen, wordt bijgehouden, en u zult zien hoe umeer details verkrijgt als problemen zoals deze optreden.

17.9 Het log van de verwerking

Notitie: Deze les beschrijft het log van de verwerking.

Alle analyses die worden uitgevoerd met het framework Processing wordt gelogd in zijn het systeem voor loggen in
QGIS. Dit stelt u in staat meer te weten te komen over wat er met de gereedschappen voor Processing is gedaan, om
problemen op te lossen als zij voorkomen, en ook om eerder uitgevoerde bewerkingen opnieuw uit te voeren, omdat
het systeem voor loggen ook enige interactiviteit implementeert.
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Klik op de ballon rechtsonder op de statusbalk van QGIS om het log te openen. Sommige algoritmen zouden hier
informatie achter kunnen laten over hun uitvoering. Bijvoorbeeld: die algoritmen die een externe toepassing aanroepen
loggen gewoonlijk de uitvoer van de console van die toepassing in dit item. Als u er naar kijkt zult u zien dat de uitvoer
van het algoritme van SAGA dat we zojuist hebben uitgevoerd (en die mislukte omdat de gegevens voor de invoer
niet juist waren) hier is opgeslagen.
Dit is behulpzaam om te begrijpen wat er aan de hand is. Gevorderde gebruikers zullen in staat zijn die uitvoer te
analyseren om uit te zoeken waarom het algoritme faalde. Als u geen gevorderde gebruiker bent, zal dit bruikbaar
zijn om anderen u te laten helpen het probleem dat u heeft te diagnosticeren, wat een probleem zou kunnen zijn in de
installatie van de externe software of een probleem met de gegevens die u verschafte.
Zelfs als het algoritme zou kunnen worden uitgevoerd, zouden sommige algoritmen waarschuwingen achter kunnen
laten in het geval dat het resultaat niet juist zou kunnen zijn. Bijvoorbeeld bij het uitvoeren van een algoritme voor
interpolatie met een zeer klein aantal punten, het algoritme kan worden uitgevoerd en zal een resultaat produceren,
maar het is aannemelijk dat het niet juist zal zijn, omdat meer punten zouden moeten worden gebruikt. Het is een
goed idee om regelmatig op dit type waarschuwingen te controleren als u niet zeker bent van bepaalde aspecten van
een bepaald algoritme.
In het menu Processing, onder het gedeelte Geschiedenis, vindt u ALGORITHM. Alle algoritmen die worden
uitgevoerd, zelfs als zij worden uitgevoerd vanuit de GUI en niet vanuit de console (wat later in deze handleiding
zal worden uitgelegd) worden in deze sectie van het log opgeslagen als een aanroep van de console. Dat betekent dat
elke keer dat u een algoritme uitvoert, een opdracht voor de console wordt toegevoegd aan het log, en u een volledige
geschiedenis heeft van uw werksessie. Hier is hoe die geschiedenis er uit ziet:

Dit kan erg bruikbaar zijn bij het beginnen te werken met de console, om te leren over de syntaxis van algoritmen.
We zullen het gebruiken wanneer we bespreken hoe opdrachten voor analyses vanuit de console uit te voeren.
De geschiedenis is ook interactief, en u kunt elk eerder algoritme opnieuw uitvoeren door eenvoudigweg op het item
ervan te dubbelklikken. Dit is een eenvoudige manier voor het herhalen van werk dat we al eerder gedaan hebben.
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probeer bijvoorbeeld het volgende. Open de gegevens die overeenkomen met het eerste hoofdstuk van deze
handleiding en voer het daar uitgelegde algoritme uit. Ga nu naar het dialoogvenster van het log en zoek het laatste
algoritme in de lijst op, wat correspondeert met het algoritme dat u zojuist heeft uitgevoerd. Dubbelklik erop en een
nieuw resultaat zou moeten worden geproduceerd, net zoals wanneer u het uitvoert als met het normale dialoogvenster
en het aanroept vanuit de Toolbox.

17.9.1 Gevorderd

U kunt ook het algoritme aanpassen. Kopieer het eenvoudigweg, open Plug-ins ► Python-console, klik op Importeer
klasse ► Importeer klsse Processing, en plak het dan om de analyse opnieuw uit te voeren; wijzig de tekst zoals u
wilt. Typ iface.addVectorLayer('/pad/bestandsnaam.shp', 'Laagnaam in legenda',
'ogr') om het resulterende bestand weer te geven. Anders kunt u processing.runandload gebruiken.

17.10 De Raster calculator. Waarden Geen gegevens

Notitie: In deze les zullen we zien hoe we de Raster calculator gebruiken om enkele bewerkingen op rasterlagen uit
te voeren. We zullen ook uitleggen wat waarden Geen gegevens zijn en hoe de berekeningen en andere algoritmen
die behandelen

De Raster calculator is een van de meest krachtige algoritmen die u zult tegenkomen. Het is een enorm flexibel en
veelzijdig algoritme dat voor veel verschillende berekeningen kan worden gebruikt, en een dat snel een belangrijk
deel van uw gereedschapskist zal zijn.
In deze les zullen we enkele berekeningen met Raster calculator uitvoeren, de meeste daarvan redelijk eenvoudig.
Dat zal ons laten zien hoe het wordt gebruikt en hoe het enkele bijzondere situaties behandelt die het zou kunnen
tegenkomen. Dat begrijpen is belangrijk om later de verwachte resultaten te krijgen bij het gebruiken van Raster
calculator, en ook om bepaalde technieken te begrijpen die er algemeen mee toegepast worden.
Open het project voor QGIS voor deze les en u zult zien dat het verschillende rasterlagen bevat.
Open nu de Toolbox en open het dialoogvenster dat correspondeert met de Raster calculator.
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Notitie: De interface is anders in recente versies.

Het dialoogvenster bevat 2 parameters.
• De voor de analyse te gebruiken lagen. Dit is een meervoudige invoer, wat betekent dat u zoveel lagen kunt
selecteren als u wilt. Klik op de knop aan de rechterkant en selecteer dan de lagen die u wilt gebruiken in het
dialoogvenster dat verschijnt.

• De toe te passen formule. De formule gebruikt de lagen die zijn geselecteerd in de parameter hierboven, die
worden vermeld met letters uit het alfabet (a, b, c...) of g1, g2, g3... als namen voor variabelen.
Dat is, de formule a + 2 * b is hetzelfde als g1 + 2 * g2 en zal de som van de waarde in de eerste laag
plus twee keer de waarde van de tweede laag berekenen. De volgorde van de lagen is dezelfde volgorde als die
welke u ziet in het dialoogvenster voor de selectie.

Waarschuwing: De calculator is hoofdlettergevoelig.

We zullen, om mee te beginnen, de eenheden van de DEM wijzigen van meters naar voet. De formule die we nodig
hebben is de volgende:

h' = h * 3.28084

Selecteer de DEM in het veld voor de lagen en typ a * 3.28084 in het veld voor de formule.

Waarschuwing: Voor niet Engelse gebruikers: gebruik altijd “.”, niet “,”.

Klik op Run om het algoritme uit te voeren. U zult ene laag krijgen die er hetzelfde uitziet als de invoerlaag, maar met
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andere waarden. De invoerlaag die we gebruikten had geldige waarden in al zijn cellen, dus heeft de laatste parameter
in het geheel geen effect.
Laten we nu een andere berekening uitvoeren, deze keer op de laag accflow. Deze laag bevat waarden van een
geaccumuleerde stroom, een hydrologische parameter. Het bevat alleen die waarden binnen het gebied van een
bepaalde waterkering, zonder waarden geen gegevens daarbuiten. Zoals u kunt zien, is het renderen niet erg
informatief, vanwege de manier waarop de waarden zijn verdeeld. Gebruiken van de logaritme van die accumulatie
van die stroom zal een veel meer informatieve weergave opleveren. We kunnen die berekenen met behulp van de
Raster calculator.
Open opnieuw het dialoogvenster voor het algoritme, selecteer de laag accflow als de enige laag voor de invoer, en
voer de volgende formule in: log(a).
Hier is de laag die u zult krijgen.

Als u het gereedschap Object identificeren selecteert om de waarde van een laag op een bepaald punt te weten te
komen, selecteer de laag die we zojuist hebben gemaakt en klik op een punt buiten het bassin, u zult zien dat het een
waarde Geen gegevens bevat.

17.10. De Raster calculator. Waarden Geen gegevens 515



QGIS Training Manual

Voor de volgende oefening gaan we twee lagen gebruiken in plaats van een, en we zullen een DEM gaan krijgen met
alleen geldige waarden binnen het bassin, gedefinieerd in de tweede laag. Open het dialoogvenster voor de calculator en
selecteer beide lagen van het project in het veld voor de invoerlagen. Voer de volgende formule in het corresponderende
veld in:

a/a * b

a verwijst naar de laag met de geaccumuleerde stroom (omdat het de eerste in de lijst is) en b verwijst naar de DEM.
Wat we hier in het eerste deel van de formule gaan doen is de laag met de geaccumuleerde stroom delen door zichzelf,
wat zal resulteren in een waarde 1 binnen het bassin, en een waarde Geen gegevens daarbuiten. Dan vermenigvuldigen
we met de DEM, om de hoogtewaarden in de cellen binnen het bassin te krijgen (DEM * 1 = DEM) en de waarden
Geen gegevens daarbuiten (DEM * no_data = no_data)
Hier is de resulterende laag.

Deze techniek wordt regelmatig gebruikt om waarden in een rasterlaag te maskeren, en is bruikbaar wanneer u
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berekeningen uit wilt voeren op een andere regio dan de willekeurige rechthoekige regio die wordt gebruikt door
de rasterlaag. Een hoogte-histogram bijvoorbeeld van een rasterlaag heeft weinig betekenis. Als het echter berekend
met alleen de waarden die overeenkomen met een bassin (zoals in het bovenstaande geval), is het resultaat dat we
verkrijgen een betekenisvolle die in feite informatie geeft over de configuratie van het bassin.
Los van de waarden Geen gegevens en hoe zij worden afgehandeld zijn er andere interessante dingen met betrekking
tot dit algoritme dat we zojuist hebben uitgevoerd. Als u eens kijkt naar de bereiken van de lagen die we hebben
vermenigvuldigd (u kunt dat doen door te dubbelklikken op de naam van de laag in de inhoudsopgave en hun
eigenschappen bekijken), zult u zien dat zij niet hetzelfde zijn, omdat het bereik dat wordt bedekt door de laag van
de geaccumuleerde stroom kleiner is dan het bereik van de volledige DEM.
Dat betekent dat deze lagen niet overeenkomen, en dat zij niet direct kunnen worden vermenigvuldigd zonder die
grootten en bereiken te homogeniseren door één of beide lagen te resamplen. Wij deden echter helemaal niets.
QGIS handelt deze situatie af en resampled automatisch invoerlagen als dat nodig is. Het bereik van de uitvoer is het
minimale bedekte bereik dat wordt berekend vanuit de invoerlagen, en de minimale celgrootte van hun celgrootten.
In dit geval (en in de meeste gevallen), produceert dit de gewenste resultaten, maar u zou zich altijd bewust moeten
zijn van de aanvullende bewerkingen die plaatsvinden, omdat zij het resultaat zouden kunnen beïnvloeden. In gevallen
wanneer dit gedrag niet gewenst is, zou van tevoren handmatig moeten worden geresampled. In latere hoofdstukken
zullen we meer zien over het gedrag van algoritmen indien gebruikt met meerdere rasterlagen.
Laten we deze les afsluiten met een andere oefening in maskeren. We gaan de helling berekenen voor alle gebieden
met een hoogte tussen 1000 en 1500 meter.
In dit geval hebben we geen laag die we als masker kunnen gebruiken, maar die kunnen we maken met behulp van
de calculator.
Voer de calculator uit met behulp van de DEM als enige invoerlaag en de volgende formule

ifelse(abs(a-1250) < 250, 1, 0/0)

Zoals u kunt zien gebruiken we de calculator niet alleen om eenvoudige algebraïsche bewerkingen uit te voeren, maar
ook om meer complexe berekeningen uit te voeren die voorwaardelijke zinnen in zich hebben, zoals die hierboven.
Het resultaat heeft een waarde van 1 binnen het bereik waarmee we willen werken, en Geen gegevens in cellen
daarbuiten.

De waarde geen gegevens komt uit de uitdrukking 0/0. Omdat dat een onbepaalde waarde is, zal SAGA een waarde
NaN (Not a Number) toevoegen, die in feite wordt behandeld als een waarde Geen gegevens. Met deze kleine truc
kunt u een waarde Geen gegevens instellen, zonder dat u hoeft te weten wat de waarde geen gegevens van de cel is.
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Nu hoeft u het nog slechts te vermenigvuldigen met de laag van de helling die is opgenomen in het project, en zult u
het gewenste resultaat verkrijgen.
Dit kan allemaal worden gedaan in één enkele bewerking met de calculator. We laten dat als een oefening voor de
lezer.

17.11 Vectorcalculator

Notitie: In deze les zullen we zien hoe we nieuwe attributen toevoegen aan een vectorlaag, gebaseerd op een
rekenkundige uitdrukking, met behulp van de vectorcalculator.

We weten al hoe we de raster calculator moeten gebruiken om nieuwe lagen te maken met behulp van rekenkundige
uitdrukkingen. Een soortgelijk algoritme is beschikbaar voor vectorlagen, en genereert een nieuwe laag met dezelfde
attributen van de invoerlaag, plus een aanvullende met het resultaat van de ingevoerde uitdrukking. Het algoritme
heet Veld calculator en heeft het volgende dialoogvenster voor parameters.

Notitie: In nieuwere versies van Processing is de interface aanzienlijk gewijzigd, hij is krachtiger en eenvoudiger te
gebruiken.

Hier zijn enkele voorbeelden van het gebruik van dat algoritme.
Laten we eerst de bevolkingsdichtheid berekenen van blanke mensen in elke polygoon, wat een census weergeeft. We
hebben twee velden in de attributentabel die we daarvoor kunnen gebruiken, namelijk WHITE en SHAPE_AREA.
We moeten ze alleen delen en vermenigvuldigen met 1 miljoen (om de dichtheid per vierkante km te verkrijgen), dus
we kunnen de volgende formule in het overeenkomstige veld gebruiken
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( "WHITE" / "SHAPE_AREA" ) * 1000000

Het dialoogvenster voor de parameters zou moeten worden gevuld zoals hieronder weergegeven.

Dit zal een nieuw veld genereren, genaamd WHITE_DENS
Laten we nu de ratio berekenen tussen de velden MALES en FEMALES om een nieuw veld te maken dat aangeeft of
de mannelijk bevolking numeriek domineert boven de vrouwelijke bevolking.
Voer de volgende formule in

"MALES" / "FEMALES"

Deze keer zou het venster met de parameters er zo uit moeten zien voordat op de knop OK wordt gedrukt.
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In een eerdere versie zou, omdat beide velden van het type integer zijn, het resultaat worden afgebroken tot een
integer. In dit geval zou de formule : 1.0 * "MALES" / "FEMALES" moeten zijn, om aan te geven dat we een
getal floating point als resultaat willen hebben.
We kunnen voorwaardelijke functies gebruiken om een nieuw veld met tekststrings male of female te krijgen in
plaats van de waarden voor de ratio, met behulp van de volgende formule:

CASE WHEN "MALES" > "FEMALES" THEN 'male' ELSE 'female' END

Het venster voor de parameters zou er zo uit moeten zien.
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Een Python veldcalculator is beschikbaar in de “Advanced Python field calculator”, waarover we hier niet in detail
treden
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17.12 Bereiken definiëren

Notitie: In deze les zullen we zien hoe we bereiken definiëren, die bij sommige algoritmen nodig zijn, in het bijzonder
voor rasters.

Sommige algoritmen vereisen een bereik om het gebied te definiëren dat moet worden bedekt door de analyse die zij
uitvoeren, en gewoonlijk ook om het bereik van de resulterende laag te definiëren.
Wanneer een bereik wordt vereist, kan het handmatig gedefinieerd worden door de vier waarden die het definieert in
te voeren (min X, min Y, max X, max Y), maar er zijn ook meer praktische en interessantere manieren om dat te
doen. We zullen ze allemaal zien in deze les.
Laten we eerst een algoritme openen dat vereist dat een bereik wordt gedefinieerd. Open het algoritme Rasterize, wat
een rasterlaag uit een vectorlaag maakt.
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Alle parameters, met uitzondering van de laatste twee, worden gebruikt om te definiëren welke laag moet worden
omgezet naar een raster, en configureren hoe het proces van het omzetten naar raster zou moeten werken. De twee
laatste parameters, aan de andere kant, definiëren de karakteristieken voor de uitvoerlaag. Dat betekent dat zij het
gebied definiëren dat wordt bedekt (wat niet noodzakelijkerwijze hetzelfde gebied is als dat wat wordt bedekt door
de invoerlaag), en de resolutie/celgrootte (die niet kan worden afgeleid vanuit de vectorlaag, omdat vectorlagen geen
celgrootten hebben).
Het eerste dat u kunt doen is de 4 waarden voor de definitie, zoals hierboven besproken, in te typen, gescheiden door
komma’s.

Dat behoeft geen nadere extra uitleg. Hoewel dit de meest flexibele optie is, is het in sommige gevallen ook minder
praktisch, en dat is waarom ander opties werden geïmplementeerd. U moet op de knop aan de rechterkant van het
tekstvak voor het bereik klikken om daar toegang toe te krijgen.

Laten we eens kijken wat elk ervan doet.
De eerste optie is Use layer/canvas extent, wat het dialoogvenster voor selectie zal weergeven dat hieronder staat.
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Hier kunt u het bereik voor het kaartvenster selecteren (het bereik dat wordt bedekt door de huidige zoom), of het
bereik van elk van de beschikbare lagen. Selecteer het en klik op OK, en het tekstvak zal automatisch worden gevuld
met de overeenkomende waarden.
De tweede optie is Select extent on canvas. In dit geval verdwijnt het dialoogvenster van het algoritme en kunt u in het
kaartvenster van QGIS klikken en slepen om het gewenste bereik te definiëren.

Als u de muisknop weer loslaat zal het dialoogvenster weer verschijnen en zal het tekstvak al de waarden bevatten die
overeenkomen met het gedefinieerde bereik.
De laatste optie is Use min covering extent from input layers, wat de standaard optie is. Dit zal de minimale bedekte
bereik berekenen van alle lagen die gebruikt zullen worden om het algoritme uit te voeren, en er is geen reden om enige
waarde in het tekstvak in te voeren. In het geval van één enkele invoerlaag, zoals in het algoritme dat we uitvoeren,
kan hetzelfde bereik worden verkregen door diezelfde invoerlaag te selecteren in Use layer/canvas extent die we al
eerder zagen. Echter, wanneer er verscheidene invoerlagen zijn, correspondeert het minimale bedekte bereik niet met
enig bereik van de invoerlaag, omdat het uit alle tezamen wordt berekend.
We zullen deze laatste methode gebruiken om ons algoritme voor het omzetten naar raster uit te voeren.
Vul het dialoogvenster voor de parameters zoals hieronder weergegeven en druk op OK.
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Notitie: In dit geval is het beter een Integer (1 byte) te gebruiken in plaats van een Floating point (4 byte), omdat
de NAME een integer is met de maximale waarde=64. Dit zal resulteren in een kleinere bestandsgrootte en snellere
berekeningen.

U zult een rasterlaag verkrijgen die exact het gebied bedekt dat wordt bedekt door de originele vectorlaag.
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In sommige gevallen zou de laatste optie, Use min covering extent from input layers, niet beschikbaar kunnen zijn. Dit
zal gebeuren bij die algoritmen die geen invoerlagen hebben, maar slechts parameters van andere typen. In dat geval
zult u de waarde handmatig moeten invoeren of een van de andere opties gebruiken.
Onthoud dat, wanneer een selectie bestaat, het bereik van de laag dat van de gehele verzameling objecten is, en de
selectie wordt niet gebruikt voor de berekening van het bereik, zelfs hoewel het rasteriseren werd uitgevoerd op alleen
de geselecteerde items. In dat geval wilt u misschien een nieuwe laag maken van de selectie, en die dan gebruiken als
invoer.

17.13 HTML-uitvoer

Notitie: In deze les leren we hoe QGIS uitvoer in de indeling HTML afhandelt, die wordt gebruikt om uitvoer als
tekst en afbeeldingen te produceren.

Alle uitvoer die we tot dusverre hebben geproduceerd waren lagen (zowel raster als vector). Echter, sommige
algoritmen genereren uitvoer in de vorm van tekst en afbeeldingen. Al deze uitvoer wordt verpakt in in HTML-
bestanden en weergegeven in het zogenaamde venster Resultaten, wat een ander element is van het framework
Processing.
Laten we eens naar één van die algoritmen kijken om te begrijpen hoe die werken.
Open het project met de gegevens die in de les moeten worden gebruikt en open dan het algoritme Basic statistics for
numeric fields.
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Het algoritme is nogal eenvoudig, en u hoeft slechts de laag te selecteren die moet worden gebruikt en één veld daarvan
(een numeriek veld). De uitvoer is van het type HTML, maar het overeenkomstige vak werkt exact zoals dat wat u
zult vinden in het geval van een uitvoer als raster of vector. U kunt ofwel een bestandspad invoeren of het leeg laten
om naar een tijdelijk bestand op te slaan. In dit geval, zijn echter alleen de extensies html en htm toegestaan, dus is
er geen manier om de indeling van de uitvoer te wijzigen door een andere te gebruiken.
Voer het algoritme uit door de enige laag in het project als invoer te selecteren, en het veld POP2000, en een nieuw
dialoogvenster zoals dat wat hieronder wordt weergegeven zal verschijnen zodra het algoritme is uitgevoerd en het
dialoogvenster voor de parameters wordt gesloten.
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Dit is het venster Resultaten. Het bevat alle HTML-resultaten die zijn gegenereerd gedurende de huidige sessie,
eenvoudig toegankelijk, dus u kunt ze snel controleren wanneer u ze maar nodig heeft. Net zoals met lagen, als u de
uitvoer hebt opgeslagen naar een tijdelijk bestand, zal het worden verwijderd als u QGIS afsluit. Als u hebt opgeslagen
naar een niet tijdelijk pad, wordt het bestand behouden, maar het zal niet verschijnen in het venster Resultaten als u
de volgende keer QGIS opent.
Sommige algoritmen genereren tekst die niet kan worden opgedeeld in meer gedetailleerde uitvoer. Dat is het geval
als, bijvoorbeeld, het algoritme de tekstuitvoer vastlegt vanuit een extern proces. In andere gevallen wordt de uitvoer
gepresenteerd als tekst, maar wordt intern opgedeeld in verscheidene kleinere uitvoeren, gewoonlijk in de vorm van
numerieke waarden. Het algoritme dat we zojuist hebben uitgevoerd is er daar één van. Elk van deze waarden wordt
afgehandeld als één enkele uitvoer, en opgeslagen in een variabele. Dit heeft op dit moment geen enkel belang, maar als
we eenmaal doorgaan naar Grafische modellen bouwen, zult u zien dat het ons zal toestaan die waarden te gebruiken
als numerieke invoer voor andere algoritmen.

528 Hoofdstuk 17. De QGIS-gids voor Processing



QGIS Training Manual

17.14 Eerste voorbeeld analyse

Notitie: In deze les zullen we enkele echte analyses uitvoeren met behulp van alleen de Toolbox, zodat u meer bekend
raakt met de elementen van het framework Processing.

Nu alles is geconfigureerd en we externe algoritmen kunnen gebruiken, hebben we een zeer krachtig gereedschap om
ruimtelijke analyses uit te voeren. Het is tijd om een wat grotere oefening met gegevens uit de echte wereld uit te
werken.
We zullen de welbekende gegevensset gebruiken die John Snow gebruikte in zijn baanbrekende werk in 1854 (https:
//en.wikipedia.org/wiki/John_Snow_%28physician%29), en we zullen enkele interessante resultaten verkrijgen. De
analyse van deze gegevensset is redelijk helder en er is geen noodzaak voor ingewikkelde GIS-technieken om te
eindigen met goede resultaten en conclusies, maar het is een goede manier om weer te geven hoe deze ruimtelijke
problemen kunnen worden geanalyseerd en opgelost door verschillende gereedschappen van Processing.
De gegevensset bevat shapefiles met choleradoden en pomplocaties, en een OSM gerenderde kaart in de indeling
TIFF. Open het overeenkomstige project van QGIS voor deze les.

Het eerste dat moet worden gedaan is het Voronoi-diagram berekenen (ook bekend als. Thiessen polygonen) van de
laag Pumps, om de zone van invloed voor elke pomp te verkrijgen. Het algoritme Voronoi Diagram kan daarvoor
worden gebruikt.
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Redelijk eenvoudig, maar het geeft ons al interessante informatie.
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Duidelijk, de meeste gevallen liggen binnen een van de polygonen
We kunnen het aantal doden in elk polygoon tellen om een meer kwantitatief resultaat te verkrijgen,. omdat elk
punt een gebouw weergeeft waar doden vielen, en het aantal doden is opgeslagen in een attribuut, kunnen we niet
eenvoudigweg de punten tellen. We hebben een gewogen telling nodig, dus zullen we het gereedschap Count points in
polygon (weighted) gebruiken.
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Het nieuwe veld zal DEATHS worden genoemd, en we gebruiken het veld COUNT als het te wegen veld. De
resulterende tabel geeft duidelijk aan dat het aantal doden in de polygoon die overeenkomt met de eerste pomp
veel groter is dan in de andere.
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Een andere goede manier om de afhankelijkheid van elk punt op de laag Cholera_deaths te visualiseren met een
punt in de laag Pumps is om een lijn te tekenen naar het dichtstbijzijnde. Dit kan worden gedaan met het gereedschap
Distance to nearest hub, en de hieronder getoonde configuratie te gebruiken.
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Het resultaat ziet er uit als dit:
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Hoewel het aantal lijnen groter is in het geval van de centrale pomp, vergeet niet dat dit niet het aantal doden weergeeft,
maar het aantal locaties waar choleragevallen werden aangetroffen. Het is een representatieve parameter, maar het
houdt geen rekening met het feit dat sommige locaties meer gevallen zouden kunnen hebben dan andere.
Een laag voor dichtheid zal ons ook een zeer helder beeld geven van wat er gebeurt. We kunnen die maken met het
algoritme Kernel density. Door de laag Cholera_deaths te gebruiken, het veld COUNT daarvan als veld om te wegen,
met een straal van 100, het bereik en de celgrootte van de rasterlaag Streets, krijgen we zoiets als dit.
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Onthoud dat, om het bereik voor uitvoer te krijgen, u die niet hoeft in te voeren. Klik op de knop aan de rechterkant
en selecteer Use layer/canvas extent.
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Selecteer de rasterlaag Streets en het bereik daarvan zal automatisch worden toegevoegd aan het tekstveld. U moet
hetzelfde doen voor de celgrootte, door ook de celgrootte van die laag te selecteren.
Door dit te combineren met de laag Pumps, zien we dat er slechts één pomp duidelijk in de hotspot ligt waar de
maximale dichtheid van dodelijke gevallen is gevonden.

17.15 Rasterlagen clippen en samenvoegen

Notitie: In deze les zullen we een ander voorbeeld van ruimtelijke voorbereiding zien, om het gebruiken van geo-
algoritmen in scenario’s van de echte wereld te vervolgen.

Voor deze les gaan we een hellingslaag berekenen voor een gebied dat een stedelijk gebied omsluit, wat is opgegeven
in een vectorlaag met één enkele polygoon. De basis DEM is opgedeeld in twee rasterlagen die, tezamen, een veel
groter gebied bedekken dan dat rondom de stad waarmee we willen werken. Als u het project opent dat overeenkomt
met deze les, zult u iets zoals dit zien.
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Deze lagen hebben twee problemen:
• Zij bedekken ene gebied dat veel te groot is voor wat we willen (we zijn geïnteresseerd in een kleinere regio
rondom het centrum van de stad)

• Zij staan in twee verschillende bestanden (de stadsgrenzen vallen precies binnen één enkele rasterlaag, maar,
zoals gezegd, we willen er wat extra gebied rondom bij).

Beide zijn eenvoudig op te lossen met behulp van de toepasselijke geo-algoritmen.
Eerst willen we een rechthoek maken die het gebied definieert dat we willen. We maken, om dit te doen, een laag
die het begrenzingsvak van de laag met de grenzen van het stedelijk gebied bevat, en dan bufferen we die, om een
rasterlaag te verkrijgen die iets meer bedekt dan strikt noodzakelijk.
We kunnen het algoritme Polygon from layer extent gebruiken om het begrenzingsvak te berekenen.
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We gebruiken het algoritme Fixed distance buffer, met de volgende waarden voor de parameters om het te bufferen.
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Waarschuwing: Syntaxis is in recente versies gewijzigd; stel zowel Afstand als Boogpunt in op .25

Hier is het resulterende begrenzingsvak dat is verkregen met behulp van de hierboven weergegeven parameters

Het is een afgerond vak, maar we kunnen eenvoudig het equivalente vak met vierkante hoeken verkrijgen door het
algoritme Polygon from layer extent er op uit te voeren. We zouden eerst de stadsgrenzen hebben kunnen bufferen,
en dan de rechthoek van het bereik berekenen, wat ons één stap bespaart.

Het zal u opvallen dat de rasters een verschillende projectie dan de vector hebben. We zouden ze daarom opnieuw
moeten projecteren, met behulp van het gereedschapWarp (Herprojecteren), voordat we verder gaan.
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Notitie: Recente versies hebben een meer complexe interface. Zorg er voor dat tenminste één methode voor
compressie is geselecteerd.

Met deze laag, die het begrenzingsvak bevat van de rasterlaag die we willen verkrijgen, kunnen we beide rasterlagen
bijsnijden, met behulp van het algoritme Clip raster with polygons.
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Als de lagen eenmaal zijn bijgesneden, kunnen zij worden samengevoegd met behulp van het algoritme van SAGA
Mosaic raster layers.
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Notitie: Ukunt tijd besparen door eerst samen te voegen en dan bij te snijden, en u zult voorkomen dat u het algoritme
voor clippen tweemaal moet aanroepen. Als er echter meerdere lagen zijn die moeten worden samengevoegd en zij
zijn van een nogal aanzienlijke grootte, dan zult u eindigenmet een grote laag die later misschienmoeilijk te verwerken
is. In dat geval dient u misschien het algoritme voor clippen meerder malen aan te roepen, wat tijd zou kunnen vergen,
maar maak u geen zorgen, we zullen snel zien dat er enkele aanvullende gereedschappen zijn om die bewerking te
automatiseren. In dit voorbeeld hebben we slechts twee lagen, dus u zou zich daar nu geen zorgen over moeten maken.

Daarmee krijgen we de uiteindelijke DEM die we willen.
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Nu is het tijd om de hellingslaag te berekenen.
Een hellingslaag kan worden berekendmet het algoritme Slope, Aspect, Curvature, maar de in de laatste stap verkregen
DEM is niet geschikt als invoer, omdat de waarden voor de hoogte in meters zijn, maar de celgrootte is niet uitgedrukt
inmeters (de laag gebruikt eenCRSmet geografische coördinaten). Opnieuw projecteren is nodig. Het algoritmeWarp
(herprojecteren) kan opnieuwworden gebruikt om een rasterlaag opnieuw te projecteren.We projecteren opnieuw naar
een CRSmet meters als eenheden (bijv. 3857), zodat we daarna de helling correct kunen berekenen, met ofwel SAGA
of GDAL.
Met de nieuwe DEM kan de helling nu worden berekend.
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En hier is de uiteindelijke hellingslaag.
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De door het algoritme Slope, Aspect, Curvature geproduceerde helling kan worden uitgedrukt in graden of radialen,
maar graden zijn eenmeer praktische en algemenere eenheid. In het geval u het berekende in radialen zal het algoritme
Metric conversions zal ons helpen de conversie uit te voeren (maar voor het geval u niet wist dat dat algoritme bestond,
kunt u de Raster calculator gebruiken die we al eerder hebben gebruikt).
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We krijgen de uiteindelijke laag die we willen door de geconverteerde hellingslaag opnieuw terug te projecteren met
Reproject raster layer.

Waarschuwing: todo: Afbeelding toevoegen

De processen voor opnieuw projecteren zouden er voor hebben kunnen zorgen dat de uiteindelijke laag gegevens bevat
die buiten het begrenzingsvak liggen dat we in een van de eerste stappen hebben berekend. Dit kan worden opgelost
door het opnieuw te clippen, zoals we hebben gedaan om de basis DEM te krijgen.

17.16 Hydrologische analyse

Notitie: In deze les zullen we een hydrologische analyse uitvoeren. Deze analyse zal worden gebruikt in enkele van
de volgende lessen, omdat het bestaat uit een goed voorbeeld van een werkstroom voor een analyse, en we het zullen
gebruiken voor het demonstreren van enkele geavanceerde mogelijkheden.

Doelen: Beginnend met een DEM, zullen we een netwerk van kanalen gaan uitnemen, waterbergingen uittekenen en
enkele statistieken berekenen.

1. Het eerste is om het project te laden met de gegevens voor de les, wat slechts een DEM bevat.
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2. De eerste module die moet worden uitgevoerd is Catchment area (in sommige versies van SAGA wordt hij
Flow accumulation (Top Down) genoemd). U kunt elk van de andere, genaamd Catchment area, gebruiken. Zij
hebben verschillende onderliggende algoritmes, maar de resultaten zijn in de basis hetzelfde.

3. Selecteer de DEM in het veld Elevation, en laat de rest van de parameters staan op de standaardwaarden.
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Sommige algoritmen berekenen vele lagen, maar de laag Catchment Area is de enige die we zullen gebruiken.
U kunt de andere verwijderen als u dat wilt.
Het renderen van de laag is niet erg informatief.
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U kunt, om te weten waarom, naar het histogram kijken en u zult zien dat de waarden niet evenredig zijn
verdeeld (er zijn enkele cellen met een zeer hoge waarde, die welke overeenkomen met het netwerk van
kanalen). Gebruik het algoritme Raster calculator om de logaritme te berekenen van de waarde van het
opvanggebied en u zult een laag met veel mer informatie krijgen.
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4. Het opvanggebied (ook bekend als flow accumulation), kan worden gebruikt om een drempel in te stellen voor
het initiëren van kanalen. Dit kan worden gedaan met behulp van het algoritme Channel network.

• Initiation grid: gebruik de laag Catchment Area en niet die van de logaritme.
• Initiation threshold: 10.000.000
• Initiation type: Greater than

Als u de waarde Initiation threshold verhoogt, zult u een schaarser netwerk van kanalen verkrijgen. Als u het
verlaagt, zult u een dichter verkrijgen. Dit is wat u krijgt met de voorgestelde waarde.
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De afbeelding hierboven geeft slechts de resulterende vectorlaag en de DEM weer, maar er zou ook een
rasterlaag moeten zijn met hetzelfde netwerk van kanalen. Die rasterlaag zal, in feite, de laag zijn die we zullen
gaan gebruiken.

5. Nu zullen we het algoritmeWatersheds basins gaan gebruiken om de subbassins uit te tekenen die overeenkomen
met dat netwerk van kanalen, waarbij we alle kruisingen daarin gebruiken als uitlaatpunt. Hier staat hoe u het
overeenkomende dialoogvensters met parameters moet instellen.
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En dit is wat u zult krijgen.
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6. Dit is een resultaat als raster. U kunt het vectoriseren met het algoritme Vectorising grid classes.
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Laten we nu eens proberen statistieken te berekenen over de hoogtewaarden in één van de subbassins. Het idee is om
een laag te krijgen die slechts de hoogte binnen dat subbassin weergeeft en die dan doorgeeft naar de module die die
statistieken berekent.

1. Laten we eerst de originele DEM clippen met de polygoon die een subbassin weergeeft. We zullen het algoritme
Clip raster with polygon gebruiken. Als we één enkele polygoon voor een subbassin selecteren en dan het
algoritme voor het clippen aanroepen, kunnen we de DEM clippen tot het gebied dat wordt bedekt door die
polygoon, omdat het algoritme zich bewust is van de selectie.
1. Selecteer een polygoon
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2. Roep het algoritme om te clippen aan met de volgende parameters:
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Het geselecteerde element in het invoerveld is, natuurlijk, de DEM die we willen clippen.
U zult iets krijgen zoals dit.

2. Deze laag is gereed om te worden gebruikt in het algoritme Raster layer statistics.
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De resulterende statistieken zijn de volgende.

We zullen zowel de procedure voor het berekenen van het bassin gebruiken als de berekeningen voor statistieken uit
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andere lessen, om uit te zoeken hoe andere elementen ons kunnen helpen om beide te automatiseren en meer effectief
te werken.

17.17 Beginnen met Grafische modellen bouwen

Notitie: In deze les zullen we Grafische modellen bouwen gebruiken, een krachtige component die we kunnen
gebruiken om een werkstroom te definiëren en een reeks algoritmen uit te voeren.

Een normale sessie met de gereedschappen voor Processing omvat meer dan het uitvoeren van één enkel algoritme.
gewoonlijk worden verscheidene ervan uitgevoerd om een resultaat te krijgen, en de uitvoer van sommige van die
algoritmen worden gebruikt als invoer voor sommige van de andere.
Door het gebruiken van Grafische modellen bouwen kan die werkstroom worden geplaatst in een model, wat in één
enkele keer alle noodzakelijke algoritmen zal uitvoeren, aldus het gehele proces vereenvoudigend en het automatiseren.
We gaan, om deze les te beginnen, een parameter berekenen, genaamd Topographic wetness index. Het algoritme dat
dit berekent is genaamd Topographic wetness index (twi).

Zoals u kunt zien zijn er twee verplichte invoeren: Slope en Catchment area. Er is ook een optionele invoer, maar die
zullen we niet gebruiken, dus kunnen we die negeren.
De gegevens voor deze les bevat slechts een DEM, dus we hebben geen van de vereiste invoeren. We weten echter
hoe we die beide kunnen berekenen vanuit die DEM, omdat we al algoritmen hebben gezien om de helling en het
opvanggebied te berekenen. We kunnen dus eerst die lagen berekenen en ze dan gebruiken voor het algoritme TWI.
Hier zijn de dialoogvensters voor de parameters die u zou moeten gebruiken om de 2 tussenliggende lagen te
berekenen.
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Notitie: Helling moet worden berekend in radialen, niet in graden.
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En dit is hoe u het dialoogvenster voor de parameters van het algoritme TWI zou moeten instellen.
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Dit is het resultaat dat u zult verkrijgen (het standaard geïnverteerde palet enkelband pseudokleur is gebruikt voor het
renderen). U kunt de verschafte stijl twi.qml gebruiken.
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Wat we nu zullen proberen te doen is om een algoritme te maken dat de TWI berekent vanuit een DEM in slechts één
enkele stap. Dat zal ons werk besparen voor het geval we later een laag TWI moeten berekenen uit een andere DEM,
omdat we slechts één stap nodig hebben om het te doen in plaats van de drie bovenstaande. Alle processen die we
nodig hebben zijn te vinden in de Toolbox, dus wat we moeten doen is de werkstroom definiëren om ze te verpakken.
Dat is waar Grafische modellen bouwen van pas komt.

1. Open Grafische modellen bouwen door het menuitem daarvan te selecteren in het menu Processing.

Twee dingen zijn nodig om een model te maken: de benodigde invoer instellen en het algoritme definiëren dat
het bevat. Beide worden gedaan door elementen toe te voegen uit de twee tabs aan de linkerkant van het venster
Grafische modellen bouwen: Invoer en Algoritmes.

2. Laten we beginnen met de invoer. In dit geval hebben we niet veel toe te voegen. We hebben slechts een
rasterlaag nodig met de DEM en dat zullen onze enige gegevens voor invoer zijn.

3. Dubbelklik op de invoer Raster layer en u zult het volgende dialoogvenster zien.
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4. Hier moeten we de invoer definiëren die we willen:
1. Omdat we verwachten dat deze rasterlaag een DEM zal zijn, zullen we die DEM noemen. Dat is de naam

die de gebruiker van het model zal zien bij het uitvoeren.
2. We zullen het definiëren als een vereiste laag, omdat we die laag nodig hebben om te kunnen werken.

Hier is hoe het dialoogvenster zou moeten zijn geconfigureerd.

5. Klik op OK en de invoer zal verschijnen in het kaartvenster van Grafische modellen bouwen.

6. Laten we nu naar de tab Algoritmes gaan.
7. Het eerste algoritme dat we moeten uitvoeren is het algoritme Slope, aspect, curvature. Zoek het op in de lijst

met algoritmes, dubbelklik erop en u zult het dialoogvenster zien dat hieronder wordt weergegeven.
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Dit dialoogvenster lijkt erg op dat wat u krijgt als u het algoritme uitvoert vanuit de Toolbox, maar het element
dat u kunt gebruiken als waarde voor de parameters worden niet uit het huidige project van QGIS genomen,
maar vanuit het model zelf. Dat betekent dat, in dit geval, we niet alle rasterlagen van ons project beschikbaar
hebben voor het veld Elevation, maar slechts die welke zijn gedefinieerd in ons model. Omdat we slechts één
enkele rasterinvoer hebben toegevoegd, genaamd DEM, zal dat de enige rasterlaag zijn die we zullen zien in de
lijst die correspondeert met de parameter Elevation.
Uitvoer gemaakt door een algoritme wordt een beetje anders afgehandeld als het algoritme wordt gebruikt
als deel van een model. In plaats van het bestandspad te selecteren waar u elke uitvoer wilt opslaan, hoeft
u slechts te specificeren dat de uitvoer een tussenliggende laag is (en dat u het niet wilt behouden nadat het
model is uitgevoerd), of dat het het uiteindelijke is. In dit geval zijn alle door dit algoritme geproduceerde lagen
tussenliggende. We zullen er slechts één van gebruiken (de hellingslaag), maar we willen die niet behouden,
omdat we die slechts nodig hebben om de laag TWI te berekenen, die het uiteindelijke resultaat is dat we willen
verkrijgen.
Wanneer lagen geen uiteindelijk resultaat zijn, zou u het corresponderende veld moeten laten zoals het is.
Anders moet u een naam invoeren die zal worden gebruikt om de laag te identificeren in het dialoogvenster
voor de parameters dat zal worden weergegeven wanneer u het model later uitvoert.

8. Er is niet veel te selecteren in dit eerste dialoogvenster, omdat we slechts één laag in ons model hebben (De
invoer DEM die we gemaakt hebben). In feite is de standaard configuratie van het dialoogvenster in dit geval de
juiste, dus u hoeft alleen maar op OK te drukken. Dit is wat u nu zult hebben in het kaartvenster van Grafische
modellen bouwen.
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9. Het tweede algoritme dat we moeten toevoegen aan ons model is het algoritme Catchment area. We zyllen
het algoritme, genaamd Catchment area (Paralell) gebruiken. We zullen opnieuw de laag DEM gebruiken als
invoer, en geen van de uitvoeren die het produceert is de uiteindelijke, dus hier is hoe u het overeenkomstige
dialoogvenster in moet vullen.
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Nu zou uw model er zo uit moeten zien.
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10. De laatste stap is om het algoritme Topographic wetness index toe te voegen, met de volgende configuratie.

In dit geval zullen we niet de DEM gebruiken als invoer, maar in plaats daarvan zullen we de lagen voor de
helling en het opvanggebied gebruiken die zijn berekend door de algoritmen die we eerder toevoegden. Als u
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nieuwe algoritmen toevoegt, komt de uitvoer die zij produceren beschikbaar voor andere algoritmen, en door
ze te gebruiken koppelt u de algoritmen, wat de werkstroom maakt.

11. In dit geval is de uitvoerlaag TWI de uiteindelijke laag, dus moeten we dat aangeven. Voer, in het
overeenkomstige tekstvak, de naam in die u wilt hebben weergegeven voor deze uitvoer.
Nu is uw model voltooid en zou er zo uit moeten zien.

12. Voer een naam en een naam voor de groep, in het bovenste gedeelte van het venster Grafischemodellen bouwen,
in.

13. Sla het op door te klikken op de knop Opslaan. U kunt het overal opslaan waar u wilt en het later openen, maar
als u het opslaat in de map Models (wat de map is die u zult zien als het dialoogvenster Opslaan verschijnt), zal
uw model ook in de Toolbox beschikbaar zijn. Blijf dus in die map en sla het model op onder de bestandsnaam
die uw voorkeur heeft.

14. Sluit nu het dialoogvenster Grafische modellen bouwen en ga naar de Toolbox. In het item Models zult u uw
model vinden.
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15. U kunt het net als elk normaal algoritme uitvoeren, door erop te dubbelklikken.

Zoals u kunt zien bevat het dialoogvensters voor de parameters de invoer die u had toegevoegd aan het
model, tezamen met de uitvoer die u als uiteindelijk heeft ingesteld bij het toevoegen van de overeenkomstige
algoritmen.

16. Voer het uit met behulp van de DEM als invoer en u zult de laag TWI in slechts één stap krijgen.

17.18 Meer complexe modellen

Notitie: In deze les zullen we werken met een meer complex model in Grafische modellen bouwen.

Het eerste model dat we hebben gemaakt in het vorige hoofdstuk was een heel eenvoudig, met slechts één invoer
en drie algoritmes. Meer complexe modellen kunnen worden gemaakt, met verschillende typen voor invoer en die
meerdere stappen bevatten. Voor dit hoofdstuk zullen we werken met een model dat een vectorlaag met waterkering
maakt, gebaseerd op eenDEMen een drempelwaarde. Dat zal zeer bruikbaar zijn voor het berekenen van verscheidene
vectorlagen die overeenkomen met verschillende drempelwaarden, zonder elke stap elke keer te hoeven herhalen.
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Deze les bevat geen instructies over hoe uw model te maken. U kent de noodzakelijke stappen al (we zagen ze al in
eerdere les) en u heeft de basisideeën voor het bouwen van modellen al gezien, dus u zou het zelf moeten proberen.
Spendeer een paar minuten aan het proberen te maken van uw eigen model, en maak u geen zorgen over eventuele
fouten die u maakt. Onthoud om eerst de invoer toe te voegen en voeg dan de algoritmes toe die ze gebruiken om de
werkstroom te maken.

Notitie: Voor het geval u het volledige model niet zelf kon bouwen en u heeft wat extra hulp nodig, de map met
gegevens die overeenkomt met deze les bevat een ‘bijna gereed’ voltooide versie ervan. Open Grafische modellen
bouwen en open het bestand van het model dat u zult vinden in de map met gegevens. U zou iets als dit moeten zien.

Dit model bevat alle stappen die nodig zijn om de berekening te voltooien, maar het heeft slechts één invoer: de
DEM. Dat betekent dat de drempel voor de definitie van het kanaal een vaste waarde gebruikt, wat het model niet zo
bruikbaar maakt als zou kunnen. Dat is geen probleem, omdat we het model kunnen bewerken en dat is precies wat
we zullen gaan doen.

1. Laten we als eerste een numerieke invoer toevoegen. Die zal de gebruiker vragen naar een numerieke invoer
die we kunnen gebruiken wanneer een dergelijke waarde nodig is in een van de algoritmes die zijn opgenomen
in ons model.

2. Klik op het item Number in de boom voor de Invoer, en u zult het overeenkomende dialoogvenster zien.
3. Vul het met de volgende waarden.

• Naam parameter: Threshold for channel definition

• Standaardwaarde: 1,000,000
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Uw model zou er nu ongeveer zo uit moeten zien.

De invoer die we zojuist hebben toegevoegd is niet gebruikt, dus is het model in feite niet veranderd. We
moeten die invoer koppelen aan het algoritme dat het gebruikt, in dit geval is dat Channel network. Dubbelklik
eenvoudigweg op het overeenkomstige vak in het kaartvenster om een algoritme, dat al bestaat in Grafische
modellen bouwen, te bewerken.

4. Klik op het algoritme Channel network en u zult iets zien zoals dit.
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Het dialoogvenster is gevuld met de huidige waarden die door het algoritme gebruikt worden. U kunt zien dat
de parameter voor de Initiation threshold een vast waarde heeft van 1.000.000 (dit is ook de standaardwaarde
van het algoritme, maar elke andere waarde kan daar ingevoerd worden). U zou echter kunnen opmerken dat
de parameter niet is ingevoerd in een algemeen tekstvak, maar in een keuzelijst.

5. Vouw het menu voor de parameter drempelwaarde uit en u zult iets zien zoals dit.
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De invoer die we hebben toegevoegd is daar en we kunnen die selecteren. Wanneer een algoritme in een model
een numerieke waarde vereist, kunt u die hard coderen en er direct in typen, of u kunt een van de beschikbare
invoeren en waarden gebruiken (onthoud dat sommige algoritmen single numerieke waarden genereren. We
zullen hier snel meer van zien). In het geval van een parameter string, zult u ook invoer voor tekenreeksen zien
en u u zult in staat zijn er één van te selecteren of de gewenste vaste waarde in te typen.

6. Selecteer de invoer Threshold for channel definition in de parameter Initiation threshold.
7. Klik op OK om de wijzigingen op uw model toe te passen. Nu zou het ontwerp van het model er zo uit moeten

zien.
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8. Het model is nu compleet. Voer het uit met de DEM die we in eerdere lessen hebben gebruikt, en met
verschillende drempelwaarden.
Hieronder staat een voorbeeld van het resultaat dat is verkregen voor verschillende waarden. U kunt het
vergelijken met het resultaat voor de standaardwaarde, wat die is welke we hebben verkregen in de les over
hydrologische analyse.

Fig. 17.1: Threshold = 100.000
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Fig. 17.2: Threshold = 1.0000.000

17.19 Numerieke berekeningen in Grafische modellen bouwen

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: In deze les zullen we zien hoe we numerieke uitvoer gebruiken in Grafische modellen bouwen

Voor deze les gaan we het hydrologische model, dat we en het laatste hoofdstuk maakten, aanpassen (open het
in Grafische modellen bouwen om te beginnen), zodat we de berekening van een geldige drempelwaarde kunnen
automatiseren en we de gebruiker niet hoeven te vragen die in te voeren. Omdat die waarde verwijst naar de variabele
in de drempel rasterlaag, zullen we die uitnemen uit die laag, gebaseerd op enkele eenvoudige statistische analyses.
Laten we, beginnend met het eerder vermelde model, de volgende aanpassingen doen:
Bereken eerst de statistieken van de laag flow accumulation met behulp van het algoritme Raster layer statistics.
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Dit zal een statistische waarden genereren die nu beschikbaar zullen komen voor alle numerieke velden in andere
algoritmen.
Als u het algoritme Channel network bewerkt, zoals we deden in de laatste les, zult u zien dat u nu andere opties heeft,
naast de numerieke invoer die u had toegevoegd.
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Echter, geen van deze waarden is geschikt om te worden gebruikt als geldige drempelwaarde, omdat zij zullen
resulteren in netwerken van kanalen die niet erg realistisch zullen zijn. We kunnen, in plaats daarvan, enkele nieuwe
parameters, daarop gebaseerd, afleiden, om een beter resultaat te verkrijgen. We kunnen bijvoorbeeld het gemiddelde
plus 2 keer de standaard afwijking gebruiken.
We kunnen de calculator gebruiken die u zult vinden in de groep Geoalgorithms/modeler/modeler-tools om een
rekenkundige bewerking toe te voegen. Deze groep bevat algoritmen die niet erg bruikbaar zijn buiten Grafische
modellen bouwen, maar dat verschaft enige bruikbare functionaliteit bij het maken van een model.
Het dialoogvenster voor de parameters van het algoritme Calculator zier er als volgt uit:
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Zoals u kunt zien is het dialoogvenster afwijkend van dat welke we eerder hebben gezien, maar u heeft daar dezelfde
variabelen als die welke beschikbaar waren in het veldThreshold in het algoritmeChannel network. Voer bovenstaande
formule in en klik op OK om het algoritme toe te voegen.

Als u het item voor de uitvoer uitbreidt, zoals hierboven weergegeven, zult u zien dat het model is verbonden met
twee van de waarden, namelijk het gemiddelde en de standaard afwijking, wat die zijn die we in de formule hebben
gebruikt.
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Toevoegen van dit nieuwe algoritme zal een nieuwe numerieke waarde toevoegen. Als u opnieuw naar het algoritme
Channel network gaat, kunt u nu die waarde selecteren in de parameter Threshold.

Klik op OK en uw model zou er nu zo uit moeten zien.
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We gebruiken niet de numerieke invoer die we aan het model hadden toegevoegd, dus die kan worden verwijderd.
Klik er met rechts op en selecteer Remove

Waarschuwing: todo: Afbeelding toevoegen

Ons nieuwe model is nu voltooid.

17.20 Een model binnen een model

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: In deze les zullen we zien hoe we een model gebruiken binnen een groter model.

We hebben al een aantal modellen gemaakt en in deze les gaan we zien hoe we ze kunnen combineren tot één groter.
Ee model gedraagt zich net als alle andere algoritmen, wat betekent dat u een model kunt toevoegen dat u al eerder
heeft gemaakt als deel van een ander dat u daarna maakte.
In dit geval gaan we ons hydrologische model uitbreiden, door het toevoegen van de gemiddelde TWI-waarde in elk
van de bassins die het als resultaat genereert. Wemoeten, om dat te kunnen doen, de TWI uitrekenen en de statistieken
berekenen. Omdat we al een model hebben gemaakt om de TWI vanuit een DEM te berekenen, is het een goed idee
om dat model opnieuw te gebruiken in plaats van de individuele algoritmen toe te voegen die het bevat.
Laten we beginnen met het model dat we gebruikten als beginpunt voor de laatste les.
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Waarschuwing: todo: Afbeelding toevoegen

eerst zullen we het TWI-model toevoegen. het zou, om beschikbaar te kunnen zijn, moeten zijn opgeslagen in de map
Models, omdat het anders niet wordt weergegeven in de Toolbox of de lijst met algoritmen in Grafische modellen
bouwen. Zorg er voor dat het beschikbaar is.
Voeg het toe aan het huidige model en gebruik de invoer DEM als de invoer ervan. De uitvoer is een tijdelijke, want
we willen alleen dat de laag TWI de statistieken berekent. De enige uitvoer van dit model dat we maken is nog steeds
de vectorlaag met de waterbergingen.
Hier is het corresponderende dialoogvenster voor de parameters:

Waarschuwing: todo: Afbeelding toevoegen

Nu we een laag TWI hebben die we kunnen gebruiken naast de vectorlaag met waterbergingen, om een nieuwe te
genereren die de waarden voor de TWI bevat die corresponderen met elke waterberging.
Deze berekening wordt uitgevoerd met het algoritme Grid statistics in polygons. Gebruik de hierboven vermelde lagen
als invoer om het uiteindelijke resultaat te maken.

Waarschuwing: todo: Afbeelding toevoegen

De uitvoer van het algoritme Vectorize grid classes was oorspronkelijk onze uiteindelijke uitvoer, maar nu willen we
het slechts als een tussenliggend resultaat. We moeten het algoritme bewerken om dat te wijzigen. Dubbelklik er
eenvoudigweg op om het dialoogvenster voor de parameters te zien, en verwijder de naam van de uitvoer. Dat zal het
een tijdelijke uitvoer maken, zoals het standaard is.

Waarschuwing: todo: Afbeelding toevoegen

Dit is hoe het uiteindelijke model er uit zou moeten zien:

Waarschuwing: todo: Afbeelding toevoegen

Zoals u ziet is het gebruiken van een model in een ander model niets speciaals, en u kunt het toevoegen net zoals u
een ander algoritme toevoegt, zolang het model is opgeslagen in de map Models en beschikbaar is in de Toolbox.

17.21 Specifiek modelleergereedschap gebruiken om een model
te maken

Notitie: Deze les laat zien hoe enkele algoritmen te gebruiken die alleen beschikbaar zijn in Grafische modellen
bouwen, om aanvullende functionaliteiten te verschaffen aan modellen.

Het doel van deze les is om Grafische modellen bouwen te gebruiken om een algoritme voor interpolatie te maken
dat rekening houdt met de huidige selectie, niet slechts om alleen de geselecteerde objecten te gebruiken, maar om
het bereik van die selectie te gebruiken om de geïnterpoleerde rasterlaag te maken.
Het proces voor interpolatie omvat twee stappen, zoals al eerder is uitgelegd in eerdere lessen: rasteriseren van
de puntenlaag en de waarden geen gegevens vullen die in die gerasteriseerde laag verschijnen. In het geval dat de
puntenlaag een selectie heeft, zullen alleen de geselecteerde punten worden gebruikt, maar als het uitvoerbereik is
ingesteld op automatisch aanpassen, zal het volledige bereik van de laag worden gebruikt. Dat is, het bereik van
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de laag wordt altijd beschouwd als het volledige bereik van alle objecten, niet die welke slechts zijn berekend uit
de geselecteerde. We zullen dat proberen te repareren door enkele aanvullende gereedschappen te gebruiken in ons
model.
Open Grafische modellen bouwen en start het model door de vereiste invoer toe te voegen. In dit geval hebben we
een vectorlaag nodig (beperkt tot punten) en een attribuut ervan, met de waarden die we zullen gebruiken voor het
rasteriseren.

De volgende stap is om het bereik van de geselecteerde objecten te berekenen. Dat is waar we het Specifiek
modelleergereedschap, genaamd Vectorlaag-extent kunnen gebruiken. Eerst zullen we ene laag moeten maken die
het bereik van die geselecteerde objecten heeft. Daarna kunnen we dit gereedschap op die laag gebruiken.
Een gemakkelijke manier om een laag te maken met het bereik van de geselecteerde objecten is om een convex hull
te berekenen van de puntenlaag voor de invoer. Dat zal alleen de geselecteerde punten gebruiken, dus zal de convex
hull hetzelfde begrenzingsvak hebben als de selectie. Daarna kunnen we het algoritme Vectorlaag-extent toevoegen,
en de laag van de convex hull gebruiken als invoer. Het zou er in het venster van Grafische modellen bouwen zo uit
moeten zien:
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Het resultaat van Vectorlaag-extent is een verzameling van vier numerieke waarden en een object Bereik. We zullen
zowel de numerieke uitvoer als het bereik voor deze oefening gebruiken.

We kunnen nu het algoritme toevoegen dat de vectorlaag rasteriseert, met behulp van het bereik van het algoritme
Vectorlaag-extent als invoer.
Vul de parameters van het algoritme in zoals hieronder weergegeven:

584 Hoofdstuk 17. De QGIS-gids voor Processing



QGIS Training Manual

Het venster zou er nu zo uit moeten zien.
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Vul tenslotte de waarden Geen gegevens van de rasterlaag met behulp van het algoritme Close gaps.

Het algoritme is nu klaar om te worden opgeslagen en om te worden toegevoegd aan de Toolbox. U kunt het uitvoeren
en het zal een rasterlaag genereren middels het interpoleren van de geselecteerde punten in de invoerlaag, en de laag
zal hetzelfde bereik hebben als de selectie.
Hier is een verbetering voor het algoritme. We hebben een hard gecodeerde waarde gebruikt voor de grootte van de
cel bij het rasteriseren. Deze waarde is prima voor onze test-invoerlaag, maar dat zou niet zo hoeven zijn in andere
gevallen. We zouden een nieuwe parameter kunnen toevoegen, zodat de gebruiker de gewenste waarde kan invullen,
maar een betere benadering zou zijn om die waarde automatisch te laten berekenen.
We kunnen het Specifiek modelleergereedschap Calculator gebruiken, en die waarde laten berekenen uit de
coördinaten van het bereik. We kunnen, om bijvoorbeeld een laag te maken met een vaste breedte van 100 pixels, de
volgende formule in de Calculator gebruiken.
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Nu moeten we het algoritme voor het rasteriseren bewerken, zodat het de uitvoer van de Calculator gebruikt in plaats
van de hard gecodeerde waarde.
Het uiteindelijke algoritme zou er als volgt uit moeten zien:
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17.22 Interpolatie

Notitie: Dit hoofdstuk geeft weer hoe puntgegevens te interpoleren, en zal u een andere echt voorbeeld tonen van
het uitvoeren van ruimtelijke analyses

In deze les gaan we puntgegevens interpoleren om een rasterlaag te verkrijgen. Vóórdat we dat gaan doen, zullen we
wat voorbereidingen aan de gegevens moeten doen, en na het interpoleren zullen we wat extra verwerking toepassen
om de resulterende laag aan te passen, zodat we een volledige analyseroutine hebben.
Open de voorbeeldgegevens voor deze les, wat er zo uit zou moeten zien.

De gegevens corresponderen met gegevens voor de opbrengst van een oogst, zoals geproduceerd door een moderne
oogstmachine, en we zullen dat gebruiken om een rasterlaag voor de opbrengst van de oogst te verkrijgen. We zijn
niet van plan om nog meer analyses met die laag uit te voeren, maar slechts te gebruiken als een achtergrondlaag om
eenvoudige de meest productieve gebieden te identificeren en ook die waar de productiviteit kan worden verbeterd.
Het eerste om te doen is het opruimen van de laag, omdat het herhalende punten bevat. Deze worden veroorzaakt door
de verplaatsing van de oogstmachine, op plaatsen waar die een bocht moet maken of om enige reden zijn snelheid
wijzigt. Het algoritme Points filter zal hier bruikbaar voor zijn. We zullen het tweemaal gebruiken, om punten te
verwijderen die uitschieters kunnen worden geacht in zowel het bovenste als onderste gedeelte van de verdeling.
Gebruik de volgende waarden voor de parameters bij de eerste uitvoering.
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Gebruik voor de volgende uitvoering de configuratie die hieronder is weergegeven.
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Onthoud dat we niet de originele laag aks invoer gebruiken, maar in plaats daarvan de uitvoer van de eerste uitvoering.
De uiteindelijke gefilterde laag, met een verminderd aantal punten, zou er soortgelijk koeten uitzien als de originele,
maar het bevat een kleiner aantal punten. U kunt dat controleren door hun attributentabellen te vergelijken.
Laten we nu de laag rasterizeren met behulp van het algoritme Rasterize.
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De laag Filtered points verwijst naar de resulterende van het tweede filter. Het heeft dezelfde naam als die welke werd
geproduceerd door het eerste filter, omdat het de naam is die wordt toegewezen door het algoritme, maar u zou de
eerste niet moeten gebruiken. Omdat we die ook niet ergens anders voor gaan gebruiken kunt u hem veilig verwijderen
uit uw project om verwarring te voorkomen, en alleen de laatste gefilterde laag laten staan.
De resulterende rasterlaag ziet er zo uit.
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Het is al een rasterlaag, maar er ontbreken gegevens in enkele van zijn cellen. Het bevat alleen geldige waarden in die
cellen die een punt bevatten uit de vectorlaag die we zojuist gerasteriseerd hebben, en een waarde Geen gegevens in
alle andere. We kunnen het algoritme Close gaps gebruiken om de ontbrekende waarden in te vullen.
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De laag ziet er zo uit zonder zonder waarden Geen gegevens.
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We kunnen de rasterlaag clippen met de verstrekte laag Limits om het gebied dat wordt bedekt door de gegevens te
beperken tot slechts het gebied waar de opbrengst van de oogst werd gemeten.
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En voor een gladder resultaat (minder nauwkeurig maar beter voor het renderen op de achtergrond als een
ondersteuningslaag), kunnen we een Gaussiaans filter op de laag toepassen.
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Met de bovenstaande parameters zult u het volgende resultaat verkrijgen
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17.23 Meer interpolatie

Notitie: Dit hoofdstuk geeft een ander praktisch geval weer waar algoritmen voor interpolatie werden gebruikt.

Interpolatie is een veel voorkomende techniek, en het kan worden gebruikt om verscheidene technieken te
demonstreren die kunnen worden toegepast met behulp van het framework Processing van QGIS. Deze les gebruikt
enkele algoritmen voor interpolatie dia al werden besproken, maar het heeft een andere benadering.
De gegevens voor deze les bevat ook een puntenlaag, in dit geval met hoogtegegevens. We gaan het in grote mate op
dezelfde manier interpoleren zoals we in de eerdere les deden, maar deze keer zullen we een deel van de originele
gegevens opslaan om die te gebruiken om de kwaliteit van het proces van interpolatie te beoordelen.
We moeten eerst de puntenlaag rasterizeren en de resulterende cellen met Geen gegevens vullen, maar met behulp
van slechts een fractie van de punten op de laag. We zullen 10% van de punten opslaan voor een latere controle, dus
moeten we 90% van de punten klaarmaken voor de interpolatie.We zouden, om dat te doen, het algoritme Split shapes
layer randomly kunnen gebruiken, wat we al in een eerdere les hebben gebruikt, maar er is een betere manier om het
te doen, zonder dat we een nieuwe tussenliggende laag zouden moeten maken. In plaats daarvan hoeven we slechts
de punten die we willen gebruiken voor de interpolatie te selecteren (het gedeelte van 90%), en dan het algoritme uit
te voeren. Zoals we al hebben gezien zal het algoritme voor het rasterizeren alleen de geselecteerde punten gebruiken
en de rest negeren. De selectie kan worden gedaan met het algoritme Random selection. Voer dat uit met de volgende
parameters.
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Dat zal 90% van de punten in de laag selecteren om te rasterizeren
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De selectie is willekeurig, dus zou uw selectie af kunnen wijken van de selectie die in bovenstaande afbeelding wordt
weergegeven.
Voer nu het algoritme Rasterize uit om de eerste rasterlaag te krijgen, en voer dan het algoritme Close gaps uit om de
cellen met Geen gegevens te vullen [Celresolutie: 100 m].

We kunnen nu de punten gebruiken die niet zijn geselecteerd om de kwaliteit van de interpolatie te controleren.
Op dit punt weten we de echte hoogte (de waarde in de puntenlaag) en de geïnterpoleerde hoogte (de waarde in de
geïnterpoleerde rasterlaag). We kunnen die twee vergelijken door de verschillen tussen die waarden te berekenen.
Omdat we de punten gaan gebruiken die niet zijn geselecteerd, laten we dus eerst de selectie omdraaien.
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De punten bevatten de originele waarden, maar niet de geïnterpoleerde. We kunnen het algoritme Add raster values
to points gebruiken om ze toe te voegen aan een nieuw veld
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De rasterlaag om te selecteren (het algoritme ondersteunt meerdere rasters, maar we hebben er slechts één nodig) is
de resulterende van de interpolatie. We hebben die hernoemd naar interpolate en die laagnaam is die welke zal worden
gebruikt als naam voor het veld dat zal worden toegevoegd.
Nu hebben we een vectorlaag die beide waarden bevat, met punten die niet werden gebruikt voor de interpolatie.

Nu zullen we Veldcalculator gebruiken voor deze taak. Open het algoritme Field calculator en voer dat uit met de
volgende parameters.
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Als uw veld met de waarden uit de rasterlaag een andere naam heeft, zou u de hierboven vermelde formule
overeenkomstig moeten aanpassen. Door het uitvoeren van dit algoritme zult u een nieuwe laag verkrijgen met
slechts de punten die we niet hebben gebruikt voor de interpolatie, waarvan elk het verschil bevat tussen de twee
hoogtewaarden.
Weergeven van die laag overeenkomstig die waarde zal ons een eerste idee geven over waar de grootste verschillen te
vinden zullen zijn.
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Interpoleren van die laag zal u een rasterlaag geven met de geschatte fout in alle punten van het geïnterpoleerde
gebied.
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U kunt dezelfde informatie (verschil tussen originele puntwaarden en de geïnterpoleerde) ook direct krijgen met
GRASS ► v.sample.
Uw resultaten zouden af kunnen wijken van deze, omdat er een willekeurige component werd geïntroduceerd bij het
uitvoeren van de willekeurige selectie, aan het begin van deze les.

17.24 Herhalend uitvoeren van algoritmen

Notitie: Deze les toont u een andere manier voor het uitvoeren van algoritmen die vectorlagen gebruiken, door ze
herhalend uit te voeren, doorlopend over de objecten in een vectorlaag als invoer

We kennen al Grafische modellen bouwen, wat één manier is van het automatiseren van taken voor Processing. In
sommige situaties zou echter Grafische modellen bouwen niet kunnen zijn wat we nodig hebben om een bepaalde
taak te automatiseren. Laten we eens naar zo’n situatie kijken en hoe eenvoudig die op te lossen is met een andere
functionaliteit: het herhalend uitvoeren van algoritmen.
Open de gegevens die overeenkomen voor dit hoofdstuk. Het zou er zo uit moeten zien.

U zult onze welbekende DEM herkennen uit eerdere hoofdstukken en een daaruit uitgenomen verzameling
waterbergingen. Veronderstel dat u de DEM dient op te delen in verscheidene kleinere lagen, die elk slechts de
hoogtegegevens bevatten van slechts één waterberging. Dat zou handig kunnen zijn als u later enkele parameters wilt
berekenen die gerelateerd zijn aan elke waterberging, zoals de gemiddelde hoogte of de hypsografische curve ervan.
Dit kan een lange en saaie taak zijn, speciaal als het aantal waterbergingen groot is. Het is echter, zoals we zullen
zien, een taak die eenvoudig geautomatiseerd kan worden.
Het algoritme om te gebruiken voor het clippen van een rasterlaag met een polygoonlaag is genaamd Clip raster with
polygons, en heeft het volgende dialoogvenster voor de parameters.
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U kunt het uitvoeren met de lagen van waterbergingen en de DEM als invoer, en u zult het volgende resultaat
verkrijgen.
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Zoals u kunt zien wordt het gebied, dat bedekt is door alle polygonen van de waterbergingen, gebruikt.
U kunt de DEM clippen met slechts één enkele waterberging door de gewenste waterberging te selecteren en dan het
algoritme uit te voeren zoals we eerder deden.

Omdat alleen geselecteerde objecten worden gebruikt, zal alleen de geselecteerde polygoon worden gebruikt om de
rasterlaag bij te snijden.
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Door dit voor alle waterbergingen te doen zal dat het resultaat produceren waar we naar op zoek zijn, maar het lijkt
niet een praktischemanier om het te doen. Laten we, in plaats daarvan, eens zien hoe we die selecteer en snij bij-routine
kunnen automatiseren.
Verwijder als eerste de eerdere selectie, zodat opnieuw alle polygonen zullen worden gebruikt. Open nu het algoritme
Clip raster with polygon en selecteer dezelfde invoer als hiervoor, maar klik deze keer op de knop aan de rechterkant
van de invoer voor de vectorlaag waar u de laag watersheds heeft geselecteerd.

Deze knop zal er voor zorgen dat de geselecteerde invoerlaag zal worden gesplitst in net zoveel lagen als er objecten
in gevonden worden, waarvan elk één enkele polygoon bevat. Daarmee zal het algoritme herhaaldelijk worden
aangeroepen, één keer voor elk van die lagen met één polygoon. Het resultaat, in plaats van slechts één rasterlaag
in het geval van dit algoritme, zal een verzameling rasterlagen zijn, elk corresponderend met één van de uitvoeringen
van het algoritme.
Hier is het resultaat dat u zult krijgen als u het algoritme voor het clippen uitvoert zoals is uitgelegd.
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Voor elke laag wordt het kleurenpalet zwart en wit, (of welk palet u dan ook gebruikt), anders aangepast, van zijn
minimale tot zijn maximale waarden. Dat is de reden waarom u kunt zien dat de onderscheidenlijke stukken en de
kleuren niet lijken overeen te komen met de grenzen tussen de lagen. De waarden komen echter overeen.
Als u een bestandsnaam voor de uitvoer invoert, zullen de resulterende bestanden worden benoemd met behulp van
die bestandsnaam en een getal dat correspondeert met elke iteratie als achtervoegsel.

17.25 Meer herhaalde uitvoering van algoritmen

Notitie: Deze les toont hoe de herhaalde uitvoering van algoritmen te combineren met Grafische modellen bouwen
om meer automatisering te verkrijgen.

De herhaalde uitvoering van algoritmen is niet alleen beschikbaar voor ingebouwde algoritmen, maar ook voor de
algoritmen die u zelf kunt maken, zoals modellen. We gaan zien hoe een model en de herhaalde uitvoering van
algoritmen te combineren, zodat we eenvoudiger meer complexe resultaten kunnen verkrijgen.
De gegevens die we voor deze les gaan gebruiken zijn dezelfde als die we voor de laatste gebruikten. In dit geval,
in plaats van slechts de DEM te clippen met elk polygoon van een waterberging, zullen we enkele extra stappen
toevoegen en een hypsometrische curve berekenen voor elk daarvan, om te bestuderen hoe de hoogte is verdeeld
binnen de waterberging.
Omdat we een werkstroom hebben die verscheidene stappen omvat (clippen + berekenen van de hypsometrische
curve), zouden we naar Grafischemodellen bouwenmoeten gaan en het corresponderendemodel voor die werkstroom
moeten maken.
U vindt het reeds gebouwde model in de map met gegevens voor deze les, maar het zou goed zijn als u het eerst
zelf probeert. De geclipte laag is in dit geval niet een uiteindelijk resultaat, omdat we alleen zijn geïnteresseerd in de
curves, dus dit model zal geen lagen genereren, maar slechts een tabel met de gegevens van de curves.
Het model zou er zo uit moeten zien:
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Voeg het model toe aan uw map met modellen, zodat het beschikbaar is in de Toolbox, en voer het uit.
De DEM en bassins voor waterberging selecteren.
Het algoritme zal tabellen maken voor alle bassins en ze plaatsen in de map voor de uitvoer.
We kunnen dit voorbeeld nog complexer maken door het model uit te breiden en enkele statistieken voor hellingen te
berekenen. Voeg het algoritme Slope toe aan het model en daarna het algoritme Raster statistics, wat de uitvoer voor
de hellingen als enige invoer zou moeten gebruiken.

Als u nu het model uitvoert, zult u, naast de tabellen, een aantal pagina’s met statistieken verkrijgen. Deze pagina’s
zullen beschikbaar zijn in het dialoogvenster Resultaten.
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17.26 De interface Batch-processing

Notitie: Deze les introduceert de interface voor Batch-processing, die het mogelijk maakt één enkel algoritme uit te
voeren met een set van verschillende invoerwaarden.

Soms moet een bepaald algoritme herhaaldelijk worden uitgevoerd met verschillende invoer. Dit is bijvoorbeeld het
geval als een set invoerbestanden moeten worden geconverteerd vanuit de ene indeling naar een andere, of wanneer
verscheidene lagen in een bepaalde projectie moeten worden geconverteerd naar een andere projectie.
In dat geval is het herhaaldelijk aanroepen van het algoritme vanuit de Toolbox niet de beste optie. In plaats daarvan
zou de interface Batch-processing moeten worden gebruikt, die het meerdere malen uitvoeren van een bepaald
algoritme enorm vereenvoudigd. Zoek het in de Toolbox en, in plaats van erop te dubbelklikken, klik met rechts
en selecteer Uitvoeren als batch-proces om een algoritme als een batch-proces uit te voeren,

Voor dit voorbeeld zullen we het algoritme Reproject algorithm gebruiken, dus zoek het op en doe zoals hierboven
beschreven. U zult het volgende dialoogvenster krijgen.

Als u naar de gegevens voor deze les kijkt, zult u zien dat het drie shapefiles bevat, maar geen projectbestand voor
QGIS. Dat is omdat, wanneer een algoritme wordt uitgevoerd als een batch-proces, invoer als lagen kunnen worden
geselecteerd ofwel vanuit het huidige project vanQGIS of vanuit bestanden. Datmaakt het eenvoudiger grote aantallen
lagen te verwerken, zoals, bijvoorbeeld, alle lagen in een bepaalde map.
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Elke rij in het dialoogvenster van Batch-processing vertegenwoordigt één enkele uitvoering van het algoritme. Cellen
in een rij corresponderen met de benodigde parameter voor het algoritme, die niet boven elkaar zijn geschikt zoals in
het normale dialoogvenster voor eenmalige uitvoering, maar horizontaal in die rij.
Definiëren van het uit te voeren batch-proces is er een van het vullen van de tabel met de corresponderende waarden,
en het dialoogvenster zelf bevat verscheidene gereedschappen om deze taak eenvoudiger te maken.
Laten we beginnen met het één voor één vullen van de velden. De eerste kolom om te vullen is die van de Input layer.
In plaats van de namen in te voeren van elk van de lagen die we willen verwerken, kunt u ze allemaal selecteren en het
dialoogvenster er één in elke rij laten plaatsen. Klik op de knop in de cel linksboven, en selecteer in het dialoogvenster
voor bestandsselectie dat zal verschijnen, selecteer de drie bestanden om opnieuw te projecteren. Omdat één ervan
nodig is voor elke rij, zullen de resterende gebruikt worden om de rijen eronder te vullen.

Het standaard aantal rijen is 3, wat exact het aantal lagen is dat we moeten converteren, maar als u meer lagen
selecteert, zullen automatisch nieuwe rijen worden toegevoegd. Als u de items handmatig wilt vullen, kunt u meer
rijen toevoegen met behulp van de knop Add row.
We gaan al deze lagen converteren naar het CRS EPSG:23029, dus moeten we dat CRS selecteren in het tweede veld.
We willen hetzelfde voor alle rijen, dus we hoeven het niet voor elke individuele rij te doen. In plaats daarvan, stel dat
CRS in voor de eerste rij (die bovenaan) met behulp van de knop in de overeenkomstige cel, en dubbelklik dan op de
kolomkop. Dat zorgt er voor dal alle cellen in de kolom worden gevuld met behulp van de waarde in de bovenste cel.
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Tenslotte zullen we een uitvoerbestand moeten selecteren voor elke uitvoering, wat de overeenkomstige opnieuw
geprojecteerde laag zal bevatten. Nogmaals, laten we dat doen voor alleen de eerste rij. Klik op de knop in de
bovenste cel en voer, in een map waar u uw uitvoerbestanden wilt plaatsen, een bestandsnaam in (bijvoorbeeld
reprojected.shp).
Nu, wanneer u op OK klikt in het dialoogvenster voor bestandsselectie, wordt het bestand niet automatisch
weggeschreven naar de cel, maar in plaats daarvan wordt een invoervak weergegeven zoals dat wat hieronder wordt
getoond.

Indien u de eerste optie selecteert zal alleen de huidige cel worden gevuld. Als u een van de andere opties selecteert,
zullen alle rijen daaronder worden gevuld met een bepaald patroon. In dit geval selecteren we de parameter-optie
Vullen met parameterwaarden, en voeren dan de waarde Input Layer in in het keuzemenu eronder. Dat zal er voor
zorgen dat de waarde in Input Layer (dat is de laagnaam) zal worden toegevoegd aan de bestandsnaam die we al
hebben toegevoegd, wat elke bestandsnaam voor de uitvoer anders maakt. De tabel voor het batch-proces zou er nu
zo uit moeten zien.
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De laatste kolom stelt in of de resulterende lagen al dan niet worden toegevoegd aan het huidige project van QGIS
project. Laat de standaard optie Yes staan, zodat u in dit geval uw resultaten kunt zien.
Klik op OK en het batch-proces zal worden uitgevoerd. Als alles goed ging zouden al uw lagen moeten zijn verwerkt
en zouden 3 nieuwe lagen moeten zijn gemaakt.

17.27 Modellen in de interface Batch-processing

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: Deze les toont een ander voorbeeld van de interface Batch-processing, maar deze keer met behulp van een
model in plaats van een ingebouwd algoritme

Modellen zijn hetzelfde als elk ander algoritme, en zij kunnen in de interface Batch-processing worden gebruikt. Hier
is een kort voorbeeld dat we kunnen uitvoeren met ons welbekende reeds bekende hydrologische model om dat te
demonstreren.
Zorg er voor dat u uw model heeft toegevoegd aan uw Toolbox, en voer het dan uit als een batch-proces. Dit is hoe
het dialoogvenster Batch-processing er uit zou moeten zien.

Waarschuwing: todo: Afbeelding toevoegen

Voeg rijen toe tot een totaal van 5. Selecteer het bestand DEM dat correspondeert met deze les als de invoer voor alle
rijen. Voer dan 5 verschillende drempelwaarden in, zoals hieronder weergegeven.
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Waarschuwing: todo: Afbeelding toevoegen

Zoals u ziet kan de interface Batch-processing niet alleen worden uitgevoerd om hetzelfde proces op verschillende
gegevenssets uit te voeren, maar ook op dezelfde gegevensset met verschillende parameters.
Klik op OK en u zou 5 nieuwe lagen moeten krijgen met waterbergingen die corresponderen met de gespecificeerde
5 drempelwaarden.

17.28 Haken voor vóór en na uitvoering van scripts

Notitie: Deze les laat u zien hoe hooks te gebruiken vóór en na uitvoering, die het mogelijk maken aanvullende
bewerkingen uit te voeren vóór en na de feitelijke verwerking.

Hooks vóór en na uitvoering zijn scripts voor Processing die worden uitgevoerd vóór en nadat de feitelijke verwerking
van de gegevens wordt uitgevoerd. Dit kan worden gebruikt om taken te automatiseren die altijd zouden moeten
worden uitgevoerd wanneer een algoritme wordt uitgevoerd.
De syntaxis van de hooks is identiek aan de syntaxis van scripts voor Processing, bekijk het betreffende hoofdstuk in
de QGIS Gebruikersgids voor meer details.
In aanvulling op alle mogelijkheden voor scripts, kunt u in hooks een speciale globale variabele genaamd alg
gebruiken, die staat voor het algoritme dat zojuist is (of zal worden) uitgevoerd.
Hier is een voorbeeld voor een script voor na uitvoering. Standaard slaat Processing resultaten van analyses op in
tijdelijke bestanden. Dit script zal de uitvoer kopiëren naar een specifieke map, dus zullen zij niet worden verwijderd
bij het sluiten van QGIS.

import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = '/home/alex/outputs'

for output in alg.outputs:
if isinstance(output, (OutputVector, OutputRaster, OutputFile)):

dirname = os.path.split(output.value)[0]
shutil.copytree(dirname, MY_DIRECTORY)

In de eerste twee regels importeren we de vereiste pakketten van Python: os— voor manipulaties aan het pad, bijv.
het uitnemen van de bestandsnaam, en shutil— voor verscheidene bewerkingen voor het bestandssysteem zoals
het kopiëren van bestanden. In de derde regel importeren we uitvoer van Processing. Dit zal later meer in detail in
deze les worden uitgelegd.
Daarna definiëren we een constante MY_DIRECTORY, die het pad is naar de map waar we de resultaten van de
analyses naartoe willen kopiëren.
Aan het einde van het script staat de hoofdcode voor de hook. In de loop gaan we door alle uitvoer van het algoritme
en controleren of deze uitvoer een uitvoer is die op een bestand is gebaseerd en of die kan worden gekopieerd. Als dat
zo is bepalen we de map op het hoogste niveau waarin de bestanden zijn opgeslagen en kopiëren dan alle bestanden
naar onze map.
We moeten, om deze hook te activeren, de opties van Processing te openen, het item Na-uitvoering script in de groep
Algemeen, en daar de naam specificeren van het script van de hook. de gespecificeerde hook zal na elk algoritme van
Processing worden uitgevoerd.
Op dezelfde manier kunnen we hooks vóór uitvoering implementeren. Laten we bijvoorbeeld een hook maken om
invoervectoren voor fouten in geometrieën te controleren.
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from qgis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

for param in alg.parameters:
if isinstance(param, ParameterVector):

layer = processing.getObject(param.value)
for f in layer.getFeatures(QgsFeatureRequest().setSubsetOfAttributes([])):

errors = f.geometry().validateGeometry()
if len(errors) > 0:

progress.setInfo('One of the input vectors contains invalid␣
↪→geometries!')

Net als in het vorige voorbeeld importeren we eerst de vereiste pakketten voor QGIS en Processing.
Daarna gaan we door alle parameters van het algoritme en als een parameter ParameterVector wordt gevonden, halen
we we het daarbij behorende object van de vectorlaag op. We lopen door alle objecten van de laag en controleren ze
op fouten in de geometrie. Als tenminste één object een ongeldige geometrie bevat, drukken we een waarschuwing
af.
We moeten, om deze hook te activeren, de optie Vóór-uitvoering script te openen in het dialoogvenster voor
configuratie van Processing. De hook zal vóór het uitvoeren van elk algoritme van Processing worden uitgevoerd.

17.29 Andere programma’s

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe aanvullende programma’s kunnen worden gebruikt vanuit Processing. U moet,
om het te voltooien, de relevante pakketten, met de gereedschappen van uw besturingssysteem, hebben geïnstalleerd.

17.29.1 GRASS

GRASS is een gratis en open bron softwarepakket voor GIS voor het beheren van geo-ruimtelijke gegevens en
analyses, verwerking van afbeeldingen, productie van afbeeldingen en kaarten, ruimtelijk modelleren en visualisatie.
Het wordt standaard geïnstalleerd op Windows door middel van het OSGeo4W zelfstandige installatiepakket (32 en
64 bit), en het is verpakt voor alle grote distributies van Linux.

17.29.2 R

R is een gratis en open bron software-omgeving voor statistische berekeningen en grafieken.
Het moet afzonderlijk worden geïnstalleerd, samen met een aantal noodzakelijke bibliotheken (LIST). De plug-in
Processing R Provider moet ook zijn geïnstalleerd om het gebruiken van R in QGIS in te schakelen.
Het mooie van de implementatie van Processing is dat u uw eigen scripts kunt toevoegen, eenvoudige of complexe,
en dat zij dan kunnen worden gebruikt net als elke andere module, gepiped in meer complexe werkstromen, etc.
Test enkele van de reeds geïnstalleerde voorbeelden als u R al heeft geïnstalleerd (vergeet niet de modules van R te
activeren in de configuratie General van Processing).
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17.29.3 Andere

LASTools is een verzameling, gemend vrije en merkgebonden, opdrachten om gegevens van LiDAR te verwerken en
te analyseren. De beschikbaarheid varieert in de verschillende besturingssystemen.
Meer gereedschappen zijn beschikbaar door middel van aanvullende plug-ins, bijv.:

• LecoS: een pakket voor statistieken van landgebruik en ecologie van landschappen
• lwgeom: eerder deel van PostGIS, deze bibliotheek bevat een aantal bruikbare gereedschappen voor het
opknappen van geometrie

• Animove: gereedschappen om het leefbereik van dieren te analyseren.
Er zullen er nog meer komen.

17.29.4 Vergelijking tussen programma’s

Buffers en afstanden

Laten we points.shp laden en typ buf in het filter van de Toolbox, dubbelklik dan op:
• Fixed distance buffer: Distance 10000
• Variable distance buffer: veld Distance SIZE
• v.buffer.distance: distance 10000
• v.buffer.column: bufcolumn SIZE
• Shapes Buffer: fixed value 10000 (uitnemen en niet), attribuutveld (met schaal)

Zie hoe de snelheid nogal verschilt en hoe de verschillende opties beschikbaar zijn.
Oefening voor de lezer: zoek de verschillen in de uitvoer van geometrie tussen de verschillende methoden.
Nu, buffers en afstanden voor rasters:

• Laad eerst en rasteriseer de vector rivers.shp met GRASS ► v.to.rast.value; LET OP: celgrootte moet
worden ingesteld op 100 m, anders zal de berekeningstijd enorm zijn; de resulterende kaart zal 1-en en NULL-
en hebben

• hetzelfde met SAGA ► Shapes to Grid ► COUNT (resulterende kaart: 6 tot en met 60)
• dan proximity (value= 1 voor GRASS, een lijst met rivers ID voor SAGA), r.buffer met parameters
1000,2000,3000, r.grow.distance (de eerste van de twee kaarten, de tweede zal de gebieden weergeven die
tot elke rivier behoren, indien uitgevoerd op het raster van SAGA).

Uitnemen

Neem objecten uit, gebaseerd op een gemeenschappelijk attribuut:
• GRASS ► v.dissolve municipalities.shp op PROVINCIA
• QGIS ► Dissolve municipalities.shp op PROVINCIA
• OGR ► Dissolve municipalities.shp op PROVINCIA
• SAGA► Polygon Dissolve municipalities.shp op PROVINCIA (NB: Keep inner boundariesmoet niet
zijn geselecteerd)

Notitie: De laatste is defect in SAGA <=2.10

Oefening voor de lezer: zoek de verschillen (geometrie en attributen) tussen de verschillende methoden.
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17.30 Interpolatie en contouren

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe verschillende programma’s te gebruiken om verschillende interpolaties te
berekenen.

17.30.1 Interpolatie

Het project toont een kleurverloop voor regenval, van zuid naar noord. Laten we verschillende methoden gebruiken
voor interpoleren, alle gebaseerd op de vector points.shp, parameter RAIN:

Waarschuwing: Stel de celgrootte voor alle analyses in op 500.

• GRASS ► v.surf.rst

• SAGA ► Multilevel B-Spline Interpolation

• SAGA► Inverse DistanceWeighted [Inverse distance to a power; Power: 4; Search radius: Global; Search range:
all points]

• GDAL ► Grid (Inverse Distance to a power) [Power:4]
• GDAL ► Grid (Moving average) [Radius1&2: 50000]

Meet dan de variatie tussen de methoden en correleer die met de afstanden tot de punten:
• GRASS ► r.series [Unselect Propagate NULLs, Aggregate operation: stddev]
• GRASS ► v.to.rast.value op points.shp
• GDAL ► Proximity

• GRASS ► r.covar om de correlatie-matrix weer te geven; controleer de significantie van de correlatie
bijvoorbeeld met http://vassarstats.net/rsig.html.

Dus, gebieden ver van punten zullen minder nauwkeurige interpolatie hebben.

17.30.2 Contour

Verscheidene methoden om contourlijnen te tekenen [altijd stap= 10] op het raster stddev:
• GRASS ► r.contour.step

• GDAL ► Contour

• SAGA► Contour lines from grid [NB: in sommige oudere versies van SGA is output shp niet geldig, onbekend
probleem]
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17.31 Vereenvoudigen van vectoren en gladder maken

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk toon hoe vectoren te vereenvoudigen en scherpe hoeken gladder te maken.

Soms hebben we een vereenvoudigde versie van een vector nodig, om een kleinere bestandsgrootte te krijgen en
onnodige details weg te laten. Vele gereedschappen doen dit op een nogal ruwe manier, en missen de aansluitingen en
soms de topologische juistheid van polygonen. GRASS is het ideale gereedschap hiervoor: omdat het een topologisch
GIS is worden aansluitingen en juistheid behouden zelfs op hele hoge niveaus van vereenvoudiging. In ons geval
hebben we een vector die resulteert vanuit een raster, waardoor een “zaag”-patroon aan de randen wordt weergegeven.
Toepassen van een vereenvoudiging resulteert in rechte lijnen:

• GRASS ► v.generalize [Maximale tolerantie waarde: 30 m]
We kunnen ook het tegenovergestelde doen en een laag meer complex maken, scherpe hoeken gladder makend:

• GRASS ► v.generalize [methode: chaiken]
Probeer deze tweede opdracht toe te passen op zowel de originele vector als op die uit de eerste analyse, en zie het
verschil. Merk op dat de aansluitingen niet verloren zijn gegaan.
Deze tweede optie kan worden toegepast op bijv. contourlijnen die resulteren vanuit een grof raster, op GPS-sporen
met weinig punten, etc.

17.32 Zonnepanelen plannen

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk toont hoe verscheidene criteria te gebruiken om de geschikte gebieden vast te stellen voor
een fotovoltaïsche elektriciteitscentrale

Ten eerste, maak een kaart van het aspect vanuit DTM:
• GRASS ► r.aspect [Data type: int; cell size:100]

In GRASS wordt aspect berekend in graden, tegen de wijzers van de klok beginnend vanuit het oosten. We kunnen
het opnieuw classificeren om alleen hellingen uit te nemen die uitkijken op het zuiden (270 graden +- 45):

• GRASS ► r.reclass

met de volgende regels:

225 thru 315 = 1 south
* = NULL

U kunt het verschafte tekstbestand reclass_south.txt gebruiken. Onthoud dat we met deze eenvoduige
tekstbestanden ook zeer complexe opnieuw uitgevoerde classificaties kunnen maken.
We willen een grote centrale bouwen, dus selecteren we alleen grote (> 100 ha) aaneengesloten gebieden:

• GRASS ► r.reclass.greater

Tenslotte converteren we naar een vector:
• GRASS ► r.to.vect [Feature type: area; Smooth corners: yes]

Oefening voor de lezer: herhaal de analyse, vervang de opdrachten voor GRASS door analoge voor andere
programma’s.
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17.33 Scripts van R gebruiken in Processing

Module bijgedragen door Matteo Ghetta - mogelijk gemaakt door Scuola Superiore Sant’Anna
Processing (met de plug-in Processing R Provider) maakt het mogelijk scripts voor R te schrijven en uit te
voeren binnen QGIS.

Waarschuwing: R moet zijn geïnstalleerd op uw computer en het PATH moet correct zijn ingesteld. Meer nog,
Processing roept eenvoudigweg de externe pakketten van R aan, het kan ze niet installeren. Zorg er dus voor de
externe pakketten direct in R te installeren. Bekijk het gerelateerde hoofdstuk in de gebruikershandleiding.

Notitie: Als u problemen met pakketten heeft, zijn die misschien gerelateerd aan ontbrekende voorgeschreven
pakketten die zijn vereist door Processing, zoals sp, rgdal en raster.

17.33.1 Scripts toevoegen

Toevoegen van een script is eenvoudig. De gemakkelijkste manier is om de Toolbox van Processing te openen en te
kiezen voor Create new R script… uit het menu R (gelabeld met een pictogram R) aan de bovenzijde van de Toolbox
van Processing. U kunt bijvoorbeeld ook het script maken in een tekstbewerker en het opslaan in uw map voor R-
scripts (processing/rscripts). Als het daar werd opgeslagen, zal het beschikbaar zijn voor bewerken door
met rechts te klikken op de naam van het script in de Toolbox van Processing en dan te kiezen Script bewerken…).

Notitie: Indien u R niet ziet in Processing, dient u het te activeren via Processing ► Opties ► Providers

Het opent een venster voor bewerken van scripts waarin u enkele parameters moet specificeren vóórdat u de tekst va
het script kunt toevoegen.
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17.33.2 Plots maken

In deze handleiding gaan we een boxplot maken van een veld van een vectorlaag.
Open het project van QGIS r_intro.qgs in de map exercise_data/processing/r_intro/.

Parameters voor scripts

Open de bewerker en begin met het schrijven aan het begin ervan.
U moet enkele parameters specificeren vóór de tekst van het script:

1. De naam van de groep (plots in dit geval) waarin u uw script wilt plaatsen (als de groep niet bestaat, zal die
worden gemaakt):

##plots=group

U zult uw script terugvinden in de R groep plots in de Toolbox van Processing.
2. U moet Processing vertellen dat u een plot wilt weergeven (voor dit voorbeeld):

##showplots

U zult dan een koppeling vinden naar het plot in het paneel Resultaten bekijken (kan worden in- /
uitgeschakeld in Beeld ► Panelen en met Processing ► Resultaten bekijken).

3. U dient Processing ook over uw invoergegevens te vertellen. In dit voorbeeld willen we een plot maken uit een
veld van een vectorlaag:

##Layer=vector

Processing weet nu dat de invoer een vector is. De naam Laag is niet belangrijk, wat van belang is is de
parameter vector.

4. Tenslotte moet u het invoerveld van de vectorlaag specificeren (gebruik de naam die u hierboven opgaf - Laag):

##X=Field Layer

Processing weet nu dat u een veld Laag nodig hebt, en dat u het X wilt noemen.
5. Het is ook mogelijk de naam van uw script te definiëren met name:

##My box plot script=name

Indien niet gedefinieerd zal de naam van het bestand worden gebruikt als de naam van het script.
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Tekst van het script

Nu u de kop van het script heeft ingesteld kunt u de functie toevoegen:

boxplot(Layer[[X]])

boxplot is de naam van de functie van R, de parameter Laag is de naam die u hebt gedefinieerd voor de gegevensset
voor de invoer en X is de naam die u hebt gedefinieerd voor het veld van die gegevensset.

Waarschuwing: De parameter X moet binnen dubbele vierkante haken staan ([[]]).

Het uiteindelijke script ziet er als volgt uit:

##Vector processing=group
##showplots
##Layer=vector
##X=Field Layer
boxplot(Layer[[X]])

Sla het script op in het standaard pad dat wordt voorgesteld door Processing (processing/rscripts). Als u geen name
hebt gedefinieerd in de kop van het script, zal de bestandsnaam die u kiest de naam van het script worden in de
Toolbox van Processing.

Notitie: U kunt het script opslaan in waar u maar wilt, maar Processing is dan niet in staat om ze automatisch op te
nemen in de Toolbox van Processing, dus dient u het handmatig te uploaden.

Voer het nu eenvoudigweg uit met behulp van de knop aan de bovenzijde van het venster van de bewerker:
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Gebruik, als het venster van de bewerker eenmaal is gesloten, het tekstvak van Processing om uw script te zoeken:

U kunt nu de vereiste parameters invoeren in het venster Algoritme van Processing:
• voor Laag kies sample_points

• voor het veld X kies value
Klik op Run.
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Het venster Resultaten zou automatisch moeten worden geopend, indien niet, klik eenvoudigweg op Processing ►
Resultaten bekijken….
Klik op de koppeling in Resultaten bekijken en u zult zien:
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Notitie: U kunt de afbeelding openen, kopiëren en opslaan door met rechts te klikken op het plot.

17.33.3 Een vector maken

U kunt ook een vectorlaag maken en die automatisch laden in QGIS.
Het volgende voorbeeld is afkomstig uit het script Random sampling grid dat te vinden is in de online collectie
van R-scripts (de scripts in deze online collectie zijn te vinden op https://github.com/qgis/QGIS-Processing/tree/
master/rscripts).
Het doel van deze oefening is om een willekeurige punten vectorlaag te maken met een invoer vectorlaag om het
bereik te beperken met behulp van de functie spsample van het pakket sp.
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Parameters voor scripts

Net als eerder moeten we, vóór de tekst van het script, enkele parameters instellen:
1. Specificeer de naam van de groep waarin u uw script wilt opslaan, in dit geval Point pattern analysis:

##Point pattern analysis=group

2. Definieer een invoerparameter (een vectorlaag) die de plaatsing van de willekeurige punten zal beperken:

##Layer=vector

3. Stel een invoerparameter in voor het aantal punten dat moet worden gemaakt (Size, met een standaardwaarde
10):

##Size=number 10

Notitie: Omdat een standaardwaarde (10) is gedefinieerd, kan de gebruiker dit aantal wijzigen of de parameter
zonder een getal kan laten.

4. Specificeer dat er een uitvoer vectorlaag is (genaamd Output):

##Output=output vector

Tekst van het script

Nu kunt u de tekst van de functie toevoegen:
1. Gebruik de functie spsample:

pts=spsample(Layer, Size, type="random")

De functie gebruikt de Laag om de plaatsing van de punten te beperken (als het een lijnlaag is, moet een punt
op een van de lijnen in de laag liggen, als het een polygoonlaag is, moet ene punt binnen een polygoon liggen).
Het aantal punten wordt genomen uit de parameter Size. De methode van samplen is willekeurig.

2. Genereer de uitvoer (de parameter Output):

Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Het uiteindelijke script ziet er als volgt uit:

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output=output vector
pts=spsample(Layer, Size, type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))
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Sla het op en voer het uit door te klikken op de knop Script uitvoeren.
Typ in het nieuwe venster de juiste parameters in:

en klik op Run.
De laag met resultaten zal worden toegevoegd aan de inhoudsopgave en de punten ervan zullen worden weergegeven
in het kaartvenster:
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17.33.4 Tekst en grafische uitvoer vanuit R - syntaxis

Processing (met de plug-in Processing R Provider) gebruikt speciale syntaxis om de resultaten uit R te
verkrijgen:

• > vóór uw opdracht, zoals in >lillie.test(Layer[[Field]]) betekent dat het resultaat moet worden
verzonden naar uitvoer voor R (Resultaten bekijken)

• + na een plot schakelt overliggende plots in. Bijvoorbeeld plot(Layer[[X]], Layer[[Y]]) +
abline(h=mean(Layer[[X]]))

17.34 Landverschuivingen voorspellen

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe een erg vereenvoudigd model te maken om de waarschijnlijkheid van
landverschuivingen te voorspellen.

eerst berekenen we de helling (kies uit verscheidene programma’s; de geïnteresseerde lezer kan het verschil tussen de
uitvoeren berekenen):

• GRASS ► r.slope

• SAGA ► Slope, Aspect, Curvature

• GDAL Slope

Dan maken we een model van voorspelde neerslag, gebaseerd op de interpolatie van waarden voor neerslag van
meetstations:

• GRASS ► v.surf.rst (resolutie: 500 m)
De waarschijnlijkheid van ene landverschuiving zal zeer ruw zijn, gerelateerd aan zowel de neerslag als de helling
(natuurlijk zal een echt model meer lagen gebruiken, en toepasselijke parameters), laten we zeggen (neerslag *
helling )/100:

• SAGA ► Raster calculator rain, slope: (a*b)/100 (of: GRASS ► r.mapcalc)
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• laten we dan de plaatsen berekenen met het grootste berekende risico op neerslag: SAGA ► Raster statistics
with polygons (de interessante parameters zijn Maximum en Mean)
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Module: Ruimtelijke databases in QGIS gebruiken

In deze module zult u leren hoe ruimtelijke databases te gebruiken met QGIS om gegevens in de database te beheren,
weer te geven en te bewerken, als ook het uitvoeren van analyses door bevragingen. We zullen primair PostgreSQL
en PostGIS gebruiken (die in eerdere gedeelten werden behandeld), maar dezelfde concepten zijn van toepassing op
andere implementaties van ruimtelijke databases inclusief SpatiaLite.

18.1 Lesson: Werken met databases in de Browser van QGIS

In de voorafgaande 2 modules hebben we gekeken naar de basisconcepten, mogelijkheden en functies van relationele
databases, als ook naar uitbreidingen die ons ruimtelijke gegevens op laten slaan, beheren, bevragen en bewerken in
een relationele database. Dit gedeelte zal dieper duiken in hoe effectief ruimtelijke databases te gebruiken in QGIS.
Het doel voor deze les: Leren over interactie met ruimtelijke databases met behulp van de interface browser in QGIS.

18.1.1 Follow Along: Databasetabellen aan QGIS toevoegenmet behulp
van de Browser

We hebben al even kort gekeken naar hoe we tabellen uit een databases toevoegen als lagen aan QGIS, laten we hier
nu eens iets meer in detail naar kijken en kijken naar de verschillende manieren waarop dat kan worden gedaan in
QGIS. Laten we beginnen met te kijken naar de nieuwe interface Browser.

• Begin een nieuwe lege kaart in QGIS.
• Open de Browser door te klikken op de tab Browser onder in het paneel Lagen
• Open het gedeelte PostGIS van de boom en u zult uw eerder geconfigureerde verbinding beschikbaar vinden
(u moet misschien op de knop Bijwerken drukken oven in het venster Browser).
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• Dubbelklikken op een van de hier vermelde tabellen/lagen zal dat toevoegen aan het kaartvenster.
• Met rechts klikken op een tabel/laag in deze weergave zal u een aantal opties geven. Klik op het item

Eigenschappen om de eigenschappen van de laag te bekijken.
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Notitie: Natuurlijk kunt u deze interface ook gebruiken om databases van PostGIS die worden gehost op een externe
server te verbinden met uw werkstation. Met rechts klikken op het item PostGIS in de boom zal u in staat stellen
parameters voor de verbinding te specificeren voor een nieuwe verbinding.

18.1.2 Follow Along: Een gefilterde set records als een laag toevoegen

Nu we hebben gezien hoe een gehele tabel als een laag aan QGIS toe te voegen, zou het leuk zijn om te leren hoe een
set gefilterde records uit een tabel kan worden toegevoegd als een laag door query’s te gebruiken die we in eerdere
gedeelten geleerd hebben.

• Begin een nieuwe lege kaart zonder lagen.
• Klik op de knop PostGIS-laag toevoegen of selecteer Kaartlagen ► PostGIS-laag toevoegen uit het menu.
• In het dialoogvenster PostGIS-tabel(len) toevoegen dat verschijnt, verbindt met de verbinding
postgis_demo.

• Breidt public schema uit en u zou daar de drie tabellen moeten vinden waar we eerder mee hebben
gewerkt.

• Klik op de laag lines om die te selecteren, maar in plaats van die toe te voegen, klik op de knop Filter
instellen om het dialoogvenster Querybouwer naar voren te brengen.

• Construeer de volgende expressie met behulp van de knoppen of door hem direct in te voeren:

"roadtype" = 'major'
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• Klik op OK om het bewerken van het filter te voltooien en klik op Toevoegen om de gefilterde laag aan uw kaart
toe te voegen.

• Hernoem de laag lines in de boom naar roads_primary.
Het zal u opvallen dat alleen de Primary roads zijn toegevoegd aan uw kaart in plaats van de gehele laag.

18.1.3 In Conclusion

U heeft gezien hoe u interactief kunt werken met ruimtelijke databases met behulp van de Browser van QGIS en hoe
u lagen aan uw kaart toevoegt, gebaseerd op een queryfilter.
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18.1.4 What’s Next?

Vervolgens zult u zien hoe te werken met de interface DB Manager in QGIS voor een meer complete set van
beheerstaken voor databases.

18.2 Lesson: DB Manager gebruiken om te werken met ruimtelijke
databases in QGIS

We hebben al gezien hoe we veel bewerkingen aan databases kunnen uitvoeren met QGIS, als ook met andere
gereedschappen, maar nu is het tijd om te kijken naar het gereedschap DBManager wat veel dezelfde functionaliteiten
verschaft en ook meer op beheer georiënteerde gereedschappen.
Het doel voor deze les: Te leren hoe interactief te werken met ruimtelijke databases met behulp van de DBManager
in QGIS.

18.2.1 Follow Along: Databases van PostGIS beheren met DB Manager

U zou eerst de interface van de DB Manager moeten openen door te selecteren Database –> DB Manager –> DB
Manager in het menu of door het pictogram DB Manager te selecteren op de werkbalk.

U zou de eerdere verbindingen die we hebben geconfigureerd al moeten zien en in staat zijn het gedeelte myPG en
het schema public uit te breiden om de tabellen te zien waarmee we in eerdere gedeelten hebben gewerkt.
Het eerste dat u zou moeten opvallen is dat u nu enkele metadata kunt zien over de schema’s die zijn opgenomen in
uw database.
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Schema’s zijn een manier om gegevenstabellen en andere objecten in een database van PostgreSQL te groeperen en
een container voor rechten en andere beperkingen. het beheren van schema’s van PostgreSQL valt buiten het bereik
van deze handleiding, maar u kunt er meer informatie over vinden in de PostgreSQL documentation on Schemas.
U kunt DB Manager gebruiken om nieuwe schema’s te maken, maar u zult een gereedschap als pgAdmin III of de
interface voor de opdrachtregel moeten gebruiken om ze effectief te beheren.
DB Manager kan ook worden gebruikt om de tabellen in uw database te beheren. We hebben al gekeken naar de
verscheidene manieren om tabellen te maken en te beheren via de opdrachtregel, maar laten we nu eens kijken hoe
dat te doen in DB Manager.
Eerst is het handig om te kijken naar de metadata van een tabel door te klikken op zijn naam in de boom en te kijken
op de tab Info.

In dit paneel kunt u de Algemene info over de tabel zien als ook de informatie die de extensie PostGIS onderhoudt
over de geometrie en het ruimtelijke referentiesysteem.
Als u naar beneden scrollt op de tab Info, kunt u meer informatie zien over de Velden, Beperkingen en Indexen voor
de tabel die u bekijkt.
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Het is ook zeer handig om DB Manager te gebruiken om eenvoudig naar de records in de database te kijken op
nagenoeg dezelfde manier als u zou doen door de attributentabel van een laag te bekijken in de boom van Lagen. U
kunt door de gegevens bladeren door de tab Tabel te selecteren.
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Er is ook een tab Voorvertoning die u de gegevens van de laag in een voorbeeldkaart laat zien.
Klikken met rechts op een laag in de boom en klikken op Aan kaartvenster toevoegen zal deze laag toevoegen aan uw
kaart.
Tot dusverre hebben we alleen gekeken naar de schema’s en tabellen van de database en hun metadata, maar wat als
we de tabel willen veranderen door misschien een aanvullende kolom toe te voegen? DB Manager stelt u in staat om
dat direct te doen.

1. Selecteer de tabel die u wilt bewerken in de boom
2. Selecteer Tabel ► Tabel bewerken uit het menu om het dialoogvenster Tabel-eigenschappen te openen.
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U kunt dit dialoogvenster gebruiken om kolommen toe te voegen, geometrie-kolommen toe te voegen, bestaande
kolommen te bewerken of om een kolom volledig te verwijderen.
Door de tab Beperkingen te gebruiken kunt u beheren welke velden gebruikt moeten worden als de primaire sleutel
of om bestaande beperkingen te verwijderen.
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De tab Indexen kan worden gebruikt om zowel ruimtelijke als normale indexen te verwijderen.
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18.2.2 Follow Along: Een nieuwe tabel maken

Laten we, nu we door het proces van werken met bestaande tabellen in onze database zijn gegaan, DB Manager
gebruiken om een nieuwe tabel te maken.

1. Als het al niet geopend is, open het venster DB Manager en breidt de boom uit totdat u de lijst met tabellen
ziet die al in uw database aanwezig zijn.

2. Selecteer uit het menu Tabel –> Tabel maken om het dialoogvenster Tabel maken naar voren te halen.
3. Gebruik het standaard schema Public en noem de tabel places.
4. Voeg de velden id, place_name en elevation toe, zoals hieronder weergegeven
5. Zorg er voor dat het veld id is ingesteld als de primaire sleutel.
6. Klik op het keuzevak Geometriekolom maken en zorg er voor dat het is ingesteld op een type POINT` en

laat de naam als ``geom en specificeer 4326 als het SRID.
7. Klik op het keuzevak Ruimtelijke index aanmaken en klik op Aanmaken om de tabel te maken.
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8. Sluit het dialoogvenster dat u laat weten dat de tabel werd gemaakt en klik op Close om het dialoogvenster
Tabel maken te sluiten.

U kunt nu uw tabel in DB Manager inspecteren en u zult natuurlijk vinden dat er geen gegevens in staan. Vanaf hier
kunt u Bewerken aan/uitzetten in het menu van de Lagen en beginnen met het toevoegen van plaatsen aan uw tabel.

18.2.3 Follow Along: Basisbeheer van database

DB Manager zal u ook in staat stellen enkele basis beheerstaken voor de database uit te voeren. Het is zeker geen
vervanging voor een meer compleet gereedschap voor databasebeheer, maar het verschaft enige functionaliteit die u
kunt gebruiken om uw database te onderhouden.
Databasetabellen kunnen vaak vrij groot worden en tabellen die regelmatig worden bijgewerkt kunnen achterblijfselen
van records bevatten die niet langer nodig zijn voor PostgreSQL. De opdracht VACUUM zorgt voor een soort
afvalverwerking om uw tabellen te verkleinen en optioneel te analyseren voor betere uitvoering.
Laten we eens kijken hoe we een opdracht VACUUM ANALYZE kunnen uitvoeren vanuit DB Manager.

1. Selecteer één van uw tabellen in de boom van DB Manager
2. Selecteer Tabel ► Vacuüm Analyze uitvoeren uit het menu

PostgreSQL zal nu de bewerking uitvoeren. Afhankelijk van de grootte van uw tabel, zou dit enige tijd kunnen vergen
om te voltooien.
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U vindt meer informatie over het proces VACUUM ANALYZE in de PostgreSQL Documentation on VACUUM
ANALYZE

18.2.4 Follow Along: SQL-query’s met DB Manager uitvoeren

DB Manager verschaft ook een manier om query’s voor uw databasetabellen te schrijven en om de resultaten te
bekijken. We hebben dit type functionaliteit al gezien in het paneel Browser, maar laten we er hier nog eens naar
kijken met DB Manager.

1. Selecteer de tabel lines in de boom.
2. Selecteer de knop SQL-venster in de werkbalk van DB Manager.

3. Voer de volgende SQL query in de daarviior bestemde ruimte in:

select * from lines where roadtype = 'major';

4. Klik op de knop Uitvoeren (F5) om de query uit te voeren.
5. U zou nu, in het paneel Resultaat, de records moeten zien die overeenkomen.

6. Klik op het keuzevak Als nieuwe laag laden om de resultaten aan uw kaart toe te voegen.
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7. Selecteer de kolom id als de Kolom met unieke integer-waarden en de kolom the_geom als de
Geometriekolom.

8. Voer roads_primary in als de Laagnaam (prefix).
9. Klik op Nu laden! om de resultaten als een nieuwe laag in uw kaart te laden.

De lagen die overeenkomen met uw query worden nu weergegeven in uw kaart. U kunt natuurlijk dit gereedschap
voor query gebruiken om enige willekeurige opdracht voor SQL uit te voeren, inclusief veel van die waarnaar we
hebben gekeken in eerdere modules en gedeelten.

18.2.5 Gegevens in een database importeren met DB Manager

We hebben al gekeken naar hoe we gegevens in een een ruimtelijke database importeren met behulp van de
gereedschappen voor de opdrachtregel, dus laten we nu leren hoe DB Manager te gebruiken om te importeren.

1. Klik op de knop Laag/bestand importeren op de werkbalk in het dialoogvenster DB Manager.

2. Selecteer het bestand urban_33S.shp uit exercise_data/projected_data als de gegevensset
voor invoer

3. Klik op de knop Opties vernieuwen om enkele van de waarden in het formulier vooraf in te vullen.
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4. Zorg er voor dat de optie Nieuwe tabel makem is geselecteerd
5. Specificeer Bron SRID als 32722 en het Doel SRID as 4326.
6. Selecteer het keuzevak Ruimtelijke index aanmaken

7. Klik op OK om het importeren uit te voeren
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8. Sluit het dialoogvenster dat u laat weten dat het importeren is voltooid
9. Klik op de knop Bijwerken op de werkbalk van DB Manager.

U kunt nu de tabel in uw database inspecteren door op de naam te klikken in de boom. Verifieer dat de gegevens
opnieuw zijn geprojecteerd door te controleren of Ruimtelijk refsys: is vermeld als WGS 84 (4326)

Klik met rechts op de tabel in de boom en selecteren van Aan kaartvenster toevoegen zal de tabel als een laag aan uw
kaart toevoegen.

18.2.6 Gegevens uit een database exporteren met DB Manager

Natuurlijk kan DB Manager ook worden gebruikt om gegevens vanuit uw ruimtelijke databases te exporteren, laten
we dus eens kijken hoe dat moet worden gedaan.

1. Selecteer de laag lines in de boom en klik op de knop Naar bestand exporteren op de werkbalk om het
dialoogvenster Naar vectorbestand exporteren te openen.

2. Klik op de knop … om het Uitvoerbestand te selecteren en sla de gegevens op in uw map exercise_data
als urban_4326.

3. Stel het Doel SRID in als 4326.
4. Klik op OK om het exporteren te initialiseren.
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5. Sluit het dialoogvenster dat u laat weten dat het exporteren is voltooid en sluit DB Manager.
U kunt nu het shapefile dat u heeft gemaakt inspecteren in het paneel Browser.
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18.2.7 In Conclusion

U heeft nu gezien hoe u de interface DB Manager kunt gebruiken in QGIS om uw ruimtelijke databases te beheren,
om SQL-query’s uit te voeren op uw gegevens en hoe gegevens te im- en exporteren.

18.2.8 What’s Next?

Vervolgens zullen we kijken hoe we veel van deze zelfde technieken gebruiken met databases van SpatiaLite.

18.3 Lesson: Werken met databases van SpatiaLite in QGIS

Waar PostGIS over het algemeen op een server wordt gebruikt om mogelijkheden voor ruimtelijke databases te
verschaffen voor meerdere gebruikers tegelijkertijd, Ondersteunt QGIS ook het gebruiken van ene bestandsindeling
genaamd SpatiaLite wat een lichtgewicht draagbare manier is een gehele ruimtelijke database in één enkel bestand op
te slaan. Uiteraard zouden deze 2 typen ruimtelijke databasesmoetenworden gebruikt voor verschillende doelen, maar
dezelfde basisprincipes en technieken zijn op beide van toepassing. Laten we een nieuwe database voor SpatiaLite
maken en de functionaliteit verkennen die wordt verschaft om met deze databases in QGIS te werken.
Het doel voor deze les: leren hoe interactief te werken met databases van SpatiaLite met behulp van de interface
Browser van QGIS.

18.3.1 Follow Along: Een database van SpatiaLite maken met de
Browser

Met behulp van het paneel Browser kunnen we een nieuwe database voor SpatiaLite maken en die instellen voor
gebruik in QGIS.

1. Klik met rechts op het item SpatiaLite in de boom van de Browser en selecteer Database maken.
2. Specificeer waar op uw bestandssysteem u het bestand wilt opslaan en noem het qgis-sl.db.
3. Klik opnieuw met rechts op het item SpatiaLite in de boom van de Browser en selecteer nu het item Nieuwe

verbinding. Zoek het bestand dat u in de laatste stap maakte en open het.
Nu u uw nieuwe database heeft geconfigureerd zult u zien dat dat item in de boom van de Browser tree er niets onder
heeft en dat het enige dat u op dit moment kunt doen is de verbinding te verwijderen. Dat komt natuurlijk omdat we
nog geen tabellen aan deze database hebben toegevoegd. Laten we doorgaan en dat doen.

1. Zoek de knop om een nieuwe laag te maken en gebruik het keuzemenu om een nieuwe laag voor SpatiaLite te
maken, of selecteer Kaartlagen ► Laag maken ► Nieuwe SpatiaLite-laag….

2. Selecteer de database die we in de eerder stappen gemaakt hebben in het keuzemenu.
3. Geef de laag de naam places.
4. Selecteer het keuzevak naast Maak een automatisch ophogend primair sleutelveld aan.
5. Voeg twee attributen toe zoals hieronder weergegeven
6. Klik op OK om de tabel te maken.
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7. Klik op de knop Bijwerken boven in de Browser en u zou nu uw tabel places vermeld moeten zien.
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U kunt met rechts op de tabel klikken en de eigenschappen ervan bekijken zoals we in de eerdere oefening
deden.

vanaf hier kunt u een sessie voor bewerken beginnen en beginnen met het direct toevoegen van gegevens aan uw
nieuwe database.
We leerden ook hoe gegevens te importeren in een database met behulp van DB Manager en u kunt deze zelfde
techniek gebruiken gegevens in uw nieuwe database van SpatiaLite te importeren.

18.3.2 In Conclusion

U heeft gezien hoe databases voor SpatiaLite te maken, daaraan tabellen toe te voegen en deze tabellen als lagen te
gebruiken in QGIS.
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Appendix: Bijdragen aan deze handleiding

U moet de richtlijnen in deze Appendix volgen om materiaal aan deze cursus toe te voegen. U wordt geacht de
voorwaarden in deze Appendix niet te wijzigen, uitgezonderd om te verduidelijken. Dat is om er voor te zorgen dat
de kwaliteit en consistentie van deze handleiding kunnen worden onderhouden.

19.1 Bronnen downloaden

De bron van dit document is beschikbaar op GitHub. Consulteer GitHub.com voor instructies over hoe het
versiebeheerssysteem GIT te gebruiken.

19.2 Indeling handleiding

Deze handleiding is geschreven met behulp van Sphinx, een Python documentgenerator door middel van de
opmaaktaal reStructuredText . Instructies over hoe deze gereedschappen te gebruiken zijn beschikbaar op hun
respectievelijke sites.

19.3 Een module toevoegen

• Maak eerst een nieuwe map (direct onder het bovenste niveau van de map qgis-training-manual) met
de naam voor de nieuwe module om een nieuwe module toe te voegen.

• Maak, onder deze nieuwe map, een bestand genaamd index.rst. Laat dit voor nu blanco.
• Open het bestand index.rst in de map van het bovenste niveau. De eerste regels daarvan zijn:

.. toctree::
:maxdepth: 2

foreword/index
introduction/index
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Het zal u opvallen dat dit een lijst met namen van mappen is, gevolgd door de naam index. Dit verwijst het index-
bestand op het bovenste niveau naar de indexbestanden in elke map. De volgorde waarin zij staan bepaalt de volgorde
die zij in het document zullen hebben.

• Voeg de naam van uw nieuwe module (d.i. de naam die u aan de nieuwe map gaf), gevolgd door /index, aan
die lijst toe, waar u wilt dat uw module zou moeten verschijnen.

• Onthoud om de volgorde van de modules logisch te houden, en wel zo dat latere modules zijn gebouwd op de
in eerder modules gepresenteerde kennis.

• Open het indexbestand van uw eigen module ([naam module]/index.rst).
• Schrijf, aan het begin van de pagina, een regel met 80 asterisken (*). Dat staat voor een kop van een module.
• Vervolg deze regel met een regel die de frase voor opmaak |MOD| (wat “module” betekent) bevat, gevolgd
door de naam van uw module.

• Sluit dit af met nog een regel met 80 asterisken.
• Laat hieronder een regel open.
• Schrijf een korte alinea die het doel en de inhoud van de module uitlegt.
• Laat één regel open en voeg dan de volgende tekst toe:

.. toctree::
:maxdepth: 2

lesson1
lesson2

…waar lesson1, lesson2, etc., de namen zijn van uw geplande lessen.
Het indexbestand op het niveau van de module zal er zo uitzien dit:

*******************************************************************************
|MOD| Module Name
*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

19.4 Een les toevoegen

Een les toevoegen aan een nieuwe of bestaande module:
• Open de map van de module.
• Open het bestand index.rst (in het geval van nieuwe modules, hierboven gemaakt).
• Zorg er voor dat de naam van de geplande les is vermeld onder de vermelding toctree, zoals hierboven
weergegeven.

• Maak een nieuw bestand aan in de map van de module.
• Noem dit bestand exact hetzelfde als de naam die u heeft vermeld in het bestand index.rst van de module,
en voeg de extensie .rst toe.
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Notitie: Voor bewerkingsdoeleinden werkt een .rst-bestand exact hetzelfde als een normaal tekstbestand (.txt).

• Schrijf de frase voor opmaak |LS|, gevolgd door de naam van de les om te beginnen met het schrijven van
de les.

• Schrijf, op de volgende regel, een regel met 80 ‘is gelijk aan’-tekens (=).
• Laat hieronder een regel open.
• Schrijf een korte omschrijving van het beoogde doel van de les.
• Neem een algemene introductie op voor het onderwerp. Bekijk de bestaande lessen in de handleiding voor
voorbeelden.

• Begin hieronder een nieuwe alinea, beginnend met deze frase:

**The goal for this lesson:**

• Leg in het kort de bedoelde leerdoelen uit van het voltooien van deze les.
• Als u het doel van de les niet kunt uitleggen in één of twee zinnen, overweeg dan om het onderwerp op te delen
in meerdere lessen.

Elke les zal worden opgedeeld in meerdere gedeelten, die hierna zullen worden besproken.

19.5 Een gedeelte toevoegen

Er zijn twee typen gedeelten: “follow along” en “try yourself”.
• Een gedeelte “follow along” is een gedetailleerde verzameling aanwijzingen die zijn bedoeld om de lezer te
leren hoe een bepaald aspect van QGIS te gebruiken. Dit wordt over het algemeen gedaan door zo duidelijk
mogelijke klik-na-klik aanwijzingen te geven, afgewisseld met schermafdrukken.

• Een gedeelte “try yourself” geeft de lezer een korte opdracht om zelf te proberen. Het wordt gewoonlijk
geassocieerd met een item in het antwoordenblad aan het einde van de documentatie, wat zal weergeven of
verklaren hoe de opdracht te voltooien, en zal, indien mogelijk, de verwachte uitvoer weergeven.

Elk gedeelte heeft een niveau van moeilijkheid. Een eenvoudig gedeelte wordt vermeld als |basic|, gemiddeld
door |moderate|, en moeilijk door |hard|.

19.5.1 Een gedeelte “follow along” toevoegen

• Vermeld, om dit gedeelte te beginnen, de frase voor opmaak van de bedoelde moeilijkheidsgraad (zoals
hierboven weergegeven).

• Plaats een spatie en schrijf dan |FA| (voor “follow along”).
• Plaats nog een spatie en vermeld de naam van het gedeelte (gebruik alleen een hoofdletter aan het begin, en
voor eigennamen).

• Schrijf, op de volgende regel, een regel met 80 minussen/streepjes (-). Zorg er voor dat uw tekstverwerker niet
het standaard teken minus/streepje vervangt door een lang streepje of ander teken.

• Schrijf een korte introductie voor het gedeelte, die het doel ervan uitlegt. Geef dan gedetailleerde (klik-na-klik)
instructies over de procedure die moet worden gedemonstreerd.

• Neem in elk gedeelte de benodigde interne links, externe links en schermafdrukken op.
• Probeer elk gedeelte af te sluiten met een korte alinea met een conclusie en die op natuurlijke wijze leidt naar
het volgende gedeelte, indien mogelijk.
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19.5.2 Een gedeelte “try yourself” toevoegen

• Vermeld, om dit gedeelte te beginnen, de frase voor opmaak van de bedoelde moeilijkheidsgraad (zoals
hierboven weergegeven).

• Plaats een spatie en schrijf dan |TY| (voor “try yourself”).
• Schrijf, op de volgende regel, een regel met 80 minussen/streepjes (-). Zorg er voor dat uw tekstverwerker niet
het standaard teken minus/streepje vervangt door een lang streepje of ander teken.

• Leg de oefening uit die u de lezer wilt laten voltooien. Verwijs, indien nodig, naar eerdere gedeelten, lessen of
modules.

• Neem schermafdrukken op om de vereisten te verduidelijken als een heldere tekstuele omschrijving niet
duidelijk is.

In de meeste gevallen zult u een antwoord willen verschaffen met betrekking tot hoe de in dit gedeelte vermelde
opdracht zou moeten worden voltooid. To do so, U zult een item in het antwoordenblad moeten toevoegen om dat te
doen.

• bepaal eerst een unieke naam voor het antwoord. Idealiter zal deze naam de naam van de les bevatten en een
volgnummer.

• Een koppeling voor dit antwoord maken:

:ref:`Check your results <answer-name>`

• Open het antwoordenblad (answers/answers.rst).
• Maak een koppeling naar het gedeelte “try yourself” door deze regel te vermelden:

.. _answer-name:

• Schrijf de instructies over hoe de opdracht te voltooien, gebruik, waar nodig, koppelingen en afbeeldingen.
• Neem, om het af te sluiten, een koppeling terug op naar het gedeelte “try yourself” door deze regel te vermelden:

:ref:`Back to text <backlink-answer-name>`

• Voeg, om deze koppeling te laten werken, de volgende regel toe boven de kop naar het gedeelte “try yourself”:

.. _backlink-answer-name:

Onthoud dat elk van deze hierboven weergegeven regels een lege regel erboven en eronder moet hebben, anders zou
het fouten kunnen veroorzaken bij het maken van het document.

19.6 Een conclusie toevoegen

• Vermeld, om een les te beëindigen, de frase |IC| voor “in conclusion”, gevolgd door een nieuwe regel met 80
minussen/streepjes (-). Schrijf een conclusie voor de les waarin u uitlegt welke concepten zijn behandeld in de
les.
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19.7 Een gedeelte Meer informatie toevoegen

• Dit gedeelte is optioneel.
• Schrijf de frase FR voor “further reading”, gevolgd door een nieuwe regel van 80 minussen/streepjes (-).
• Neem koppelingen op naar de van toepassing zijnde externe websites.

19.8 Een gedeelte Wat nu toevoegen

• Schrijf de frase |WN| voor “what’s next”, gevolgd door een nieuwe regel van 80 minussen/streepjes (-).
• Leg uit hoe deze les studenten heeft voorbereid voor de volgende les of module.
• Onthoud om het gedeelte “what’s next” van de vorige les indien nodig te wijzigen, zodat die verwijst naar uw
nieuwe les. Dit zal nodig zijn als u een nieuwe les tussen bestaande lessen heeft ingevoegd, of na een bestaande
les.

19.9 Opmaak gebruiken

U zult standaard opgemaakte tekst zullen moeten toevoegen aan uw tekst om de standaarden van dit document te
volgen,

19.9.1 Nieuwe concepten

• Als u een nieuw concept uitlegt,zult u de naam van het nieuwe concept cursief moeten schrijven door het te
omsluiten met asterisken (*).

This sample text shows how to introduce a *new concept*.

19.9.2 Benadrukken

• Een cruciale term benadrukken die geen nieuw new concept is, schrijf de term vet door die te omsluiten met
dubbele asterisken (**).

• Gebruik dit spaarzaam! Als u dit teveel gebruikt kan het voor de lezer lijken of u schreeuwt of neerbuigend
doet.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

19.9.3 Afbeeldingen

• Bij het toevoegen vaneen afbeelding, sla die op in de map _static/naam_les/.
• Neem die als volgt op in het document:

.. figure:: img/image_file.extension
:align: center

• Onthoud om een lege regel over te laten boven en onder de opmaak voor de afbeelding.
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19.9.4 Interne koppelingen

• Schrijf, om een anker voor een koppeling te maken, de volgende regel boven de plaats waar u wilt dat de
koppeling naar verwijst:

.. _link-name:

• Voeg deze regel toe om een koppeling te maken:

:ref:`Descriptive link text <link-name>`

• Onthoud om een lege regel boven en onder deze regel te houden.

19.9.5 Externe koppelingen

• Schrijf, om een externe koppeling te maken, die als volgt uit:

`Descriptive link text <link-url>`_

• Onthoud om een lege regel boven en onder deze regel te houden.

19.9.6 Mono gespatieerde tekst gebruiken

• Wanneer u tekst schrijft die de gebruiker moet invoeren, een padnaam, of de naam van een element van een
database, zoals een naam van een tabel of kolom, moet u die schrijven in mono gespatieerde tekst.
Biijvoorbeeld:

Enter the following path in the text box: :kbd:`path/to/file`.

19.9.7 Items voor de GUI labelen

• Indien u verwijst naar een item van de GUI, zoals een knop, moet u de naam ervan schrijven in de opmaak
voor label van de GUI. Bijvoorbeeld:

To access this tool, click on the :guilabel:`Tool Name` button.

• Dit is ook van toepassing als u de naam van een gereedschap vermeld, zonder dat de gebruiker op een knop
hoeft te drukken.

19.9.8 Menuselecties

• Als u een gebruiker door menu’s leidt, moet u de :menuselection:`indeling menu –> selectie –> ` gebruiken.
Bijvoorbeeld:

To use the :guilabel:`Tool Name` tool, go to :menuselection:`Plugins -->
Tool Type --> Tool Name`.
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19.9.9 Opmerkingen toevoegen

• U wilt misschien een opmerking in de tekst opnemen, die extra details uitlegt die niet eenvoudig deel van de
les kunnen worden gemaakt. Dit is de opmaak:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]

19.9.10 Een opmerking voor sponsors/auteurs toevoegen

Als u een nieuwe module, les of gedeelte schrijft ten behoeve van een sponsor, moet u een kort bericht van de sponsor
opnemen, naar hun keuze. Dit moet de gebruiker attenderen op de naam van de sponsor en moet onder de kop van
de module, les of gedeelte, dat zij sponsoren, verschijnen. Het mag echter geen advertentie voor hun bedrijf zijn.
Als u op vrijwillige basis, op eigen titel, een module, les of gedeelte, schrijft, en niet ten behoeve van een sponsor, mag
u een opmerking over de auteur opnemen onder de kop van de module, les of het gedeelte dat u schreef. Dat moet
in de vorm Deze [module/les/gedeelte] is bijgedragen door [naam auteur]. Voeg geen
verdere tekst, contactdetails, etc. toe. Dergelijke details dienen te worden toegevoegd in het gedeelte “Contributors”
van het Voorwoord, tezamen met de namen van de gedeelte(n) die u heeft toegevoegd. Als u alleen verbeteringen,
correcties en/of toevoegingen heeft gemaakt, vermeld u zichzelf als een editor.

19.10 Dank u wel!

Dank u voor uw bijdrage aan dit project! Hierdoor maakt u QGIS meer toegankelijk voor gebruikers en voegt u
waarde toe aan het project QGIS als geheel.
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Voorbereiden gegevens voor oefeningen

Notitie: Dit proces is bedoeld voor makers van cursussen, of meer ervaren gebruikers van QGIS die gelokaliseerde
voorbeeldgegevens voor hun cursus willen maken. Standaard voorbeeldgegevens worden met de trainingshandleiding
verschaft, maar u kunt deze instructies volgens als u de standaard gegevenssets wilt vervangen.

De voorbeeldgegevens die worden verschaft met de trainingshandleiding verwijzen naar de stad Swellendam en de
omgeving ervan. Swellendam bevindt zich op ongeveer 2 uur oostelijk van Kaapstad in deWestkaap van Zuid-Afrika.
De gegevensset bevat namen van objecten in zowel het Engels als Afrikaans.
Iedereen kan deze gegevensset zonder problemen gebruiken, maar het zou uw voorkeur kunnen hebben om gegevens
te gebruiken uit uw eigen land of stad. Als u daarvoor kiest, uw gelokaliseerde gegevens zullen worden gebruikt in
alle lessen van module 3 tot en met module 7.2. Latere modules gebruiken meer complexe gegevensbronnen, die al
dan niet beschikbaar zouden kunnen zijn voor uw regio.

Notitie: Deze instructies gaan er van uit dat u goede kennis heeft van QGIS en zijn niet bedoeld te worden gebruikt
als lesmateriaal.

20.1 Try Yourself Op OSM gebaseerde vectorbestanden
maken

Als u voor uw cursus de standaard voorbeeldgegevens wilt vervangen door gelokaliseerde gegevens, kan dat eenvoudig
worden gedaan met behulp van de gereedschappen die zijn ingebouwd in QGIS. De regio die u kiest om te gebruiken
zou een goede mix moeten zijn van stedelijke en landschappelijk gebieden, wegen van verschillende significantie
moeten bevatten, gebiedsgrenzen (zoals natuurreservaten of boerderijen) en oppervlaktewater, zoals stromen en
rivieren.

1. Open een nieuw project in QGIS
2. Selecteer Kaartlagen ► Databonnen beheren om het dialoogvenster Databronnen beheren te openen
3. Op de tab Browser, vergroot het keuzemenu van XYZ Tiles en dubbelklik op het item OpenStreetMap.
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Een kaart van de wereld wordt nu zichtbaar in het kaartvenster.
4. Sluit het dialoogvenster Databronnen beheren.
5. Verplaats naar het gebied dat u nader wilt bekijken

Nu we het gebied hebben waarvan we de gegevens willen uitnemen, kunnen we de gereedschappen voor uitnemen
inschakelen.

1. Ga naar Plug-ins ► Plug-ins beheren en installeren…

2. Typ, op de tab Alles, QuickOSM in het zoekvak
3. Selecteer de plug-in QuickOSM, druk op Plug-in installeren en dan Close het dialoogvenster.
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4. Voer de nieuwe plug-in uit vanuit het menu Vector ► QuickOSM ► QuickOSM…

5. Selecteer, op de tab Snelle query, building in het keuzemenu Sleutel

6. Laat het veldWaarde leeg, wat betekent dat u alle gebouwen wilt opvragen.
7. Selecteer Canvas Extent in de volgende keuzelijst
8. Vergroot de groep Geavanceerd onder en deselecteer alle typen geometrie aan de rechterkant, uitgezonderd

Multipolygonen.
9. Druk op Query uitvoeren

Een nieuwe laag building is toegevoegd aan het paneel Lagen die de gebouwen weergeeft in het
geselecteerde bereik.

10. Ga door zoals hierboven om andere gegevens uit te nemen:
1. Sleutel = landuse en type geometrie Multipolygonen.
2. Sleutel = boundary, Waarde = protected_area en type geometrie Multipolygonen.
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3. Sleutel = natural, Waarde = water and type geometrie Multipolygonen.
4. Sleutel = highway en selecteer de typen geometrie Lijnen en Multilijnen.
5. Sleutel = waterway, Waarde = river en selecteer de typen geometrie Lijnen en

Multilijnen.
6. Sleutel = place en type geometrie Punten.

Dit proces voegt de lagen toe als tijdelijke bestanden (aangegeven door het pictogram naast hun naam).

U kunt een monster nemen van de gegevens die uw regio bevat om te zien welke resultaten uw regio zal opleveren.
We dienen nu de resulterende gegevens op te slaan om gedurende onze cursus te gebruiken. We zullen indelingen
ESRI Shapefile, GeoPackage en SpatiaLite gebruiken, afhankelijk van de gegevens.
De tijdelijke laag place converteren naar een andere indeling:

1. Klik op het pictogram naast de laag place om het dialoogvenster Tijdelijke tekenlaag opslaan te openen.

Notitie: Wanneer u een van de eigenschappen (CRS, bereik, velden…) van de tijdelijke tekenlaag dient te
wijzigen, gebruik dan in plaats hiervan het contextmenu Exporteren ► Objecten opslaan als…, en zorg er voor
dat de optie Voeg opgeslagen bestand toe aan kaart is geselecteerd. Dit voegt een nieuwe laag toe.

2. Selecteer de indeling ESRI Shapefile

3. Gebruik de knop… om te bladeren naar de map exercise_data/shapefile/ en sla het bestand op als
places.shp.
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4. Klik op OK

In het paneel Lagen wordt de tijdelijke tekenlaag place vervangen door de opgeslagen Shapefile-laag places en
het pictogram voor tijdelijk ernaast wordt verwijderd.

5. Dubbelklik op de laag om zijn tab Laag Eigenschappen ► Bron te openen en de eigenschap Laagnaam bij te
werken zodat die overeenkomt met de bestandsnaam.

6. Herhaal het proces voor de andere lagen, hernoem ze als volgt:
• natural_water naar water
• waterway_river naar rivers
• boundary_protected_area naar protected_areas

Elke resulterende gegevensset zou moeten worden opgeslagen in de map exercise_data/shapefile/.
De volgende stap is om een bestand voor GeoPackage te maken uit de laag building om te gebruiken tijdens de cursus:

1. Klik op het pictogram naast de laag building

2. Selecteer de indeling GeoPackage

3. Sla het bestand op als training_data.gpkg in de map exercise_data/
4. Standaard wordt de Laagnaam gevuld met de bestandsnaam. Vervang die door buildings.
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5. Klik op OK

6. Hernoem de laag in zijn dialoogvenster voor de eigenschappen
7. Herhaal het proces met de laag highway, sla die op als roads in dezelfde database van GeoPackage.

De laatste stap is om het resterende tijdelijke bestand op te slaan als een bestand voor SpatiaLite.

1. Klik op het pictogram naast de laag landuse

2. Selecteer de indeling SpatiaLite

3. Sla het bestand op als landuse.sqlite in de map exercise_data/. Standaard wordt de Laagnaam
gevuld door de bestandsnaam. Wijzig die niet.
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4. Klik op OK

U zou nu een kaart moeten hebben die er ongeveer uitziet zoals deze (de symbologie zal zeker heel anders zijn, omdat
QGIS willekeurig kleuren toewijst als lagen worden toegevoegd aan de kaart):

Het belangrijkste is dat u 7 vectorlagen heeft die overeenkomenmet die hierboven en dat al deze lagen enkele gegevens
hebben.
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20.2 Try Yourself SRTM DEM tiff-bestanden maken

Voor de modules Module: Vectorgegevens maken en Module: Rasters, heeft u ook rasterafbeeldingen nodig (SRTM
DEM) die de regio bedekken die u heeft geselecteerd voor uw cursus.
De CGIAR-CGI verschaft enkele SRTM DEM’s die u kunt downloaden vanaf https://srtm.csi.cgiar.org/srtmdata/.
U zult afbeeldingen nodig hebben die de gehele regio bedekken die u heeft gekozen om te gebruiken. Voor het bepalen
van de coördinaten van het bereik, ga in QGIS , zoom naar het bereik van de grootste laag en selecteer de waarden
in het vak Bereik van de statusbalk. Behoud de indeling GeoTiff. Als het formulier helemaal is ingevuld, klik
dan op de knop Search en download het/de bestand(en).
Als u eenmaal de vereiste bestand(en) heeft gedownload, zouden zij moeten worden opgeslagen in de map
“exercise_data” in de submappen van “raster/SRTM”.

20.3 Try Yourself TIFF afbeeldingsbestanden maken

In module Module: Vectorgegevens maken, geeft les Follow Along: Gegevensbronnen close-up afbeeldingen van drie
sportvelden van een school waarvan studenten wordt gevraagd die te digitaliseren. U zult daarom die drie afbeeldingen
dienen te reproduceren met behulp van uw nieuwe SRTM DEM tiff-bestand(en). Het is geen verplichting om
sportvelden van de school te gebruiken: alle drie types landuse voor school kunnenworden gebruikt (bijv. verschillende
schoolgebouwen, speelplaatsen of parkeerplaatsen).
Ter verwijzing, de afbeelding in de voorbeeldgegevens is:
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20.4 Try Yourself Tokens vervangen

Nadat u uw gelokaliseerde gegevensset heeft gemaakt, is de laatste stap om de tokens in het bestand
substitutions.txt te vervangen zodat de toepasselijke namen zullen verschijnen in uw gelokaliseerde versie
van de trainingshandleiding.
De tokens die u dient te vervangen zijn de volgende:

• majorUrbanName: dit is standaard “Swellendam”. Vervang die door de belangrijkste stad in uw regio.
• schoolAreaType1: dit is standaard “athletics field”. Vervang die door de naam van het grootste type
schoolgebied in uw regio.

• largeLandUseArea: dit is standaard “Bontebok National Park”. Vervang dit door de naam van de grootste
polygoon voor landuse in uw regio.

• srtmFileName: dit is standaard srtm_41_19.tif. Vervang deze door de naam van uw SRTM DEM-
bestand.

• localCRS: dit is standaard WGS 84 / UTM 34S. U zou deze moeten vervangen door het juiste CRS voor
uw regio.

20.4. Try Yourself Tokens vervangen 665



QGIS Training Manual

666 Hoofdstuk 20. Voorbereiden gegevens voor oefeningen



HOOFDSTUK21

Antwoordenblad

21.1 Results For Een overzicht van de interface

21.1.1 Overzicht (Deel 1)

Bekijk opnieuw de afbeelding die de opmaak van de interface laat zien en controleer of u de namen en functies van
de elementen van het scherm nog weet.
Terug naar de tekst

21.1.2 Overzicht (Deel 2)

1. Opslaan als

2. Zoom naar laag

3. Selectie omdraaien

4. Renderen aan/uit

5. Meetlijn

Terug naar de tekst

21.2 Results For Uw eerste laag toevoegen

21.2.1 Voorbereiding

In het hoofdgebied van het dialoogvenster zou u veel vormen met verschillende kleuren moeten zien. Elke vorm
behoort tot een laag die u kunt identificeren door zijn kleur in het linkerpaneel (uw kleuren zouden anders kunnen
zijn dan die hieronder):
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Terug naar de tekst

21.2.2 Gegevens laden

Uw kaart zou zeven lagen moeten hebben:
• protected_areas

• places

• rivers

• roads

• landuse

• buildings (genomen uit training_data.gpkg) en
• water (genomen uit exercise_data/shapefile).

Terug naar de tekst

21.3 Results For Symbologie

21.3.1 Kleuren

• Verifieer dat de kleuren zijn gewijzigd zoals u verwachtte dat ze zouden veranderen.

• Het is genoeg om de laag water te selecteren in de legenda en dan te klikken op de knop
Paneel Laag opmaken openen. Wijzig de kleur naar een die past in de laag water.
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Notitie: Als u slechts met één laag tegelijk wilt werken en niet afgeleid wilt worden door de andere lagen, kunt u een
laag verbergen door in het keuzevak naast de naam in het paneel Lagen te klikken. Als het vak leeg is, dan is de laag
verborgen.

Terug naar de tekst

21.3.2 Symboolstructuur

Uw kaart zou er nu zo uit moeten zien:

Als u een gebruiker bent op het niveau Beginner, mag u hier stoppen.
• Gebruik de bovenstaande methode om de kleuren en stijlen voor alle resterende lagen te wijzigen.
• Probeer natuurlijke kleuren te gebruiken voor de objecten. Een weg zou niet rood of blauw moeten zijn, maar
kan grijs of zwart zijn.
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• Het staat u vrij te experimenteren met verschillende instellingen voor Vullingsstijl en Randstijl voor de
polygonen.

Terug naar de tekst

21.3.3 Symboollagen

Pas uw laag buildings aan zoals u wilt, maar onthoud dat het eenvoudig moet zijn de verschillende lagen in de kaart
te onderscheiden.
Hier is een voorbeeld:

Terug naar de tekst
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21.3.4 Symboolniveau’s

U heeft drie symboollagen nodig om het vereiste symbool te maken:

De onderste symboollaag is een brede, volle grijze lijn. Daarop ligt een enigszins dunnere volle gele lijn en tenslotte
een nog dunnere volle zwarte lijn.
Als uw symboollagen er bijna uitzien zoals hierboven, maar u krijgt niet het resultaat dat u wilt:

1. Controleer dan of uw symboolniveau’s er ongeveer uitzien zoals dit:

2. Nu zou uw kaart er ongeveer zo uit moeten zien:
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Terug naar de tekst

21.3.5 Symboolniveaus

1. Pas uw symboolniveaus aan naar deze waarden:

2. Experimenteer met verschillende waarden om verschillende resultaten te zien.
3. Open opnieuw uw originele kaart voordat u doorgaat met de volgende oefening.

Terug naar de tekst
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21.4 Markeringen voor omtrek

Hier zijn voorbeelden van de structuur van de symbolen:
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Terug naar de tekst

21.4.1 Symbologie voor Geometrie-generator

• Klik op de knop om een ander symboolniveau toe te voegen.

• Verplaats het nieuwe symbool naar de onderzijde van de lijst door te klikken op de knop .
• Kies een goede kleur om de polygonen voor water te vullen.
• Klik opMarkering van de symbologie voor Geometrie-generator en wijzig de cirkel naar een andere vorm zoals
u dat wilt.

• Probeer met andere opties te experimenteren om meer nuttiger resultaten te krijgen.
Terug naar de tekst
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21.5 Results For Vector attributengegevens

21.5.1 Attributen van vectorgegevens verkennen

• Er zouden 9 velden in de laag rivers moeten zijn:
1. Selecteer de laag in het paneel Lagen.

2. Klik met rechts en kies Attributentabel openen, of druk op de knop op de werkbalk Attributen.
3. Tel het aantal kolommen.

Tip: Een snellere benadering zou kunnen zijn om te dubbelklikken op de laag rivers, de tab Laageigenschappen
► Velden te openen, waar u een genummerde lijst met tabelvelden zult vinden.

• Informatie over plaatsen is beschikbaar op de laag places. Open de attributentabel daarvan zoals u ook deed
voor de laag rivers: er zijn twee objecten waarvan het attribuut place is ingesteld op town: Swellendam en
Buffeljagsrivier. U kunt opmerkingen toevoegen aan andere velden van deze twee records, als u dat wilt.

• Het veld name is het meest bruikbaar om als label weer te geven. Dit omdat alle waarden ervan uniek zijn voor
elk object en het is zeer onwaarschijnlijk dat hetNULL-waarden bevat. Als uw gegevens enkeleNULL-waarden
bevatten, maak u dan geen zorgen omdat de meeste van uw plaatsen namen hebben.

Terug naar de tekst

21.6 Results For Labels

21.6.1 Aanpassen van Label (Deel 1)

Uw kaart zou nu de markeringspunten moeten weergeven en de labels zouden verschoven moeten zijn met 2 mm: De
stijl van de markeringen en labels zouden het mogelijk moeten maken beide duidelijk te zien op de kaart:
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Terug naar de tekst

21.6.2 Aanpassen van Label (Deel 2)

Eén mogelijke oplossing heeft dit uiteindelijke product:
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Dit resultaat bereiken:
• Gebruik een grootte van het lettertype van 10
• Gebruik een afstand voor plaatsing rondom punt van 1.5 mm

• Gebruik een grootte voor de markering van 3.0 mm

• In aanvulling daarop gebruikt dit voorbeeld de optie Afbrekingsteken:
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• Voer een spatie in dit veld in en klik op Toepassen om hetzelfde effect te bereiken. In ons geval zijn enkele
van de plaatsnamen erg lang, wat resulteert in namen over meerdere regels, wat niet erg gebruikersvriendelijk
is. U vindt misschien dat deze instelling meer toepasselijk is voor uw kaart.

Terug naar de tekst
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21.6.3 Gegevens-bepaalde instellingen gebruiken

1. Stel, nog steeds in de modus bewerken,, de waarden FONT_SIZE in op die welke u wenst. Het voorbeeld
gebruikt 16 voor steden, 14 voor kleinere steden, 12 voor dorpen en 10 voor gehuchten.

2. Vergeet niet de bewerkingen op te slaan en verlaat de modus Bewerken
3. Ga terug naar de opmaakopties voor Tekst voor de laag places en selecteer FONT_SIZE in het Attribuutveld

van de grootte van het lettertype in de keuzelijst van Data-bepaalde ‘override’:

Uw resultaten, als u bovengenoemde waarden gebruikte, zou dit moeten zijn:
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Terug naar de tekst

21.7 Results For Classificatie

21.7.1 De classificatie verfijnen

De instellingen die u gebruikte zouden niet hetzelfde hoeven te zijn, maar met de waarden Klassen = 6 en Modus =
Natuurlijke grenzen (Jenks) (en door natuurlijk dezelfde kleuren te gebruiken), zal de kaart er zo uit zien:
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Terug naar de tekst

21.8 Results For Een nieuwe vector gegevensset maken

21.8.1 Digitialiseren

De symbologie is niet van belang, maar de resultaten zouden er min of meer als volgt uit moeten zien:
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Terug naar de tekst

21.8.2 Topologie: Gereedschap Ring toevoegen

De exacte vorm maakt niet uit, maar u zou een gat in het midden van uw object moeten hebben, zoals dit:

• Maak uw bewerking ongedaan voordat u doorgaat met de volgende oefening voor het volgende gereedschap.
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Terug naar de tekst

21.8.3 Topologie: Gereedschap Deel toevoegen

• Selecteer eerst Bontebok National Park:

• Voeg nu uw nieuwe gedeelte toe:
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• Maak uw bewerking ongedaan voordat u doorgaat met de volgende oefening voor het volgende gereedschap.
Terug naar de tekst

21.8.4 Objecten samenvoegen

• Gebruik het gereedschap Geselecteerde pbjecten samenvoegen, zorg er voor dat u eerst beide polygonen heeft
geselecteerd die u wilt samenvoegen.

• Gebruik het object met de OGC_FID 1 als de bron van uw attributen (klik op het item ervan in het
dialoogvenster, klik dan op de knop Gebruik attributen van geselecteerde object):

Notitie: Als u een andere gegevensset gebruikt, is het zeer waarschijnlijk dat uw originele polygoon’s OGC_FID niet
1 zal zijn. Kies eenvoudigweg het object dat een OGC_FID heeft.

Notitie: Gebruiken van het gereedschap Attributen van geselecteerde objecten samenvoegen zal de afzonderlijke
geometrieën behouden, maar ze dezelfde attributen geven.

Terug naar de tekst

21.8.5 Formulieren

Voor het TYPE is er uiteraard een beperkt aantal typen dat een weg kan zijn, en als u de attributentabel voor deze
laag bekijkt, zult u zien dat zij vooraf gedefinieerd zijn.

• Stel de widget in op Aanwezige waarden en klik op Data laden van laag.
• Selecteer roads in het keuzemenu Label en highway voor de beide optiesWaarde en Omschrijving:
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• Klik driemaal op OK.
• Als u het gereedschap Objecten identificeren nu gebruikt op een straat terwijl de modus Bewerken actief is, zal
het dialoogvenster dat u krijgt er nu als volgt uitzien:

Terug naar de tekst
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21.9 Results For Vectoranalyse

21.9.1 Afstand van scholen

• Uw dialoogvenster voor de buffer zou er nu ongeveer zo uit moeten zien:

De Buffer afstand is 1 kilometer.
• De waarde Segmenten voor benadering is ingesteld op 20. Dit is optioneel, maar het wordt aanbevolen, omdat
het de buffers in de uitvoer er gladder uit laat zien. Vergelijk dit:
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met dit:
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De eerste afbeelding geeft de buffer weer met de waarde Segmenten voor benadering ingesteld op 5 en de tweede
geeft de waarde weer als die is ingesteld op 20. In ons voorbeeld is het verschil subtiel, maar u kunt zien dat de randen
van de buffer met de hogere waarde gladder zijn.
Terug naar de tekst

21.9.2 Afstand vanaf restaurants

We gaan door een proces met twee stappen om de nieuwe laag houses_restaurants_500m te maken:
• Maak eerst een buffer van 500 m rondom de restaurants en voeg de laag toe aan de kaart:
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• Neem vervolgens de gebouwen uit binnen het gebied van de buffer:
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Uw kaart zou nu alleen die gebouwen moeten weergeven die binnen 50 m van een weg, 1 km vanaf een school en
500 m vanaf een restaurant liggen:
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Terug naar de tekst

21.10 Results For Netwerkanalyse

21.11 Fastest path

Open Netwerkanalyse ► Kortste pad (punt naar punt) en vul het dialoogvenster als volgt in:

Zorg er voor dat Te berekenen type pad is Snelste.
Klik op Uitvoeren en sluit het dialoogvenster.
Open nu de attributentabel van de uitvoerlaag. Het veld cost bevat de reistijd tussen de twee punten (als deel van
uren):
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Terug naar de tekst

21.12 Results For Rasteranalyse

21.12.1 Aspect berekenen

• Stel uw dialoogvenster Aspect als volgt in:

Uw resultaat:
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Terug naar de tekst

21.12.2 Helling berekenen (minder dan 2 en 5 graden)

• Stel uw dialoogvenster Rasterberekeningen in met:
– de volgende expressie: slope@1 <= 2

– de laag slope als de Reference layer(s)
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• Vervang, voor de versie van 5 graden, de 2 in de expressie en bestandsnaam door 5.
Uw resultaten:

• 2 graden:
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• 5 graden:
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Terug naar de tekst

21.13 Results For De analyse voltooien

21.13.1 Raster naar vector

1. Open de Query bouwer door met rechts op de laag all_terrain in het paneel Lagen te klikken en selecteer
selecteer de tab Eigenschappen ► Bron.

2. Bouw dan de query "suitable" = 1.
3. Klik op OK om alle polygonen die niet aan de voorwaarde voldoen uit te filteren.

Indien bekeken over het originele raster, zouden de gebieden elkaar perfect moeten overlappen:
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4. U kunt deze laag opslaan door met rechts te klikken op de laag all_terrain in het paneel Lagen en te kiezen
voor Opslaan als…, en dan door te gaan door de instructies te volgen.

Terug naar de tekst

21.13.2 Inspecteren van de resultaten

Het zal u zijn opgevallen dat enkele van de gebouwen in uw laag new_solution “in plakjes” zijn gesneden door
het gereedschap Intersect. Dit geeft aan dat slechts een deel van het gebouw - en daarom slechts een gedeelte van
het eigendom - op geschikt terrein ligt. We kunnen daarom deze gebouwen met een gerust hart uit onze gegevensset
verwijderen.
Terug naar de tekst
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21.13.3 De analyse verfijnen

Op dit moment zou uw analyse er ongeveer als volgt uit moeten zien:

Denk aan een cirkelvormig gebied, 100 meter doorlopend in alle richtingen.

Als het groter is dan 100 meter in straal, dan zal het aftrekken van 100 meter van de grootte (vanuit alle richtingen)
resulteren in het overlaten van een deel ervan in het midden.
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daarom kunt u een interne buffer van 100 meter op uw bestaande vectorlaag suitable_terrain toepassen. In de uitvoer
van de bufferfunctie, wat overblijft van de originele laag zal de gebieden weergeven waar een geschikt terrein van 100
meter naast ligt.
Als demonstratie:

1. Ga naar Vector ► Geoprocessing-gereedschap ► Buffer(s) om het dialoogvenster Buffer(s) te openen.
2. Stel dat als volgt in:

21.13. Results For De analyse voltooien 699



QGIS Training Manual

3. Gebruik de laag suitable_terrainmet 10 segmenten en een bufferafstand van -100. (De afstand is automatisch
in meters omdat uw kaart een geprojecteerd CRS gebruikt.)

4. Sla de uitvoer op in exercise_data/residential_development/ als
suitable_terrain_continuous100m.shp.

5. Indien nodig, verplaats de nieuwe laag tot boven uw originele laag suitable_terrain.
Uw resultaten zullen er ongeveer zo uitzien:
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6. gebruik nu het gereedschap Selecteren op plaats (Vector ► Onderzoeks-gereedschap ► Selecteren op plaats).
7. Stel dat als volgt in:

8. Selecteer objecten in new_solution die objecten kruisen in suitable_terrain_continuous100m.shp.
Dit is het resultaat:
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De gele gebouwen zijn geselecteerd. Hoewel enkele van de gebouwen gedeeltelijk buiten de nieuwe laag
suitable_terrain_continuous100m vallen, liggen zij ruimschoots binnen de laag suitable_terrain en voldoen
daarmee aan al onze eisen.

9. Sla de selectie op onder exercise_data/residential_development/ als final_answer.
shp.

Terug naar de tekst

21.14 Results ForWMS

21.14.1 Een andere WMS-laag toevoegen

Uw kaart zou er nu ongeveer zo uit moeten zien (u moet misschien de volgorde van de lagen aanpassen):
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Terug naar de tekst

21.14.2 Een nieuwe WMS-server toevoegen

• Gebruik dezelfde benadering als eerder om de nieuwe server toe te voegen en de toepasselijke laag zoals die
gehost moet worden op die server:
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• Als u inzoomt op het gebied Swellendam, zult u opmerken dat deze gegevensset een lage resolutie heeft:

Daarom is het beter deze gegevens niet te gebruiken voor de huidige kaart. De gegevens van Blue Marble zijn meer
geschikt voor globale of nationale schalen.
Terug naar de tekst
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21.14.3 Een WMS-server zoeken

Het zal u zijn opgevallen dat veel WMS-servers niet altijd beschikbaar zijn. Soms is dat tijdelijk, soms is dat
permanent. Een voorbeeld van een WMS-server die werkte op het moment van schrijven is de WMS World
Mineral Deposits op http://apps1.gdr.nrcan.gc.ca/cgi-bin/worldmin_en-ca_ows. Die vereist geen bijdrage en heeft
geen beperkingen voor toegang, en is globaal. Daarom voldoet hij aan de vereisten. Onthoud echter dat dit slechts
een voorbeeld is. Er zijn nog vele andere WMS-servers om uit te kiezen.
Terug naar de tekst

21.15 Results For Integratie van GRASS

21.15.1 Lagen toevoegen aan mapset

U kunt lagen (zowel vector als raster) toevoegen aan een mapset van GRASS Map door ze te slepen en te laten vallen
in de Browser (zie Follow Along: Gegevens laden met de QGIS Browser) of met v.in.gdal.qgis voor vector-
en r.in.gdal.qgis voor rasterlagen.
Terug naar de tekst

21.15.2 Opnieuw classificeren rasterlaag

Voer, om de maximale waarde van het raster te weten te komen, het gereedschap r.info uit: in de console zult u
zien dat de maximale waarde 1699 is.
U bent nu klaar om de regels te schrijven. Open een tekstbewerker en voeg de volgende regels toe:

0 thru 1000 = 1
1000 thru 1400 = 2
1400 thru 1699 = 3

sla het bestand op als een bestand mijn_regels.txt en sluit de tekstbewerker.
Voer het gereedschap r.reclass uit, kies de laag g_dem en laadt het bestand dat de regels bevat die u zojuist
hebt opgeslagen.
Klik op Uitvoeren en dan op Uitvoer bekijken. U kunt de kleuren wijzigen en het uiteindelijke resultaat zou er uit
moeten zien als op de volgende afbeelding:
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Terug naar de tekst

21.16 Results For Database-concepten

21.16.1 Address tabeleigenschappen

Voor onze theoretische tabel Address, zouden we mogelijk de volgende eigenschappen willen opslaan:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

Bij het maken van de tabel om een object adres weer te geven, zouden we kolommen maken om elk van deze
eigenschappen weer te geven en we zouden ze aan SQL-eisen laten voldoen en mogelijk afgekorte namen geven:

house_number
street_name
suburb
city
postcode
country

Terug naar de tekst
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21.16.2 De tabel People normaliseren

Het belangrijkste probleemmet de tabel People is dat er één enkel adresveld is dat het volledige adres van een persoon
bevat. denkend aan onze theoretische tabel Address eerder in deze les, weten we dat een adres is opgebouwd uit vele
verschillende eigenschappen. Door al deze eigenschappen op te slaan in één veld, maken we het veel moeilijker
om onze gegevens bij te werken en te bevragen. We dienen daarom het adresveld op te splitsen in de verscheidene
eigenschappen. Dat zou ons een tabel geven die de volgende structuur heeft:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

Notitie: In het volgende gedeelte zult u meer leren over relaties met Foreign Key die in dit voorbeeld zouden kunnen
worden gebruikt om de structuur van onze database te verbeteren.

Terug naar de tekst

21.16.3 Verdere normalisatie van de tabel People

Onze tabel People ziet er momenteel als volgt uit:

id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

De kolom street_id geeft een relatie ‘één-tot-veel’ weer tussen het object People en het gerelateerde object Street,
wat in de tabel Streets staat.
Eén manier voor het verder normaliseren van de tabel is om het veld Name op te splitsen in first_name en last_name:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

We kunnen ook afzonderlijke tabellen maken voor de namen van stad of dorp en het land, en ze koppelen aan onze
tabel People via relaties ‘één-tot-veel’:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

Een ER-diagram om dit weer te geven zou er zo uitzien:
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Terug naar de tekst

21.16.4 Een tabel People maken

De SQL die is vereist voor het maken van de juiste tabel People is:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );

Het schema voor de tabel (voer \d people in) ziet er zo uit:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

Notitie: Om redenen van illustratie hebben we opzettelijk de beperking fkey weggelaten.

Terug naar de tekst
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21.16.5 De opdracht DROP

De reden dat de opdracht DROP in dit geval niet zal werken is omdat de tabel People een beperking Foreign Key heeft
voor de tabel Streets. Dit betekent dat het droppen (of verwijderen) van de tabel Streets de tabel People zou achterlaten
met verwijzingen naar niet-bestaande gegevens van Streets.

Notitie: Het is mogelijk om te ‘forceren’ dat de tabel Streets zal worden verwijderd met behulp van de opdracht
CASCADE, maar dat zou ook de tabel People en elke andere tabel die een relatie heeft met de tabel Streets verwijderen.
Gebruik het dus voorzichtig!

Terug naar de tekst

21.16.6 Een nieuwe straat invoeren

De opdracht voor SQL die u zou moeten gebruiken ziet er als volgt uit (u mag de straatnaam vervangen door de naam
van uw keuze):

insert into streets (name) values ('Low Road');

Terug naar de tekst

21.16.7 Een nieuwe persoon met een relatie Foreign Key toevoegen

Hier is de juiste opdracht voor SQL:

insert into streets (name) values('Main Road');
insert into people (name,house_no, street_id, phone_no)

values ('Joe Smith',55,2,'072 882 33 21');

Als u opnieuw naar de tabel Streets kijkt (met behulp van een argument SELECT zoals eerder), zult u zien dat het
id voor het item Main Road 2 is.
Dat is waarom we hierboven eenvoudigweg het nummer 2 konden invullen. Zelfs hoewel we Main Road niet
volledig zien uitgeschreven in het item hierboven, zal de database in staat zijn om dat te associëren met de waarde
van 2 voor street_id.

Notitie: Als u al een nieuw object street had toegevoegd, zou u kunnen merken dat de nieuwe Main Road een
ID heeft van 3 en niet 2.

Terug naar de tekst
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21.16.8 Straatnamen teruggeven

Hier is het juiste argument voor SQL dat u zou moeten gebruiken:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Resultaat:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

Notitie: Het zal u zijn opgevallen dat we veldnamen hebben met daaraan voorafgaand de tabelnaam (bijv.
people.name en streets.name). Dat is altijd nodig wanneer de veldnaam niet duidelijk te onderscheiden is (d.i. niet
uniek over alle tabellen in de database).

Terug naar de tekst

21.17 Results For Ruimtelijke query’s

21.17.1 De eenheden gebruikt in ruimtelijke query’s

De eenheden die door het voorbeeld van de query worden gebruikt zijn graden, omdat het CRS dat de laag gebruikt
WGS 84 is. Dat is een Geografisch CRS, wat betekent dat de eenheden ervan in graden zijn. Een geprojecteerd CRS,
zoals de projecties in UTM, is in meters.
Onthoud dat wanneer u een query schrijft, u dient te weten in welke eenheden het CRS van de laag is. Dat zal u in
staat stellen een query te schrijven die de resultaten zal teruggeven die u er van verwacht.
Terug naar de tekst

21.17.2 Een ruimtelijke index maken

CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);

Terug naar de tekst
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21.18 Results For Construeren van geometrie

21.18.1 Lijnen maken

alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(the_geom) = 'ST_LineString'::text OR the_geom IS NULL);
insert into geometry_columns values ('','public','streets','the_geom',2,4326,

'LINESTRING');
create index streets_geo_idx

on streets
using gist
(the_geom);

Terug naar de tekst

21.18.2 Tabellen koppelen

delete from people;
alter table people add column city_id int not null references cities(id);

(steden vastleggen in QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('Faulty Towers',

34,
3,
'072 812 31 28',
1,
'SRID=4326;POINT(33 33)');

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('IP Knightly',

32,
1,
'071 812 31 28',
1,F
'SRID=4326;POINT(32 -34)');

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('Rusty Bedsprings',

39,
1,
'071 822 31 28',
1,
'SRID=4326;POINT(34 -34)');

Als u het volgende foutbericht krijgt:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

dan betekent dat dat u bij het experimenteren met het maken van polygonen voor de tabel Cities, u enkele ervan
verwijderd moeten hebben en overnieuw zijn begonnen. Controleer de items in uw tabel Cities en gebruik een
bestaande id.
Terug naar de tekst
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21.19 Results For Eenvoudig object model

21.19.1 Tabellen vullen

create table cities (id serial not null primary key,
name varchar(50),
the_geom geometry not null);

alter table cities
add constraint cities_geom_point_chk
check (st_geometrytype(the_geom) = 'ST_Polygon'::text );

Terug naar de tekst

21.19.2 De tabel geometry_columns vullen

insert into geometry_columns values
('','public','cities','the_geom',2,4326,'POLYGON');

Terug naar de tekst

21.19.3 Geometrie toevoegen

select people.name,
streets.name as street_name,
st_astext(people.the_geom) as geometry

from streets, people
where people.street_id=streets.id;

Resultaat:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

Zoals u kunt zien staat onze beperking toe nulwaarden toe te voegen aan de database.
Terug naar de tekst
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